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Copyright © 2014 Softpress Systems Ltd. All rights reserved. The Freeway software and this documentation are copyright materials. No part of 
the Freeway software may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language, or computer 
language, in any form or by any means without the prior written permission of Softpress Systems Ltd. Additional copies of this guide may be 
made and distributed provided they include this copyright notice. 

Softpress Systems Ltd specifically retains title to all Freeway computer software. The software described in this guide is furnished under a license 
agreement and may only be installed, used, or copied in accordance with the terms of that agreement. 

Softpress is a trademark of Softpress Systems Ltd in the United States and other countries. Freeway is a trademark of Softpress Systems Ltd, which 
may be registered in some countries. Apple, Macintosh, Power Macintosh, the Universal logo and the Mac Logo are registered trademarks of 
Apple Computer Inc. All other product names are trademarks, or registered trademarks of their respective owners. 

Limitation of liability
The information in this guide is believed to be correct as of the date of publication. However, our policy is one of continuous development and 
so the information in this guide is subject to change without notice, and does not represent a commitment on the part of Softpress Systems Ltd.

System requirements
Freeway 6.x requires Mac OS 10.6 and above

Contact details 
Web: http://www.softpress.com/    Email: info@softpress.com

Introduction
The Freeway Reference is intended to be an in-depth resource for beginners and experienced users alike. 

We try to cover almost everything, from planning and preparation, to starting your web site in Freeway, defining page sizes, and so 
on right through to dealing with forms, markup, and managing your site. You will occasionally find cross references to other Softpress 
publications. If you don’t have copies of these, please visit the Softpress web site (http://www.softpress.com/support/) under “Manuals”.

If you want to learn how to get started with using Freeway, we recommend you download the Using Freeway guide as this guide has a 
Getting Started tutorial. 

A note about the differences between  
Freeway Pro and Express
Much of this Reference covers both Freeway Pro and Express, but there are some fundamental differences between the two versions. 
Where possible, we have highlighted in the text where such differences affect any actions described. You can find a list on the next page 
which outlines the key features that are only available in Freeway Pro.

Enjoy Freeway!

What’s the difference?
Freeway Pro and Express have a lot of features in common. However, in order to differentiate between the two products, the following 
features are not available to Express users.

•	 Multiple output options (HTML 4.01 Transitional and Strict, XHTML 1.0 Transitional and Strict, HTML5, XHTML5).
•	 Full choice of output encodings available.
•	 High resolution graphic output.
•	 HTML5 semantic elements.Full choice of output encodings available.
•	 HTML5 functionality on form items
•	 Website search function
•	 Link map: overview and maintenance of all the links in your document.
•	 Multiple windows open for the same document at once.
•	 Snapping palettes for easier workspace management.
•	 Complete color and text style management across your entire document.
•	 Employ multiple style sheets for each document.
•	 Full CSS text styling and CSS Layout.
•	 Ability to specify relative and percentage positions and dimensions for layout items.
•	 Specify padding, wrap, margin, and border (HTML items only) separately for each side of an item.
•	 Import Illustrator, Photoshop, TIFF, EPS, PDF.
•	 Extended transformation options: Skew, Scale, and Mirror content separately from its box.
•	 Save items and pages as images.
•	 Use the full range of Freeway Actions, or write your own.
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Learn the basics by building the Using Freeway tutorial site 
By far the best way to learn the basics and to understand the workflow of building sites in Freeway we strongly recommend that new 
users build the Using Freeway tutorial site. Please visit the Softpress web site (http://www.softpress.com/support/) and download the 
Using Freeway guide which is listed under “Manuals”. You can then print out the Tutorial section or view it on-screen so you can read 
the tutorial as you build the site following the steps outlined in the Tutorial section.

Once you’ve learnt the basics of working with Freeway, it’s probably a good idea to have some basic information before you start, such 
as the width of your site pages, what the main sections of the site will be and what common items you intend to use on your pages. 

Freeway is not an HTML editor but a layout program that automatically generates HTML files to display your web page designs in a 
browser. Using Freeway is like using Desktop Publishing (DTP) software. In DTP, you create a document that can only be read by the 
original application and is then usually output as a PDF or PostScript file. In Freeway you define documents, which again can only be 
read by the native application but which are then exported as HTML pages and web-ready graphics for viewing in any web browser. 

Freeway’s approach to web authoring separates web design from HTML code, and allows you to design for the medium of the web 
instead of concentrating on the low-level task of writing markup to express your designs. Freeway produces clean and efficient HTML 
offering many advantages over HTML editing programs.

Starting a website 
It’s probably a good idea to have some basic information before you start, such as the width of screen you want to work within and an 
idea of what the main sections of the site will be. The most important thing to appreciate before you start a site in Freeway is how the 
application works. 

Freeway is not an HTML editor but a layout program that automatically generates HTML files to display your web page designs in a 
browser. Using Freeway is like using Desktop Publishing (DTP) software. In DTP, you create a document that can only be read by the 
original application and is then usually output as a PDF or PostScript file. In Freeway you define documents, which again can only be 
read by the native application but which are then exported as HTML pages and web-ready graphics for viewing in any web browser. 

Freeway’s approach to web authoring separates web design from HTML code, and allows you to design for the medium of the web 
instead of concentrating on the low-level task of writing markup to express your designs. Freeway produces clean and efficient HTML 
offering many advantages over HTML editing programs.

Planning the site 
If you are using Freeway Pro it is very important to plan ahead so you know what type of site you would like to build—as decisions need 
to be made very early on in the project. We generally recommend that beginners use table-based or CSS-positioned layout, but you can 
also build a flexible (percentage-based) site, a site with full-width headers and footers, one which can be made to work with responsive 
layout or a content management system. We recommend you read the section in the Appendix on page 00.

Creating a new site 
To begin a web site you first create a Freeway document, which stores all the information about your web site. Within the document you may 
define as many pages as you like, each of which corresponds to an HTML web page that will be created when you export or “publish” the site. 
Each HTML page is a file that a web browser displays. On your pages, you can create items that may contain text, graphics, or multimedia 
content, or that are exported as colored graphics or lines. 

You can also build master pages, which are used to define the basic appearance of the pages in your document. Any items—such as 
logos or navigation buttons—that should appear on all the pages in a particular section can be created on a master page, which can 
then be applied to one or more of your site pages. Within a document you may also define folders and subfolders to organize the 
physical structure of your site. 

Navigation is one of the most important issues when planning a new site, and it is important to decide on a consistent scheme early on. 
Careful structuring of your content so that it makes sense to the visitor is also crucial. Make your site easy to get around, let your visitors 
know where a link will take them, and ensure that visitors can tell where they are in your site at all times. 

Publishing and previewing your site 
Once you have created your document with its pages, page contents, and links, the next step is to “publish” the pages from the 
document as HTML files. You will then transfer the resulting files to a web server (by using Freeway’s built-in upload function), which 
allows other people to access them.

Publishing is the process whereby Freeway generates the HTML pages with their associated resources (i.e. graphics and multimedia 
elements). This is done using the Preview command, the Publish command or by clicking on the Browser button to preview the site in 
a browser of your choice. Each command will publish the site into a local folder (which will be automatically set if you start a new project 
by using the Blank template), but Preview only publishes and displays the current page in a cut-down browser while clicking on Browser 
publishes the entire site then displays it in your chosen browser. Freeway Pro users starting a new project using the New Document dialog’s 
Custom tab will need to specify a site folder when publishing the project for the first time.

Getting started
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As you work, you need to preview your site regularly. When you do this, any new pages or any elements that have been changed are 
republished. If you delete a page from the document, the HTML file and associated graphics will be removed as well. 

After publishing your site locally, you can use the Upload command to transfer it to a web server so it can be viewed online. 

Workflow 
There is a sequence of steps to designing a web site with Freeway: 

1.	 Planning the site 
2.	 Designing the layout 
3.	 Creating and assembling content 
4.	 Creating a new Freeway document 
5.	 Defining grids, master pages, and navigation 
6.	 Adding and laying out pages 
7.	 Previewing the site and making corrections 
8.	 Publishing and uploading the site 
9.	 Maintaining the site 

1  Planning the site 
It’s usually beneficial to spend some time planning the site before you start, even if it’s just a few minutes to gather your thoughts—this 
will help to avoid false starts. 

If you are designing for clients, then it’s essential you understand their requirements and expectations before you start and then plan how to 
fulfil these. For example, you may find that they want to include advanced features such as multimedia, animation, database integration, or 
online shopping at a later stage, and your design may need to take these factors into account. 

You may also want to clarify up front with the client how far your responsibility extends—are you just going to hand over a disk 
containing the HTML and graphics which make up the site or are you expected to upload it to their web space? Do they expect you to 
provide web space for them? Are you expected to arrange their domain name? What about revisions and routine maintenance in the 
future? 

2  Designing the layout 
Just as with design for print, you’ll probably want to take some time to rough out some ideas on paper before you sit down at the 
computer. Even experienced designers find sitting at a computer staring at a blank page is the last place to find inspiration! 

When working for clients, you may be liaising closely with them on the design brief. The site may need to fit in with an existing identity, 
so that typefaces, colors, and even design elements may be prescribed for you—or you may be expected to come up with an identity 
yourself. Either way, you’ll want to get client approval for the design before you go too far in creating the site. Freeway is great for pulling a 
few ideas together quickly and producing two or three mock sites for clients to look at in a very short space of time. 

Don’t worry too much if the client wants some small, last minute changes as long as these only affect elements created within Freeway. 
It’s mainly design elements that need to be painstakingly created in other packages that cause trouble if the client wants to change them 
later. Be especially sure to clear typeface and color choices with the client if you’re going to be doing any animation, 3D work, or image 
manipulation to form part of the site content. 

The end product of the design stage should be confirmation of the basic layout that’s going to be used, as well as an understanding 
between you and the client over typeface, color, and how much (and what) technology is going to be used. 

3  Creating and assembling content 
With the design stage complete, you’re ready to begin creating and assembling the content for the site. This includes the basic textual copy for 
the pages and any graphic or multimedia elements that can’t be easily created within Freeway—for example, animated GIFs, or Flash, video, 
or sound content, PDFs for download, photographic images, and so on. 

It’s often a good idea to assemble all the resources in one place before you 
import them into Freeway, purely for administrative reasons. When the project 
is complete, archive these original resources along with the Freeway document 
and the finished HTML site folder. When creating art for the web, it’s best 
to work at 72 ppi (pixels per inch) for bitmap images. As a result, you’ll find 
you’re spending less time watching the clock in Photoshop and more time 
creating. 

You don’t need to save your artwork as GIF or JPEG before you use it in 
Freeway—actually, you often have more control and get better results if 
you don’t. Also, repeated JPEG compression of an image will introduce 
cumulative artifacts, which damage the image every time you save. 

There’s no need to create bitmap graphics of text or simple shapes in an 
image editing program because Freeway allows you to create these with much 
more control and greater flexibility. As you’re planning the actual content, 
try to look for things that can be created in Freeway itself, and do so—when 
last minute changes are called for, you’ll be glad you did. 

A typical web site 
folder. This one is 
created automatically by 
Freeway when choosing 
the Blank template 
or any other specified 
template as a basis 
for your site. Pro users 
creating a new site using 
the Custom settings, 
you may want to create 
a similar folder structure 
by hand.
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When you finally import the finished content into Freeway, Freeway links to the original files as well as storing a version internally. 
The original is used when the site is published, but if the linked files can’t be found, Freeway often has enough information stored to 
produce acceptable results. 

If you’re creating art in a vector illustration program such as Illustrator or FreeHand, you can take advantage of Freeway Pro’s support 
for Illustrator files. Import Illustrator files directly into Freeway Pro or save EPS documents in Illustrator format. You can also use your 
vector program to save as EPS, and then use Photoshop to rasterize it for you. Save the finished raster version as a TIFF or PSD for 
import into Freeway Pro. Alternatively, the most up-to-date versions of these professional drawing tools allow you to save a version as a 
bitmap format. 

Freeway Pro allows you to import a large variety of file types, so if you are 
working with bitmap images (such as those generated by Photoshop), you 
can import them as Photoshop files in addition to TIFF or any of the other 
supported formats. TIFF and PSD files with transparency are also supported 
by Freeway Pro. 

4  Creating a new Freeway document 
Once you’ve come up with a basic layout, the essential design decisions have been made and you have assembled at least some of the 
content, you can then go ahead and create a new Freeway document. 

Your Freeway document is essentially a self-contained unit, fonts and external resources aside. It can contain as many pages as you need and 
allows you to define a hierarchical folder structure for your site. This document file is not uploaded to the web but remains on your system. Only 
Freeway can open the document. 

When you want to make changes to your site, open this document up in Freeway, edit it, and then publish it into the site folder again.

To view the site in a web browser, you need to publish it as HTML into a destination folder. This folder is known as the Site Folder, 
and it is the contents of this folder that need to be uploaded to your web space when you publish your site on the web. For more 
information about the Site Folder, see page 16.

5  Defining grids, master pages, and navigation 
Once you have created your new document, the first job is generally to set up a consistent layout grid using one or more master pages. 
These master pages form a basis for the real pages you create in your document—the guides and grid you define are repeated on every 
page that uses the master page, and any page elements also appear on all the instance pages. 

Master pages can be used to ensure consistent design, branding, and navigation throughout your site. When using links on graphics 
for navigation, replicate the links using HTML text elsewhere on the page, so that visitors browsing with their images off or using older 
browsers can still navigate your site. 

You should also be scrupulous about defining “alt text” for graphic elements; alt text describes an image on the web page if it is not 
displayed in the browser. Freeway can create alt text for imported images automatically. See Alt text for exported graphics on page 99 for 
more information.

Remember that the visitor is only going to see one page at a time and is going to have to reach every page in your site by navigating 
from a starting point—you need to keep asking yourself, does this make sense? Is it easy to tell which section I’m in or which page I’m 
on? Is it obvious where to go now? Is it easy to get back to the home page? 

6  Adding and laying out pages 
Apart from the familiar tasks of adding text, graphics, and other content, there are other considerations to bear in mind at this stage. 

You should use the title of each page to help visitors keep track of where they are: use the Title field in the Inspector palette to set these, 
and make them helpful and informative. It’s most important to give the home page in the site a sensible title, such as “Softpress Systems: 
Home Page” which will help with “search engine optimization” to give better search rankings for your site. Another benefit of using 
sensible names is so that when someone bookmarks it in their browser, it is easy to find again in their bookmarks menu.

You should also remember to check that the file name for your home page is set to something like index.html or default.html 
(whichever is supported by the web server you’re going to be using). This is so that someone coming to your web site without 
specifying a particular page name will be taken to the home page. Freeway 
automatically uses index.html as the name of the first page that is created 
in a document or folder. You can change a page’s file name using the Page 
General panel in the Inspector palette in Freeway. 

7  Previewing the site and making corrections 
You’ll find it helpful to preview your pages in a web browser from time to time while you’re working. Although the screen feedback in 
Freeway is excellent, it will still be subtly different from the result in the browser. By previewing in the browser periodically, you can alert 
yourself to any problems that emerge. 

Take care to preview the site using a variety of different browser versions, and—most important—using Microsoft Internet Explorer, 
Firefox, or Google Chrome, as well as Apple’s Safari browser. Unfortunately, just because a page looks fine in one browser does not mean 
it will look the same in all others. 

You can also preview within Freeway, but although the internal preview uses the same engine that drives Safari, it is only really suitable 
for a quick check on one page at a time. Links to external pages will not work in Preview, so you won’t be able to navigate around your 
site. On the other hand, Freeway’s Preview provides various options for checking pages with Javascript switched off, etc., and Pro users  
can view the page with an accessibility stylesheet, or in grayscale, etc.

Note: Freeway Express does not support TIFF or Photoshop 
import formats. If you require transparency, you can save 
graphics in PNG format (PNG is a lossless format which can 
be used for graphics with millions of colors). Another possible 
alternative is PICT.

Important: Never rename or move your web files outside 
Freeway, as this will break the links between pages in your site or 
mean that images won’t load when the page is viewed.
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When you create a page, you should preview it in a browser with font sizes set to larger (and smaller) than the default. This is essential 
to check that page elements haven’t broken up or moved apart under different viewing conditions. Also, be aware that font sizes on 
Windows PCs are approximately 10% larger than they are on the Mac, so problems can occur when pages that look fine on the Mac are 
viewed using Windows browsers. 

If you don’t have a Windows PC available to check the pages yourself, ask a friend or colleague with a PC to check the site for you or join 
a web design mailing list on the Internet and ask for a site review (Softpress’s own Freeway Talk list is a good place to start!). You may be 
surprised how helpful people are on such lists, but you do need to make the pages available on the web for other people to view at their 
convenience. You might like to consider using a “virtual machine” (such as Parallels or VMWare) on your Mac so you can run Windows to 
view your sites in different versions of PC browsers. 

8  Publishing and uploading the site 
Previewing your site on your own machine or network is one thing, but if others are to see it, you have to get the files (HTML documents, 
graphics, sounds, etc.) onto a web server. Whether you have a web server on your internal network or you use one the various FTP 
protocols to upload files to your web space, Freeway can do this for you automatically using the Upload… command. See the section 
Publishing the site on page 135 for more information on how to upload your files using FTP, FTPS or SFTP as well as publishing your files to 
a specified local folder by using the File Copy option.

In order to make the connection to your web space, you need to know the server or host details, the path to your folder (if any), and 
a login and password. If in doubt about what these should be, you need to speak to either your web server system administrator or the 
support helpline of your web host, who will be able to give you this information. 

Each web host will use slightly different settings (such as requiring an IP address or your web domain), so find the information your 
host sent to you by email which gives you all of that information. There is an article on the Softpress KnowledgeBase which offers help 
for this at http://www.softpress.com/kb/questions/152/.

9  Maintaining the site 
When the time comes to make changes to your site, the easiest way of doing this is to open the original Freeway document, make the 
changes you need, and use the Upload… command to update your web site. When using the Upload… command, both your local site 
folder and your web space are updated with the latest changes in your document.

Creating a new site document
To create a new document, choose New… from the File menu. 
The New Document dialog is displayed to allow you to specify 
settings that will apply to your entire site.

Freeway Express will always display options for starting from a 
template. If you wish to start from a blank canvas (ie, starting 
without using a template as a basis for your new site), choose 
the Blank template which you will find by selecting General in 
the left-hand pane. See the screenshot (right).

Freeway Pro has an additional feature in the New Document 
dialog in that it has two “tabs” where you can switch between 
Templates or Custom. See the screenshot (below right).

In Freeway Pro the Templates tab offers a list of predefined 
templates you can use as a basis for your new site—which is 
very similar to that shown in the Freeway Express screenshot, 
but clicking on the Custom tab you can see the New Document 
dialog shown below right.

In the following pages, we will concentrate on the Custom 
settings, available only in Freeway Pro.

Default HTML FW Pro only  

This popup menu in the New Document dialog box Custom 
panel allows you to select which version of HTML will be used for 
Freeway’s output. It also affects whether certain functionality is 
available.

•	 HTML 4.01 Transitional and HTML 4.01 Strict provide 
dynamic HTML and CSS support with most browsers 
including many older ones.

•	 XHTML 1.0 Transitional and XHTML 1.0 Strict generate 
XHTML-compliant code, for use with applications that require 
it.

•	 HTML5—which is the version we recommend you use unless you have a particular reason to choose otherwise—takes advantage of 
many new features of recent browsers.

•	 XHTML5 generates XHTML-compliant code, for use with applications that require it.

Important: Freeway Express only publishes to HTML5. 

Freeway Express’s New Document dialog. 

Freeway Pro’s New Document dialog showing the Custom panel.
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Default page size, width, and height 
Freeway allows you to define a nominal page size for the pages in your document. This size is used to define the page boundaries viewed 
within Freeway. Items placed within the page boundaries will always be output when the site is published. 

The width value entered here is usually of greater importance than the height. This is because with most layout methods the width 
value is output in the code of the page and this will define where the page area will align and if the browser window is made smaller 
than the given width, a horizontal scrollbar will display in the browser. The height value on the other hand is a nominal value because 
a browser will display only scroll down to display the lowest item used on the page area (or, in Freeway Pro, down to the lowest layer 
item used in your Freeway file even if it is not on the page area).

The page sizes set here are used to define the sizes of the master page or pages in your document, and therefore define the default 
size for any new pages that are created. It is also possible to set the dimensions of individual site pages using the Page General panel 
of the Inspector palette. If you set page sizes individually, changes to the default page size in the New Document dialog or the 
Document Setup dialog (see Changing document setup on page 19) will not take affect on these pages. 

The Default page size popup menu in the New Document dialog contains some sample sizes, but you can enter your own values for width 
and height by typing values into the Width and Height text fields. 

Freeway offers several default page sizes, but unless you expect your target audience to use very old computer screens, a good starting 
point is a width of 980 pixels which will mean that your page will look fine on laptops as well as larger desktop screens. Although some 
people try to build pages which use a fixed height so that all the content is visible without scrolling, most websites are built so they use 
variable heights according to the content of each page—because most web visitors are comfortable with scrolling vertically, and many 
will even expect to do so.

For more information on sizes and screen resolutions, see Deciding on a page size later. 

Site Folder
Freeway publishes the HTML and images that make up your web 
site into a folder specified using the Site Folder option. You 
should set a separate site folder for each web site that you create. 
The Site Folder should ideally be contained within the folder that 
holds your project files, such as the main Freeway document, 
image and multimedia files, etc. The illustration on page 13 
shows a typical project folder. On no account should you save your Freeway document in the Site Folder—we recommend that you save 
the Freeway file inside the document folder, alongside the Site Folder. It is usually best to let Freeway control the contents of the Site 
Folder, since only the latest version of the published code is placed there when you publish from your document.

If creating a large site, it may be best to split your site across several Freeway documents to make it quicker and easier to work with. In 
this case, you should ensure that each of the Freeway documents is set to publish into your main Site Folder.

Any folders defined within your Freeway document will be created within the Site Folder as subfolders. The site folder corresponds 
to the root directory of your web site, and like the root directory, it should contain any top-level items required, such as the index or 
default page. For more information, see Document Setup: Site Folder on page 233 (Pro) or page 234 (Express).

Resources
When exporting pages from your document, Freeway creates an HTML document representing each page, as well as any image files required. 
The image files referenced from each HTML document are known as the “resources” for that page.

Freeway allows you to choose where you want the resources for each page to be published. Freeway defaults to using a Common 
Resource Folder. This can make it easier to manage the output files for your site. 

When common or separate Resource folders are specified for a site, any graphics, movies, mp3s, Java applets, or other files used in your 
site will be published into a folder called Resources, leaving the actual HTML files for your pages together. 

Specifying the resource folder 

The location for publishing page resources is set using the New 
Document dialog when you open a new Freeway document (or it 
can be changed later by going to File>Document Setup… and then 
clicking on the Resources folder in the Output tab).

The Resources popup menu offers the following options: 

•	 Common Resource Folder: All resources are saved in a single 
“Resources” folder in the root of the site folder. This is the default 
option for new documents.

•	 Separate Resource Folders: Resources are saved in separate 
“Resources” folders in each subdirectory of the site folder, as well as 
in the root of the site folder. 

•	 With HTML Files: Resources are saved in the same directories as HTML files.

File names
The File names popup menu allows you to specify whether you want to use UNIX/Windows style long file names, DOS 8.3 file 
names, or long Alphanumeric file names. By default, the HTML pages and other files created from your site will be named with 
UNIX/Windows style long file names. These allow characters other than numbers and letters to be used in the file names for the 
files generated from your document, though you should bear in mind that some characters, such as apostrophes and speech marks, 

Note: If you selected a template as the basis for your site, Freeway will 
already have created a Site Folder to contain the HTML files and resources 
generated when you publish the site. If you are using Freeway Express the 
folder structure is always generated automatically.
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are deemed “illegal”. Alphanumeric long file names allow only 
letters, numbers, hyphens, and underscores in the file name 
(apart from the dot before the file extension): some web hosts 
require file names to be limited to these characters.

When Freeway generates the file names using the titles of items 
or pages within Freeway as a basis, any illegal characters will be 
removed.

The way file names are specified may be important when 
transferring your files to a web server. All Macintosh, Windows 
95/98/NT/2000/XP/Vista and UNIX computers handle long file 
names. If you find that you need to transfer your site files via DOS on a PC, or are experiencing problems which you suspect are a result 
of long filenames being truncated, you can use this option to tell Freeway to use DOS 8.3 file names instead. Alternatively, if Freeway 
reports that it is unable to upload a file because its file name is not allowed, you can use the Alphanumeric option to avoid this 
problem.

This can be done at any time. If you change this option after a site has been created, you must republish the site to ensure that changes 
to referenced files are correctly updated.

Deciding on a page size 
Each web page seen by a visitor to a web site exists as an individual HTML file; and every page you create in Freeway is exported as an 
individual HTML file when you publish your site. One of the most important things to do when deciding on a page size is to plan the 
overall structure of your site in advance—although you can create pages as you need them, it’s best to have a clear idea of the general 
sections that your site will contain. 

Web pages are not limited in dimension; and if you create pages that are wider or longer than the visible area inside the visitor’s browser 
window, the browser window will display scroll bars to allow the visitor to view parts of the page that are off the screen. However, it is 
usually considered poor design to have pages that force the user to scroll horizontally to see the rest of the page. 

Your pages may be viewed in a variety of environments, including smartphones, tablets, small desktop monitors, laptop screens and 
very large desktop monitors such as an iMac 27-inch. A screen’s resolution refers to its dimensions in pixels; therefore the older standard 
screen size of 640 x 480 (which are now quite rare) gave you a web page size of 640 pixels wide by 480 high. At the time of writing this, 
the most common display resolution for browsing the internet is 1024 pixels wide, so although larger and wider displays are becoming 
more common, it’s recommended to offer a web site which has a page width of between 950 pixels to 1050. Any narrower and the page 
may look small on a modern screen; any wider and it may force the visitor to scroll horizontally to view all the page content.

It is also worth noting that most web users will not have a problem with scrolling vertically (and in fact most visitors now expect to)—
so the height of the page is not so important. Trying to constrain every page of your web site to a fixed height is very limiting as there 
are always going to be some pages which will naturally have more text and graphic content than other pages. It is a common trait of 
people coming into ‘design-for-web’ from the ‘design-for-print’ world to try to work to a fixed height for all pages of their site—and 
most soon learn to build pages with a height that’s governed by their content.

If you wish to create pages for commercial sites with a non-scrolling policy, you need to judge carefully the size you define for your 
Freeway pages, so that they will fit comfortably inside a browser window. The size you choose needs to allow for the menu bars, button 
bars, status bar, and so on belonging to the browser. This can result in a very small area indeed if you are designing for smaller, older 
computer displays. 

Remember, however, that Microsoft Windows browsers tend to open full screen, and many users never change that default. If you are 
creating a site that will be flexible if the browser window is resized, you need to be aware of how it may appear on a full-screen high 
resolution PC display. Mac users surfing on high-resolution screens tend to prefer to size the window to approximately the aspect ratio 
of a portrait sheet of paper, rather than expand windows to fill their field of vision.

Freeway lets you specify a page size for the document as a whole in the Document Setup dialog box, but you can set different sizes for 
individual pages using the Page General panel of the Inspector palette.

Layout options FW Pro only  
Freeway Express only supports table-based layout (although some lower level inflow layout can be used). Freeway Pro, however, gives 
you a variety of layout options as it allows you to create table-based, CSS-positioned or inflow layouts. This is covered in greater detail in 
Appendix 1 at the end of this manual.

Table layout (CSS Layout button off)
Table-positioned items are drawn with a blue outline and/or blue corner mounts in Freeway. These items form a layout that is 
reproduced in HTML when you publish your site. To recreate your layout in HTML, Freeway creates an invisible layout table, consisting 
of rows and columns that combine to create table cells. Because the contents of Freeway boxes are output into their corresponding cell 
or cells in this two-dimensional grid, it is not possible to have the contents of two different cells overlapping one another in the output 
except by using layer items.

CSS layout (CSS Layout button on) FW Pro only  

CSS layouts are created using items which are positioned on the page using CSS (and those items are often called “layer” items). 
Layer items are drawn on the page when the CSS Layout button on Freeway’s tool bar is switched on, and layer items display with 
a green outline and/or green corner mounts on the Freeway page. CSS items can also be part of a flow (inflow items), in which case 
their position is dependent on the position of previous items within the flow, or they may have a fixed position on the page (layers). 

Note 1: If DOS file names are selected, the Resources folder is renamed 
“resource” instead of “Resources”.

Note 2: If a resource is shared by several pages in different folders, and the 
common or separate Resource folder options are selected, the resource will be 
copied into a single folder and not duplicated in each of the separate folders.

Note 3: Full details of Freeway’s preference settings, Document Setup 
dialog and shortcuts can be found in the Appendix 2 and Appendix 3 
sections, starting on page 231.
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Freeway distinguishes layers from inflow items by drawing 
small triangular corner mounts in the top left and bottom 
right corners.

One way in which CSS boxes differ from table-positioned 
boxes is that their height is treated inflexibly by browsers. If 
a box is specified as being 200 pixels high, it will always be 
200 pixels high in a browser, regardless of whether this is tall 
enough for the box’s content to be displayed. By contrast, table-positioned boxes will grow to fit their contents. For this reason, CSS 
boxes that contain text content should normally be set to have an undefined height by deselecting the height button in the Item 
General panel of the Inspector palette or by setting the Height popup in the Inspector to Minimum or Minimum (%) (Minimum 
is the default setting). CSS items whose height is undefined will grow and shrink to fit their content in a browser.

Layer items are output so they float in the HTML output and their position relative to the top left hand corner of the browser 
window is fixed.

This difference makes layer items extremely useful for layout. Their position on the page can be recreated in the browser window 
absolutely, without requiring an invisible layout table to hold them in place. They can overlap each other without requiring other 
items to reflow, be cut up or combine with them.

It is important to note that every layer item will be used on a layer of its own (i.e., it is not like using layers in desktop publishing 
where you can use multiple items on the same layer). Also, you can control the stacking order of layer items by selecting them and 
using Item>Bring Forward, Item>Send Backward, etc., or by assigning a specific “z-index” attribute to an item in the item’s <div 
style> dialog.

Finally, because individual layer items are individual objects in the HTML output, they offer tremendous scope for adding animation 
and interactivity to your web pages using Dynamic HTML 
(DHTML), i.e. by scripting their behavior using JavaScript. For 
example, a layer item may be animated so as to appear from the 
edge of the screen and move across the screen in a particular 
path.

Using Relative Page Layout with CSS layout

Although CSS (layer) items have many advantages they also have a major disadvantage—and that is that because the items are 
positioned on the page using CSS, they will not automatically move down the page if the content above grows in height (which 
table-based items do automatically). This can mean that if HTML text increases slightly in size when rendered in a browser (especially 
if the text turns to create additional lines), layer items may overlap or underlap the content above. To avoid this problem, Freeway 
has a powerful Action called Relative Page Layout which you can apply to either the Site Folder in the Site Panel (which will make it 
take effect globally for all pages in the site) or to individual pages/master pages.

Using Relative Page Layout on your site file effectively means that it will be converted to an inflow layout, so that if any content on 
the page grows in height, all other items will move down the page, keeping the spacing between the items relative to how were used 
on the Freeway page. There are some limitations, however (for example if a single item overlaps multiple other items, or if multiple 
items are stacked on top of each other)—in which case you may need to consider applying the Remove from Relative Page Layout 
Action on one or more Actions. It is also important to note that to use Relative Page Layout, every item on the page needs to be a 
layer item, and you will see error messages if you have any table-based items used on the page.

You can read all about the principles of Relative Page Layout and how to troubleshoot inherent issues by reading through the articles 
on the Softpress KnowledgeBase at http://www.softpress.com/kb/questions/238/ and http://www.softpress.com/kb/questions/287/.

CSS inflow items FW Pro only  

CSS inflow items are output as part of a flow, and their position is dependent on the position of previous inflow items and other 
content (such as text) within the same flow. This makes them useful in cases where you do not want content to overlap in a browser. 
One of the problems that can occur when using layers is that text content which fits within the layer in Freeway may spill out of it, 
and overlap with other content, when it is displayed within a browser. Alternatively, if the layer is set to have an undefined height, 
the box as a whole will grow to fit its content, and may overlap with other content. Inflow items provide a way of dealing with this 
problem, but they also have their own limitations—unless they are floated, you cannot position two CSS inflow items so that they 
next to each other horizontally.

To draw a CSS inflow item within Freeway, insert a text cursor onto the page or within another CSS item and then draw the item. To 
insert a text cursor onto the page, either click in it when it is already selected, or double-click on the page if “Require double-click to 
enter text in page” is selected in Freeway’s General Preferences.

You can download a (very basic) tutorial on how to build inflow CSS layouts along with a sample Freeway file by clicking on the link 
at the foot of the page at http://users.softpress.com/keith/box_model_tutorial/.

Note also that because there is an inherent bug in CSS when building inflow CSS layouts with items which are floated inside a parent 
item, you will need to apply the Auto Clearfix Action to the 
Master page(s) of your site so that the parent item’s height will 
not collapse. You can get the Action from http://actionsforge.
com/actions/view/299-auto-clearfix.

Note: Using CSS items for layout is also regarded as a “cleaner” web 
design technique than using invisible layout tables, since their use shouldn’t 
cause problems for unusual browser software. For example, the screen reader 
software used by visually impaired people may become confused when it 
encounters a layout table. As more and more web users have adopted modern 
browsers, the need for web designers to use tables for layout will decrease. 

Important: Freeway Express does not support layer items, but it has 
limited inflow functionality, such as inflow table-based items (see Working 
with Items later in this manual)

Important: Freeway Express does not support CSS inflow items.
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Changing Document Setup after a new 
document has been created
In addition to specifying the site setup when you first create 
a new document, you can change the setup of the current 
document at any time by choosing Document Setup… from the 
File menu (see screenshots on the right). The Document Setup 
dialog is divided into five sections: Document, Output, Upload, 
Text, and Graphics.

Setting the HTML level FW Pro only  

You can set the default HTML level for all pages in a document or 
for individual pages. The choices available are HTML 4.01 (Strict 
or Transitional), HTML 4.01 (Strict or Transitional), HTML5, 
XHTML 1.0 (Strict or Transitional) and XHTML5. 

Important: Freeway Express does not have an option for setting the 
HTML level. All pages are output as HTML5, but without support for 
CSS items and styles. 

Choosing between Strict and Transitional FW Pro only  

Transitional versions of HTML 4.01 and XHTML 1.0 allow the use 
of deprecated elements and attributes, and may be compatible 
with a wider range of browsers. Strict versions of HTML 4.01 and 
XHTML do not support framesets or the target attribute.

To set the HTML level for the document FW Pro only  

When creating a new document in Freeway Pro, choose the default page HTML level desired from the HTML output popup menu 
in the New Document dialog. You can use the Document Setup… command on the File menu to change this for the document 
(including any new pages and master pages) at any time. 

Comparison between Document Setup in Freeway Express (above)  
and Freeway Pro (below)

Choosing default HTML in the New Document dialog (above). The 
Document Setup dialog (right), allows the HTML level to be changed 

for the whole document.
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To set the HTML level for a page FW Pro only  

Make sure nothing is selected on the page. The Inspector palette now shows the page panel. Choose 
the desired level of HTML support from the HTML popup menu.  

HTML page alignment 
New pages in Freeway are set by default to the page alignment 
called None (see “Why would you create a site with an Align 
of None?” box panel below). There are many different layout 
methods possible when using Freeway Pro with None as the page 
alignment, but Express users will probably want to change the 
Align popup to Center or Left. It is very rare to set a page to Right 
align.

Sites built with a specific alignment (i.e., Left, Center or Right) will 
have fixed-width pages, and the Align option refers to how the 
page will be positioned in the browser window. In the browser, 
left-aligned pages will show clear space to the right, right-aligned 
will show clear space to the left, and center-aligned will show clear 
space on both sides.

You should be careful if the effect of your page design depends on 
a precise alignment with a page background image. Background 
images can be controlled using the Inspector palette (see 
Applying a background image to a page, page 35, for more 
information). Note that Freeway Pro lets you apply a background 
image to the page background or the window background (the 
latter will be the image that shows up in the background of the 
browser window off the page area).

Pro users wanting to build flexible or inflow sites can choose None 
for the page alignment and then control how the page aligns by 
using the methods explained in the Appendix at the back of this 
manual.

Setting a different page alignment 
1	 Go to the page or master page where you wish to set the 

alignment.
2	 From the Page General panel of the Inspector palette, 

locate the Align popup menu. Choose from the following: 

	 None 	 allows flexible page content items to have variable width. 

	 Left	 aligns the page contents with the left-hand edge of the browser window. 

	 Center	 centers the page contents within the browser window. 

	 Right	 aligns the page contents with the right-hand edge of the browser window. 

3	 When the page is viewed in the browser, the contents will display using the chosen alignment. 

Note: The effect of changing this setting can be viewed in Freeway 
itself using the Preview option. For more accurate results, though, 
check your page in a browser. 

Why would you create a site with an Align of None?

As mentioned above, choosing a specific Align option (Left, Center or Right) will mean that the pages of the site will have a fixed width. If you want to 
have a site which has a flexible width or uses header and/or footer bars to extend horizontally to always fill the width of the browser window, then you 
will need to set the Align popup to None and then use alternative methods to control the alignment of the content on the page.

With flexible layout you can use one of the many different Width options (Fixed, Flexible, Minimum, Maximum or Min/Max) to control how the page 
behaves in a browser. All Width options other than Fixed allow you to use percentage-based widths and it is possible to determine a minimum or 
maximum width (or both) to control the point after which the page width will not change when the browser window is resized.

If you want to use a header or footer bar which will always fill the width of the browser window, for example, the page Align must be set to None, the 
Width set to Flexible so you can use items as inflow items with their widths set to 100%.

Inflow layout uses items which are used inside other HTML items (to many different levels) which are embedded into the flow of the text—and to control 
the alignment of those items you need to use “floats” to align an item left or right or use “auto margins” to align an item to center). This is explained in 
detail in the Appendix at the back of this manual.

Choosing an Align option in 
Freeway Pro (left) and Freeway 
Express (above)
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Saving and opening files
After you have created your document, you need to save it. 
Freeway saves documents in its own format, not as HTML. Only 
Freeway can open and save Freeway documents. To export a 
document as HTML, you must use the Publish or Preview 
commands.

Saving your document
To save a file that not been saved before, choose Save from the 
File menu. Freeway will display the Save dialog box, which you 
can use to specify where you wish to save the document. The 
default is to your Documents folder.

Choose a location, then type a file name for your Freeway 
document. You should make the document file name simple 
and informative, so that you can identify it easily in the future. 
It does not matter what name you give the document file, as 
this file remains on your system and is not uploaded to the 
web. Do not use an extension, such as .html, since this may 
cause problems later. Mac OS X filenames can be long enough 
to be descriptive. Freeway will automatically add a “.freeway” 
extension to the file name—this identifies the document to the 
system as a Freeway document.

You may wish to keep both the Freeway document and the Site Folder together for ease of administration. However, we do not 
recommend that you keep the Freeway document inside the Site Folder itself, as that can cause problems. Freeway will automatically 
create a folder structure for you if you use a template for your new design. For more information about Site Folders, see Creating and 
assembling content on page 13.

When you have made some changes to the file, use the Save command again. When you choose Save in a document which has already 
been saved, Freeway updates that file with the new information without asking you for a file name again.

Freeway does not automatically save as you work. As with any software program, remember to save your document frequently to 
minimize the danger of losing work.

Saving your document with a new name
To create a copy of your document with a new name, either duplicate the file in the Finder, or use the Save As… command in Freeway’s 
File menu to specify a new filename.

Saving your document as an archive
Saving your document as an archive allows you to save your 
project in its current state along with copies of associated 
graphics and other resources. This is useful if you want to take 
periodic backups while working on a site, or if you wish to copy 
a document, with all its resources, to a different volume.

When you save an archive, Freeway creates a new folder and 
saves a copy of your document together with a Media folder 
containing graphics and other resources, and an empty Site 
folder.

To save an archive:

1.	 Choose Save Archive… from the File menu. (You will be 
asked to save changes if the document has been modified 
since it was last saved.)

2.	 Navigate to the folder where you want your archive folder 
to be created.

3.	 Click the Save Archive button.
4.	 Provide a name for the archive folder that will be created and click OK.

5.	 The archive will be created and your original Freeway document will then be reopened.

One of the benefits of creating an archive is that it gathers together all the files for your project, including the Freeway file, copies of all 
the original graphics you imported, multimedia files, etc., and then it will place them all in a single convenient location. This makes it 
an ideal way to make a backup of your project by burning it to CD/DVD or to move the project to a different computer.

If Freeway won’t let you save an archive it is usually because there are one or more resources missing. To fix that, go to Edit>Resources 
and check through the list of resources to find the first one which has a status of “Missing”, select it in the list, click Edit, click Locate 
and then relink to the original resource file. Relink to all other missing resources you can find (you may have moved or delete some) 
then click on the Update All button and click OK when Freeway asks if you wish to “detach” any missing resources. Freeway will now 
let you save the archive.

If you open the archive folder you will see that it contains the Freeway file, a fresh clean Site Folder (which will be empty until you first 
publish your site) and a folder called “Media” which contains copies of all the resources used in your site project.

The Save As dialog box in its default state.

The Save Archive dialog box. After clicking Save Archive you will be  
asked to choose a name for the new archive folder
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The only things which are not saved when you save an archive are galleries/slideshows made in Showcase and Exhibeo. Showcase 
has its own Save Archive function, and we recommend you make an archive of each of your galleries/slideshows and then save them 
(along with the original .spg and .fwgallery files) in a separate folder within the archive folder. For Exhibeo we recommend you save 
the .exhibeo and .xbExport files along with copies of all the images you imported into Exhibeo galleries so they will also be contained 
within the archive folder.

Automatic backups 
Freeway automatically makes a copy of a document when you do your first save 
after opening it. The backup copy is created in the same folder as the original, and 
has the same file name but with the extension “.fwbackup”.

This means that when you finish working with a file and save and close it, you 
also have a copy of the file as it was before you made the most recent series of 
changes. If the main document file cannot be opened for any reason, you should 
still be able to open the backup file and recover your work up to that earlier stage. 

You have only one generation of backup through Freeway’s automatic backup 
facility. When next you open up your document file and save it, the old backup 
file is overwritten. To provide additional protection, you should ensure that you 
make additional backup copies of your documents. 

To disable the automatic backup option, open Preferences… and turn off the 
Make backups checkbox in the General panel. 

Opening a backup document 
In Freeway, you can open an existing document by choosing Open… in the File 
menu. Use the Open dialog to find your desired Freeway document. 

Freeway lists backup documents in the Open dialog as grayed out by default. This 
is because you should never need to open the backup, unless the original document is damaged. If you do need to open the backup 
document, you can do one of the following: 

Double-click on the icon of the backup document in the Finder, which will cause the backup file to open in Freeway as an untitled copy 
of your document. 

Alternatively, if you are in Freeway, you can hold down Alt as you choose Open… from the File menu. The menu entry changes to 
Open Backup…, and the backup files are listed normally in the Open dialog.

Working with Freeway’s templates
Freeway Pro and Express ship with a set of “get you started” 
templates. These are essentially complete mini web sites, with 
master pages and layouts ready for you to import your own 
images and text. 

Freeway Express always uses a template for new site creation, 
and if the various templates that are available don’t appeal, you 
can choose the “Blank” template to give you a clean canvas from 
which to design your own site. You can also create your own 
templates for future use, or to share with other Freeway users.

Creating a new site document on page 15 briefly explained the 
process of creating a new site document using Freeway Pro’s 
Custom settings. This section explains in a little more detail 
creating a new document using a template, and how to save and 
use your own template designs.

Using a template to create a new site document
To create a new site document using a template:

1.	 Choose New… from the File menu.
2.	 The New Document dialog appears. If you’re using Freeway Pro, it will show two tabs across the top: Templates and Custom. If 

you are using Freeway Express, you will see only the templates section.
3.	 Select one of the headings in the panel on the left of the dialog to view the templates in that section. To get a clearer view, you can 

enlarge the icons by dragging the slider below the main panel to the right.
4.	 To open the preferred template, select it and click the OK button. You will be prompted to save the new document by the Save 

dialog.

Freeway creates a folder structure like the one illustrated on page 13. The folder contains the new Freeway document, a Media folder (to 
contain images and other materials you wish to use with your new document), and a Site Folder where Freeway saves the HTML code and 
images that make up the web site.

By default, new template-based documents will be saved to your user Documents folder, but you can choose any location using the Save 
dialog.

Turn off Make backups if you don’t want Freeway to 
create a backup the first time you save changes to an 

existing document.



Freeway Reference: Getting Started
23

23

If you choose the “Blank” template, the folder structure created by Freeway is the same as the other templates. The only difference is 
that the Media folder for the other templates will contain the images that were used to create the template.

Creating a new template
You can save any Freeway document as a template. The advantages of using a template are that you can create new copies of the 
document without accidentally saving over the original, and you 
can share your design with others if you wish.

When you save a document as a template, Freeway makes 
a special file, called a bundle, which contains the Freeway 
document and images that were used to create it. Once this 
template has been saved, it can be imported into Freeway so that 
it appears in the New Document dialog. 

1.	 Choose Save as Template… from the File menu.
	 If your document needs to be saved, a warning dialog will 

appear. To continue simply click OK. If you click Cancel, the 
save will be stopped and you can then manually choose Save 
from the File menu.

2.	 The Save dialog opens. The default save location is the user’s Documents 
folder. 
If desired, enter a new name for the template in the Save As text field. 
Clicking the disclosure button will reveal the full Save dialog, which 
allows you to navigate to an alternative location to save the template. See 
page 21 for more information about using Freeway’s Save dialog.

3.	 When you click the Save button, the Save as Template dialog appears.
	 The default group for a new template is “General”. If you wish to save the 

template in a different group, enter its name in this field. You may enter 
some copyright text and a description if you wish.

	 From the Language popup menu, choose a default language for your 
template if you desire. The languages available are Danish, Dutch, English 
(default), French, German, Hebrew, Italian, Japanese, Spanish, and 
Swedish.

The default template icon is shown in the Icon box. If you would like to use 
a custom icon so that your template can be recognized quickly in the New 
Document dialog, select the new icon by clicking the Select… button and 
choosing a suitable image from the dialog box.

4.	 Click OK to complete saving the template. 

Freeway will save the template, and return you to the document from which 
you created the template. 

The new template is now ready to be installed in Freeway.

Installing a template
1.	 Choose New… from the File menu.
2.	 In the New Document dialog, show the Templates panel. If you are using Freeway Express, the templates will already be visible.
3.	 Click the Install Templates… button.

Clicking on Install Templates to install the template into the list. After installing the template it will be visible in the appropriate group.
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4.	 Freeway opens the Choose a File dialog. 
5.	 Navigate to the location of the new template, and select it. Click the Choose button.

Freeway will add the new template to the relevant group.

To check that the new template appears, click on the group heading in the left panel. If the template has been installed correctly, it will 
appear in the preview panel on the right.

Creating a custom icon for a template
To make your new template more readily recognizable in the New 
Document dialog, you can apply a custom icon when you save it. 
The image can be any format that Freeway will read, and should 
ideally be no larger than 128px square. The actual pixel size is not 
critical, though, since Freeway will convert the image when the 
template is saved.

1.	 In Freeway, choose the page you want to set as the icon, and 
preview your new template design in Freeway or a browser.

2.	 Take a screen shot of the page.
3.	 Using your favorite image editor application you can resize the 

screen grab and save to JPEG or PNG if you wish. 
4.	 Follow steps 1 to 3 of Creating a new template. In the Save as 

Template dialog, click the Select… button next to the Icon 
preview box to select the new custom icon. Click the Choose 
button, and the icon should appear in the preview box in the 
Save as Template dialog.

5.	 Click OK to continue saving the template.

Choose New Document from the File menu to check that your new icon appears properly in the Templates window.

Power Tip: To take a screen shot of the page you can use the Mac OS 
shortcuts. Grab just a part of the screen by pressing Shift-Command-4. 
This will change the mouse cursor to a target. Click and drag across the 
area you wish to grab, and when you release the mouse button, the image 
will be saved to your desktop.

The saved screen shot format will depend on which version of Mac OS X 
you are using. 



Working with pages 
In a Freeway document, pages are represented on the screen by a black outline with a drop shadow showing the edge of the page. 
Outside this area is the “pasteboard”. You can use this area for working, but certain items, such as CSS layered items outside the page 
border, may be published to your web pages (see Preventing an item from publishing on page 55).

Adding pages 
You can add pages to your document using the following steps: 

1.	 Choose New Pages… from the Page menu or click on the  
menu in the lower left corner of the document window and choose 
New Pages…, or Control-click and choose New Pages… from the 
contextual menu.

2.	 Enter a name for the page(s) in the New Pages dialog box. 
 
 
 
 
 
 
 
 

3.	 Enter the number of pages you want to add to the document. New pages will be automatically named “YourTitle1”, “YourTitle2”, etc
4.	 If you want to apply a different master page from that shown, select its name from the Master popup menu.
5.	 Click OK. The current page changes to the first of the new 

pages. 

New pages are normally inserted after the current page, in the 
same folder—unless you have selected a folder in the Site panel, 
in which case the pages will be added at the end of the selected 
folder.

You can also add a new page by dragging the icon of the master 
page from the Master Pages area in the Site panel into the Site 
Pages section. This brings up the New Page dialog, which asks 
you to supply a title for the new page. 

Page title and file name 
It’s important to give pages meaningful titles. This is not only helpful in 
assisting you to navigate the document more easily but also determines 
the window title of the page when it is viewed in a browser and is used 
as the title when the page is bookmarked. It may also play a role in the 
way search engines list your site, so it should describe your page well. 

Enter the title into the Title field in the Page General panel of the 
Inspector palette. Freeway will automatically generate an HTML file 
name from this title (unless the file name is already distinct), but you 
can type a different file name into the File field if you wish.

If the current page is going to be your home page (the first page which 
someone will see when visiting your site), you should normally use 
index.html as the file name. This tells the web server to display this 
page as the default (home) page. Freeway automatically sets index.html 
as the name of the first page that is created in a document or folder. 
It’s best to type the file name in lowercase letters to prevent confusion 
in case your web server differentiates between upper- and lowercase file 
names. You don’t need to add the correct extension to the file name; 
Freeway will automatically apply the correct extension (.htm or .html, 
depending on your settings in the Output panel of Document Setup) 
when you press Enter or Return.

For more information on changing the titles of your pages, see Changing 
the title of a page in the Inspector palette on page 35. 

Creating new pages 
from the Page menu 
(left), from the Site 
panel  menu 
(above).

When creating a new page by dragging 
a master page into the Site panel, the 
New Page dialog appears.

The Page Inspector in Freeway 
Express (above) and Freeway 
Pro (right)

Working with Pages
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Viewing and changing pages 
When viewing a document in Freeway, you can see only one page at a time in the document window, but changing to another is quick 
and easy. You can change pages using the Site panel, or the Link Map view (Freeway Pro only), or you can follow internal hyperlinks. 

Changing pages using the Site panel 
The current page is shown in the Site panel with its icon darkened and the title shown in bold. To change 
pages, click on the icon or name of another page. 

Changing pages by following internal hyperlinks 
You can test the navigation through the site by following internal hyperlinks between your pages 
without leaving Freeway to preview the site in a browser. To follow a link within Freeway, select the 
item or highlight the text that has the hyperlink applied and choose Follow Link… from the Edit 
menu or from the contextual menu (pictured). When a link is selected, an icon accompanied by the 
link’s name appears in the hyperlink area at the lower part of the window. If you hold the Command 
key while clicking on the hyperlink area, it will follow the link. 

Changing pages using the Link Map FW Pro only  

You can also follow hyperlinks in Freeway’s Link Map. The Link Map graphically presents the relation 
of a selected page to the other pages in the site—the pages which link to it are on the left of the icon and the pages to which it links on 
the right. 

In order to change the central page in the Link Map, simply single-
click on the icon of the desired page. It then becomes the focal 
point of the Link Map view, where the chosen page is represented 
by a larger, darkened page icon. If you double-click on the selected 
page, Freeway will switch to the Page view for that page. You can 
choose to show or hide links to or from a page 
by clicking on the round disclosure button 
beside it. If you hold the Alt key as you click 
on a disclosure button, it will show (or hide) all 
the links in that level in your site’s hierarchy. 
If a page links back to itself, subsequent links 
appear in bold and their disclosure buttons are 
disabled. 

Selecting pages, folders, and items in the Site panel 
You may want to delete one or more pages or folders, or move them into a different subfolder if you have created a hierarchical site 
structure. You can select items on the page using the Site panel, if you have Show Items turned on in the Site panel  menu, or if 
you are using the Site panel’s Page view. 

Select folders, pages, or items by clicking on their icons or names in the Site panel. When you select an object, its name and icon 
appear highlighted in the panel. Hold down the Shift key to select two or more pages or items at the same time. Hold down the 
Command key to select two or more items that are not in a continuous range (you can’t select items that have different parents). You 
can also select a page in Freeway Pro by clicking on its name (not icon) in the Link Map. 

Deleting pages 
You can delete pages by choosing Delete Pages from the Page menu and clicking OK in the 
warning dialog box—if you have a range of pages selected using the Site panel, Freeway will 
ask if you wish to delete the selected pages; otherwise it will ask if you wish to delete the current 
page. Another way to delete a page or folder (or range of pages/folders) is to select it in the Site 
panel and then press the Delete or backspace key or click on the  button at the bottom of 
the Site panel. You can also delete the current page by Control-clicking on it and choosing 
Delete… from the contextual menu.

If there are internal hyperlinks elsewhere in your Freeway document to the page or pages you 
wish to delete, Freeway will give you the chance to replace the internal links with properly 
formed URLs, or to simply remove the references to the page or pages you are deleting.
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Rearranging pages using the Site panel 
You can rearrange the order of the pages in a document, although this has no effect on how the 
site is viewed by the visitor. Navigation through a site is determined solely by the hyperlinks 
that you define to permit this. However, sometimes it is helpful to have the pages arranged in a 
particular order to help you work with the document more easily. 

To change the page order, simply drag the page using either its icon or its title up or down to a new 
position in the Site panel. Feedback in the panel shows where the new position will be. You can 
change the order of pages in the same folder or drag them into a subfolder by dragging below the site 
folder and to the right.

See Working with page folders on page 37 for how to create subfolders in the Site panel.

Copying pages 
In order to copy a page, simply select it as described above and choose Copy from the Edit menu. 
You can only copy one page at a time. 

You can also Alt-drag a page, or range of pages, within the Site panel to duplicate the selected pages. 
Type a new title into the New Page dialog that appears.

Freeway also lets you copy and paste complete pages. To do that you simply need to select a page in 
the Site Panel, copy it, select the location where you want to place the new page (either loose in the 
Site Panel, in a specific page folder or even in the Site Panel of a different document) and then paste 
it in.

Duplicating pages
You can use the Duplicate Page… command on the Page menu to create identical copies of the current page.

1.	 Choose Duplicate Page… from the Page menu, or Control-click on the page and choose Duplicate… from the contextual menu.
2.	 In the New Page dialog, enter a name for the duplicated page and click OK. 

Working with master pages 
Master pages carry the elements you want to appear consistently 
on a number of site pages. For example, you could place running 
headers, navigation buttons, or a logo on the master page, which 
would then automatically appear consistently on each page with 
that master applied to it. 

Master pages are like ordinary site pages, except they are not 
published. Master pages are shown at the top of the Site panel, 
above a horizontal dividing line. You can view a master page by 
clicking the icon for the master page in the Site panel. 

You can also switch to the master of the page you are currently 
viewing by clicking the Master button near the top left of the document window.

You can tell that you are looking at a Master page because the rulers to the top and left of the page 
area are colored in a pale yellow. When viewing a Site page, the rulers will be colored in white.

The Site panel uses a secondary (light gray) highlight to indicate which master page is applied 
to a particular site page, or which site pages derive from a particular master. When a site page is 
selected, the master page on which it is based is shown with a secondary highlight. When a master 
page is selected, the site pages that are based upon that master are shown with a secondary highlight. 

Master pages can also hold guides and grids that help you position elements consistently over a range of site pages. (These guides do not 
appear on your published web pages.)  

By default, a new document contains one master page and one ordinary site page. If you’re 
only using one basic page design, you can modify the default master page, Master1, to suit 
your needs. Simply change to the master page to set up items, guides, and page grids as you 
want. However, if you want to work with more than one master page, you can add new 
master pages. 

What are Master pages?
Master pages are non-publishing pages on which you can use content which is common to one or more groups of pages of your site. 
The main benefit of using Master pages is that if you decide to make an edit on one of the common items used on all your pages (such 
as an item in your header bar, a footer item or a navigation menu), you need only make that edit once on the Master page and it will 
take effect on all pages based on that Master. Even the most simple sites will benefit from making sure you spend a little time in the 
early stages of your web project to get your initial Master page or pages set up correctly.

People who have worked with desktop publishing applications will already know the benefits of using Master pages—but it is worth 
noting that there are some important differences in Freeway which is mainly because of the need for everything to work with HTML.

If you have worked with Master pages in previous versions of Freeway you will see that many additional functions have been added to 
Masters in Freeway 6.

Create an exact duplicate of a page 
or range of pages by Alt-dragging it 
within the Site panel.

Note: Freeway Express has ruler guides, but 
not page grids.
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Master page concepts and good working practices
Almost every site on the web has common items and settings which help to brand 
the site’s pages using the same header bar (perhaps with a logo or distinctive colored 
background), along with a common page background and browser background color, 
page width, default page height, etc., to give them a consistent appearance.

Some sites may use a very similar layout—perhaps in terms of headings used on each 
page or using the same column structure—for particular groups of pages within the 
site. For example, there may be a Home page, About Us page and a Contact page 
which use a particular appearance, but this may be different to how, for example, 
pages for a company’s products need to be laid out. If this is the case, you can set up 
multiple Master pages to create pages used in each distinctive section of your site. 

You do need to bear in mind, however, that if you later need to make an edit to a 
common item such as a header item (perhaps the client has changed their telephone 
number), then each Master page will need to be changed individually—so you might 
want to take that into account before setting up many different Masters.

By planning ahead you can very easily work out how many different Master pages 
you might need for the site, and how they will differ. It is also at this stage that you 
will probably have some idea about how you are going to use a navigation menu 
so it can be incorporated into the Master page (with main menus 
and sub-menus), and how the text and graphic content will be 
positioned on each page.

How much you decide to use on your Master page in terms of 
common content is entirely up to you and how you prefer to work. 
Some people limit Master content to just the main header bar and 
navigation menu, whereas other prefer to place empty placeholder 
items on their Master pages which can be used to import unique 
text or graphic content on each individual page—and this is why 
you need to consider the concepts of Master items and how those 
items and Master pages are controlled by their Master links.

A good example of how much content to use on a Master is the 
Using Freeway tutorial file (see the Master page in the screenshot on 
the right) where you can see that only the items which are common 
to all pages have been used on the Master. 

If you haven’t already built the Using Freeway tutorial site, we 
strongly recommend that you do so. By building the tutorial site 
you will be taken through all of the basic steps of creating and 
building a website from scratch in Freeway, and this is a far better 
way to learn Freeway than simply reading through a series of 
articles online or from a manual. You can find a link to download 
the Using Freeway guide PDF (which contains the tutorial) at 
http://www.softpress.com/help/ (under Manuals) along with all the 
resources you will need to build the tutorial site yourself. Either 
print off the tutorial chapter or read through the PDF as you build 
the tutorial site.

The next screenshot (right) shows the Welcome page of the Using 
Freeway tutorial site, which shows the Master items used on the 
Master page along with the unique items that have also been placed 
on that page. Note that the rulers are now in the normal light grey 
color because you are viewing a Site page.

Looking at the items on the page in the Freeway interface it is not 
immediately clear which items are Master items and which are 
unique items on the Site page, but you can usually tell by selecting 
an item to see the name it has been given by Freeway. All items 
drawn on a Master page or placed there from the Insert menu will 
have the letter “m” in front of the item’s name. However, you 
need to be aware that if a graphic or multimedia resource has been 
imported into an item (or dragged and dropped onto the page), the 
item will be given the imported file’s name rather than being given a 
name with “m” in front.

Another way to tell that an item is a Master item is to see if a name 
surrounded by square brackets appears immediately after the item’s 
name in the Site Panel list. Inside the square brackets the name 
refers to the name of that item on the Master page, so even if you 
rename the item on the site page the original Master name will still 
display within the square brackets.
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The next screenshot (right) shows the HTML item 
containing the word “photographer” selected on the 
Welcome page, and you can see that this is a Master 
item because its Name/ID begins with “m”—in this 
case the item is called “m2” (which, if you select the 
item on the Master page itself, is what it is called there 
as well). Another way to tell that this item is a Master 
item is by looking in the Inspector to see that the 
various “Use Master …” options are listed). 

Note that the Site Panel shown in the screenshot above 
is in Page mode (which is displayed when you click 
on the header bar of the Site Panel to toggle the view 
from “Site” to “Page”) so you can see all the items on 
just that page. With the item selected on the page, you 
can see that the Site Panel has the item called “m2” 
highlighted.

As mentioned earlier, graphic items imported into 
an item drawn on the page will not use a Name/ID 
beginning with “m” in the same way as other items 
drawn on the page will do—as can be seen in the 
screenshot on the right. Note that the logo in the top 
right of the page is selected, and this item was created 
by drawing a graphic item on the page and then 
importing a graphic into it. The name displayed in the 
Name/ID field (and the name of the item in the Site 
Panel list) is the name of the imported graphic file but 
without the file suffix (.jpg, .gif, etc.).

Although the name of the item does not start with the 
letter “m” as other Master items do, it is still possible 
to see that this item is a Master item because the four 
different Use Master… options appear underneath 
the Name/ID field of the Inspector (even though two 
of them are greyed out in the screenshot). If you see those options displayed in the Inspector when an item is selected, this will always 
mean that the item has been inherited from the Master page.

As you can see in the next screenshot, if you select a 
unique item on that page (i.e., one that was drawn on 
the Site page and not on the Master page) you won’t 
see the Name/ID beginning with the letter “m” (as 
it did when selecting the item containing the word 
“photographer”) and you won’t see any Use Master… 
options in the Inspector.

Earlier, you will have seen that we said: “How much 
you decide to use on your Master page in terms of 
common content is entirely up to you”—and the 
reason this was mentioned is because you need to know 
what will happen to a Master item or page setting if 
you move or resize it, and what Master Settings will 
still be used on that item if you edit the content of a 
Master item on a Master page. This is a very important 
part of the concept of Master items, and learning the 
differences between the different settings will mean you may want to work in a different way.

Before moving on to the four different Use Master Settings, you may have noticed that the selected Master items in the screenshots 
of the Welcome page display with red handles around them. Please note that this is nothing to do with how Master items display, it is 
simply due to those items being locked on the Master page. In the Using Freeway tutorial we recommend that you lock Master items 
to prevent them being accidentally moved on the Site pages. If you decide not to lock Master items, you will see no difference to the 
handles of selected items. You can read about locking items in the Working with Items section of this manual.

The “Use Master…” options for pages and items in the Inspector’s General Settings tab
As shown in the screenshots of Master items earlier, there are up to four Use Master… options displayed in the General Settings tab of 
the Inspector:

•	 Use Master Content

•	 Use Master Settings

•	 Use Master Actions

•	 Use Master Children
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It is important to note that the changes introduced in Freeway 6 not only include the new Use Master Actions and Use Master 
Children options, those Use Master… options (with the exception of Use Master Content) can be applied to the Site page itself as well 
as Master items used on Site Pages. This means, for example, that after changing the page width, background color, etc., of a Site page 
you can quickly reapply the settings used on the Master page by checking the Use Master Settings option when nothing is selected on 
the page.

When you first go to a Site page, you will always see the first two Use Master… options checked by default.

This first section covers just the Use Master... options which are displayed in the Inspector’s General Settings tab—see later for five 
other ways to revert the settings of HTML Markup, Meta tags, Form Setup, Extended attributes or an Action (when they have been 
changed from the original Master settings).

Use Master Content

If the Use Master Content option is unchecked in the Inspector’s General Settings tab, this means that the original content of an 
item used on the Master page has been edited or deleted on that Site page. Checking the Use Master Content option will make the 
content of the Master item on the Site page revert to its original content and it will also restore the 
item’s Master links for that item.

It is important to note that if the Use Master Content option is unchecked, making an edit to the 
content of the item on the Master page will not take effect on the Master item on the Site page as that 
Master link will be broken. To make changes on the Master page item take effect on the Master item on 
the Site page you need to check the Use Master Content option again in the Inspector—but note that 
any edits you made to the Master item on the Site page will be removed.

As mentioned earlier, you won’t see the Use Master Content option unchecked on the Site page itself (i.e., when nothing is selected 
on the page) unless you have double-clicked inside the page area, inserted text or items and then edited the text or deleted one or more 
items. Checking the Use Master Content option will restore those items inside the page area of the Site page. 

It is important to note, however, that if you want to recover a Master item which was drawn as a normal item on the Master page and 
then deleted on the Site page, you need to recheck the Use Master Children option instead.

Use Master Settings

This option controls the settings applied to either the Site page itself or a Master item used on a Site page. Changing the page width, 
background color, etc., of a Site page, or changing the size, position, color, etc., of a Master item on a Site page will result in the Use 
Master Settings option being unchecked.

Just as when the Use Master Content option is unchecked (see above), having the Use Master Settings option unchecked will break 
the specific “settings” link between the Master page/Master item and the Site page or master item used on the Site page. Switching on 
the option again in the Inspector will make the page or item revert to the original settings used by the Master page or Master item, and 
this also re-establishes the Master links again.

Use Master Actions

As the name suggests, this option controls the Actions used on the Master page itself or a Master item on a Site page. 

If an Action applied to the Master page itself is removed from a Site page, the Use Master Actions option will be unchecked and active 
in the Inspector—and checking the option will restore the Action again.

You will also see the Use Master Actions option active in the Inspector if an item on the Site page which has an Action applied to it 
has the Action removed. Switching on the Use Master Actions option will restore the Action again.

It is important to note, however, that if you want to recover a “standalone” Action item (ie, an Action item placed on the page by 
clicking on the Action tool on Freeway’s toolbar then drawing the item on the page or by going to Insert>Action item and choosing 
the standalone Action) which was drawn as a normal item on the Master page and then deleted on the Site page, you need to recheck 
the Use Master Children option instead.

Use Master Children

This option works in two very different ways – and it is important to 
understand the differences. 

The first way to see the option unchecked is if an item on a Master 
page is removed from a Site page when there is nothing selected on the 
page (so the Inspector is in Page mode). The reason for this is that items 
placed on the page itself are considered to be child items of that page.

After checking the Use Master Children option, any item removed 
from the page will be restored and the option will then become inactive 
again.

The second way is when you use an item as a child item embedded 
inside another item and then you delete the child item. It is important 
to note, however, that you will only see the Use Master Children 
option unchecked if you have the parent item (ie, the item inside which 
the child item was originally embedded) selected on your page.

If a child of a parent item used on a Master page is deleted on a Site 
page you will only see the Use Master Children option active (and 
unchecked) in the General Settings tab of the Inspector if you select 

The white panel selected on the screenshot above is an item which 
was drawn on top of the yellow item (which automatically makes the 

new item a child of the original item). 
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the child item’s original parent item on the Site page, as shown in the 
screenshot below. Selecting the parent item and checking the option 
again will restore the child item inside its parent.

When using multiple levels of parent/child relationships, the Use Master 
Children option will only be available to use when you select the parent 
item which previously contained that child item within it (ie, you will 
not see the option available if you select a parent item two levels up in 
the nesting order.

Other “Use Master” options
As mentioned earlier, there are five other Use Master options which are located in 
various dialogues or floating palettes.

Use Master option in the Actions palette

If you use a standalone Action or apply an Action to an item on a Master page, you 
will see a Use Master option in the bottom left of the Actions palette if you select that 
item. By default, this option will be checked.

However, if you then change any setting for that Action on the Site page the Use 
Master option will be unchecked in the Actions palette. Checking the option (whether 
the Action is applied to the page, applied to an item or used as a standalone Action) will 
restore the original Action’s settings

Use Master Settings in the Form Setup dialog

If you set up a form manually (ie, by using your own PHP file rather than the Send 
Form Action), you will do this by entering a Method and Action, etc., in the Form 
Setup dialog—which you can see by visiting a Site page, going to Page>Form 
Setup and looking in the bottom left.

Although it is probably rare, it is possible to set up the Form Setup dialog on a 
Master page so the same functionality is used on all your Site pages. If, however, 
you then change any setting on a Site page you will see a Use Master Settings 
button which you can click on at any time to revert back to the same settings used 
on the Master page.

Use Master Settings in 
the Meta Tags dialog

If you want to use 
“meta data” (such as a Description or Keywords meta tag) on your pages, it is 
usually much quicker to set up the meta tags on the Master page—by going to 
Page>Meta Tags. If, later on, you change or remove the meta data on one of 
your Site pages you can always click on the Use Master Settings button in the 
bottom left of the Meta Tags dialog to revert back to the same settings used on the 
Master page.

Use Master Settings in the Extended Attributes 
dialog

If you want to apply some extended attributes to items on 
the page, you do that in Freeway by selecting a layer item and 
then use a Name/Value pair (by going to Item>Extended) 
to achieve a specific function. If you set this up on a Master 
page and then later edit or remove the Extended attribute on a 
Site page, you can always revert back to the same settings used 
on the Master page by clicking on the Use Master Settings 
button.

After selecting and deleting the child 
item (see right), the Use Master 

Children option is now active but 
unchecked when the parent item 

that originally contained that child 
item is selected on the page.
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Use Master Settings in the HTML Markup dialog

It is quite common for web designers to use custom markup 
code in the Head or Body of the page by going to Page>HTML 
Markup, choosing the location in the Insert menu. If you set 
this up on a Master page and then later edit or remove the 
markup code on a Site page, you can always revert back to the 
same settings used on the Master page by clicking on the Use 
Master Settings button.

Note: If you make a change to an Action, Form Setup, Meta Tags, 
Extended Attributes or HTML Markup on a Site page and then 
it is changed back so it is the same as the Master, Freeway will 
automatically restore the Master link again. This is important is, for 
example, you have multiple meta-tags on the Master and you want 
to restore individual Master links but not all.

Creating a new Master page
To add a new Master page to your Freeway document, you can use one of the following methods:

•	 Go to Page>New Master (see screenshot below left).

•	 Click and hold on the cog popup near the left side of Freeway’s footer bar (see screenshot below 
center) and choose New Master… .

•	  Control-click (or right-click) on an existing Master page and choose New Master… (see screenshot 
below right).

Each of the methods mentioned above will display the New Master Page dialog (see screenshot below) 
where you can enter the name for the new Master and click OK.

Renaming a Master page
To change the name of an existing Master page you can use one of the following methods:

•	 Select the Master page in the Site Panel, change the name of the page in the Title field of the Page Inspector and type a Return.

•	 Alt-click on the page icon or page name in the Site Panel, enter the new name and type a Return.

Deleting a Master page
To delete a Master page that’s displayed in your list of Master pages in the Site Panel, you can use one of the following methods:

•	 Select the Master page you wish to delete and go to Page>Delete Pages…. After choosing this option you will see an alert telling 
you that if you delete a Master page, all Site pages based on that Master will also be deleted. Click OK if you are sure this is what you 
want to do.

•	 Control-click (or right-click) on the Master page you wish to delete and choose Delete…. This will also display the alert mentioned 
above.

•	 Select the Master page you wish to delete and click on the “minus” sign button in the far left of Freeway’s footer bar. This will also 
display the alert mentioned above.

Be very careful that you don’t lose a lot of your Site pages by accidentally deleting one of your Master pages to which those Site pages 
are associated. Also, be aware that if you delete a Master page so you are left with no Site pages left in the Site Panel, you will not have 
any pages to preview in a browser because Master pages do not publish (i.e., you must have at least one Site page in your Site Panel for 
Freeway to be able to use Preview or Preview in Browser.
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Applying a different Master page to a Site page
Below the Title and File fields in the Inspector is a popup called Master. If you have multiple Master 
pages set up in your document you can click and hold on this popup and choose the Master page you 
want your Site page to be based on.

Changing the Master page on which your Site page is based on will change the content so that all 
Master items associated with the old Master page will be removed, and all the Master items associated 
with the new Master page will be placed on the page instead.

It is important to note that if an item has lost its Master links (ie, the links to the item on the Master 
page previously used), this may result in that item not being removed because Freeway may not 
recognize the item as being a Master item.

Rearranging the order of Master pages in the Site Panel
There may be times when you have created pages out of order and you want to order 
them in a particular way in the Site Panel. This can be done very quickly by clicking and 
dragging one or more pages into the location you want them to appear in the list. The 
screenshot below shows how to click and drag the “Master1” Page to a location between 
“Master3” and “Master4”. As soon as the mouse button is released, “Master1” with then 
move to a location between “Master3” and “Master4”.

To move multiple pages, use the Shift key and click (to select pages next to each other 
in the list) or the Command key and click (to select pages which are not in a continuous 
range) to add to the selection after the first page has been selected. Once you have 
selected all the pages you want, click and drag on one of the selected pages to move all 
the selected pages at the same time.

Duplicating and Deleting Master pages
There are a few methods you can use to duplicate an existing page of your site. First is to select a page in your Site Panel and then go 
to Page>Duplicate Page ... (which will display the New Master Page dialog where you can give the duplicate page a name before 
clicking OK). See the screenshot below left.

Second is to Alt-click and drag a page in the Site Panel (which, when you let go of the mouse button, will display the New Master 
Page dialog), and note that the new page will appear in the location where you were pointing to in the Site Panel list when the mouse 
button is released. See the screenshot below right.

You can also Control-click on a page in your Site Panel and choose 
Duplicate… in the “contextual” menu which displays. This will again 
display the New Master Page dialog where you can name the page, and, 
after clicking OK, the new page will be placed immediately after the page 
which was selected originally.

Deleting pages can be done the same way as duplicating (using the Page 
menu, the Site Panel or the contextual menu) or you can simply select a 
page (or multiple selection of pages) and hit the Backspace/Delete key. 
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Another method is to select a page (or selection of pages) and click on the Minus 
button in the bottom left of the Freeway interface window (on Freeway’s Footer 
Bar). All methods will display an alert asking if you are sure you want to delete the 
page(s)—click OK to proceed.

Making a Site Page into a Master page
There may be times when you build a site page in Freeway and then you want to make that page into a Master page. To do this, select 
the page in the Site Panel list and go to Page>Make Master… (see screenshot below left). You will be prompted to give the new 
Master page a name before you can click OK to close the New Master Page dialog.

Another method is to click and drag a Site page into the Master page section of the Site Panel (see screenshot below right). When you 
release the mouse button, you will be prompted to name the new Master page.

Making a Site Page into a Master from the Page menu.
Making a Site Page into a Master by dragging 

the page into the Master list.

Applying Color Labels to Master pages
Some people like to colorize the pages in the Site Panel list to make them easy to identify 
when using a particular workflow. Freeway lets you colorize the name of a page using Apple’s 
Color Labels.

To colorize a page, Control-click (or right-click with a multi-button mouse) on the page 
you want to colorize, then choose the color from the Color Labels at the bottom of the 
contextual menu. See the screenshot (right).

To remove a color applied to a page, Control-click (or right-click) on the page and click on 
the “X” in the Color Label list at the bottom of the contextual menu.

Using Master pages/items with some options unchecked  
and others checked
Because there are four different Use Master… options (unlike in desktop publishing 
applications which have only one type) it is possible to mix and match the different Master 
settings so that one or more Use Master… options are unchecked in the Inspector.

For example, it is possible to use “placeholder” items on your Master page (which have no 
content) and then add unique content to those items on the individual Site page. Doing so will uncheck the Use Master Content option 
in the Inspector, but the Use Master Settings will remain checked. This will mean that the content Master link has been broken (so 
editing the content on the Master page will have no effect on the content of the Master item on the Site page) but any changes made to 
settings of the Master item on the Master page will still take effect on the item on the Site page (such as changing its position, editing 
the background color, etc.

It is important to note, however, that checking any unchecked Use Master… options in the Inspector will make the item revert back to 
the settings, content, etc., used by the page/Master item on the Master page.

Like with many things in Freeway, how you choose to work is up to you—some people find this way of working as a time-saving 
feature, whereas others consider it confusing. It’s up to you to decide how you prefer to work.
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Important note on using Freeway’s Reapply Master option
There may be times (though hopefully not too often) when you may consider using the Reapply Master option in the Page menu. 
However, you need to be aware that this can often result in many duplicate items being used on your pages.

If you have any Master items used on your Site pages which have one or more Use Master… options unchecked, going to 
Page>Reapply Master will place a duplicate item on the Site page (in exactly the same position as that item is used on the Master 
page) because one or more Master links have been broken. Any items which have all Use Master… options selected will not be affected. 

Rather than use Reapply Master, we recommend you re-check the Use Master… options for each affected item in turn so it reverts to its 
original settings used on the Master page.

Modifying Site pages 
Pages can be given a different title, have a different master applied to them or have a new background color or a background image applied to 
them. You can also specify what the filename of the HTML file created will be. Page modifications like this are usually made in the Site panel 
or in the Inspector palette, using the Page General panel and the Page Appearance panel. Click on a clear part of the page or pasteboard 
to ensure no items are selected. While the Page panel allows you to set the title, file name, dimensions, and so on of your current page, the 
Page Appearance panel deals with the background color and images, as well as the colors of your hyperlinks. 

Changing the title of a page in the Inspector palette 
To change the title of the current page using the Inspector palette: 

1.	 Click on the page or pasteboard to deactivate any selection and display 
the Page General panel in the Inspector palette. 

2.	 Highlight the text in the Title field and enter the new title. 
3.	 Press Return or click back onto the page to confirm the new title. 

Changing the title of a page in the Site panel 
1.	 Hold down the Alt key as you click on the title of the page in the Site panel. 
2.	 The existing title is shown highlighted for you to overtype. Enter the new title.
3.	 Press Return or click back onto the page to confirm the new title. Freeway renames the page, 

changing the title displayed in the Site panel. 

Note: Freeway automatically changes the file name for the HTML page to 
match the title unless the file name is already distinct, as described in Page 
title and file name on page 25. Freeway automatically manages hyperlinks 
in your site during such changes.

Applying a background color to the browser window background or page background
It is very important to note that Freeway Pro offers two different background colors for a page—the Window Background and the 
Page Background—whereas Freeway Express only lets you apply a single 
background color, which is the Window Background.

Applying a Window background color

The Window Background color (or image) is what you will see in the 
background of the browser window. Note that this is the complete area of 
the browser window and not the page area defined in the Freeway file.

In Freeway Pro you can choose to use a different color or image for the 
background of the page area (see next section)—so the page area and the 
browser background can be different.

By default, Freeway creates pages that will display in the browser with a 
white background. To change the background color for the current browser 
window background, choose a color in the Color popup in the Window 
Background panel of the Inspector’s Paintbrush tab when the page (or 
nothing) is selected. 

Freeway Pro Freeway Express

Freeway Pro

Freeway Express
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Applying a Page background color (Pro-only)

As mentioned above, Express does not have a specific option in the 
Inspector for creating a page area background color. Pro, however, has 
an additional panel in the Inspector’s Paintbrush tab which allows 
you to choose a color or background image to fill the page area of 
your Freeway file.

To change the background color for the current browser window 
background, choose a color in the Color popup in the Page 
Background panel of the Inspector’s Paintbrush tab when the page 
(or nothing) is selected. 

Note: For Express users, the only way to set up different colors for the 
page area and the browser background is to set the Window Color first and 
then draw a large HTML item on the page, apply the different color and 
then make it the full size of the page area. After that you need to draw 
items on top of the HTML background item so that they are “child” items, 
embedded inside the parent HTML background item.

Applying a background image to the browser window background or page background
Instead of choosing a solid color for the browser window or page background, you can select an image to be used as a background. 

Just as with applying a color, Freeway Pro gives you the option of applying a different background image to the browser window 
background and the page area background—but in Freeway Express there is only an option to apply a background image to the browser 
window background.

The image you select will normally be tiled to fill the entire window of the browser, starting from the top left-hand corner of the 
browser window, but you can change the default position and tiling behavior in the Inspector palette. 

Background images may be in any graphic format that Freeway can read. Images that are in a web format (GIF, JPEG, or PNG), are 
exported unchanged in their original format (as pass-through images), unless they are sliced (see below). Other images are converted to an 
appropriate web format.

To apply a background image to the current page, you can either:

1.	 Drag and drop an image from the Finder or another application onto an empty area of the page 
while holding the Shift key down.

Or: 

1.	 Click on the page or pasteboard to deactivate any other selection. The Page General panel should be 
shown in the Inspector palette. 

2.	 Change to the Page Appearance panel. 
3.	 From the Image popup menu in the Window Background panel, choose Select… and then locate 

the image you want as the background. 
4.	 Click Open. Freeway applies the image to the page as a tiled background. To remove a page background 

image, choose None from the Image popup menu. 

Tiling the background image
Once a background image has been added to a page, the Inspector palette shows options you can use to control how the image is 
positioned on the page and whether it is tiled or not. By default the imported image will be positioned Left for Horizontal and Top 
for Vertical tiled and the image will be repeated across and down the page because the Horizontal and Vertical defaults are set to Tile, 
which will fill the page with the selected image in both directions.

In our example, the background image (shown in the screenshot on the right) is a small block of orange and white 
about 4px wide by 100px deep, which is shown below on a grey background:

Importing the background graphic by using the default settings will give the effect of a striped background when using 
the tile graphic shown below.

Picking a page background color in Freeway Pro (left) and Express (right).

Hold the Shift key as you drag 
in a suitable graphic to make a 
page background.

Note: With the Tile option switched off, Freeway 
Pro users can enter specific pixel values in the 
Horizontal and/or Vertical fields to offset the 
background image. If the Tile option is switched on, 
the offset values will only apply to the initial image 
(i.e., all subsequent repeat images will simply fill 
the background as normal).

If you want an image which is centered in a browser 
but has space at the top of the page, use Center for 
Horizontal and enter a specific value (such as 50px) 
in the Vertical field.
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By setting the Horizontal popup to Center, the 
Vertical popup to Top and the Tile to Vertically, 
the orange/yellow squares will be centered within 
the width of the browser window:

By setting the Horizontal and Vertical to Center 
and Tile to Horizontally the background graphic 
displays as a single stripe across the center of the 
page:

The Background scrolls checkbox, checked by 
default, lets you set whether the background 
moves with the page as the browser window is 
scrolled up or down. Turning off this option will 
fix the background in the browser window.

Working with page folders 
When creating a web site, if there is to be a large number of pages, 
you may wish to divide the site using subfolders to keep related 
pages together, as in a filing cabinet. You can add folders to your 
document in Freeway and when the site is published, the folder 
structure you defined will be reproduced within the site folder you 
specified for the document. 

Creating a new folder 
You create a new folder by choosing New Folder… from either the 
Page menu or the Site panel  menu, or by Control-clicking in 
the Site panel and choosing New Folder… from the contextual 
menu. The new folder will be inserted into the document after the 
last site page in the current or selected folder. 

Moving folders and pages into subfolders 
You can drag either pages or folders into folders you have created in a 
document. To do this, you need to select the page or folder you wish to 
move in the Site panel, then drag down and to the right of the folder 
you want to move it into. When you let go, the item should be shown 
indented one level to the right of its parent folder—if not, drag it to the 
right again. 

Creating a new folder from the 
Page menu (left) or by using 
the contextual menu in the 
Site panel.

Dragging a folder in the 
Site panel. Note the blue 
“line-and-ring” marker to 
show where the folder will be 
positioned.



Freeway Reference: Working with Pages
38

38

Deleting folders 
To delete a folder, select it in the Site panel and either press the Delete 
or Backspace key or click on the  button at the bottom of the Site panel 
or choose Delete from the Edit menu. Click OK in the confirmation 
dialog. You can also delete a folder by Control-clicking on it and choosing 
Delete… from the contextual menu. 

Important: Deleting a folder will also delete any pages and their content in 
the folder. If you wish to keep any of the pages, drag them out of the folder in 
the Site panel, or copy their content to a new page before deleting the folder.

Renaming folders 
To rename a folder, Alt-click on the name of the folder in the Site panel. 

Color labels 
You can use colors to label pages, folders, and items in the Site panel, in a similar way to using color labels in the Finder.

To set a color label:

1.	 Control-click on an item, page, or folder in the Site panel.
2.	 Select a color label from the contextual menu.

You can change the names of color labels in the Preferences dialog.

Viewing the page at different magnifications
To look at a page in more or less detail, you can enlarge or reduce 
the magnification at which the page is viewed. 

There are several ways of doing this: using the popup Zoom 
menu at the bottom right of the document window, using the 
Zoom tool or selecting a preset magnification from the View 
menu. 

Take care while viewing the page at different magnifications, as 
Freeway’s representation of how things will look in a web browser 
is only valid at 100% zoom. You can zoom in up to a maximum 
magnification of 1600% or out to a minimum of 5%. 

When you click on the popup Zoom menu at the lower right of the document window, you’ll see a list of magnifications to choose 
from. You can also type in a custom magnification by choosing Other… from the popup menu or automatically select a zoom that 
reveals the entire page in the window by choosing Fit Page In Window. 

Changing the view magnification using the Zoom tool 
You can use the Zoom tool from the Toolbar or Tools 
palette (Freeway Pro only) to magnify or reduce the 
view of the page. You can either click or drag with the 
Zoom tool. Clicking on the page with the Zoom tool 

increases the magnification in increments of 25%, while Alt-
clicking with the Zoom tool reduces the magnification by the 
same amount. Also useful is the ability to define a rectangular 
marquee by clicking and dragging diagonally with the Zoom 
tool, which zooms in on that selected area. 

While working with the Zoom tool, press the Command key to temporarily toggle to the Selection tool. 

Zooming in or out while using another tool 
To work with the Zoom tool while using another tool, press Shift-Control to zoom in and Shift-Alt-Control to zoom out. Then click 
to zoom in or out in increments of 25% or drag to zoom in on a defined area. 

Zooming to a preset view size from the View menu 
You can choose two view sizes directly from the View menu: 

•	 Choosing Actual Size displays the document at 100% (keyboard shortcut: Command-f). 

•	 Choosing Fit in Window scales the view up or down to fit a page to the current window area 
(keyboard shortcut: Command-zero). 

Preset options available 
from the popup Zoom 
menu in the bottom 
right of the document 
window.

Defining a rectangular 
marquee by clicking 
and dragging with the 
Zoom tool.
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To quickly restore the view to 100%, just double-click on the Zoom tool in the Toolbar. (This does not work with the Tools palette 
Zoom tool.)

You can also call up the Zoom dialog from the View menu. 

You can enter any percentage zoom between the minimum and maximum numbers, or you can 
nudge the current zoom level up or down using the arrow buttons. Click the OK button to accept 
the new zoom level.

Working with multiple windows 
You can have multiple windows open for different documents or (in Freeway Pro) showing different views of the same document 
simultaneously. Any changes you make in one window are shown in all open windows. 

By creating additional windows and stacking or tiling them, you can view the document in both close up and at a distance, or you can 
view a page and its master page at the same time.

Working with multiple documents 
You can work with two or more documents at once by opening another document without closing the first one.

Displaying multiple views of the same document FW Pro only  

To display a new window choose New Window from the 
Window menu. Freeway opens a new window on top of 
the original one, displaying the document in the same 
magnification. The first window has “1” appended to the 
document name in the title bar. The new window has the 
same document name, with the number “2” appended and so 
on. 

Note: The New Window option is not available in Freeway 
Express.

You can move and resize windows in the normal way to display two or more views of the document simultaneously. 

Switching between windows 
Open windows are listed on the Window menu and you can change between them by choosing the 
name of the window you wish to become active from the list. 

Note: You can also cycle through open document windows in 
Freeway by typing Command-’ (Command-singlequote). 

Closing a window 
To close a window: 

1.	 Make a window active by clicking in it. 
2.	 Choose Close from the File menu or click on the close button in the top left-hand corner of the document window. Freeway closes 

the window. If this is the only open window for the document and changes have been made, a warning message asks if you want to 
save the changes. Choose Save or Cancel, as appropriate. 

Tiling windows 
There are two tiling options available in the Window menu, both of which arrange any open windows to fill the screen. Tile arranges 
windows horizontally so that two windows will be positioned one above the other, while Tile 
Vertically arranges windows so that two windows will appear side by side. If you add a new window, 
the tiled windows will be obscured. Choose Tile or Tile Vertically from the Window menu again to 
rearrange the windows.

Stacking windows 
When you choose Stack from the Window menu, Freeway places the open windows on top of each other but slightly offset. You can 
select a window from the stack by clicking on its edge. The selected window is then brought to the top of the stack and becomes active. 

Save Default Window
Choosing Save Default Window from the Window menu saves the currently open document’s window dimensions and position so 
that all new documents you create open with the same relative window size and position.

By choosing New Window (left) a new 
title bar is appended to the top of the 
Freeway window (above).
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Rulers, guides, and grids 
To help you produce consistent layouts and align items accurately, Freeway provides various rulers, guides, and grids: 

1.	 Rulers along the top and left-hand edges of a window reflect the vertical and horizontal offset of your items. 
2.	 Ruler guides are vertical and horizontal lines that you use to align items accurately. 
3.	 Vertical and horizontal grids consist of repeating lines occurring at a specified interval. FW Pro only  
4.	 Margin guides can be used to control a consistent top and left inset for items on your pages. FW Pro only  

Rulers are not shown while working with a frame layout in order to provide a more accurate preview of how the window will look. 

Changing the color of guides, grids, and margins 
The default color for ruler guides is light green (red for locked guides), and the default color for grid lines is light blue. You can change 
the default colors for these if you want: 

1.	 Choose Preferences… from the Freeway menu. 
2.	 Click on the Grids & Guides button in Freeway Pro, or the Guides button in Freeway Express.
3.	 Click on the appropriate color selector button to display the Color Picker and select another color. 
4.	 Click OK to confirm the color and then click OK to confirm the dialog and return to the document.

Guides preferences in Freeway Express.

Grids & Guides preferences in Freeway Pro.

	
Rulers 
Rulers along the top and left-hand side of the page view give you an indication of the position of items on a page with respect to the 
ruler origin. Initially, the ruler origin is aligned with the top left corner of the page. When working in a particular area of the page 
though, you may wish to move the ruler origin to work more conveniently. 

The ruler display varies with the selection on the page. For example, with an item selected, the horizontal ruler reflects the standard origin 
but with the text cursor in a box, the horizontal ruler reflects the text margins of the item. 

Hiding and displaying rulers 
You can display or hide the rulers along the top and left-hand side of the screen. Rulers are displayed by default when you open a new 
document. 

Choose Hide Rulers from the View menu to remove the rulers from the window and increase the visible working area. Choose Show 
Rulers to display the rulers. The keyboard combination Command-Alt-r toggles the ruler view on and off.

Setting the ruler origin 
You can alter the origin of the ruler measurements by repositioning 
the zero point (the ruler origin). This affects the entire document, not 
just the page on which you’re working. The current positioning of 
items on the page is not affected by changes to the ruler origin. 

To set the ruler origin, ensure the rulers are visible and then: 

1.	 Move the pointer over the ruler origin area at the top left 
corner of the window, where the horizontal and vertical rulers 
intersect. 

2.	 Hold down the mouse button and drag the pointer onto the 
page. A long crosshair shows the position of the new ruler 
origin. 

3.	 Release the mouse at the new origin. 

The new origin point will show in the horizontal and vertical rulers marked with a zero. 

The ruler origin, circled, is 
the point where the top and 
left rulers meet. Dragging 
from the origin point into 
the page repositions the 
zero point.
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Resetting the ruler origin 
To reset the ruler origin to the top left corner of the page when finished, simply double-click on the ruler origin area at the top left 
corner of the window. 

Ruler guides 
Freeway allows you to set up non-publishing guides to help you position items when laying out a page. These lines can be visible or 
hidden as you work but they are not published to your web pages. You can make objects snap into alignment with ruler guides. 

Placing a ruler guide 
To place a ruler guide on a page: 

1.	 Make sure that the rulers are visible along the top and left-hand edges of the window. If they 
are not, choose Show Rulers from the View menu. 

2.	 Make sure guides are visible. If they are not, choose Guides from the View menu. 
3.	 To place a vertical guide, point at the vertical ruler along the left-hand edge of the page area, 

hold the mouse button down and drag the pointer onto the page. To place a horizontal guide, 
point at the horizontal ruler along the top edge of the page area, hold the mouse button 
down and drag the pointer onto the page. A solid black line in the ruler indicates the current 
position of the guide as you drag. 

4.	 When you reach the position you want, release the mouse button to place the guide. 

Creating guides FW Pro only  

The Create Guides dialog allows you to set guides for a page, and automatically calculates the correct widths and heights for layouts 
with a fixed number of columns or rows, with or without a gutter.

1.	 Choose Create Guides… from the Page menu. 
2.	 Specify the number of rows and columns you want. 
3.	 Select the From Margins checkbox if you want guide positions to be relative to page margins.
4.	 Enter values for row or column gutters if required.
5.	 Click OK to confirm your changes.

Freeway automatically updates the page display to show guides as they are created. If you cancel the dialog, any guides that have 
been created in this way will be removed.

Moving a ruler guide with the mouse 

Use the Selection tool to drag the guide to the new position, then release the mouse. 

When you try to move a guide, you may select a nearby item or rule instead. If this happens, try dragging from somewhere else along 
the guide first. 

If you want to drag a guide to a new part of the page and have the view scroll to follow it, hold down the Shift key as you drag. 

Repositioning ruler guides numerically 
Double-click on an existing ruler guide to display the Guide dialog box. Type in a new value 
for the position of the guide relative to the ruler origin and click OK. There is no need to 
enter “px” in the text field as Freeway will automatically add the measurement when the OK 
button is clicked.

Removing a ruler guide 
To remove a ruler guide from a page, use the Selection tool to drag the guide off the page in any direction. Alternatively, double-click 
on the ruler guide to display the Guide dialog box, and click on the Remove button. 

To remove all guides from a page (in Freeway Pro), choose Remove Guides from the Page menu. 

Snapping to guides 
You can make guides “magnetic”, so that when you move items within a certain distance of a guide or gridline, they snap into 
alignment. 

Snapping to guides is on by default, but you can turn it off if necessary by deselecting Snap to Guides from the View menu. 

Altering the magnetic range of guides  
and grids FW Pro only  

The magnetic distance is set to 5 pixels by default for both guides and grids but can be changed using the Preferences dialog box: 

1.	 Choose Preferences… from the application menu. 
2.	 Click on the Grids & Guides button. 
3.	 Enter a value in pixels in the Magnetic range text box in either the Guides section or the Grids section. 
4.	 Click OK. 
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Hiding and displaying guides and grids 
You might find it useful to hide the guides and grid lines while you’re working on a document. 
To do this, choose Guides from the View menu. 

The non-publishing guides are then hidden from view throughout the document. However, 
guides and grid lines are still magnetic, even when they are hidden. 

To display guides and grids again, choose Guides from the View menu once more. 

Displaying guides and grids above  
or below other elements 
You can display guides and grid lines above or below the other elements on a page. 

To change the display position of the ruler guides, choose Guides Above from the View menu. 

Locking guides on the page
To lock guides on the page to prevent accidentally moving them as you work, select Lock 
Guides in the View menu. All horizontal and vertical ruler guides will be locked throughout the 
Freeway document. 

To unlock all guides again, deselect Lock Guides in the View menu.

Freeway uses different colors (that can be set in the Preferences dialog) to distinguish between 
locked and unlocked guides. Guides that are set on a master page are always locked on site pages.

Margins and grids FW Pro only  

To help you position items and rulers consistently, you can set up horizontal and vertical grids of 
regularly spaced guides.

When applying grids, you can specify a start and end point as an offset from either 
the margins or from the edge of the page. 

Setting margins FW Pro only  

You can define margins for pages in your document using the Margins and Grids 
dialog. This can help you position items consistently between pages. Margins can be 
set on any page or on a master page. To set up margins: 

1.	 Choose Margins and Grids… from the Page menu. 
2.	 Enter the values you desire for the top, left, right and bottom margins, and click 

OK. Setting any value to “0px” removes that margin.

Setting horizontal and vertical grids 
To apply a horizontal or vertical grid: 

1.	 Choose Margins and Grids… from the Page menu. 
2.	 Turn on the type of grid(s) you want to apply (Vertical and/or Horizontal) 

using the relevant checkboxes. 
3.	 Specify the width of the grids in the appropriate fields.
4.	 Select From Top Margin and/or From Left Margin if you want your grids to be defined relative to the page margins.
5.	 Click OK if you’re happy with the settings. The grids you specify are placed over the page.

Note: If the new grid doesn’t appear, check that Freeway is set to show 
grids. Use the Guides command on the View menu to toggle the display of 
the grid.

Removing grids and margins 
To remove existing grids and margins: 

1.	 Choose Margins and Grids… from the Page menu. 
2.	 Click the Clear Settings button. 
3.	 Click OK. 

To restore the margins and grids to those defined on the master page, click on the Use Master Settings button.

The Margins and Grids dialog automatically updates the current page as you make changes. If you click the Cancel button any changes 
to the margins or grids that have been made whilst the dialog is open will be discarded.



This chapter assumes you are already familiar with the basic functions of the various tools and 
palettes available to you in Freeway Pro. 

Important: Freeway Express does not support CSS items. However, “blue 
outline” HTML items referred to in this chapter have the same functionality 
in both the Express and Pro versions of Freeway.

Note: For more information on creating items, and manipulating them and 
their contents, see Working with graphics on page 92.

Types of items 
Elements created on your Freeway pages are known as “items”. To create items, use the drawing tools 
in the Toolbar or Tools palette (Freeway Pro only) or choose commands from the Insert menu. 

Independent and inflow items 
Independent items have a position relative to the page or to a parent item—in constrast 
to inflow items, which are placed within a flow of text and/or other items. Inflow items 
do not have an independent position—their location on the page or within an item is 
determined by where they are in the flow. Some types of inflow item can stand on the same 
line as text and other items, in which case they are known as inline items.

Freeway distinguishes independent items from inflow items by drawing triangular corner 
mounts on the item’s outline.

Child items 
Freeway allows items to be placed directly on the page or within other items. Items that are within another item are known as child 
items. The containing item is the parent of a child item. In one sense, every item is a child item, since every item is ultimately a 
descendent of the page itself. However, Freeway distinguishes between items that are children of other items and items that are directly 
on the page.

Independent (non-inflow) child items are positioned in much the same way as top-level items on the page, except that all the position/
dimension settings are relative to the parent item rather than the page—when a parent item is moved or deleted, child items are moved 
or deleted with it.

A child item may also be the parent of other child items. Most types of items can be parents (and contain other items), but there are 
exceptions—including map areas, and some types of Action items.

CSS and table-positioned items FW Pro only  

Freeway Pro distinguishes between CSS items, which are positioned using CSS, and non-CSS items, which are 
positioned using tables. In Freeway, CSS items have a green outline (and/or green triangular corner mounts) while non-CSS items have a 
blue outline (and/or blue corner mounts). Freeway creates CSS items when you have the CSS Layout button turned on in the Toolbar. 
Otherwise it creates table-positioned items—except in the case of inflow layout (inflow items are a type of CSS item, except on HTML 
3.2 pages).

Independent CSS items are known as layers. These have a fixed position on the page or within another item—in contrast to inflow 
items, which are positioned within a flow of text and/or other items.

Layer items are available only when the HTML level of your page has been set to 4.01 or higher. Existing table-positioned graphic and 
HTML items become layer items when their “Layer” option is set in the Inspector palette. New CSS (layer or inflow) items are created 
when the CSS Layout button in the Toolbar is active.

Important: Freeway Express does not support CSS layer items, and has 
limited support for inflow layout. 

 HTML items 
HTML items are shown with a blue outline (table layout) or green outline (CSS layout). The 
contents of an HTML item are output to the web using standard HTML tags. Graphics that 
are imported in HTML boxes are published in their original form and cannot be resized 
or modified within Freeway. HTML items may contain text, images in GIF, JPEG, or PNG 
format, or multimedia content. Additional types of HTML items include form controls, tables, Action items, and others.

Working with Items

The Freeway Pro Tools 
palette duplicates the 
tools available from the 
main Toolbar. It enables 
the Toolbar to be hidden 
so that more space is 
available for the document 
you are working on.

Note: The default box colors (blue for table-
positioned items and green for CSS items) can 
be changed in the Preferences dialog.
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You will read later in this manual that some HTML items offer new HTML5 functionality that was not supported in Freeway prior 
to Freeway 6. These new features include Section Elements (see below) and additional functionality for forms, such as validation, 
placeholder text, etc., which is covered in detail in the Working with Forms section of this manual.

 Graphic items 
Graphic items are shown with a gray outline; they can be either table positioned or CSS positioned. CSS graphic items have green 
triangular corner mounts to help differentiate them from table-positioned items. Graphic items can contain text or images in GIF, JPEG, 
PNG, TIFF, Photoshop, PICT, BMP, EPS, PDF, or Illustrator format. 
Freeway can also import any other graphic format supported 
by QuickTime. The contents of graphic items are processed for 
output to the web as 72ppi graphics in GIF, JPEG, or PNG format. 

 Map area items 
Map area items are shown with a purple outline. These items indicate the area of a hyperlink “hotspot” over an item. Unlike HTML 
items and graphic items, map areas do not hold any content of their own. (For more information on map area items, see Image maps on 
page 118.) 

HTML5 Section Elements FW Pro only  

Freeway supports the following HTML5 section elements: Address, Article, Aside, Footer, Header, 
Nav, Section (as well as the generic div element, referred to as HTML).

Users can choose an element type from the Type popup of the Item Export panel (when the page 
level is set to HTML5 or XHTML5). If a page is changed from (X)HTML5 to a lower level, HTML5 
section items are changed to generic HTML items.

HTML5 section elects are not required, but can provide useful hints about your page to screen 
readers, search engines, and syndicators. The following advice on using HTML5 section elements is 
taken from the official HTML5 documentation (some minor edits have been made):

Div Element

Generic CSS HTML boxes – layers and inflow items – are output as div elements in Freeway. Items 
will be output as divs if HTML is selected as the Type in the Item Output Settings of the Inspector 
palette.

Divs have no special meaning at all. They should only be used when no other element is suitable. 
Use of more appropriate elements instead of the div element leads to better accessibility for readers 
and easier maintainability for authors. 

For example, a blog post would be marked up using article, a chapter using section, a page’s navigation using nav, and a group of form 
controls using fieldset.

Section Element

The section element represents a generic section of a document or application. A section, in this context, is a thematic grouping of 
content, typically with a heading. 

Examples of sections would be chapters, the various tabbed pages in a tabbed dialog box, or the numbered sections of a thesis. A Web 
site’s home page could be split into sections for an introduction, news items, and contact information. 

The section element is not a generic container element. When an element is needed only for styling purposes or as a convenience for 
scripting, authors are encouraged to use the div element instead. A general rule is that the section element is appropriate only if the 
element’s contents would be listed explicitly in the document’s outline. 

Nav Element

The nav element represents a section of a page that links to other pages or to parts within the page: a section with navigation links. 

Not all groups of links on a page need to be in a nav element – the element is primarily intended for sections that consist of major 
navigation blocks. In particular, it is common for footers to have a short list of links to various pages of a site, such as the terms of 
service, the home page, and a copyright page. The footer element alone is sufficient for such cases; while a nav element can be used in 
such cases, it is usually unnecessary. 

Article Element

The article element represents a self-contained composition in a document, page, application, or site and that is, in principle, 
independently distributable or reusable, e.g. in syndication. This could be a forum post, a magazine or newspaper article, a blog entry, a 
user-submitted comment, an interactive widget or gadget, or any other independent item of content. 

Aside Element

The aside element represents a section of a page that consists of content that is tangentially related to the content around the aside 
element, and which could be considered separate from that content. Such sections are often represented as sidebars in printed 
typography. 

Note: Freeway Express supports a smaller range of graphic types: GIF, 
JPEG, PNG, and PICT. Graphic items drawn in Freeway Express have the 
same functionality as non-CSS layer items drawn in Freeway Pro.
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The element can be used for typographical effects like pull quotes or sidebars, for advertising, for groups of nav elements, and for other 
content that is considered separate from the main content of the page. 

Header Element

The header element represents a group of introductory or navigational aids. 

A header element is intended to usually contain the section’s heading (an h1-h6 element or an hgroup element), but this is not 
required. The header element can also be used to wrap a section’s table of contents, a search form, or any relevant logos. 

Footer Element

The footer element represents a footer for the page or section. A footer typically contains information about its section such as who 
wrote it, links to related documents, copyright data, and the like.

When the footer element contains entire sections, they represent appendices, indexes, long colophons, verbose license agreements, and 
other such content. 

Contact information for the author or editor of a section belongs in an address element, possibly itself inside a footer. Bylines and 
other information that could be suitable for both a header or a footer can be placed in either (or neither). The primary purpose of these 
elements is merely to help the author write self-explanatory markup that is easy to maintain and style; they are not intended to impose 
specific structures on authors. 

Footers don’t necessarily have to appear at the end of a section, though they usually do.

Address Element

The address element represents the contact information for an article or the page.

The address element must not be used to represent arbitrary addresses (e.g. postal addresses), unless those addresses are in fact the 
relevant contact information for an article or the page. The p element is the appropriate element for marking up postal addresses in 
general.

The address element must not contain information other than contact information. 

This is the only HTML5 section element which will affect the look of the text used inside it. Text in the Address Element will display as 
italic.

Creating items 
Items are usually created by drawing a box on the page. Freeway’s Toolbar and Tools palette contain a selection of drawing tools that 
can be used to sketch HTML boxes, graphic boxes, tables, and form controls. You can also create items by using commands in the Insert 
menu.

Freeway’s box-drawing tools 
There are four box-drawing tools in Freeway: two Rectangle tools, an Oval tool, and a Path tool for creating items that consist of polygons or 
bezier curves. 

The HTML 
rectangle tool.

The Graphic 
rectangle tool.

The Graphic 
Path tool.

The Graphic 
Oval tool.

Items that are drawn with the main box tools default either to HTML boxes (with a blue or green outline) or GIF boxes (with a gray 
outline). The output type can be changed in Item Output panel of the Inspector palette. The output type of an item determines how 
its content is reproduced in a web browser when the site is published. The six main output types are: HTML, GIF, JPEG, PNG, URL, and 
Map Area. 

To access the Path tool from Freeway’s default toolbar, click and hold on the Graphic box drawing toolbar item and select the Path 
tool from the menu.

If you later wish to change the output type of an item in Freeway, simply select the item, switch to the Item Output panel in the 
Inspector palette and choose a different output format. The output type might also change automatically when a graphic or other 
content is imported. 

When you want a box to hold text 
The contents of a box drawn to hold text can be published either as HTML text, or as a graphic. You normally make this decision when 
you draw the box—Freeway offers the ability to draw HTML text boxes or graphic text boxes with the individual drawing tools. Graphic 
boxes holding text can be any shape you choose, but HTML text boxes can only be rectangular. 

When you want a box to hold an image 
An image can be imported into any empty HTML or graphic box. Images imported into empty HTML boxes are output by default as 
“pass-through graphics” (see Pass-through graphics on page 105) and are not processed by Freeway. In this case, the imported graphic 
should be in a web-ready format (GIF, JPEG, or PNG). By contrast, images imported into graphic boxes are processed by Freeway and 
may be of any format supported by Freeway. 



Freeway Reference: Working with Items
46

46

When you want a plain filled box 
You can create an empty box and give it a fill color. A filled box can be output either as HTML or as a graphic. HTML items add less to 
the overall page file size and are therefore marginally quicker to download. HTML items can also be made flexible.

When you want a box to reference existing web content 
Items intended to hold external content referenced from the web (when the page is viewed in a browser) are called URL items. URL items 
can be given one of two URL output types: Image or HTML. Any empty HTML or graphic item can be made into a URL item by setting its 
type in the Item Output panel of the Inspector palette. URL items are useful for embedding a reference on your page to counters, Server 
Side Includes, and other types of content. 

Drawing items 
Drawing a rectangular box 
1.	 Select the HTML or graphic box-drawing tool. 
2.	 Position the pointer where you want one corner of the box to begin. 
3.	 Click and drag diagonally. You can drag left or right to draw the box.
4.	 Release the mouse button when the box is the right size.

The newly drawn box will be selected, with visible “handles” for resizing, and will display a non-publishing blue, green, or gray outline. 
If you want to hide the box outline at any point for a more realistic preview of how the page will look, deselect Outlines from the View 
menu. 

Drawing an oval graphic box 
1.	 Select the Oval box-drawing tool. 
2.	 Position the pointer over the page where you want one corner of the box to begin. 
3.	 Click and drag diagonally. You can drag left or right to draw the box.
4.	 Release the mouse button when the box is the right size. 

Drawing a polygonal graphic box 
To create a straight-sided or polygonal box by positioning corner points with the Path tool: 

1.	 Click and hold the mouse button on the Rectangle tool to show the menu, and choose the Path tool. 
2.	 Position the cursor where you want to start drawing the box and click once. 
3.	 Place the cursor where you want to create the second corner point and click again. Repeat until you have 

drawn the desired shape. 
4.	 To complete the box, place the cursor over the initial point and click—the cursor displays a closed circle 

when you are over the starting point to show that you are closing the shape. You may also double-click at any point to finish 
drawing the object and leave it open. 

Note: If you want to draw a regular polygon shape or a star with a specified 
number of points, you can do so by using the Fill Master Action (see the 
KnowledgeBase article at http://www.softpress.com/kb/questions/355/

Drawing a curved graphic box 
To create a box using curve points, drag the Path tool as you click to position the next point: 

1.	 Select the Path tool as described in the previous section. 
2.	 Position the cursor where you want to start drawing the box. 
3.	 Click on the page and hold down the mouse button. 
4.	 Drag the pointer to make direction handles that will determine the 

curvature of the line segment through the point you’re drawing. 
Release the mouse button to create a curved path. 

5.	 Continue clicking and dragging to complete the shape. 
6.	 Click on the first point in the path to complete the box. 

Note: You can draw an item with both curves and straight lines.

Modifying the operation of box-drawing tools 
You can change the way Freeway’s box-drawing tools work by using different keyboard modifiers.

Keeping a drawing tool selected to create additional items 
Usually, when you’ve finished drawing an item, the currently active tool in the Toolbar or Tools palette reverts automatically to 
the Selection tool. If you want to draw more than one box of the same type without having to reselect the box-drawing tool each 
time, hold down the Alt key as you select the tool. When you do this, the tool is shown selected in a panel that matches your system 
highlight color and remains selected until you choose another tool. 

Drawing a box from its center point 

line segment

control point

direction handles
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Boxes are normally drawn diagonally from corner to corner—however, there are occasions when you want to draw the box outward 
from a center point. 

To start drawing from the center point of the box, hold down the Alt key after you have started to drag the mouse to define your box 
and keep it held down until you release the mouse button. 

Note: If you press the Alt key before beginning to draw the box, you will 
activate the Grabber hand, which drags the page within the window. 

Drawing a square or circular box 
To constrain the Rectangle or Oval drawing tools, hold down Shift as you draw a box. The result will be a square or circular box, as 
appropriate. 

Power Tip: Holding Shift and Alt will draw a constrained square or circular 
box from its center.

Drawing child items 
Items may be drawn directly on the page, or as children of other items. When you are drawing an item as the child of another item, this 
is indicated by the cursor having a small square around it. Freeway also highlights the prospective parent of a box that is being drawn. 
If you draw a box within an existing box, Freeway will normally choose that as the box’s parent. 
If you are not drawing the box within another box, Freeway will choose the page as the parent. 
You can cycle between possible parents by pressing the space bar while a box is being drawn.

Manipulating items 
Once you’ve created an item, you can modify it in many ways. For example, you can change its size 
and shape, move it, transform it, or change its attributes such as its fill or border color. For more 
information about manipulating items and their contents, see Working with graphics on page 92.

Selecting an item 
Before making changes to an item, you must first select it using one of these five methods: 

•	 Click on an item with the Selection tool. This is probably the easiest way of selecting an 
item, so long as you are not currently editing text within the item. 

•	 Hold down the Command key and click anywhere on the item. 

•	 Click on the edge of the item using the Selection tool. 

•	 Alt-Command-click an item to select the item behind 
another item. 

•	 Click on the item’s icon in the Site panel, if Show Items has 
been selected in the  menu. 

Once an item has been selected, selection handles (tiny black 
squares) will then appear around the edge of the item. 

Parent and child highlight of the selected item 
Freeway highlights parent and child items to make it easier to see 
which items are related. When a child item is selected, Freeway 
highlights the item’s parent using the current highlight color (as set in the Appearance 
panel of System Preferences). When a parent item is selected, Freeway highlights the item’s 
children using a secondary highlight color (normally gray).

Selecting multiple items 
There are six ways of selecting multiple items: 

•	 With the Selection tool, Shift-click on each item. 

•	 With the Selection tool, drag around or through items on the page or pasteboard that you 
want to select.

•	 Choose Select All from the Edit menu. This selects all items on the currently visible page and pasteboard—unless a child item is 
selected, in which case it selects all items that have the same parent as the selected child.

•	 Shift-Alt-Command-click to select successive items stacked one in front of the other. 

•	 In the Site panel, click on the first item, then Shift-click on the subsequent items. (This keeps the first box selected while adding 
others.) By holding the Command key you can select items that are not next to each other in the list.

•	 With combined graphics (where two or more non-layer graphic items are overlapping or touching) Shift-Alt-click within the 
combined item bounds to select all the items.

Deselecting an item 
To deselect an item, you can select something else, click on the box again while holding 
down the Shift key, or click on any blank area of the page or pasteboard. 

Selected 
graphic item

Graphic 
pan tool

Selection tool

Selection handles

Note: Freeway does not allow you to 
select multiple items that do not have 
the same parent.
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Deleting an item 
To delete an item, select it and press either the Backspace or Delete key, or choose Delete from the Edit menu. 

Deleting the content of a box 
You can delete the content of a box and leave the box itself on your page. If it contains graphic or plug-in content, select the box and 
choose Delete Content from the Edit menu. If it contains text, click inside the box, choose Select All and then Delete from the Edit 
menu. 

Displaying and hiding box outlines 
You can hide or display the non-printing box outlines, which are displayed by default. To hide or display box outlines, choose Outlines 
from the View menu. 

Resizing items 
You can resize an item using the Selection tool by selecting it and then dragging its handles. To specify its size more accurately, use the 
Transform dialog, the Inspector palette or keyboard commands. 

Note: Freeway Express does not have a Transform dialog.

To resize an item using the Selection tool 
1.	 Select the item to display the selection handles. As you point at an item handle, the pointer changes shape to a tail-less arrow. 
2.	 Drag one of the handles. The corner handles allow you to resize in any direction while the edge handles allow you to resize only 

horizontally or vertically. 

Hold the Shift key down while resizing a rectangle or oval to constrain its dimensions to a square or circle. 

Hold the Shift and Alt keys down while resizing to constrain an item to its previous aspect ratio. 

To resize an item using the Inspector palette
1.	 Select the item. 
2.	 In the Item General panel of the Inspector palette, enter new values in the text fields for width and height, 

then press the Return key to accept the changes. 
3.	

To resize an item using keyboard commands 
Hold down the Shift key on the keyboard as you press the arrow keys to 
resize the box in 1 pixel increments. 

You can change the increment in Preferences, General panel, Arrows 
Nudge setting. 

To resize an item using the Transform dialog FW Pro only  

1.	 Select the item and choose Transform… from the Item menu. 
2.	 Enter the new values for the Scale percentages and click OK. This scales the item and its contents. 

Note: Freeway Express does not have a Transform dialog.

Freeway Pro

Freeway Express
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Height measurement options of table-based HTML items 
There are just two different options for HTML items in Freeway Express or table-based (non-layer) items in Freeway Pro.

Minimum Height
An item with fixed height will always be displayed at the same height even if its contents fall short of the height of the item.

Flexible Height
An item with flexible height will grow and shrink to fit its contents. This is similar to the “Height can shrink” option in earlier versions 
of Freeway. Flexible-height items will make the item’s box fit the height of its content and the three top and three bottom handles will 
display in red to give you a visual cue that the item has an undefined height. Note that you cannot change the height of an item with an 
undefined height by dragging the handles—if you want to change the height of the item you will need to change its height to Minimum.

Height measurement options of layer (CSS) HTML items  FW Pro only  

There are additional options available for layer (CSS) HTML items in Freeway Pro.

Fixed Height
An item with fixed height will always be displayed at the same height regardless of its contents. If an item has a fixed height of 100px, 
but the contents are 200px high, the item will be half the height of the content. 

Fixed % Height
If the height is a percentage, it will always be displayed at the same percentage height, but that will vary depending on the height of its 
parent.

Flexible Height
An item with flexible height will grow and shrink to fit its contents. This is similar to the “Height can shrink” option in earlier versions of 
Freeway. Flexible-height items are displayed with undefined height in the Dimensions section of the Inspector palette.

Minimum Height
An item with minimum height has a flexible height that will not shrink below the value that is set as its minimum height. If the content 
is added to an item, or the content is increased in size, the item will grow to accommodate the content. If content is removed, or the 
content is decreased, the item will stop shrinking when it reaches the value entered in the Minimum Height field. Minimum heights can 
be fixed pixels (in which case you should use this option) or percentage based (see below).

Minimum % Height
This setting works in exactly the same way as the Minimum Height option (above), but it is specifically for percentage-based values.

Stretchy Height
An item with stretchy height is defined by its top and bottom offsets, and will grow or shrink as its parent grows or shrinks.
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Width measurement options of table-based HTML items 
There are just two different options for HTML items in Freeway Express or table-based (non-layer) items in Freeway Pro.

Minimum Width
An item with fixed height will always be displayed at the same height even if its contents fall short of the height of the item.

Flexible Width
An item with flexible height will grow and shrink to fit its contents. This is similar to the “Height can shrink” option in earlier versions 
of Freeway. Flexible-height items will make the item’s box fit the height of its content and the three top and three bottom handles will 
display in red to give you a visual cue that the item has an undefined height. Note that you cannot change the height of an item with an 
undefined height by dragging the handles—if you want to change the height of the item you will need to change its height to Minimum.

Width measurement options of layer (CSS) HTML items  FW Pro only  

There are additional options available for layer (CSS) HTML items in Freeway Pro.

Fixed Width
An item with fixed width will always be displayed at the same width regardless of its contents. Use this option if the item has a fixed 
pixel width

Fixed % Width
If the width is a percentage, it will always be displayed at the same percentage width, but that will vary depending on the width of its 
parent. Use this option if the item has a percentage-based width.

Flexible Width
An item with flexible width will grow and shrink to fit its contents. This is similar to flexible height, but you should be careful about 
using this option with paragraph text – unless it is constrained in some other way, an item may expand so that all the text in a paragraph 
is fitted on a single line.

Minimum Width
An item with minimum width has a flexible width that will not shrink beyond the value that is set as its minimum width. If the content 
is added to an item, or the content is increased in size, the item will grow to accommodate the content. If content is removed, or the 
content is decreased, the item will stop shrinking when it reaches the value entered in the Minimum Width field. Minimum widths can 
be can be fixed pixels (in which case you should use this option) or percentage based (see below).

Minimum % Width
This setting works in exactly the same way as the Minimum Width option (above), but it is specifically for percentage-based values.

Stretchy Width
An item with stretchy width is defined by its left and right offsets, and will grow or shrink as its parent grows or shrinks.

Note: If you use a layer HTML item “inflow” (within the flow of the text by clicking in the text flow 
and going to Insert>HTML item), if you select that item you will see another Width option called 
Available. If you use the Available Width option, the inflow item will fill the width of its parent item. If 
the item is floated, its width cannot be set as available.
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Freeway Pro

Freeway Express

Note: To constrain the movement of the item to horizontal, 
vertical or diagonal, hold the Shift key after beginning to move the 
mouse.

Power Tip: If you have set the Arrows Nudge increment to a value 
greater than or equal to 10 pixels, holding down the Alt key as you 
use the arrows will move the item 1/10th the specified distance. 

Note: Copying items in this way may cause non-layer HTML items on the 
destination page to become overflowed. Items affected will be displayed with 
a diagonal cross in the box.

Freeway Pro
Freeway Express

Moving items 
There are several ways to move an item, provided it is not locked. 

Using the Selection tool 
1.	 Choose the Selection tool. 
2.	 Click on the box and while holding the mouse button down drag the mouse to the location you desire. 

Dragging items close to guides or grids will cause the item to snap to the guide or grid line if Snap to Guides on the View menu is 
turned on. 

You can cancel a drag by pressing the Escape key.
Child items are normally constrained to the bounds of their parent, but you can drag items out of their current parent (into a new 
parent) by pressing the space bar while dragging. Repeatedly pressing the space bar will allow you to cycle through all possible parents, 
highlighting each one in turn.

In contrast to table-positioned items, which cannot be outside the 
bounds of their parent, layer items can be dragged outside or partially 
outside the bounds of their parent by holding the Command key while 
dragging (Freeway Pro only).

Using the Inspector palette 
1.	 Select the box. 
2.	 Enter new values in the Left Inset and Top Inset text fields of the 

Inspector palette. (These normally correspond to the upper left 
corner of the item’s constraining rectangle.) 

3.	 Press Enter or Return. 

Using the keyboard arrow keys 
To move an item on the page by using the keyboard arrow keys: 

1.	 Select the item. 
2.	 Use the four keyboard arrow keys to nudge it up, down, right, or 

left in 1-pixel increments. 
You can change the increment in Preferences, General panel, 
Arrows Nudge setting. 

Moving an item to another page using the Site panel 
You can move an item to another page within the Site panel. Simply drag the item’s icon, in the Site 
panel, to the space just below the desired page’s icon. If items aren’t visible in the Site panel, choose 
Show Items from the Site panel  menu.

You can also drag items from the Site panel to the currently 
visible page. This will create a copy of the dragged item. See 
Showing items in the Site Panel on page 52.

Locking and unlocking an item 
You can lock an item into position to prevent inadvertently moving it. To do this, select the box and choose Lock from the Item menu or 
select the Lock checkbox in the Item General panel of the Inspector palette.

When an item is locked, its selection handles are drawn in red. Some boxes that have not been locked in this way may also have locked 
selection handles:

•	 The top and bottom selection handles of a box are locked if the box’s height is undefined or if “Height can shrink” is selected—in 
this case, the height is determined by the box contents, and cannot be set separately. 

•	 In Freeway Pro, the left and right selection handles of an inflow box are locked if the box’s width is undefined—in this case, the 
width is determined by the width of the parent (or by the box contents in the case of floated boxes). 

Changing box shape 
You can change the shape of a graphic box or map area. For example, 
you can draw an oval and then later convert it to a rectangle: 

1.	 Select the box and display the Item Appearance panel of the 
Inspector palette and open the Shape section of the panel. 

2.	 Choose a different shape from the Shape popup menu in the Other 
panel. 

Note: HTML items can only be rectangular. 
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Showing items in the Site panel
Items can be shown in the Site panel, either by switching from Site view to Page view (click on the header 
bar of the Site panel to toggle the view between Site and Page), or by selecting Show Items from the  
menu at the bottom of the Site panel. When items are displayed, their order and arrangement within the 
Site panel indicates the stacking order of items on the page.

Items that belong to each page are shown below and slightly to the right of the page icon. Similarly, items 
that are children of other items are shown below and slightly indented from their parent item. If an item is 
on the pasteboard or has overflowed from its containing box, its icon has a small cross in the center.

You can hide the display of items on individual pages by clicking the disclosure triangle next to each page.

Showing all 
items on a 
page (left), 
and hiding 
the items by 
clicking the 
disclosure 
triangle.

Reshaping paths 
You can reshape an item drawn with the Path tool (i.e., a path graphic item) by moving, adding and deleting points or by altering its 
curved paths. Use the Selection tool to edit the shape of the path item, and use the Path tool to add or remove “reshape points”. 

Moving points 
1.	 Using the Selection tool, select the path item to display hollow squares, called “control 

points”. 
2.	 Point at a control point—the mouse cursor will then change to a tail-less, hollow arrow. 
3.	 Drag the appropriate point to a new position. 

Adding points 
You can add extra points to a path with the Path tool: 

1.	 Select the item. 
2.	 Switch to the Path tool and move the cursor over the path position where you want to add a 

control point. The cursor will change to . 
3.	 Click to add a corner point, or Shift-click to add a curve point.

Deleting points 
You can delete unwanted points from a path with the Path tool: 

1.	 Select the item. 
2.	 Switch to the Path tool and move the cursor over the point you want to delete. The cursor will 

change to . 
3.	 Click on the point to delete it. 

Altering curves 
1.	 Select the box to display its points and direction handles. 
2.	 Drag the points or direction handles to reshape the curve. 



Freeway Reference: Working with Items
53

53

To make a round-cornered graphic box 
1.	 Select the box and display the Item Appearance panel in the Inspector palette. 
2.	 Open the Shape section. 
3.	 Choose a radius from the Corner popup menu, or enter a radius in the text field and press Enter or Return. 

Freeway Pro
Freeway Express

All four corners of the box are altered by the amount you set. Small circles appear inside the box, close to each corner at the radius 
origin of the curve. You can alter the shape of individual corners by dragging these circles.

If you want to give precise dimensions to each corner, choose Custom… from the Corner popup menu. Enter the dimensions you want 
in the text fields. Entering 0px removes the radius from a corner.

Note 1: When a box has corners of different radii, a “–” appears in the 
Inspector palette’s Corner field.

Transforming items 

Rotate tool Skew tool Mirror tool

Graphic items may be rotated, skewed, scaled, or reflected using 
either the Transform dialog box or by using the Rotate, Skew, 
and Mirror tools. You can also transform an item’s contents 
independently of the box.

Rotating an item using the Rotate tool 
You can rotate items by any angle. To rotate an item using the Rotate tool: 

1.	 Select the item. 
2.	 Select the Rotate tool from the Toolbar or Tools palette. 
3.	 Drag any handle to rotate the item. 

Note: HTML items cannot be rotated.

Rotating an item using the Transform dialog box FW Pro only  

1.	 Select the item, and choose Transform… from the Item menu. 
2.	 Under the Item section of the dialog, enter the desired angle in the Rotation field. Entering a positive value rotates the item 

counter-clockwise. Entering a negative value rotates the item clockwise. To prevent the contents from being rotated, type in the 
negative value of the rotated item. 

3.	 Click OK. 

Note: Freeway Express does not have the Transform dialog box, the Skew 
or Mirror tools, or a separate Tools palette.
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Skewing an item using the Skew tool FW Pro only  

You can skew items horizontally and vertically to any angle: 

1.	 Select the item. 
2.	 Select the Skew tool from the Toolbar or Tools palette. 
3.	 Drag any handle to skew the item. (Greatest control is gained by dragging an edge handle, 

rather than a corner handle.) 

Note: HTML items cannot be skewed.

Skewing an item using the Transform dialog box FW Pro only  

1.	 Select the item and choose Transform… from the Item menu. 
2.	 To skew the item horizontally, enter a new value for Skew (x). To skew the item vertically, enter a new value for Skew (y). 
3.	 Click OK. 

Reflecting an item using the Mirror tool FW Pro only  

The Mirror tool allows you to reflect an item and at the same time, rotate it.

1.	 Select the item. 
2.	 Select the Mirror tool from the Toolbar or Tools palette. 
3.	 Drag any selection handle to rotate and reflect the item at the same time. To reflect the item across a vertical axis, 

single-click any handle. To reflect the item across a horizontal axis, drag the left edge handle across the central axis of 
the item and release. 

Note: HTML items cannot be mirrored.

Reflecting an item using the Transform dialog box FW Pro only  

1.	 Select the item and choose Transform… from the Item menu. 
2.	 To reflect the item across a vertical axis, select the Mirror checkbox. To reflect the item across a horizontal axis, select the Mirror 

checkbox and enter “180” in the Rotation field. 
3.	 Click OK. 

Scaling an item using the Selection tool 
1.	 Select the item. 
2.	 Using the Selection tool, drag any handle to resize the item. 

•	 To scale a graphic item box together with its contents, hold down the Command key while dragging a handle. 

•	 To preserve the graphic’s aspect ratio but trim the graphic to fit the box, hold the Alt key while you drag a handle. 

•	 To preserve the graphic’s aspect ratio and pad the inside of the box (so that the graphic isn’t cut), hold down Command and Alt as 
you drag a handle. 

•	 To proportionally scale the box and its contents while retaining any cropping, hold down Shift-Alt-Command as you drag a corner 
handle. 

For more information, see Resizing items on page 48. 

Scaling an item using the Transform dialog  
box FW Pro only  

1.	 Select the item and choose Transform… from the Item menu. 
2.	 Select Keep aspect ratio if you want to retain the original aspect ratio 

of the box. 
3.	 Under the Item section of the dialog, enter new values for horizontal 

scaling and vertical scaling using Scale (x) and Scale (y) respectively. 
4.	 Click OK. 

Note: Freeway Express does not have the Transform dialog box.
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Changing attributes for items 
Item titles 
When an item is created, Freeway gives it a default title such as “item1”, “item2”, and so on. The title of an item is shown in the Item 
General panel of the Inspector palette. You can change the title of an item at any time. When you import a graphic into a box, the title of 
the item changes to reflect the name of the graphic file. The title of an item is used to generate the file name that Freeway gives any resulting 
images in the HTML output. It is therefore best to avoid using a hyphen (“–”), quote marks, or apostrophes in your image names to prevent 
conflicts with JavaScript Actions, such as Rollovers. 

To change the title for an item: 

1.	 Select the item. 
2.	 In the Item General panel of the Inspector palette, highlight the existing name in the Title text field and enter a new name.
3.	 Press Return to accept the change. 

You can also Alt-click on the item title in the Site panel. This will let you edit the name in the Site panel. Press Return to accept the 
changes. The new item name will be reflected in the Inspector palette.

If you decide not to edit the title, or change your mind after starting to edit it, press Escape.

You can undo item name changes by choosing Undo from the Edit menu.

Preventing an item from publishing 
There may be occasions when you do not wish an item to be included when the page is published—for 
example, when adding notes to a page for information. To prevent this: 

1.	 Select the item and display the Item General panel on the Inspector palette. 
2.	 Click to deselect the Publish checkbox. 

Creating layer items FW Pro only  

HTML and graphic items may be set to output as layer items using fixed or absolute positioning in HTML 4.01 or XHTML 1.0. 
Additionally, graphic items may be set to output as individual images or combined into one. 

If the CSS Layout button is not active (shows as gray in the Toolbar, or is not checked in the Tools palette), non-inflow items that are 
drawn on the Freeway page are positioned in the output using a hidden layout table—this is what imposes the restrictions on certain 
types of overlap between items and why images are cut up by overlapping HTML text, for example. 

However, when items are set to output as layer items, they no longer form part of this layout table and are freed from these restrictions. 
Layer items may overlap without interacting in any way and are stacked in the HTML output in the same order as they appear on the 
Freeway page.

If a layout table is output because of the presence on the page of any non-layer items, it is always the rearmost element in the output. 
Layer items are always treated as being in front of the layout table. It is therefore impossible for non-layer items to be output in front of 
layer items. 

HTML elements may be positioned with complete freedom when they are set to output as layer items, and will not interact with each 
other in any way. Their stacking order may be changed by using the Bring to Front or Send to Back commands from the Item menu, 
or by dragging their icons in the Site panel when this is set to Show Items. 

Creating a layer item FW Pro only  

1.	 Select the CSS Layout button in the Toolbar, or click the checkbox in the Tools palette. 
2.	 Draw the item using one of the drawing tools. 

Power Tip: It can be hard to remember which items you have drawn in your layout are layers and which are not. 
Freeway Pro helps you by using a simple color code to identify items. When the CSS layout button is active, HTML 
item tools are shown with a green border in the Toolbar and Tools palette. HTML items drawn on the page have 
the same green border. Non-layer items are drawn with a blue border. Graphic items are always drawn with a gray 
border, but will show a small green ‘corner mount’ if they are layers, or blue if non-layers.

Setting any item to output as a layer item FW Pro only   
Select the item you wish to make a layer and turn on the Layer 
checkbox in the Item General panel of the Inspector palette. The 
item border changes from blue to green, visible if Outlines is turned 
on in the View menu.  

When the CSS 
Layout button 
is active, HTML 
tools show a 
green border.

The item now shows a green border, 
and further options appear in the 
Inspector palette.
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Setting publishing options for items 
When an item is selected, the Inspector palette displays a number of 
settings for that item, with the basic options shown in the Item General 
panel. There will also be options available in the Item Output panel that 
control how the item outputs when the site is published. 

Item General panel 
The Item General panel controls the position and size of an item, as well 
as its title, fill color, and other attributes.

Item Output panel 
Use the Item Output panel to select an item’s output type as well as 
attributes for the content that is output. 

HTML5 Section Elements FW Pro only  

Freeway supports the following HTML5 section elements: Address, 
Article, Aside, Footer, Header, Nav, Section (as well as the generic div 
element, referred to as HTML).

Users can choose an element type from the Type popup of the Item 
Export panel (when the page level is set to HTML5 or XHTML5). If a 
page is changed from (X)HTML5 to a lower level, HTML5 section items 
are changed to generic HTML items.

You can read more about the different HTML5 Section Elements and 
what they do in the HTML5 Section Elements section on page 44.

Freeway Pro (left); 
Freeway Express (right).

Freeway Pro

Freeway Express
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Combined Graphic Output panel 
When GIF or JPEG items are overlapped and combined, or grouped to 
form a single image on output, the Combined Graphic Output panel 
appears. This panel controls the output options for the resulting graphic. 

Referring to layer items in DHTML or Actions 
When an item is output as a layer item, it is specified using a named, fixed-
position <div> tag. This tag indicates a document division, and the contents 
of this can be treated as a unique object when writing JavaScript to affect the 
document contents. 

You can specify the name of the layer item to be used in the output. To set 
the name of the layer item to something of your choosing, simply select the 
item and type the desired text into the Name field in the Item General panel 
in the Inspector palette. 

If you want several items to be kept together in the same layer, you can insert 
them into an HTML layer item as child items. See Child items on page 43 for 
more information.

Arranging items
It is possible to change the stacking order of items on the page. You can also copy, duplicate, and paste items in a document. 

Cutting, copying, and pasting 
1.	 Select the item(s) to be cut or copied.
2.	 Choose Cut or Copy from the Edit menu to transfer the selected items to the Clipboard. (Cut removes the original from its location, 

while Copy leaves the original in place.) 
3.	 Move to a new page or new document (or select a new parent on the current page) and choose Paste from the Edit menu. Freeway 

then pastes the items into the same relative position in which they appeared in their original parent. 

Option-dragging to duplicate items 
To make a quick copy, begin dragging an item with the Selection tool, then hold down the Alt key and continue to drag until the item 
is in the desired position. You can also use the Alt key to create copies while working with the Mirror, Skew, or Rotate transformation 
tools. Note that you must hold down the Alt key after you have begun dragging. If you press Alt before you drag, the cursor will switch 
to the Grabber hand and adjust the page position within the window. 

If you hold down the Shift key while moving an item, it will be constrained to move horizontally, vertically, or diagonally at 45°. 

You can also drag items from the Site panel to the currently visible page. Doing this will make a copy of the item you drag. See Moving 
an item to another page using the Site panel on page 51 for further information.

Duplicating an item using the Duplicate dialog 
You can duplicate an item to make as many copies as you need, while simultaneously assigning a horizontal and vertical offset to each 
copy. 

1.	 With the box selected, choose Duplicate… from the Item menu. 
2.	 Enter the number of copies you want, as well as the horizontal and vertical offset. 
3.	 Click OK. 

Freeway Pro Freeway Express

Naming items helps 
when using JavaScript to 
give interactive elements 
on your page.
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Aligning items 
You can align selected items along their edges or through their center points: 

1.	 Select the items you want to align. 
2.	 Choose Align… from the Item menu. The Alignment dialog box opens 

with the most recently used alignment options chosen. 
3.	 Click on the relevant horizontal and vertical alignment icons. 
4.	 Click OK. 

Changing the stacking order of items using the Item menu 
Freeway items are “stacked” in a front-to-back order on each page. You can alter the stacking order by bringing items to the front, 
sending them to the back or by sending them one level forward/back in the stack. To do this: 

1.	 Select the item. 
2.	 Choose Send to Back or Bring to Front from the Item menu to send to the very back or front of the stack. 

Choose Bring Forward or Send Backward to move items forward or backward by one step. 

Note: Layer items are always in front of table-positioned items in the stacking order.

Changing the stacking order of items using the Site panel
1.	 Select the item. 
2.	 Ensure that items are visible in the Site panel, either by selecting Show Items in the  popup menu, or by switching to the Page 

view of the Site panel. 
3.	 Drag the selected item up or down in the list to change its stacking order position. The item that is at the top of the stack appears 

lowest in the Site panel. 

Group command
Preventing items from breaking apart
If HTML text in a browser window is enlarged, it can force items around it to move. Let’s say, for example, we have a set of navigation 
buttons, formed of graphic items, spaced neatly down the left hand side of a page. 

Placing an HTML text item on the right looks correct in the Freeway page layout, but when previewed in a browser the buttons become 
separated if the text is enlarged.

To avoid the buttons splitting apart like this, we can select them all and choose Group from the Item menu. This has the effect of 
forcing Freeway to create a whole table cell for the items that have been grouped.

With Show HTML Layout turned on, 
the table structure shows as a series 
of dotted blue lines. In our example, 
you can see the first button will be 
published into a separate table cell to 
the others.

Grouping items
1.	 Select the items you want to group either by Shift-clicking each in turn, or by dragging a 

marquee over them.
2.	 From the Item menu, choose Group.
3.	 The grouped items show a single set of selection handles.
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How grouping works
When a series of items is grouped in Freeway, a new parent item is 
created that contains those items. The selected items become children of 
the parent item. 

You can also create a group by drawing new items within the boundary 
of a larger item. Child items drawn like this are constrained to the parent 
item’s boundary: you can move children around within the parent, but 
they cannot be dragged outside their parent unless you press the space bar 
(which causes the item to be moved into a different parent), or hold down 
the Command key (which allows layer items to be positioned outside 
their parent). 

Another way to create a group is to drag items in the Site panel: 

1.	 Click on the  button at the bottom of the Site panel and choose 
Show Items. 
 
 
 
 
 
 
 
 
 
 

2.	 The Site panel will show a hierarchical list of the items on 
each page. 
 
 
 
 
 
 
 
 
 
 

3.	 In the Site panel, select the item you wish to make into a child.
4.	 Drag the item up and to the right, so that the item you wish 

to become the target parent becomes highlighted. 
 
 
 
 
 
 
 
 
 
 
 
 

5.	 When you release the mouse, the item becomes a child of the 
parent. 

A special crosshair cursor 
indicates that the item 
being drawn will become 
a child of the outer box. 
Note that the parent box 
has a thicker highlight 
border. This acts as 
another visual clue that a 
child item is being drawn.

Power Tip: Clicking an item in the Site panel will highlight 
it in the page layout as if you have selected it with the mouse 
normally. This can be useful when you are trying to select an item 
hidden several layers down in your layout.

Power Tip: Dragging items in the Site panel is a useful 
technique to ungroup an item. Drag the item you want to ungroup 
down and to the left in the Site panel so it is no longer nested 
with its parent.

Note 1: If the dragged item is outside the original parent boundary, the 
parent may stretch to encompass the new child, or the child may be moved 
within the parent’s boundary. This can be a little unpredictable, so it may 
be better to drag the first item over the second in the page layout, then drag 
it in the Site panel to create the group. 

Note 2: Grouping items is an essential part of using the Rollover Action to 
avoid showing a blue outline on rollover images with a link applied when 
viewed in Safari. To prevent this happening, you must select all items which 
make up the rollover, group them and then apply the Rollover Action to the 
group item.



Freeway Reference: Working with Items
60

60

Distributing items 
In the Item menu, the Distribute… option becomes available when you have two or more items selected on the page. This allows you 
to space the selected items in three different ways: 

•	 Space the selected items between the two endmost items in the selection. 

•	 Space the selected items across the page. 

•	 Space the selected items a specific distance apart. 

You can distribute the selected items either vertically or horizontally, using their boundaries, centers, or particular edges. 

When spacing items, you will normally want to keep the distance between each item the same. However, there are occasions where you 
might not want evenly spaced items—you may prefer to space the selected items using their sides or centers. This can be useful when 
items are different sizes but visually are center-heavy, left-heavy, or right-heavy. 

Using Distribute 
1.	 Select the items that you wish to distribute. 
2.	 Choose Distribute… from the Item menu. The Distribute dialog will appear 

showing a preview of how the current options chosen will affect the selected 
items. You can choose from the following options: 

•	 Direction (Horizontal or Vertical). 

•	 Method (Across Items, Across Page, Fixed Distance). 

•	 Distance (in pixels—only available for Fixed Distance method). 

•	 Between (Items, Top/Left Sides, Centers, Bottom/Right Sides). 

3.	 When you are happy with the positions of the items shown in the preview, click 
OK. If the results are not quite right, you can choose the Undo command from 
the Edit menu to return the items to their previous positions and try again. 

Spacing selected items evenly 
To adjust the positions of the selected items so that they are evenly spaced between the two endmost items in the selection, choose 
Across Items from the Method popup menu. Ensure the Between option is set to Items—this is normally the best option. 

Spacing items evenly across the page 
To adjust the positions of the selected items so that they are evenly spaced across the page, choose Across Page from the Method 
popup menu. Ensure the Between option is set to Items. 

Spacing items a fixed distance apart
To space items so that they are a fixed distance apart, choose Fixed Distance from the Method popup menu. Choose one of the 
following from the Between popup: 

•	 Items: Positions items so that the space between the end of one item and the start of the next one is the amount specified in the 
Distance field. 

•	 Left/Top Sides: Positions items so that the space between the left or top of each item (depending on the chosen direction) and its 
neighbor is the amount specified in the Distance field. 

•	 Centers: Positions items so that the space between the center of each item and its neighbor is the amount specified in the Distance 
field. 

•	 Right/Bottom Sides: Positions items so that the space between the right or bottom of each item (depending on the chosen 
direction) and its neighbor is the amount specified in the Distance field. 

Integrating items and text 
Setting an inner inset 
An inner inset creates a space between the edges of the text box and the text it contains. This space may be necessary if the box has 
a border applied or if the text contains “ascenders” (the part of tall lowercase letters, such as b and d, that extends above the other 
lowercase letters) that you want to keep inside the box area. See also Padding and Margins on page 65. 

To set an inner inset: 

1.	 Select the item. 
2.	 Display the Item General panel of the Inspector palette, choose 

a size from the Padding popup menu in the Dimensions panel, or 
enter a figure in the field and press Return. 
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Wrapping text in a graphic box 
You can make text in a graphic box wrap closely around an overlapping 
graphic item using controls in the Item General panel of the Inspector 
palette. 

1.	 Select the overlapping graphic box. 
2.	 Display the Item General panel and Dimensions panel in the 

Inspector palette.  

3.	 Specify the desired value for the gap between the text and the 
overlapping box from the Wrap popup list, or enter a figure in the 
field and press Return. 

Text in items behind the box is placed at the specified distance away from the box. The Wrap value only applies to graphic text behind 
the overlapping item. 

Note: HTML items cannot be forced to wrap by an overlying graphic item. The 
Wrap value only affects graphic text in graphic boxes.

Wrapping text in an HTML box 
Text in an HTML box will wrap above and below any overlapping item other than a map area item. You cannot adjust the offset 
between the HTML text and the item in front of it. You can make text in an HTML box wrap closely around a graphic element by 
positioning it within the HTML text as an inflow item, then selecting it and choosing Left or Right from the Align popup menu in the 
Dimensions panel. For more information see Applying margins on page 66.

Creating horizontal rules 
Horizontal rules can be used to visually separate or organize elements or sections of a page. They can 
also be used to emphasize text or titles, or simply to add to the visual impact of your page. 

To create a rule with the Path tool
1.	 Using the Graphic Path tool, click to position a starting point for the line. 
2.	 Click somewhere else on the page to define the finishing point. Hold down the Shift key before 

positioning the end point to constrain the line horizontally. Click to position the end point and 
then click again, while the cursor displays a closed circle, to end the path. 

3.	 In the Border panel of the Item Appearance panel of the Inspector palette, set the attributes as 
you wish.

Power Tip: Using a graphic path like this allows you to use the range of 
effects described on pages 44.

To create a text rule 
1.	 With the cursor flashing in an HTML or graphic text box, choose 

Rule from the Insert menu.  

2.	 To apply attributes to the rule, select it by placing the text insertion 
point at the end of the previous paragraph, then hold Shift while 
pressing the right cursor arrow once. 

3.	 Using the Rule panel in the Inspector palette, set the desired 
options for Align, Size, Inset, and whether the rule is solid or 
shaded. 

Linking and unlinking text boxes to form a chain 
You can specify the way text flows from box to box by linking 
individual text boxes. Moving a linked text box does not affect the 
text flow, and you can link text boxes either before or after you’ve 
placed text. You can link HTML text boxes, and you can link graphic 
text boxes. You cannot link HTML boxes with graphic text boxes.

A graphic or CSS text box that is too small to show all the text 
displays a small overflow icon in the bottom right-hand corner. Table-
positioned HTML text boxes grow in depth to accommodate the text.

Changing the shape and size of a linked box causes text to reflow 
through the chain. 

When text is too long 
to fit into a graphic text 
box, a small overflow 
icon appears at the 
bottom right-hand corner.
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To link two or more text boxes 

 
 Flow tool

1.	 Select the Flow tool in the Toolbar or Tools palette. 
2.	 Click on the first box and then on each subsequent box in the 

same order that you want text to flow through the text boxes. 

After linking your text boxes, a thick red line joining the text boxes 
will appear, indicating the links between text boxes. An arrow head shows the direction of text flow. Text placed in the first box will 
flow through the linked text boxes until all the text is placed. 

Note: Freeway Express does not have a Tools palette.

Showing text links 
To see how text flows from box to box, select a text box with either the Flow tool or the Break Flow tool. This will show all the links 
for text boxes connected to that box. 

Selecting text across linked text boxes 
There are several ways of selecting text that flows across linked text boxes: 

1.	 With the Selection tool, click anywhere in the text and then choose Select All from the Edit menu. All text in the linked boxes will 
be selected.

2.	 Place the cursor at the start of the selection, then hold down the Shift key and click where you want the selection to end. All the 
text between the two positions will be selected. 

3.	 Click and drag across the text you want to select. 

Unlinking text boxes 

 Break Flow tool

To break the link between two linked text boxes: 

1.	 Select the Break Flow tool.
2.	 Click one of the linked text boxes to display the links. 
3.	 Click on the red line linking the text boxes. 

The box “downstream” (box to which the arrow points) of the 
link is removed from the flow of text. Text reflows into the box 
that was “upstream” of the removed box. If the upstream box is 
an HTML item, it will resize vertically to contain the new text. 
If the upstream box is a graphic item it will display an overflow icon in the lower left corner to show that there is more text in the box 
than can be displayed. 

Adding a text box into an existing chain 
To add a new text box into the chain of text boxes: 

1.	 Draw a new box. 
2.	 Using the Flow tool, click on the box you want to come before the new box in the chain. 
3.	 Click on the box you’ve just drawn. 
4.	 Click on the box that will follow it in the chain. 

Deleting a text box from the text flow 
When you delete a text box from the flow, text reflows into the remaining text boxes. To do this, simply select the box using the 
Selection tool, and delete it. 

Cutting/copying and pasting a linked box 
You can cut or copy a text box from a linked series. Cutting a text box from a linked series is the same as deleting it—the text is not 
removed from the flow but rather reflows into the remaining text boxes. 

Inserting a break to the next linked text box 
You can insert a break to flow the text from where you currently are to the next box in the flow. 
Position the cursor where you would like the break to begin and select Break from the Insert menu 
(or type Command-Enter). 

If the box is not linked to a “downstream” box,  will be displayed in the lower right corner of the 
box in which you inserted the break, and the text after the insertion point will disappear from view. 
You can, however, sketch another box and link to it from the box in which you inserted the break. 
The text will automatically flow into the “downstream” box. 
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Inflow items 
There are two ways of adding items to the page: as independent items or as inflow items. Inflow items are positioned within a flow of 
text and/or other items. Independent items are positioned directly on the page or in another item, independently of any flow.

If you create an item by sketching a box using one of the drawing tools when no text cursor is displayed, the resulting item will be an 
independent item—this means that it can be moved and positioned freely, anywhere on the page. If you draw a box when a text cursor 
is displayed, the resulting item will be drawn in the flow at the point where the text cursor is positioned. Independent and inflow items 
can also be added from the Insert menu.

Inflow items are items that have been inserted into a run of text and are embedded in the text. Inflow items cannot be freely positioned 
anywhere on the page—instead, they flow with the text within the text box. This means that they offer a different range of layout 
possibilities. For example, a graphic which is related to a piece of HTML text can be embedded before or after that text in the same text 
box, so that it moves with its adjacent text if the story reflows—and that allows text to wrap around a graphic (as explained later in this 
section).

Inline items
Some inflow items, such as graphics and form controls, may be inserted within a line of text, and are known as inline items. Other 
types of inflow item, such as HTML boxes, are non-inline items and cannot stand on the same line as text or other items, except when 
floated.

Some relatively complex layouts can be achieved by setting CSS items as inflow items for which there is not sufficient room on a single 
line, rather than free-standing items. The surplus items are forced onto subsequent lines whose spacing is determined by the (variable) 
height of the inflow items involved. In this way, it is possible to force items, such as multi-column footers, down the page when a 
viewer enlarges the text in the items above. This is covered in greater detail in the Appendix at the back of this manual where there is a 
basic tutorial on working with inflow layouts.

Options for graphic and HTML items when used as inflow items
By using CSS items in Freeway Pro you have far more options that you will see in Freeway Express. This is because inflow layouts are 
only possible to build when working in Pro as CSS is not supported in Express. Freeway Express has very limited support for using 
inflow items, but it does allow you to use a graphic item (floated left or right) as a wraparound item within an HTML text item or to 
insert an item inside a table cell.

Graphic items have far less options than HTML items, and that is because only HTML items can be controlled by particular settings 
(such as Height and Width options) so they can be made to work well in inflow layouts.

Creating inflow items 
Items can be inserted into a stream of HTML text by drawing them 
when a text cursor is displayed, or by using the commands on the 
Insert menu or by pasting a suitable item from the clipboard: 

1.	 Click inside an HTML item or a table cell to create a text 
insertion point. 

2.	 Draw an item using one of the box-drawing tools, or choose an 
item to insert from the Insert menu, or choose Paste from the 
Edit menu (after previously copying an item to the clipboard).

The item is inserted into the HTML text. 

Making text wrap 
around an inflow item 
You will see that an inflow item 
will be placed inside the HTML 
item so it is aligned to the baseline 
of the text where the flashing text 
cursor was when the item was 
inserted. If you want the text to 
wrap around the graphic that can 
only be done by using either Float 
Left or Float Right in the Align 
popup in the General Settings tab 
of the Inspector. In the screenshot 
on the right you can see how the 
text reflows when Float Right is 
chosen.
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Inserting items using the Insert menu 
You can use the Insert menu instead of a drawing tool to create a new item. When you create an item in this way, it will insert the item 
as an inflow item in the text but only if a text insertion point is flashing in the text before you create the item. If the insertion point is 
not flashing, the item will appear in the center of the page view in the document window as an independent item. 

Note: When the current page is a frameset page, the Insert menu 
commands will only be available when working on a source page which is 
being viewed through the frameset.

The items that can be placed inside an HTML item as an inflow or inline item using the Insert menu are: 

•	 HTML Items 

•	 Graphic Items 

•	 Action Items 

•	 Form controls (Checkbox, Radio Button, Menu/List, Text Field, and Text Area) 

•	 Tables 

•	 Markup items

Selecting inflow items 
To select an inflow item, click on it using the Selection tool. If the text insertion point is already flashing in the box that contains 
the inflow item, Command-click on the item twice, or click on an empty part of the page or pasteboard to deselect everything before 
selecting the inflow item. 

Another way to select inflow items is by using arrow keys when there is a text selection—inflow items become selected when you move 
the text cursor to the point where they are inserted.

Resizing inflow items 
To resize an inflow item, select it so that its handles are showing and then either drag the handles to resize it, or use the Dimensions 
panel of the Inspector palette to change the numeric values for width and height. 

Aligning text beside inflow items 
When inflow items are inserted into a line of text (as inline items), you 
can control the position of the inline item relative to the surrounding 
text. Inflow items (including non-inline items such as HTML boxes) can 
also be floated left or right within a text flow.

Simply select the inflow item and then choose an alignment option 
from the Align popup menu. The available alignments are: 

•	 Top: The top of the inline item is aligned 
with the top of the tallest element on the 
same line.

•	 Text Top: The top of the inline 
item is aligned with the top of 
adjacent text. 

•	 Super: Aligns the inline item as a  
superscript to adjacent text. 

•	 Middle: The vertical middle of the inline item is aligned with the middle of 
adjacent text.  

•	 Baseline: The bottom of the inline item is aligned with the bottom of the 
inline item.  

•	 Sub: Aligns the inline item as a subscript to adjacent text. 

•	 Text Bottom: The bottom of the inline item is aligned with the bottom of 
adjacent text.  

•	 Bottom: The bottom of the inline item is aligned with the lowest element on 
the same line.

Freeway Pro Freeway Express
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Inflow items (including non-inline items such as HTML boxes) can also be floated left or right within a text flow. 

•	 Left: The inflow item sits flush left in the column and adjacent text wraps  
beside it.  
 
 
 

•	 Right: The inflow item sits flush right in the column and adjacent text wraps 
beside it.  
 
 

Certain HTML items (including form items and some Action items) do not have alignment options. 

Controlling space around inflow items 
When inflow items are adjacent to text, the offset between the text and the edge of the inflow item can be controlled using the Margin 
setting in the Inspector palette’s Dimensions panel. By default, adjacent 
text fits snugly against an inflow item. 

To change the space around an inflow item: 

1.	 Select the inflow item. 
2.	 Enter a new value in the Margin field in the Inspector palette and 

press Return, or choose a preset value from the Margin popup list.

Freeway Pro allows you to set custom margin values for each side of the 
inflow item. Choose Custom… from the Margin popup list, and enter the desired 
margin values in the Margins dialog box. This feature is not available in Freeway 
Express. 
 
 

Padding and margins
Padding and margins are commonly used to space out elements in your layout. Padding provides a method to inset an item’s content 
from its edge, while margins allow you to insert extra space between an inflow item and the other content that surrounds it.

Applying padding
Padding can be applied to any item that can contain content. Applying padding is straightforward—just 
select the item, and choose a value from the Padding popup menu on the Item General panel of the 
Inspector palette, or alternatively enter a value in the Padding field next to it. If you now click inside 
the HTML item to enter text, you will see an internal border that gives visual feedback of the padding 
that you have set:

Freeway Pro also provides a Custom… option in the Padding popup—by selecting this you will be 
presented with a dialog that allows you to specify different padding values for each of the four sides of an item.

Padding and item dimensions FW Pro only  

The dimensions seen in the Inspector palette are affected by applying padding to an item. Suppose we have an item that is 300 pixels 
wide and 300 pixels high:

and now we apply a 20 pixel padding to the item:
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If you look at the Width and Height fields, you will see that they are now both set to 260 pixels. Why have these values been changed 
by applying padding? The answer lies in the way that CSS calculates the size of a box: padding is added to a box’s dimensions, so that 
a 300x300 box with 20 pixels padding will be 340x340 pixels when it is viewed in a browser. Freeway compensates for this by reducing 
the size of the item to account for the padding. Overall, your item remains the same size as you designed it to be.

Of course, it is entirely possible that you don’t want to perform a mental calculation every time you want to work out how large your 
item will appear on screen when you publish your site. To make life easier, Freeway also includes a Screen Measurements section in 
the Inspector palette. This will display the size and position of your item taking into account any padding that has been applied; for 
the example above it displays as follows:

As you can see, the dimensions are the correct screen values for when the item is viewed in a browser. Just for completeness, the 
equations are:

Screen Measurements Width �= Item Left Padding  
+ Item Width  
+ Item Right Padding

Screen Measurements Height �= Item Top Padding  
+ Item Height  
+ Item Bottom Padding

Padding and item positions FW Pro only  

Padding also affects the position of child items. Just as text is inset when you apply padding, child items (with the exception of layer 
items) are inset when padding is applied to their parent. Layer items are not affected because CSS positions them relative to the bounds 
of their parent, irrespective of padding.

In situations where a child’s position is affected by padding, the child’s position is calculated relative to the inside of the padding (i.e. 
the inner border that is shown when you are entering text into an item with padding applied).

So, for example, if we draw a non-layer HTML item and then draw a child non-layer HTML item within it with the following position/
dimension settings (see screenshot below left) and then apply a 20 pixel padding to the parent item, the child item will change 
position—unsurprisingly it moves 20 pixels right and 20 pixels down.

However, if we look at the Dimensions section in the Inspector palette (see screenshot below (right), the Left and Top values remain at 
50 pixels. Once again, the Screen Measurements section saves any mental arithmetic by displaying the offset of the item as it will be seen 
in a browser

Applying margins
Margins can only be applied to inflow items—they are meaningless anywhere else because absolutely positioned items have no 
surrounding context to space themselves from.

Applying margins to a child item is straightforward—in many ways identical to applying padding. Select your child item, switch to the Item 
General panel of the Inspector palette, and either enter a value into the Margin field, or select a value from the popup. Once applied, you 
will see a dotted border outside the item giving visual feedback on the margins you have set:
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Freeway Pro also provides a Custom… option in the Margin popup—this allows you to specify different margin settings for each side of 
the item.

Background colors
Graphic and HTML items can have a background color, or fill, applied 
to them. (See also Working with color on page 144.)

To apply a colored fill to an item, select it and show the Item General 
panel in the Inspector palette. Click on the Color popup menu to 
choose a color from those available in your Freeway document. Choose 
Other… from the popup menu to choose a new color.

In Freeway Pro background colors can also be applied to HTML and 
graphic items using the Styles & Colors palette. Background colors 
applied to graphic items can also be made transparent to create special 
effects when overlaid on other graphic items on the page. This feature 
is accessible through the Item Appearance panel or the Styles & 
Colors palette.

Note: Freeway Express does not have a Styles & Colors palette.

Applying a background color to an HTML item
There are three ways you can apply background colors to HTML items:

•	 Select the item and choose a color from the Color popup menu in the Item General panel of the Inspector palette.  

Freeway Pro (left); 
Freeway Express (right).

Freeway Pro (left);  
Freeway Express (right).
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•	 Select the item and choose a color from the Color popup menu in the Item Appearance panel of the Inspector palette.  

•	 In Freeway Pro, you can also apply background colors to HTML items using the Styles & Colors palette.  

Freeway Pro
Freeway Express

Applying opacity to a background color on an HTML item (Pro only)
Freeway Pro lets you adjust the opacity of a background color used on an HTML item by using the Opacity slider in the Item 
Appearance panel of the Inspector palette (see screenshot left) or the Opacity slider at the foot of the Styles & Colors palette (see 

screenshot above).

Applying a background color to a graphic item
There are three ways you can apply background colors to graphic 
items:

•	 Select the item and choose a color from the Color popup menu in 
the Item General panel of the Inspector palette, as outlined in 
the section on HTML items earlier. 

•	 Select the item and choose a color from the Color popup menu in 
the Item Appearance panel of the Inspector palette. 

•	 In Freeway Pro, you can also apply background colors to graphic 
items using the Styles & Colors palette, as outlined in the section 
on HTML items earlier. 

Applying opacity to a background color on a graphic item
You can adjust the opacity of a background color used on a graphic item by using the Opacity slider in the Item Appearance panel of 

the Inspector palette (see screenshot above) or the Opacity slider at the foot of the Styles & Colors palette.

Background color filters FW Pro only  

There are three special effect filters that can be applied to a graphic item background color.

1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Click on the Background disclosure triangle to show the options available.
3.	 Choose Emboss, Blur, or Scatter from the Filter popup menu.

Freeway Pro. Freeway Express. 



Freeway Reference: Working with Items
69

69

The options for graphic item background filters are as follows:

Emboss

Angle / Altitude: Control the angle and height of the “light source” that 
generates the emboss effect. Changes can be made by clicking and dragging 
the control button, or entering numbers in the text fields. 

Global: This checkbox, selected by default, ensures that the angle and height 
information is used across all similar settings on the current page, e.g. 
embossing graphic text, adding a drop shadow effect, etc.

Specular: Controls the percentage of specular highlight. Higher values make 
the object look smooth and shiny. 

Diffuse: Specifies the percentage of diffuse lighting. Higher values make the 
object look rough or matte.  
 
 
 

Blur

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very 
blurred).  
 
 
 
 
 
 

Scatter

Scatter: The slider controls the amount of scatter, from 0 (no scatter) to 20 
(very scattered).

Background images FW Pro only  

In Freeway Pro, you can apply background images to HTML items. These may be in any graphic format that Freeway can read. Images that 
are in a web format (GIF, JPEG, or PNG), are exported unchanged in their original format (as pass-through images), unless they are sliced 
(see below). Other images are converted to an appropriate web format.

A new feature introduced in Freeway 6 is the High Resolution option which you can choose to use so that images look sharp on Retina 
screens and other high resolution computer screens. See Using a background image in high resolution (below).

Note: Freeway Express does not allow you to apply background images to items. 

Applying a background image to an HTML item
1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 From the Image popup menu, choose Select… and then locate the image you want as the background. 
3.	 Click Open. Freeway applies the image to the item as a tiled background. To remove a background image, choose None from the 

Image popup menu. 

Note: Internet Explorer 6 is unable to display transparency in background images. 

Using a background image in high resolution
1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 From the Image popup menu, choose Select… and then locate the image you want as the background. 
3.	 Click Open. Freeway applies the image to the item as a tiled background.
4.	 Check the High-resolution option.
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As soon as you check the High-resolution option you will see the image reduce in size by 50%. The reason for this is because the option 
uses a method called “@2x” which Apple recommends to make images display in high quality on Retina displays—and this requires the 
graphic to be output at 50% of its original physical size. Freeway will show you the graphic at 50% of its original size in the live preview 
on your page, so you can see how it will look on output even before previewing the page.

You can read further information on using high resolution 
graphics with Freeway in the article on the Softpress 
KnowledgeBase at http://www.softpress.com/kb/questions/447/.

Tiling a background image
Once a background image has been added to an item, the Inspector palette shows options you can use to control how the image is 
displayed. Both Horizontal and Vertical default to Tile, which will tile the selected image in both directions.

The options for Horizontal are:

•	 Tile is the default setting

•	 Left places the background image on the left side of the item

•	 Center places the image in the center of the item

•	 Right places the image on the right side of the item

The options for Vertical are:

•	 Tile is the default setting

•	 Top places the image at the top of the item

•	 Center places the image in the center of the item

•	 Bottom places the image at the bottom of the item

Sliced background images
Freeway can slice background images so that they can be used to apply a border or effect to an item. You will normally want to use an 
image that has a framed border and a uniform central area, which may be transparent or semi-transparent.

To create a sliced background image:

1.	 Apply a suitable background image to an HTML item. 
2.	 Select the Slice Image checkbox. 

There are no tiling options for sliced background images—the central slice of the image is tiled automatically.

When you resize an item with a sliced background, the background resizes automatically. This also happens when the item is viewed in 
a browser.

The content area of an item that has a sliced background is limited to the central slice—it cannot overlap the borders of the sliced 
background. Freeway displays the content area of a selected item as a green or blue dotted line within the item. (The color depends on 
whether the item is a CSS or table-positioned item.) You can also inset the content area to a greater extent by applying padding to the 
item.

The way in which a sliced background is output depends on the type of item, and the level of IE compatibility that is applied to the 
page on which the item sits:

•	 Table-positioned items are output using a table to hold the 
background slices. 

•	 CSS items are output using CSS-positioned divs to hold the 
slices if IE Compatibility is set to IE7 or None.

•	 CSS items are output using a table to hold the slices if IE 
Compatibility is set to IE6/IE7.

Borders in Freeway Pro
You can apply a variety of borders to both HTML and graphic items in Freeway Pro and Express. 
Freeway Express is covered on page 73.

Applying a border to an HTML item 
1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Select the Border checkbox. 

This will set a default 1px black border around the HTML item. To change the color, click on 
the black color swatch on the right side of the Inspector palette and choose from the menu.

Note: Freeway Express does not allow you to use high resolution background 
images. 

Note 1: Background images are automatically sliced if a graphic effect is 
applied to an HTML box. 

Note 2:  Internet Explorer 6 has a number of deficiencies in its support for 
CSS positioning, and is unable to display CSS-positioned slices correctly. If 
you do not need to support this browser, you can set the compatibility level 
to IE7 or None for non-table-positioned background slicing.
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Click on the disclosure triangle in the Border section to reveal more 
options.

The options for HTML borders are as follows:

Color: The Color menu lets you choose a border color from the colors 
in your Freeway document. Choosing Other… from the popup 
menu allows you to create a new color.

Style: Gives a choice of 8 dash styles. The default is a solid line.

Size: Pick a border width from the preset list, or enter a figure in the text 
field and press Return.

Custom: Clicking this button opens the Custom Border dialog where 
different border settings can be applied to the four sides of the 
selected item.

Applying a border to a graphic item 
1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Select the Border checkbox. 

This will set a default 1px black border around the graphic item. To change the color, click on the 
black color swatch on the right side of the Inspector palette, as described in the HTML item section 
described earlier.

Click on the disclosure triangle in the Border section to reveal more 
options.

The options for graphic item borders are as follows:

Color: The Color menu lets you choose a border color from the colors 
in your Freeway document. Choosing Other… from the popup menu 
allows you to create a new color.

Opacity: Drag the slider to set the opacity of the border, or enter a 
percentage in the field and press Return.

Size: Pick a border width from the preset list, or enter a figure in the 
text field and press Return.

Dash: Gives a choice of 10 dash styles. The default is a solid line. Choosing the 
Custom… option allows you to create new dash patterns.
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Position: Sets the border on the Outside, Center (half outside, half 
inside) and Inside the item.

Filter: Provides options to Emboss, Blur, or Scatter the border.

Graphic border filters 
Graphic border filters work best with border thicknesses of 5px or higher.

Border: Emboss

Angle / Altitude: Control the angle and height of the “light source” that 
generates the emboss effect. Changes can be made by clicking and 
dragging the control button, or entering numbers in the text fields. 

Global: This checkbox, selected by default, ensures that the angle and 
height information is used across all similar settings on the current 
page, e.g. embossing graphic text, adding a drop shadow effect, etc.

Specular: Controls the percentage of specular highlight. Higher values 
make the object look smooth and shiny. 

Diffuse: Specifies the percentage of diffuse lighting. Higher values make 
the object look rough or matte. 

Border: Blur

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very 
blurred). 

Border: Scatter

Radius: The slider controls the amount of scatter, from 0 (no scatter) to 20 
(very scattered).

Power Tip: The Shape Effects and border Filters can be combined to 
give an almost infinite variety of borders. It pays to experiment with all 
the settings to see what happens. To clear any of the settings, choose None 
from the Effect or Filter popup menu.
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Borders in Freeway Express
Applying a border to an HTML item
1.	 Select the item and choose the Item Appearance panel from the Inspector palette.  

 
 
 
 
 

2.	 Select the Border button. 

This will set a default 1px black border around the HTML item. To change the color, and other attributes, 
click on the disclosure triangle to reveal more options.

 
 

The options for HTML borders are as follows:

Color: The Color menu lets you choose a border color from the colors in your Freeway document. Choosing Other… from the popup menu 
allows you to pick a new color.

Style: Gives a choice of 8 dash styles. The default is a solid line.

Size: Pick a border width from the preset list, or enter a figure in the text field and press Return.

Applying a border to a graphic item
1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Select the Border button. 

This will set a default 1px black border around the graphic item. 

Click on the Border disclosure triangle to reveal more options.

The options for graphic borders are as follows:

Color: The Color menu lets you choose a border color from the colors in your Freeway document. Choosing Other… from the popup 
menu allows you to pick a new color.

Opacity: Drag the slider to set the opacity of the border, or enter a percentage in the field and press Return.

Size: Pick a border width from the preset list, or enter a figure in the text field and press Return.

Dash: Gives a choice of 10 dash styles. The default is a solid line. 

Position: Sets the border on the Outside, Center (half outside, half inside) and Inside the item.
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Graphic effects in Freeway Pro
(For graphic effects in Freeway Express, see page 76.) 

Graphic effects can be applied to HTML or graphic items.

Applying graphic effects to HTML items
Graphic effects which are applied to HTML items are output as sliced background images. You can choose a background image in 
addition to a graphic effect—in this case the background image will be composited with the effect and sliced.

To apply a graphic effect to an HTML item:

1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Choose a graphic effect from the Graphic Effects section. 

There are six effects to choose from: Background, Border, Outer Shadow, Inner Shadow, Outer Glow, and Inner Glow.

You can also create effects with rounded corners by setting the Corner radius. If you set a large value, border slices will be 
correspondingly large and you will have a restricted amount of space for adding content.

You can remove a graphic effect by clicking a second time on the effect icon to deselect it, or by clicking on the far right of the section 
header for that effect (Freeway displays a minus icon under the mouse when you move it to this point). It is also possible to disable an 
effect without removing it: to do this, hold down the Alt key when you move the mouse to the right of the section header. Disabled 
effects are indicated by an eye with a red line through it—click on this a second time to re-enable the effect.

Note: if you wish to set a background color on an HTML item that has a graphic effect, 
you should normally use the Background effect (in the Graphic Effect section) to do 
this. It is also possible to set a background color in the Background section of the Item 
Appearance panel—but this will color the entire background of the item (including 
transparent areas). This also applies to borders: you should normally use the Border effect 
(in the Graphic Effect section) rather than the HTML Border option to apply a border to 
an item that has other graphic effects.

 
Applying graphic effects to graphic items
To apply an effect to a graphic item:

1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Choose an effect from the Effects section. 

There are five effects to choose from: Outer Shadow, Inner Shadow, Outer Glow, Inner Glow, and Foreground.

You can remove a graphic effect by clicking a second time on the effect icon to deselect it, or by clicking on the far right of the section 
header for that effect (Freeway displays a minus icon under the mouse when you move it to this point). It is also possible to disable an 
effect without removing it: to do this, hold down the Alt key when you move the mouse to the right of the section header. Disabled 
effects are indicated by an eye with a red line through it—click on this a second time to re-enable the effect.

Background effect (HTML items)
The Background effect allows you to set a graphic background on HTML items. In contrast to HTML backgrounds (which are set in 
the Background section of the Item Appearance panel), graphic backgrounds can be semi-transparent, and can also have rounded 
corners.

Color: This popup menu lets you choose an existing color for the background effect, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the background. The default setting is 100%, and the range is from 0% 
(completely transparent) to 100% (completely opaque).

Border effect (HTML items)
The Border effect allows you to set a graphic border on HTML items. In contrast to HTML borders (which are set in the Border section 
of the Item Appearance panel), graphic borders can be semi-transparent, and can also have rounded corners.

Color: This popup menu lets you choose an existing color for the border effect, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the border. The default setting is 100%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Size: Pick a border width from the preset list, or enter a figure in the text field and press Return.

Outer Shadow and Inner Shadow effects
The Outer Shadow and Inner Shadow effects allow you to apply an inner or outer shadow to HTML or graphic items.

Color: This popup menu lets you choose an existing color for the shadow effect, or choose a new color if required. The default shadow color 
is Black.

Opacity: The Opacity slider sets the transparency level of the shadow. The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Angle: Control the angle of the “light source” that generates the shadow effect. Changes can be made by clicking and dragging the control 
button, or entering numbers in the text field. 
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Global: This checkbox, selected by default, ensures that the angle and 
height information is used across all similar settings on the current 
page, e.g. embossing graphic text, etc.

Offset: The slider controls the amount the shadow is offset from the item, 
from 0px to 40px. 

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very 
blurred). 

Outer Glow and Inner Glow effects
The Outer Glow and Inner Glow effects allow you to apply an inner or outer 
glow to HTML or graphic items.

Color: This popup menu lets you choose an existing color for the glow effect, 
or choose a new color if required. The default glow color is Red. 

Opacity: This slider sets the transparency level of the glow. The default 
setting is 75%, and the range is from 0% (completely transparent) to 
100% (completely opaque).

Spread: The slider controls the amount the glow is spread from the item, from 
0 (default) to 10. 

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very 
blurred). 

Foreground effect (graphic items)
The Foreground effect allows a graphic item, such as a box containing a background color or an imported image (see screenshot below 
left), to influence the color of graphic text that is behind it (see screenshot below right).

Color: This popup menu lets you choose an existing color for the foreground effect, or choose a new color if required. The default 
foreground color is Blue. 

Opacity: This slider sets the transparency level of the foreground color. The default setting is 100% (opaque).

Power Tip: Don’t forget that all effects and filters can be freely combined in Freeway Pro. It will 
pay you to experiment with the various settings to see what effects you can create.
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Graphic effects in Freeway Express
Graphic effects can be applied to HTML or graphic items.

Applying graphic effects to HTML items
To apply a graphic effect to an HTML item:

1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Choose a graphic effect from the Effects area. 

There are six effects (and combinations of effects) to choose from: Background, Background with Shadow, Background with Glow, 
Border, Border with Shadow, and Border with Glow.

You can also create effects with rounded corners by setting the Corner radius.

Note: if you wish to set a background color on an HTML item that has a graphic effect, you should 
normally use the color popup in the Background section. It is also possible to set a background 
color using the Color popup at the top of the Item Appearance panel—but this will color the 
entire background of the item (including transparent areas).

Applying graphic effects to graphic items
To apply an effect to a graphic item:

1.	 Select the item and choose the Item Appearance panel from the Inspector palette. 
2.	 Choose a graphic effect from the Effects area. 

There are four effects that can be selected in various combinations: Shadow, Glow, Emboss, and Scatter.

Background effect (HTML items)
The Background effect allows you to set a graphic background on HTML items. In contrast to HTML backgrounds, graphic backgrounds 
can be semi-transparent, and can also have rounded corners.

Color: This popup menu lets you choose an existing color for the background effect, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the background. The default setting is 100%, and the range is from 0% 
(completely transparent) to 100% (completely opaque).

Border effect (HTML items)
The Border effect allows you to set a graphic border on HTML items. In contrast to HTML borders (which are set in the Border section 
of the Item Appearance panel), graphic borders can be semi-transparent, and can also have rounded corners.

Color: This popup menu lets you choose an existing color for the border effect, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the border. The default setting is 100%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Size: Pick a border width from the preset list, or enter a figure in the text field and press Return.

Shadow effect
Color: This popup menu lets you choose an existing color for the shadow 

effect, or choose a new color if required. The default shadow color is 
Black.

Opacity: The Opacity slider sets the transparency level of the shadow. 
The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Offset: The slider controls the amount the shadow is offset from the item, 
from 0px to 40px. 
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Glow effect
Color: This popup menu lets you choose an existing color for the glow 

effect, or choose a new color if required. The default glow color is 
Red.

Opacity: The Opacity slider sets the transparency level of the glow. 
The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 
(very blurred).

Emboss effect
Specular: Controls the percentage of specular highlight. Higher 

values make the object look smooth and shiny. 

Diffuse: Specifies the percentage of diffuse lighting. Higher values 
make the object look rough or matte.

Scatter effect
Radius: The slider controls the amount of scatter, from 0 (no scatter) to 

20 (very scattered).

Lighting
Angle / Altitude: Control the angle and height of the “light source” 

that generates the shadow and emboss effects. Changes can be 
made by clicking and dragging the control button, or entering 
numbers in the text fields. Note that any changes that are made to 
lighting are global—they affect all items on the current page that 
have a shadow or emboss effect.

Note: Borders in Freeway Express are covered on page 73.
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Shape effects
Shape effects can be applied to graphic items. They modify the basic shape of an item by adding a crack or wobble.

Wobble

Freeway Pro. 

Freeway Express. 

Period: The distance between each peak or trough, from 0px to 100px.

Random: Increases the randomness of the wobble.

Deviation: Causes the wobbles to vary by the entered amount, from 0px to 100px.

Smooth: Varies the smoothness of the wobble, from 0% (sharp) to 100% (smooth).

It is possible to create 
an almost hand-drawn 
appearance using the 
Wobble shape effect.

Freeway Pro. 

Freeway Express. 
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Crack

Freeway Pro. 

Freeway Express. 

Period: The distance between each crack, from 0px to 100px.

Random: Makes the cracks appear at random depths.

Gap: Varies the gap between cracks, from 0px to 100px.

Depth: Varies the depth of the cracks, to a maximum of 100px.

The Crack shape 
effect can be 
adjusted for a wide 
variety of effects.

Freeway Pro. 

Freeway Express. 



When working with text, Freeway Pro offers three basic choices: standard HTML text, HTML text using Cascading Style Sheets (CSS), or 
graphic text. Freeway Express offers a simpler choice between HTML text and graphic text.

Note: Freeway Express publishes HTML5. Only Freeway Pro supports full 
CSS text control and custom styles.

The only way to make sure that viewers see text exactly as you intend is by exporting it as a graphic, usually in the GIF format, but this 
has serious drawbacks. Viewers cannot search graphic text, nor can they copy and paste it into documents as editable text. It increases 
file sizes and is generally slower to download. Furthermore, viewers with special needs, such as those with visual impairments, may 
not be able to access your text, while other viewers who may prefer text of a different size or font cannot alter its appearance in their 
browsers. Finally, search engines cannot read graphic text, which can affect your site’s ranking. In short, graphic text lacks many of 
the advantages of the versatility and accessibility of HTML text. (See  http://www.w3.org/WAI/ for a discussion and guidelines about 
accessibility for the internet.) 

HTML text has the following advantages over GIF text: 

•	 It can be searched in browsers. 

•	 It is fast to download and can be displayed quickly in browsers. 

•	 It can be copied and pasted as editable text. 

•	 It may be accessible to users with special needs. 

•	 It can be resized in the browser (unless a fixed pixel size is specified in CSS text). 

•	 It is used by search engines to evaluate a page’s content and relevance. 

As a result, many designers use HTML text for the majority of a page’s content, reserving graphic text for distinctive layout elements 
such as headings, logos, and navigation bars. 

This section explains how to work with text in a Freeway document. You can type in text yourself or import existing text from another 
source. Once you have text in your document, you can: 

•	 Copy and paste it. 

•	 Edit, correct and modify it. 

•	 Search for and replace text strings. 

•	 Check the spelling. 

•	 Apply attributes and change styles. 

For information on basic styling of HTML and graphic text in Freeway, see Styling text on page 152.

Adding text 
There are several ways to add text to a Freeway document. You can import text saved as plain text or as styled text in Rich Text Format 
(RTF). Freeway does not currently import text files in other text formats. 

To add text: 
•	 Type in the new text directly. 

•	 Import a text file previously prepared in another application. 

•	 Paste in text that has been copied to the clipboard from another Freeway document or another application.

•	 Drag text from another application that supports Drag and Drop. 

Typing in new text 
To type new text directly into an HTML or graphic box: 

1.	 Using the Selection tool, click on the box to select it (if it is not already selected). 
2.	 Click inside the box to position the cursor. A flashing vertical bar appears at the insertion point. 

The text cursor is used to place 
text in HTML or graphic item 
boxes. In an empty box, the 
flashing insertion point appears 
at the top left corner.

Working with Text
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3.	 If there is already text in the box, you can move the insertion point to another position, either using the arrow keys or by clicking at 
the new position. 

4.	 Begin typing. To start a new paragraph, press Return. 

The style of the new text depends on where you started. If you started typing inside an existing run of text, the new text will have the 
same style as the rest of the run. If no style has been assigned, the new text appears in the default style. 

Note: Freeway Express does not support the saving of custom styles.

Importing a text file using the Import Text command 
To import a text file prepared using a word processor or some other application and saved in text only format, styled text, or Rich Text Format 
(RTF): 

1.	 Using the Selection tool, click on the box to select it (if it is not already selected). 
2.	 Click inside the box to position the cursor where you want the imported text to appear. 
3.	 Choose Import Text… from the File menu. The Import dialog displays all the available text files. 
4.	 Find and select the name of the file you want. 
5.	 Click Open. 

The text is imported into the selected box. The new text will take on the style of the surrounding text, if it doesn’t already have a style. 

Importing text using drag and drop from the Finder 
1.	 In the Finder, locate the text file you want to import. 
2.	 Drag the file onto the Freeway document window. The text is imported at the pointer position. 

A text file can be dragged into a previously drawn box, or straight onto the page. Dragging straight onto the page will make Freeway create 
a box to contain the text. In either case, the box will become large enough to contain all the text, and may cause the page depth to grow 
to accommodate it.

Importing text using drag and drop from another application 
1.	 Open the document window of the application containing the text you wish to be dragged into Freeway. 
2.	 Position/resize the window so you can see the Freeway page into which you want to drag the text. 
3.	 Highlight the text you wish to drag. 
4.	 Drag the text into Freeway. 

As with dragging and dropping text files from the Finder, you can drag text over an existing box or straight onto the Freeway page.

Pasting text via the clipboard 
1.	 Open the document containing the text you want to insert. 
2.	 Select the text and choose Copy from the Edit menu to copy it to the clipboard. 
3.	 Place the cursor at the insertion point in your chosen Freeway document and choose Paste from the Edit menu.

Choose Paste And Match Style from the Edit menu if you wish the pasted text to adopt the style of surrounding text in Freeway.

Choose Paste Markup from the Edit menu if you wish to paste HTML markup into Freeway.

When text doesn’t fit in a box 
If text is too large for the box that contains it (either because you’re 
working with a large text size or because there are more words than 
will fit), what happens next depends partly on whether the box is 
an HTML item (displayed with a blue or green outline in Freeway) 
or a graphic item (displayed with a gray outline in Freeway). 

Text in a graphic item will overflow, and the overflow icon (a small 
square with a diagonal cross) will be displayed in the bottom right 
hand corner. 

A small square with diagonal 
cross in the bottom right 
corner indicates text overflow 
in a graphic item text box.
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Text in a table-positioned HTML item (with a blue outline) will not overflow. Instead, the item will grow vertically to display all the text 
it contains. If necessary, the page height will also increase to accommodate the new height of the item.

Text in a CSS-positioned HTML item (with a green outline) will overflow unless the item has undefined 
height. You can choose whether the overflowed text should be visible outside its box, or whether it 
should be hidden, or whether a scroll bar should be displayed. Generally, CSS boxes which contain 
text should be set to have undefined height, so that the text does not overflow. To do this, deselect the 
height button in the Dimensions section of the Inspector palette.

HTML items that have grown because of text overflow can also shrink vertically if the amount of room 
required by the text changes. 

You can resize a text box to fit its content by choosing Fit Box to Content from the Item menu.

You can cause the text to “flow” into a second box by linking boxes in a chain before or after importing 
text. For details on how to link text boxes in a chain, see Linking and unlinking text boxes to form a chain on page 61. 

Editing text 
In order to use Freeway’s text editing options, you must first select some text. Click twice on a box using the selection tool to begin 
editing text. 

Highlighting text using the Selection tool 
Use the following techniques to select text: 

•	 Drag the cursor with the mouse button down over a run of text to select it. 

•	 Place the cursor over a word and double click to select it. 

•	 Place the cursor in a box and press Command-a to select all the text in a “story” (the text in either a box or a flowed series of boxes). 

Clicking repeatedly on some text with the selection tool will highlight different ranges of text depending how many times you click: 

•	 Double-click to select a word. 

•	 Click three times to select the line. 

•	 Click four times to select the paragraph. 

•	 Click five times to select the entire story (list block if you’re editing a list). 

You can also use keyboard shortcuts to select text—for more information on Freeway keyboard shortcuts, see the Appendix on page 243. 

Moving text 
To move text, cut it to the clipboard and paste it in at a new position. With this method you can move text from one place to another 
within a story, from one story to another, or from one document to another. 

Use Paste and Match Style if you wish the pasted text to take on the style of the surrounding text. 

Note: Freeway does not support drag and drop text editing.

Searching for and replacing text 
You can find or replace instances of words, combinations of words, and characters in selected text, stories, or documents. Searching will 
include graphic and HTML text in your document.

Finding a text string
To search for a text string in Freeway: 

1.	 Choose Find… from the Find/Replace submenu in the Edit menu. 
2.	 Freeway displays the Find dialog box. 
3.	 Enter the text you want to search for. 
4.	 Choose which part of the document to search from the following options in 

the Range popup menu: 

Document: Searches within all stories in a document. 

Page: Searches within all stories on the current page. 

Story: Searches within the story where the cursor is placed (this option is 
disabled if nothing is selected). 

Item: Searches the box containing the cursor (this option is disabled if nothing is selected). 

5.	 Choose from the following options: 

Backwards: Searches the run of text backwards from the cursor position. 

Wrap Around: Searches to the end of the specified range (or the beginning, if Backwards is checked), then continues from the start 
(or end) of the text, returning to the cursor position. If Wrap Around is unchecked, Freeway searches to the end of the specified 
range. 

Ignore Case: Finds characters typed in either upper- or lowercase. 
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Words Only: Matches text to whole words and does not locate specified text within words. For example, use Words Only to locate 
the word “one” but ignore the word “done”. 

Keep Dialog Open: Leaves the dialog box open after the search is completed. In this mode, when Freeway has searched to the end 
of the document or selection, a warning dialog is displayed. 

6.	 Click Find. 

Finding a selection 
Highlight the text you need to find and choose Find Selection from the Find/Replace submenu in the Edit menu. Freeway will then 
find the next instance of the selected text. Note that the Find Next command finds subsequent instances of the selected text. 

Replacing a text string or selection 
You can search for a text string (or occurrences of a highlighted selection) and then replace it with another string: 

1.	 Choose Replace… from the Find/Replace submenu in the Edit menu. The 
Replace dialog box appears. 

2.	 Choose the Range you want to search from the popup menu. 
3.	 Enter the text you want to replace in the Find text field. 
4.	 Enter the replacement text in the Replace with text field. 
5.	 Choose from the other available options. These are the same as the options 

described for Find earlier in this section. 
6.	 Click Replace to replace the next instance and then stop. Click Replace All 

to search the story, item, page, or document and automatically replace all the 
instances of the specified text.

Note: You can undo a Replace operation but not a Replace All.

Freeway then finds and replaces the text. If Keep Dialog Open is selected, 
the dialog box remains open for you to use again. If you have closed the Replace dialog, choosing Replace Next replaces the next 
occurrence of the text without displaying the Replace dialog box. 

Working with lists
You can create HTML lists in Freeway. Lists are a special kind of 
indented paragraph with a leading bullet character. There are 10 
list styles you can choose from.

Creating lists
To create a list:

1.	 Select the paragraphs that you wish to make into a list.
2.	 Open the List section of the Text General panel of the 

Inspector palette. 
3.	 Click on the Increase List Indent button (  ). This will 

indent the selected paragraphs by one level, making them 
into an HTML list so that each paragraph is a list item within 
the list. Alternatively, you can use the List entry in the Style 
menu, or the keyboard shortcut Alt-Command-Right Arrow. 

To change a list item back into a non-list paragraph, select it and 
click on the Decrease List Indent button (  ), or use the List 
entry in the Style menu, or the keyboard shortcut Alt-Command-Left Arrow.

Nested lists
You can also create nested lists (lists within lists). To create a nested list:

1 	 Select the list items that you wish to make into a nested list.
2	 Click on the Increase List Indent button (  ) in the Inspector palette. 

Note: A list requires a list item to contain it—so Freeway does not allow you to have a list at 
indent level 2 without a list item at indent level 1 preceding (containing) it.

Inserting a return into a list item will create a new list item within the current list block. Typing Shift-Alt-Return at the end of a line will 
create a new list block at the current list depth.

An HTML list as it appears in Freeway (left), and in a browser (right).
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List styling
Lists can be styled in various ways (bulleted, numbered, etc.) 
A list that has no styling will default to being a bulleted list — 
to change the type of list, simply click within it and apply an 
appropriate list style.

List styling will not have any visible effect unless it is applied to 
list items.

The Styles Inspector shows styles from any ancestor list block 
containing the whole of the current selection (Freeway Pro only). 

Selecting lists for editing
Clicking five times in a list will select the whole list from the start to the end of the list block in which you click. You can then use 
Freeway’s styling tools to change the appearance of the text, or change the indent levels as described earlier.

Graphic lists
List styling can also be applied to graphic text paragraphs, whether the text is 
contained in an HTML item or a graphic item. The published text will be output 
from Freeway as a graphic. For more information about using graphic text in 
Freeway, see Graphic text on page 87.

Vertically set graphic text can also be made into lists. For more information on 
using vertical text, see Vertical text on page 91.

Checking spelling 
Freeway Pro and Express make use of the spelling dictionaries installed with Mac OS X. If Freeway finds a word that is not in the 
dictionary, it offers alternatives if possible. You can also add new words to the system dictionary using Freeway’s spelling dialog.

Since checking spelling is not context-sensitive, Freeway will not pick up words that are spelled correctly but in the wrong place. If a word 
is correctly spelled but doesn’t appear in the selected dictionary, Freeway will identify it as unknown. You then have the option of adding 
these words to the dictionary. 

To check spelling
•	 Choose Spelling… from the Edit menu.

•	 Choose Document from the Check popup menu to check the entire Freeway document, Page to check the current page, Story 
to check the item or linked HTML items containing the text insertion cursor, or Item to check just the currently selected HTML or 
graphic item.

•	 Click the Start button to start checking.

The most likely suggestion is provided in the Change to box.

Alternatively, you can select one of the other suggestions by 
clicking it in the Suggestions scrolling list.

•	 Click the Change button to change the unknown word to the 
selected word.

•	 Click the Ignore button to ignore the unknown word and 
continue checking.

Change All and Ignore All apply the corresponding option to all 
subsequent occurrences of this word in the document.

•	 Click the Add button if the unknown word is correct and you 
want to add it to your Mac OS X user dictionary so it will not be 
flagged in future spelling checks.

To remove a word from your user dictionary, type or paste the word into the Change to field and click the Remove button.
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Checking spelling in other languages
You can work with text in several different languages in the same Freeway document. You can apply a language to highlighted text 
using the Language submenu on the Style menu. Once the language is identified and the appropriate dictionary installed, Freeway will 
automatically use the correct dictionary to carry out the spelling check. 

Freeway ships with language support for Catalan, Danish, Dutch, English (US, Australian, International), Finnish, French, German, 
German (Swiss), Italian, Norwegian (Bokmål and Nynorsk), Portuguese, Portuguese (Brazilian), Spanish, Swedish, Russian, and Czech. 

Checking text using more than one language 
If you’re checking a selection of text that includes more than one 
language style, you need to click on the Language popup menu 
in the Spelling dialog box and choose <Use Language Style>. 
Freeway can then use the appropriate dictionaries to carry out the 
spell check. 

1.	 Choose Spelling from the Edit menu. Freeway displays the 
Spelling dialog box. 

2.	 Click on the Language popup menu to display the available 
language dictionaries. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 The Language popup menu shows the language currently 
applied. The <Use Language Style> option sets Freeway to use 
the appropriate dictionary for the language applied to the text. 
Alternatively, you can choose to check all of the text against one 
dictionary. In this case, select the language name from the popup 
menu. 

4.	 Click Start to start the spell check. Freeway automatically 
searches the appropriate dictionaries as it reaches text in different 
language styles. 

Exporting text 
To export the contents of the current item as a text file, make sure you have an insertion point or a text selection in the item. Then 
choose Export… from the File menu. Fill in an appropriate file name, choose a location on your hard drive to save the file, and click 
Save.

The entire text content of the current box will be exported as a text file. 

Language encoding FW Pro only  

The Encoding popup on the Page Output panel in the Inspector palette allows you to select a target 
language. This lets you create pages in Japanese, Russian, or any language supported by your operating 
system and Freeway. 

Note: Language encoding is not supported in Freeway Express.

Here’s how encoding works in Freeway: 

When you select encoding for a page, a Meta Tag is added to the document to specify the language. 
The items in the encoding popup show the Internet names for these languages. The browser uses this 
encoding to decide what character set to use for displaying a page—this means that accented characters 
can be output directly into the HTML (such as “Ö” rather than “&ouml;”).
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The encodings options are also tied in with fonts selected in the Text panel in Document Setup. Each encoding is associated with both 
a fixed and a proportional font, which will be used only for display in Freeway. The fixed and proportional fonts are meant to represent 
the default fonts used for these encodings by the browser. To select other fonts for HTML text, you need to use the Font Sets dialog in 
the Edit menu to set them. 

Checkboxes and radio buttons for Form items use the fixed version of the font. The same is true for straight HTML text where a fixed 
font has been specified. 

In addition to text in HTML boxes, some other fields (namely the title, alt text and form items) are also affected by the encoding. This 
means that on a non-Roman page (such as Japanese or Russian) the fields can be entered either in that language or in Roman. 

Power Tip: By default the Encoding popup menu is set to Automatic. Unless you 
specifically need to set a page’s encoding to match a language, leaving the encoding at 
Automatic means Freeway will choose the correct output according to the text on the page.

Note: For HTML text in a non-Roman language, the viewer’s browser will require suitable 
language support to display the page correctly.

Issues that affect HTML text
Line breaks 
With HTML text, the word processor technique of getting your layout right using the space bar and returns does not readily apply. In 
general, when using HTML text, you should not “force” line breaks—unless you do it with extreme care. For instance, you can type the 
following in Freeway, forcing a return after the word, “here”: 

This is how it may appear in the browser: 

Here it looks fine. But if it is viewed in the browser at a slightly larger font size, this is how it appears: 

The solution is not to force returns but to let the text wrap naturally. The result is less control, but less damage. If you absolutely need a 
bit of text to wrap in a certain way, you’ll have to make it a graphic or use CSS fixed sizes (Freeway Pro only). Just be aware that if graphic 
text is used, it is no longer text when viewed in the browser, and it loses the ability to be recognized by search engines or copied and 
searched by users. The best method is to accept the flexible nature of HTML and work with it. (For a discussion of the relative merits of 
HTML and GIF text, see page 80.) 

Soft returns 
You may have a line of text with a few words and you don’t want it to “word wrap”, as in the following example. This is how it appears 
in Freeway: 

And this is how it appears in the browser: 
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But maybe you don’t want such a big space between each line. In HTML, you can type a “soft return”, which will keep the formatting of 
the previous line and not insert the customary spacing of a new paragraph (although you can adjust the space between paragraphs with 
CSS, this is not supported in Freeway Express). If you hold the Shift key as you press Return, you will insert a “soft return” and your 
result will be like this: 

This is how it appears in the browser: 

Spaces/Non-breaking spaces 
In HTML multiple spaces are treated as a single space. If you want them to be recognized in HTML text, you must use non-breaking 
spaces. To insert a non-breaking space in Freeway, hold the Alt key as you type a space. 

Tabs 
Tabs are not supported in Freeway, and pressing the Alt key will simply insert a space character. To set tabular information in columns, 
create a table and use the rows and columns to organize the material. For more information on using tables, see Working with tables on 
page 177. 

Quotation marks 
If you want to insert curly quotes (“”) instead of straight quotes ("") in your HTML text, you must type them manually—press Alt-[ on 
the keyboard for the left quotation mark and Shift-Alt-[ for the right one. For single quotes (‘’), press Alt-] and Shift-Alt-].

Graphic text 
Unlike many HTML-editing programs, Freeway offers the ability to export text as anti-aliased, web-ready graphics that remain fully 
editable in Freeway. This reduces the need to use an image-editing program to create high-quality bitmap artwork for publishing on the 
web. 

Graphic text can be created in two ways: 

•	 Create a graphic text box that will export as a graphic using the GIF 
export format. 

•	 Highlight a run of text and apply GIF paragraph or character formats 
using the Text General panel of the Inspector palette.

When working with graphic text, a wider array of formatting options is 
available than with HTML text, and the final appearance of the text is 
guaranteed since it is exported as an image when the site is published. 
Graphic text remains editable in Freeway. 

Graphic text character attributes 
You can apply character attributes such as font, size, text color, and spacing to graphic text with options in the Style menu and Inspector 
palette (see Styling text on page 152, and Working with styles on page 167 (Freeway Pro only)). Because you are creating a graphic, not 
exporting text, you can use a much wider range of attributes than those available using HTML. 

However, the disadvantage of working with GIF text is that because you are creating graphics of the text, the GIF text is slower to 
download and lacks certain user functions of HTML text, such as access and the ability to do text searches. (For a discussion of the 
relative merits of HTML and GIF text, see page 80.) 

Note: Custom styles are not supported in Freeway Express. Styles can still be 
applied to graphic text using the Style menu and the Inspector palette.

Freeway Pro Freeway Express
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Typography settings FW Pro only  

With OpenType fonts, and also certain TrueType fonts that are installed 
as standard with OS X, a Typography panel appears in the Inspector 
palette when text set in these fonts is selected. This panel gives access 
to extra typographic features that may be embedded in the font, such 
as custom ligatures, fractions, tabular numbers etc.

Font 
You can apply a different font to a run of text using the Font popup 
menu in the Text General panel of the Inspector palette or the Style 
menu. Some typefaces are available in several different fonts (such as 
Book, Oblique, Black). If you want to embolden a word, for example, 
it’s best to choose a bold font of the current typeface rather than 
applying the bold or italic type styles, especially if the text is to be used 
at large sizes. 

Freeway Pro supports both PostScript Type 1, OpenType and TrueType 
fonts. If you have any QuickDraw GX fonts, these are also recognized.

Freeway Express supports only TrueType fonts and PostScript Type 1 
fonts.

Missing fonts 
If you open a document containing text in a typeface for which you 
have no corresponding fonts installed, Freeway will bring up the 
Missing Fonts dialog.

From this dialog, you can choose a replacement for each of the missing 
fonts by clicking the Edit… button. 

Clicking the Edit… button opens the Select Font dialog. 

You can choose any of the active fonts on your system to replace 
the missing font. Note that choosing a font that is very different in 
style to the missing font may cause text to overflow in your Freeway 
document.

Clicking the Errors… button opens the Font Problems dialog.

This shows a list that contains information about the missing 
fonts in your document. If you wish, you can save the errors list 
as a text file by clicking the Save… button.

Note: If the missing font is required for the document you are 
opening, you will need to quit Freeway, activate the font, then 
relaunch Freeway. This is because Freeway scans installed and 
active fonts at start-up, but does not scan for newly activated fonts 
while it is running.

The Typography panel on the 
left is for the standard OS X 
installed TrueType Palatino 
font; that on the right is for an 
Adobe OpenType font.



Freeway Reference: Working with Text
89

89

Size 
You can change the size of a character or selection using the Style menu, or the Text General panel of the Inspector palette. Freeway 
also provides keyboard shortcuts for altering the character size. 

Character size values can be between 1 pixel and 3000 pixels. 

Style 
If no suitable bold or italic font exists for a typeface, you can apply basic type styles by choosing from the 
Type Style options in the Style menu or using the buttons in the Inspector palette. 

Available type styles include Bold, Italic, Character underline, Word underline, Outline, and Shadow. 

The Type Style menu offers these options plus Condense, which closes letters together, and Extend, which spreads letters apart.

Color 
You can change character color using the Style menu, the Inspector palette, or the Styles & Colors palette. Freeway Express does not 
have a Styles & Colors palette.

Opacity
You can change the opacity of text to give transparency effects.

Shift 
You can change the baseline shift of a highlighted run of text using either the Shift command on the Style menu or 
keyboard shortcuts. 

Width 
You can change the width of text using the Style menu. These values apply an artificial stretch to the characters. 

Weight 
You can change the typographic weight (boldness) of a character using the Style menu. 

These values apply an artificial weight to characters. Choose directly from the list of standard weights displayed in the Style menu, or apply a 
custom weight. 

Slant 
You can change the slant of a character using the Style menu. Choose directly from the list of standard values displayed in the Style 
menu. Positive values produce a slant forwards from the normal upright posture of the typeface design and negative values a slant 
backwards. 

Spacing 
You can uniformly increase or decrease the space between individual characters. You can use this to “kern” characters.

Character spacing may be altered using the Style menu or the Text General panel in the Inspector palette. Freeway also provides 
keyboard shortcuts for changing the character spacing. See page 245 for a list of styling shortcuts.

You can increase or decrease the character spacing by choosing Increase Spacing or Decrease Spacing from the Spacing submenu 
in the Style menu. This changes the spacing by 5% for each selection. If you hold down the Alt key before choosing the menu, the 
change will be 1%. 

Applying a spacing attribute, with the “caret” (flashing insertion point) placed between two characters, will kern that character 
pair. 

Keyboard shortcut commands for kerning are the same as those used to control character spacing. The difference is that 
kerning occurs if the caret is simply placed between two characters. Spacing occurs if two or more characters are selected. 

Language FW Pro only  

In Freeway Pro, text always has a language associated with it; and you can use more than one language in the same document. The 
default language (defined as part of the Default fonts using the Text panel of the Document Setup dialog box) is automatically 
applied if you don’t explicitly assign a language to a run of text, in other words leave the Encoding popup menu set to Automatic. 

Making sure the correct language is applied to text is important because Freeway uses the information to identify the correct dictionaries 
for spelling. See Checking spelling on page 84. 

Graphic text paragraph attributes 
You can set paragraph attributes such as alignment, indents, leading, and spacing to graphic text with options in the Style menu, and 
Inspector palette. See Styling Text on page 152 (Freeway Pro only). 

If you are working with text in an HTML text box and choose GIF paragraph formatting, your character attributes will also have GIF 
formatting options. This is because you cannot have HTML character formats within a GIF paragraph. When you select a GIF paragraph, 
the Format popup menu in the Character area of the Text panel disappears and the panel changes to reflect GIF character options. 
HTML character attributes currently applied to the text are translated into their GIF equivalents. 
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Leading 
Leading is the spacing between lines of text. It can be set using the 
Style menu, or the Text General panel in the Inspector palette. For 
more information on leading, see Paragraph attributes: Leading on page 
165.

You can set leading to be automatic or fixed. Automatic leading is 
specified as a percentage. The default setting of 100% means that 
interline spacing is nominally the same as the type pixel size. 

Fixed leading sets the line spacing to the same amount regardless 
of the point size applied to the text. For example, 14 pixel leading 
provides a spacing of 14 pixels between the baselines of the text, 
regardless of the actual point size of text in the paragraph. 

You can choose an absolute point size or an automatic percentage. 
You can also choose Increase Leading or Decrease Leading from the 
Leading submenu in the Style menu to alter the leading point size by 1 pixel or 10% (depending on whether the current leading is in 
points or percent). If you hold down the Alt key as you select the menu, the leading will change by 0.1 pixel or 1%. You can also use 
the keyboard shortcuts listed next to the appropriate menu options. Choosing Other… from the Leading submenu in the Style menu 
displays a dialog box into which you can type a custom leading. 

Alignment 
You change the alignment of a paragraph using the Style menu or the buttons on the Inspector palette. To use the Style menu, select 
the text or place the cursor in the paragraph, choose Alignment from the Style menu and select the alignment from the list. 

The available alignments are Left, Right, Center, Justified, and Force Justified. 

The difference between Justified and Force Justified is in the spacing of the words on the last line of a 
paragraph—Forced Justified spreads the words to fill the whole line while Justified left-aligns the last line.

You can also use the Text General panel in the Inspector palette to apply alignment. Click on the preferred Align button to choose 
the alignment. 

Indents 
You can set indents for paragraphs with the ribbon that appears in the horizontal ruler above the text when you select text, or you can use the 
Inspector palette. 

The options available in the Text General panel of the Inspector palette are indenting the first 
line, the left edge and the right edge.

To set indents using the ribbon, select the text you want to change, then drag the triangles in the 
ribbon to your chosen positions for the left, right, and first line indents. You can only use the 
ribbon for GIF text. It does not apply to HTML text. 

To set the distance between the text and its bounding box in a graphic text item, see Integrating 
items and text: Setting an inner inset on page 60. 

Space before and after paragraphs 
You can set the space before and after paragraphs using Space Before and Space After in the Style menu. Values can be entered as 
either a percentage or pixels. 

Word and letter spacing 
The Edit Styles dialog box allows you to create new rules for the font spacing of words and letters in justified text. Any changes are 
stored as a new style and applied when that style is applied to text. Standard word and letter spacings are applied in the Default style. 
You can change the minimum, optimum and maximum values for each type of spacing. 

For more information about using custom styles in Freeway Pro, see What are styles? on page 
153, Styling Text on page 152 (Freeway Pro only).

100% leading

150% leading
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Text direction 
If you work with languages which are generally read from right to left, such as 
Hebrew or Arabic, Freeway automatically handles the punctuation and direction 
from the input text. For example, in Hebrew text, punctuation defaults to the 
left of the paragraph. If you want to override the default setting, select the 
text and choose from the Text Direction submenu in the Style menu. This 
command is available for HTML and graphic text.

The text direction setting can also be controlled from the Edit Styles 
dialog by assigning the text direction to a character or paragraph style 
(Freeway Pro only). 

Note: Text direction also affects the function of Delete. If text is set right 
to left, Delete removes characters to the right instead of to the left as occurs 
in Western formatted text.

Vertical text 
To set text in a graphic item to flow vertically, select the item itself; in the Item 
General panel of the Inspector palette, reveal the Other panel if it is not 
already showing, select the Vertical Text button . The flow of the text will be 
top to bottom, right to left.

Power Tip: Using the Edit Styles dialog you can set any or all of the GIF character 
and paragraph styles just described. Once a style has been set, you can select a run of 
text and apply it by clicking the style name in the Styles & Colors palette. For more 
information on using styles, see What are styles? on page 153 and Styling Text on 
page 152 (Freeway Pro only).

Note: Freeway Express does not support custom styles and does not have a Styles & 
Colors palette.



Although you can use Freeway’s box-drawing tools to create simple graphic shapes, you’ll likely want to import images that have been 
created in a dedicated graphics program. Freeway can import such images either as editable graphics (which can be cropped, scaled, 
combined with other text and graphics, etc. in Freeway) or as “pass-through” graphics (which are exported unaltered). (See To import a 
pass-through graphic on page 105.)

Editable graphics 
Freeway Pro and Express can import the following file formats as editable graphics: 

•	 GIF (Graphics Interchange Format) 

•	 JPEG (Joint Photographic Experts Group) 

•	 PNG (Portable Network Graphics) ) 

•	 PICT (a standard Mac graphics format) 

In addition, Freeway Pro can import the following formats: 

•	 TIFF (Tagged Image File format) 

•	 Adobe Photoshop (PSD) 

•	 Adobe Illustrator (AI and EPS)

•	 PDF (Portable Document Format) 

•	 BMP (Windows Bitmap) 

•	 EPS (Encapsulated PostScript) 

•	 QDGX (a legacy Mac graphics format) 

When your web pages are published, Freeway exports graphics as GIF, JPEG, or PNG, depending on which export type is applied to 
them. GIFs are normally used for simple graphics containing a limited range of colors, while JPEGs are used for photographic and other 
continuous-tone images. Freeway usually defaults to the appropriate type for each graphic. PNG is not used by default, as it is less 
widely supported by older browsers. 

Freeway offers you a variety of image editing and optimization options that are normally only found in major graphics editing packages. 
You can scale, crop, and transform images, alter the color palette of GIF and PNG images, vary the compression level of JPEG images, 
and choose “interlaced” (GIF) or “progressive” (JPEG) display. Using the Graphics Action suite gives further image editing possibilities 
(see articles on each of the Graphics Actions on the Softpress Knowledgebase at www.softpress.com/kb/).

Additionally, you don’t have to go through a separate process of saving web-ready images. Freeway Pro supports the direct import of 
TIFF, PICT, and many other standard file formats, which will be converted automatically to the correct, web-ready export formats. (In 
Freeway Express, you can use PNG as an alternative to TIFF if you require transparency support.) You can also optimize the quality-
versus-size of your images in Freeway, with real-time visual feedback on the resulting image. 

Freeway can also be used to slice the images on your page if necessary, to make the most efficient, fast downloading pages possible. 

Freeway automatically will keep track of graphic source files if you move the document to a different location on the same disk. In 
addition, if you move a Freeway document and all of its associated imported graphics files onto a different disk and keep the same 
relative directory structure, you won’t need to re-import graphics the next time you open the document because Freeway uses relative 
paths to locate graphics. 

A new feature introduced in Freeway 6 is the High Resolution option which you can choose to use so that images look sharp on Retina 
screens and other high resolution computer screens. This is explained later in this chapter.

Importing graphics 
Graphics in Freeway documents are held in boxes. Together, the graphic and its box are referred to as an “item”. (See Creating items on page 
45.)

You can import graphics into any empty box in Freeway but only GIF, JPEG, and PNG files may be imported as “pass-through” graphics. 

TIFF or PSD are the preferred formats when importing editable graphics into Freeway Pro, but if you have Freeway Express, PNG or PICT 
are suitable alternatives. Unless you want to import a transparent GIF, it is best not to save your file as indexed color before importing it 
into Freeway, especially if the image will be combined with other images or possibly exported as a JPEG. (See Setting publishing options for 
items on page 56.) 

To import a graphic using the Import command 
1.	 Click on a box so that its selection handles are visible, then choose Import… from the File menu. If the command is not available, 

check to make sure that there is no text already contained in the box. 
2.	 Use the resulting dialog box to find and select the graphic file you want to import. 
3.	 If you decide to import the graphic as pass-through, ensure that the Pass-through checkbox is selected—this is selected by default 

when importing images into HTML boxes and deselected by default when importing images into graphic boxes. 

Working with Graphics
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4.	 If you wish to import a graphic pixel for pixel (without scaling it in accordance with its resolution), select the Ignore resolution 
checkbox. Resolution information is always ignored for pass-through graphics.

5.	 If you wish to set alt text for the imported graphic, you can do so in the Alt Text field.
6.	 Click Open. 

Freeway imports your chosen graphic into the selected box and establishes a link to the original file. 

To import a graphic using Import From iPhoto or Aperture
1.	 Click on a box so that its selection handles are visible, then 

choose Import from the File menu. If the command is not 
available, check to make sure that there is no text already 
contained in the box. 

2.	 Scroll down the sidebar in the Import dialog (see screenshot 
on the the right), select Photos under the Media heading and 
then choose iPhoto or, if you also have it installed on your 
computer, choose Aperture. Click on the disclosure triangle to 
see a list of Events, albums, etc. 

3.	 Select the thumbnail of the image you wish to import.
4.	 If you decide to import the graphic as pass-through, ensure 

that the Pass-through checkbox is selected. 
5.	 If you wish to import a graphic pixel for pixel (without 

scaling it in accordance with its resolution), select the Ignore 
resolution checkbox. 

6.	 If you wish to set alt text for the imported graphic, you can 
do so in the Alt Text field.

7.	 Click Open (or double-click on the thumbnail).

To import a graphic using drag and drop 
1.	 Select an existing box or create a new box to hold the graphic. Alternatively, you can skip this step, since Freeway will automatically 

create a box if you drop a graphic onto a blank area of the page. 
2.	 Locate a file on the desktop, in a Finder window or open an application that supports drag and drop, such as iPhoto. 
3.	 Drag the file or graphic over the box in your Freeway document. (As you drag the pointer over different boxes, their borders become 

highlighted.) Alternatively, drag the file or graphic over a blank area of the page. 
4.	 Release the mouse when over the appropriate box or page area. 

A box can only hold one graphic. If you try to copy or import a graphic into a box that already holds a graphic, the first graphic will 
be replaced by the second. The second graphic will assume the scaling and orientation attributes of the previous image. For more 
information on deleting graphic content, see Deleting a graphic below.

If you hold down the Alt key before releasing the mouse button, Freeway will import the graphic as a pass-through graphic. See Pass-
through graphics on page 105. 

Replacing text with a graphic 
A box can either hold text or a graphic, but not both. If a box contains text and you want to replace it with a graphic, you must first 
delete all the text. To do this, click inside the box, choose Select All from the Edit menu then press the Backspace or Delete key. 

Pasting a graphic from the clipboard 
If you’ve previously cut or copied a graphic to the clipboard, you can simply paste the graphic into a selected box by choosing Paste 
from the Edit menu. 

Deleting a graphic 
If you make a mistake or change your mind, you can easily delete or overwrite a graphic. There are several ways to do this: 

1.	 Select the box holding the graphic then press the Backspace or D key. This deletes the box and the contents. 
2.	 Select the box holding the graphic, then choose Delete Content from the Edit menu. This deletes the content but leaves the box in 

place. 
3.	 Select the box holding the graphic and import another graphic into the same box. This will overwrite the first graphic. 

When you replace an existing graphic by importing a new one in its place, the new graphic retains any transformation applied to the 
original (scale skew, rotation, etc.). If you clear the first graphic, the default mapping options are restored.

Positioning a graphic within its box manually 
To position a graphic within the box manually: 

1.	 Select the box. Freeway displays a panning handle in the middle of the visible area of the graphic. 
2.	 Move the mouse cursor over the panning handle. The pointer tool changes to a Grabber hand. 
3.	 Click and drag the graphic to its new position. 
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Positioning a graphic within its box using the 
Graphic dialog box 
1.	 Double-click on the graphic to display the Graphic dialog or select 

the item and choose Modify… from the Item menu. Select the 
Graphic tab.

2.	 In the Horizontal offset and Vertical offset boxes, enter new 
values for the position of the graphic. 

3.	 Click OK. 

See also Manipulating items on page 47.

Centering a graphic within its box automatically 
You can center a graphic within its box by selecting the item and 
choosing Center from the Graphic submenu on the Item menu 
(see over). You can also Control-click and choose Center from the 
Graphic submenu on the contextual menu. The keyboard shortcut to 
center a graphic is Shift-Command-m.

Copying graphics to the clipboard 
When you have a graphic contained in a graphic item in Freeway you 
can copy the item or its contents to the clipboard in a variety of ways. 
Select the item, and: 

1.	 Choose Copy from the Edit menu to copy the item to the clipboard. 
2.	 Hold down the Alt key and choose Copy from the Edit menu to copy the contents of the item to the clipboard as a PICT image—

this allows you to copy/paste graphic material from Freeway into other applications. 
3.	 Hold down the Alt and Shift keys and choose Copy from the Edit menu to copy the contents of the item to the clipboard ready to 

paste into another item in Freeway. 

Exporting graphics from Freeway 
You can export any selection of graphic items or entire pages as graphics using Freeway’s export command: 

1.	 Select the graphic items you wish to export or change to the 
page you wish to export. 

2.	 Choose Export… from the File menu. 

Freeway will choose an output format depending on your 
selection. A color photo, for example, will default to JPEG, but 
graphic text will default to GIF.

3.	 If the automatic format selection is not what you want, 
choose a different export Format from the popup menu. 
Choose either Selection (just the items selected) or Page (all 
items on the page, complete with the page background). 

4.	 Enter a name for the exported file and click Save. 
5.	 An Options dialog box will appear, with options tuned to the format option selected in step 3. 

When exporting items, it’s important to remember that the background color of the page is not exported with them. When exporting 
items as a GIF you may need to select an anti-aliasing color from the Options dialog or give the items being exported a colored fill to 
control the color of anti-aliased edges and prevent a halo from appearing if the exported image is used on a colored background. For 
more information on anti-aliasing, see Preview options on page 132. 

Control-clicking 
an imported graphic 
gives access to the 
contextual menu 
for quickly applying 
transformations.
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Importing a high resolution image
1.	 Draw a graphic item on your page and choose the Item Appearance panel from the Inspector palette. 
2.	 From the Image popup menu, choose Import… and then locate the image you want to import. 
3.	 Click Open. Freeway will place the graphic inside the graphic item box.
4.	 Check the High-resolution option in the Appearance tab of the Inspector.

As soon as you check the High-resolution option you will see the image reduce in size by 50%. The reason for this is because the option 
uses a method called “@2x” which Apple recommends to make images display in high quality on Retina displays—and this requires the 
graphic to be output at 50% of its original physical size. Freeway will show you the graphic at 50% of its original size in the live preview 
on your page, so you can see how it will look on output even before previewing the page.

If you plan to import images as high resolution graphics, you might want to take the time first to resize your graphics first (in 
Photoshop or similar) so they are double the physical size (in pixel dimensions) of how you want them to appear as high resolution 
graphics. That way they will be the correct size when you import them and switch on the High-resolution option.

You can read further information on using high resolution graphics with Freeway in the article on the Softpress KnowledgeBase at 
http://www.softpress.com/kb/questions/447/.

Resizing graphics 
Because of Freeway’s roots in desktop publishing, the way it handles 
imported graphics can sometimes appear to be wrong. Essentially, 
the dimensions of an imported graphic file are considered in inches/
millimeters/picas/ciceros first, and pixels last. If you have a file that is 
set up in Photoshop to be a 1 x 1 inch square, but is 360ppi (pixels per 
inch), then when you bring it into Freeway it will display as a 1 x 1 inch 
square rather than appearing at 5 x 5 inches purely because of its pixel 
dimensions.

Whenever you preview or publish your pages, Freeway will read the full 
resolution detail from the high resolution file and use this to create an 
optimized, screen-resolution and web-ready version of your graphic.

You can, of course, scale such images up to larger sizes on your Freeway 
page: see the menu options available in the Graphic submenu on the 
Item menu. As these actions will initially scale the on-page preview 
image which may end up looking blocky or jagged, using the Resample 
button in the Graphic dialog will tell Freeway to read the original file 
from disk and show you the optimum image for that particular on-page 
size. 

After you scale an imported graphic, Freeway will automatically resample the resulting image to 72ppi (pixels per inch) upon export or when you 
publish your site. 

Resizing a graphic to fit its box exactly 
You can resize a graphic to fit its box exactly by selecting the item and choosing Scale to Box from the Graphic submenu in the Item 
menu. 

Resizing a graphic to its box, retaining proportions 
You can resize a graphic to fit its box as closely as possible, while retaining the original proportions of the graphic by selecting the item 
and choosing Scale and Pad or Scale and Trim from the Graphic submenu in the Item menu. The first of these commands retains the 
original proportions of the graphic by padding where necessary. The second retains the original proportions by trimming (cropping) the 
graphic where necessary. 

Fitting a box to its contents 
You can also resize a box to fit the graphic it contains by choosing Fit Box to Content from the Item menu.

Controlling graphic sizing behavior 
Freeway gives you four options for controlling what happens to a graphic 
when its box is resized. These are set using the Graphic dialog—to access 
this, select a graphic item containing an image and choose Modify… from 
the Item menu, or simply double-click on the graphic, then click on the 
Graphic tab. 

The following examples illustrate graphics resized in Freeway. The 
options available for the graphic sizing behavior are:
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Preserve Size

The graphic dimensions remain unaltered, no matter what happens 
to its box. This means that the graphic may be cropped if its box 
becomes smaller or may be padded with white space if its box 
becomes larger. This is the default behavior.

Scale Graphic

The graphic is scaled in direct proportion to the box. The graphic’s 
aspect ratio is not preserved.

Scale and Pad

The graphic is scaled to fit its box’s smaller dimensions. The graphic’s 
aspect ratio is retained. If necessary, the graphic is padded to fit its 
box’s larger dimension.

Scale and Trim

The graphic is scaled to fit its box’s larger dimension. The graphic’s 
aspect ratio is retained. If necessary, the graphic is trimmed to fit its 
box’s smaller dimension.

Scaling a graphic item with the mouse and modifier keys 
You can use the mouse and the Command, Alt and Shift keys to scale graphic items together with their contents: 

•	 To scale a graphic box and its contents, drag any corner selection handle while pressing the C key. (See Scale Graphic above.) 

•	 To “Scale and Trim” a graphic item, drag any corner selection handle while pressing the O key. (See Scale and Trim above.) 

•	 To “Scale and Pad” a graphic item, drag any corner selection handle while pressing the C and O keys. (See Scale and Pad above.) 

•	 To scale a graphic box and its contents, while retaining the current proportions and cropping, drag any corner selection handle while 
pressing the C, O and S keys. 

Scaling a graphic using the Transform dialog box FW Pro only  

You can select a graphic item and scale the item and/or the graphic it contains using the Transform dialog, as described in Transforming 
items on page 53. 

Note: Freeway Express does not have a Transform dialog box.

Scaling a graphic up and down 
You can resize a graphic in 5% increments by selecting the graphic or its box and choosing Scale Up or Scale Down from the Graphic 
submenu in the Item menu. 
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Restoring a graphic to its original size 
You can restore a graphic to its original size (taking account of resolution 
information) by choosing Original Size from the Graphic submenu in the 
Item menu.

Showing high resolution graphics at pixel size
When you import bitmap graphics at a higher resolution than 72ppi, Freeway automatically shows the image at its original resolution 
(unless you have selected Ignore resolution in the Import dialog). You can also display a graphic at its pixel size (ignoring resolution 
information) by choosing Pixel Size from the Graphic submenu in the Item menu.

Note: If a 72ppi graphic is selected and Pixel Size is chosen, no apparent change will occur. If the same action is performed on a high resolution bitmap 
graphic, for example one saved at 360ppi, it will be enlarged in the graphic box. You may need to resample it to make it appear sharper on the page, 
although this action will be performed automatically when you publish the page to a browser. Vector graphics, such as Illustrator files, do not have a pixel 
size, and the Pixel Size command will be grayed out in the menus.

Using the contextual menu for graphic commands
All the graphic editing commands can also be accessed by L-clicking on a 
graphic and choosing the required commands from the contextual menu.

Managing imported graphics 
The Graphic dialog box displays information about the graphic, such as its 
location on disk, the date and time the graphic was last modified, and its current status. 

Using the Graphic dialog box 
Information about a selected graphic is available in the Graphic dialog box, including its name, size, type, status, and modification. 

There is also a version of this dialog (without graphics editing options) for pass-through graphics and plug-in content. 

Note: If you select a graphic pasted from the clipboard, or if the original 
is on a master page, Freeway displays a smaller version of this dialog box 
which omits the file information. 

•	 Select Detached to detach the graphic file. If a graphic file is missing 
and detached, Freeway will publish without errors and the preview 
image will be used to generate the output graphic. 

•	 Click Locate… to display a file import dialog, allowing you to find 
and open files. Use this option to locate missing graphics. 

•	 Click Update to update the graphic. Use this option to update 
modified graphics. 

•	 Click Resample to resample the graphic after scaling. This process 
adjusts the file data brought into Freeway from the original graphic 
file. A graphic that has been enlarged will display more accurately 
on the screen after resampling, and one that has been reduced will 
require less memory to display. 

•	 Click Show to locate the selected graphic in the page layout. Use this 
to monitor the effects as you resample or update the graphic.

You can use the 
contextual menu to 
access the graphic 
editing commands.
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To define whether a graphic is published 
1.	 Double-click on the graphic to display the Graphic dialog box and 

select the Graphic tab. 

2.	 Deselect the Publish Graphic checkbox. 

The graphic will now not be published. Its enclosing box will publish, 
however, if a border or color has been defined. 

Note: Unchecking the Publish checkbox in the Inspector palette will 
prevent the whole item and its contents from publishing.

The Resources dialog box 
The Resources dialog box contains a list of all the graphics and other content files that are used in the current document. This dialog 
displays information about each individual graphic and allows you to delete, update, and resample graphics. You can also define 
whether a particular graphic will be exported when the web page is published.

To display the Resources dialog box, 
choose Resources… from the Edit 
menu. The information and options 
are: 

•	 File : Shows the file name, with the 
option of showing the location. 
Using the popup menu within 
the File option, set the display to 
include the graphic’s file name 
only, or its full file path. 

•	 Type: Gives the file type. 

•	 Status: Shows the following 
information: 
–	 OK: graphic is up to date. 
–	 Missing: file is not present. 
–	 Modified: file is not current. 
–	 Detached: file has been 

detached. 

•	 Page: Shows the page on which 
the graphic appears. 

•	 Publish: Shows whether the graphic 
will be exported as part of the web page. Select the checkbox to determine whether the graphic will be published. 

To change the sort order of the graphics in the Resources dialog, click on the title of a column. For example, to sort by the page in 
which the graphic appears, click on the Page column title. This can be helpful for viewing all of the resources for a given page. 

•	 Click Update All to update all the graphics in the document. 

•	 Click Resample All to resample graphics to their current size. 

•	 Select a graphic from the list and click Show to display the graphic in place on the page. 

•	 Select a graphic from the list and click Edit… to display the Graphic dialog box for that graphic. 

•	 Select a graphic from the list and click the Delete button or press the Backspace or D key to delete a graphic. 

Detaching missing graphics
If you have missing graphics, Freeway can detach them so that you can publish your document without the delay which otherwise 
occurs when Freeway tries to locate the missing graphics. Freeway publishes missing graphics using the document preview image

To detach missing graphics:

1.	 Choose Resources from the Edit menu.
2.	 Click on Update All.
3.	 If there are missing graphics, Freeway will display an alert asking if you wish to detach them.
4.	 Click OK.

The Update All command can also be used to reattach graphics that are no longer missing. If Freeway finds missing graphics that have 
been detached, it will display an alert asking if you wish to reattach them.

You can also detach and reattach individual resources by clicking on the Detached checkbox in the Modify Graphic dialog.
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Alt text for exported graphics 
Alt text, short for alternative text, is a short description that will display in the 
browser in place of the image if it is not shown for any reason. Some web users 
prefer not to view graphics while surfing since their size can delay downloading the 
page. If the graphic has been described using alt text, this text will display in place 
of the graphic. On many browsers, alt text may also display as “help text” when a 
visitor moves the cursor over an image in their browser.

Freeway automatically creates alt text by default. For graphic text, the text content is used; for imported graphics, the graphic’s file name is 
used.

To turn off alt text for a graphic item 
1.	 Select the graphic box and display the Item Output panel of the Inspector palette. 
2.	 Deselect the Alt Text checkbox to turn off alt text generation for the selected item. The text entry 

field will disappear when the option is turned off.

Customizing the alt text for a graphic item
Sometimes you may wish to override the automatically generated alt text. For example, if you have 
imported a digital photograph the alt text will be generated from its filename, which might be something incomprehensible such as 
“DSCF0002.JPG”. You may also wish to expand the automatic entry to something more meaningful, such as adding “Click here to email 
us” to the Email button in the example above.

To edit the alt text entry for a graphic item
1.	 Select the graphic box and display the Item Output panel of the Inspector 

palette.
2.	 Click in the Alt Text field and double-click to select the existing text. Type the 

new text you want to appear in the browser help tag and press R to accept 
it.

Power Tip: The Alt Text field can contain up to 256 characters, so you 
can provide very descriptive alt text if you wish. This is can be used to 
provide a reasonable text description of a photograph, for example, so that 
visually impaired visitors to your web site who use screen reader software 
can get some idea of what the image shows. Descriptive alt text may also 
help with search engine listings.

File names 
In Freeway, file names for graphics and other resources are automatically generated when the site is published. These file names are 
usually derived from their associated item names. You can control the names of exported graphics from the item title, except in the case 
where graphics are “reused.” 

When your web site is published, Freeway checks for any identical graphics across your entire site. If such graphics are found, only one 
graphic file will be exported into your site folder. Freeway will then create multiple references to that exported graphic, one for every 
instance in your site. For example, let’s say Freeway determines that you have five identical graphics when publishing the site. Freeway 
would then export only one copy of the five into your site folder. At the same time, Freeway will create five references to that one 
graphic in the HTML files that are exported. This reusing of images results in faster download times for the sites you create. However, 
because of this optimization, the exported graphic name will not necessarily be derived from the item name in Freeway. 

Let’s look at the relationship between the title of an item and the name of the resulting graphic that is generated when the site is 
published. While working on a master page, you might define a given graphic item as a banner for the page and wish it to be called 
“banner.gif” on output. To achieve this, the item is titled “banner” in the Item Output panel of the Inspector palette. When the site 
is built, if Freeway determines there to be no identical images, the resulting filename will be “banner.gif.” If there is a non-identical 
image called “banner.gif”, the resulting filename will be “bannera.gif” or “bannerb.gif.” Finally, if Freeway finds an identical graphic 
prior to encountering “banner,” the output name will be derived from that first graphic. 

Note: Freeway never overwrites graphics (or other resource files) that it has 
not created; however, it will overwrite HTML files. 

Export formats 
When graphic items on your page are exported as GIF, JPEG, or PNG there are various options that can be set for the exported graphic. 
These are normally set in the Item Output panel of the Inspector palette. Some of the default settings may be controlled using the 
Graphics panel of the Document Setup dialog (see Graphics on page 236). 

The two main export formats for images on the web are JPEG and GIF. In general, use JPEGs for continuous tone images, such as 
photographs and images with subtle shades, but use GIFs for flat colors such as graphic text, buttons and logos. JPEGs are capable of 
displaying millions of colors and their quality depends on the quality of the monitor own which they are viewed. GIFs are made up of a 
maximum of 256 colors, so they are generally smaller (when fewer colors are involved) and more color-consistent across browsers. This 
is especially true if you use the 216-color web-safe palette that is supported by both Macs and Windows PCs. 
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It is best to experiment and view your output in different browsers and on different platforms, taking into account both image quality 
and file size. Note that in general, graphics may appear darker on a Windows PC than on a Mac.

For more information about creating and using color in Freeway, see Working with color on page 144.

Export settings for GIF graphics 

Size 

The Size area shows the byte size of your GIF graphic files. This value 
depends on the dimensions, colors, and other attributes of your 
graphic. Size information is only displayed when you have the Preview 
Graphics option turned on (via the View menu) or if this graphic has 
been published in your site. You can also get feedback on the overall 
size of your page after you have previewed or published the site by 
turning on Show File Sizes in the Site panel  menu. 

Colors 
GIF images can have a maximum of 256 colors defined within them, 
but you can affect how those colors are selected (see GIF color palettes 
below and web-safe color on page 100). Freeway allows you to alter the 
number of colors defined within the exported GIF image using a slider 
or by editing the number of colors directly. Reducing the number of 
colors can reduce the size of the resulting file. 

GIF color palettes 
The range of actual color values used in a GIF file is called the color palette. Freeway allows you to choose from three different color 
palettes for your GIF images: 

•	 Adaptive: Color values are chosen from the original color values in the source graphic. The palette will consist of color values which 
are closest to those in the original image. 

•	 Web 216: The colors are mapped to the nearest colors in the web-safe palette. 

•	 Mac 256: The colors are mapped to the nearest colors in the Macintosh system palette. 

The default color palette for your Freeway document can be set in the Document Setup dialog. To set the default color palette for all 
subsequent documents, close all open Freeway documents and choose Document Setup… from the File menu. Any settings made in 
the dialog will be applied to all new Freeway documents. Existing documents will retain the previous settings.

Bilinear 
The Bilinear option causes graphics to be scaled more smoothly. You might want to turn this option off for some types of line art. 

Dither 
Dithering tries to match colors in your graphic using only those available in the browser. For example, a full color image uses thousands 
of colors but GIF graphics are limited to a maximum of 256 colors. Dithering provides a way of making your graphic look as though it is 
using a wider range of colors. On the other hand, dithering will generally increase the file size of your exported graphics. Dithering is off 
by default for GIF graphics. Select the Dither checkbox to turn this effect on. The default for this option may be changed in Document 
Setup.

Interlaced 
Interlaced GIF graphics are displayed gradually as the file is downloaded by the browser. Your viewers 
see the image forming as they wait for the full file to download. This setting is on by default. Interlaced 
graphics may have slightly larger file sizes. To disable interlacing, deselect the Interlaced checkbox. The 
default for this option may be changed using Document Setup. 

Anti-alias 
The Anti-alias option allows you to soften the outlines of GIF text and box shapes when the browser 
displays them. Anti-aliased text can be difficult to read at small sizes, since the outline of letters is 
blurred, so you may want to test this effect. The Anti-alias option is set to Auto by default, so Freeway 
will automatically select an appropriate color with which to blend text into a background image or color 
(see the screenshot, right). Select Off in the Anti-alias popup menu to disable this effect. You can also 
choose a different color against which the text or shape will be blended. 

When an image is anti-aliased, its color blends with the fill color of the box that contains it. If an image 
or graphic text is in a GIF box that doesn’t have a background color, it is exported as transparent, which, 
if anti-aliased, can produce an unwanted halo. When you’re using Freeway to export a GIF and you 
don’t want it to be transparent, make sure its box has a fill color. 

Although Freeway will anti-alias your graphic text by default, you can determine the minimum font size 
to which this will apply. Choose Preferences… from the Freeway application menu, and select the Text 
panel. The Minimum Anti-alias Size defaults to 0px. A larger minimum means that by default, smaller 
fonts will not be anti-aliased. You can still choose to anti-alias desired text items in the Item Output 
panel of the Inspector palette. 

For more information on anti-aliasing, see Anti-aliasing on page 132. 

Freeway Pro Freeway Express
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Alt Text

Determines whether alt text for image items is shown in the browser when the viewer has chosen not to display images. (See Alt text for 
exported graphics on page 99.) 

Submit 

Allows the item to be used as a Submit button on a form. When the box is selected, a text field appears 
in the Inspector palette. The content of the Submit field will be returned as the Name of the Submit 
button. (See Parts of a form on page 206.) 

Export settings for JPEG graphics 
Size 

The Size area shows the byte size of your JPEG graphic files. This value 
depends on the dimensions, colors, and other attributes of your graphic, 
and is displayed only when you have the Preview Graphics option in 
the View menu turned on or if you have built the site with this graphic. 
You can also get feedback on the overall size of your page after you have 
previewed or published the site by turning on Show File Sizes in the 
Site panel  menu.

Quality 

You can choose the amount of compression applied when the graphic 
is exported. The amount of compression affects the quality of the image 
seen in the browser. A setting of 100% yields the highest quality image 
and applies the minimum amount of compression. Drag the slider bar 
or enter a value in the text box to alter the quality of your JPEG images. It’s important to remember that JPEG is a “lossy” compression 
method and degrades your image slightly every time it is used, even under the 100% quality setting. It is therefore advised that you 
avoid importing low-quality JPEG images into Freeway (except as “pass-through”), as they will be decompressed and recompressed upon 
export. The default compression setting can be changed using Document Setup. The preset default is 75%.

Bilinear

The Bilinear option causes graphics to be scaled more smoothly than otherwise. You might want to turn this option off for some types 
of line art. 

Progressive 

Browsers can display JPEG images gradually as the file is downloaded so that readers see the image forming on their page. Note that 
progressive JPEGs are generally larger and take slightly longer to download than non-progressive. By default, Freeway will export non-
progressive JPEG files. The default for this option can be changed using Document Setup. 

Anti-alias 

The Anti-alias option allows you to soften the outlines of text and box shapes when the browser displays them. Anti-aliased text can 
be difficult to read at small sizes, since the outline of letters is blurred. It’s not recommended to include text in exported JPEGs, as the 
artifacts created by JPEG compression of text can look unsightly. 

Alt Text

Determines whether alt text for image items is shown in the browser when the viewer has chosen not to display images. (See Alt text for 
exported graphics on page 99.)  

Submit

Allows the item to be used as a Submit button on a form. The content of the Submit field will be returned as the Name of the Submit 
button. (See Parts of a form on page 206.) 

PNG graphics 
The PNG (Portable Network Graphics) format was developed as an alternative to GIF. The original incentive for developing PNG arose 
when Unisys began to charge software developers for the use of LZW compression. PNG also has other advantages over GIF, including: 

•	 The ability to store images which contain millions of colors. GIF images cannot contain more than 256 colors. 

•	 Full alpha-channel transparency. GIF images support only two levels of transparency, on or off. In PNG images, any color may be 
opaque, partially transparent, or completely transparent. 

•	 An interlacing option which allows a rough image to be displayed faster than with GIF interlacing. 

•	 PNG compression often produces slightly smaller files than GIF LZW compression. 

However, PNG does not have animation options and PNG transparency is not supported fully in all web browsers, though this last 
situation is gradually improving.

In contrast to JPEG images, PNG images that contain millions of colors do not lose quality when they are compressed, but they produce 
much larger file sizes. In normal circumstances it is better to use JPEG for images which contain millions of colors (photographs and 
other continuous tone images), and GIF or PNG for images which contain 256 or fewer colors. 

Freeway Pro Freeway Express
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Browser support for PNG
Some browsers (especially older versions) have limited support for PNG. Freeway Pro and Express work around some known transparency 
issues affecting older versions of Microsoft Internet Explorer. See Freeway and IE Compatibility on page 142 for more information.

Importing PNG images 
PNG images which are imported as editable graphics default to GIF or JPEG 
format when they are re-exported—PNG images with 256 or fewer colors 
default to GIF format, and PNG images with millions of colors default to 
JPEG format. Editable PNG images can be re-exported as PNG format if the 
PNG format is selected in the Graphics Output panel of the Inspector 
palette (see right). 

Exporting PNG images 
An image is exported in PNG format if the PNG option is selected in 
the Item Output panel of the Inspector palette. (Individual pages or 
selections can also be exported in PNG format via the Export… option 
on the File menu.) 

PNG images have the same export options as GIF images (see Export 
settings for GIF graphics on page 100), except that they can also be 
exported with millions of colors. Some options are only applicable to 
images that contain 256 or fewer colors (dithering, palette, number of 
colors)—these are unavailable if Millions of colors is selected. 

Combined images 
Although you can design a page with overlapping boxes in Freeway, 
standard HTML cannot display two overlapping objects on a web 
page without using CSS layer items. While Freeway Pro can use CSS 
happily, Freeway Express does not support CSS. To overcome this 
limitation of HTML when working with table layouts, Freeway can 
either combine the overlapping items into one new image, or cut 
up the underlying image so that it can be output in separate parts. 
When images are combined, the outline of the new image to be exported is 
shown in Freeway as a light blue line, outlining the combined boxes. 

When Freeway combines two or more graphic items, the new image takes 
on the format and settings of the underlying box. These are displayed in the 
Item Output panel of the Inspector palette. This contains an Item section 
(with Type and Alt Text controls) and a Combined Graphic section (see 
right). 

If the Combine Graphics option for a table-positioned graphic item that 
overlaps another is turned off in the Item Output panel, it will cut up 
the underlying graphic item, just as an HTML item would cut it. This 
issue does not affect layer-based items.

Turning off Combine Graphics
You can prevent two overlapping graphic items combining by 
selecting one of the items, switching to the Item General panel in the 
Inspector palette and turning off the Combine Graphics checkbox. 

Freeway Pro Freeway Express

Freeway Pro Freeway Express

In a table layout, two 
overlapping graphic items 
which will be combined show 
a light blue border outlining 
the combined boxes.
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Combining images with different export formats 
It is possible to combine graphic items that have different 
export formats. Since the new image takes on the characteristics 
of the underlying box, the export format options shown in the 
Inspector palette depend on the format of the underlying 
box. When you select a graphic item that is combined with 
other items and then alter the settings in the Combined 
Graphic panel, you are only altering the settings for the 
underlying box. If you subsequently separate the boxes, the 
changes you made in the Combined Graphic panel will only 
be retained by the underlying item. 

Images exported as JPEG
The JPEG format does not support transparent pixels. If you 
combine graphic items where the underlying item is set to 
export as JPEG, or use a non-rectangular box for a JPEG image, 
the pixels which Freeway inserts to fill out the group are 
opaque and will obscure any background image for this page. 

Slicing graphics
Freeway’s image handling capabilities can be used to great effect 
to optimize imported graphics. Using a technique called slicing, 
you can improve download times and image quality at the same 
time. In many ways this is similar to the technique of slicing 
found in Adobe Photoshop and ImageReady, except there is no 
need to import lots of individually optimized slices as all the 
slicing is performed within Freeway itself.

Note: The reproduction methods used for this Reference may not be 
able to show the improvements made to the graphic we’ve used in 
our example.

The goal with our example is for the main image to use as few 
colors as possible to minimize the file size, but to optimize areas 
of the image that can use a higher quality setting. 

We will use Freeway to slice the image into separate parts 
using different compression settings. To help visualize how the 
compression settings are working, and see the output file sizes 
for the sliced images, turn on Graphics Preview from the View 
menu. Now, as we work, Freeway will show the effect of different 
settings to the selected image, and show the file size in the Item 
Output panel of the Inspector palette.

1.	 Select the image.
2.	 In the Inspector palette, switch off the Combine Graphics checkbox.  

3.	 Now we can select different areas for special treatment. We can either choose to select areas to be of higher quality, or choose areas 
that can be set to lower quality. The choices depend on the image itself.

4.	 Use the Graphic tool to draw several graphic boxes that define the head, body and legs of the robot.
5.	 Turn off the Combine Graphics checkbox for each new box in the Inspector palette. At the same time, set the image compression 

to JPEG and leave the Quality setting to the default. These image slices will compress on export using these settings. 

The lower box contains the 
exported JPEG of the lighthouse 
photo and text on the left. JPEG 
does not support transparent pixels, 
so the background is obscured by 
the opaque area of the exported 
image.

Various areas of 
this graphic can be 
reduced in quality in 
order to improve file 
sizes and download 
times.
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6.	 The original poster includes some areas of text. These will benefit from different compression settings to the Robot. Draw some new 
graphic boxes over parts of the words “With Working Laser!” (taking care not to overlap the boxes making up the Robot), and set 
their compression to 75% JPEG. These two image portions will compress using these settings.

7.	 Selecting the main image, we can drastically reduce the JPEG image quality. Adjust the Quality slider until the best trade-off 
between image quality and file size is made. We’ve settled on JPEG at 20% quality.

8.	 Finally, we will apply some GIF compression settings to the poster’s main heading. We have done this because the original image has 
some blurring. The lower number of colors available for GIF won’t be that obvious, and a JPEG may suffer from some fuzziness.

This screen shot 
shows the boxes 
used to slice and 
optimize the 
Robot poster. 
Above right 
you can see a 
comparison 
between sliced 
and non-sliced 
images.

Above left is part of the final optimized image, compared with the same 
image using a 20% JPEG output setting. Note the blocky artifacts in the 
Robot, and the noisier heading quality.
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Animated GIFs 
Animated GIFs are special GIF images that contain multiple image frames. When viewed in most web browsers, the frames are played back, 
just like the frames in a piece of film. Animated GIFs are widely supported and are an excellent way of putting simple animations on the 
web in a form that can be accessed without downloading and installing a custom plug-in for the browser. 

Freeway cannot be used to create animated GIFs, but you can import them. Animated GIFs can be combined with other graphic items 
on output, but this can degrade their performance and result in unwieldy files. 

When working with animated GIFs, it’s best to import them as pass-through graphics or turn off the Combine option for them. This 
prevents them combining with other page items and gives better performance.

Pass-through graphics 
Pass-through graphics are images that Freeway exports without modifying in any way. You might import an image as a pass-through 
graphic if you have already optimized its color palette in another program (although Freeway’s Adaptive option also preserves existing 
color palettes). Pass-through graphics should normally be in GIF, JPEG, or PNG format, since other graphic formats are not directly 
supported by web browsers. If you import other formats (such as TIFF or PICT) as pass-through graphics, Freeway will treat them as plug-
in content, and web browsers will only display them if a suitable plug-in is installed—this is true even if the graphic appears in Freeway. 

In general, it is not advised to use pass-through for graphic formats other than PNG, GIF, or JPEG. Graphics that are exported in a 
standard web-ready format, such as GIF and JPEG, can be viewed in all browsers without requiring plug-ins. However, graphics that are 
not already in GIF or JPEG format should normally be imported into a graphic box, so that Freeway can convert them to the appropriate 
format. 

Note: It is important to remember that previewing your site with a Mac 
browser may show certain graphic formats not supported in other browsers on 
other computer platforms. The QuickTime browser plug-in, for example, can 
display PSD, TIFF and PICT graphics. Users who don’t have this plug-in may 
not be able to view pass-through graphics saved in these formats. 

To import a pass-through graphic 
1.	 Draw or select an HTML box and choose Import… from the 

File menu. The HTML box can be table-positioned or a CSS 
layer.

2.	 Use the Import dialog to find and select the graphic file you 
want to import. 

3.	 If the chosen file is in a suitable format, such as JPEG, 
GIF, or PNG, Freeway will have selected the Pass-through 
checkbox.

4.	 Click Open. 

You can also import pass-through graphics into a rectangular 
graphics box by selecting the Pass-through option in the 
Import dialog. The box will be converted into an HTML box 
after the graphic has been imported. 

Pass-through graphics cannot be scaled, cropped or transformed in any way on the Freeway page. Unless they are set to export as layer 
items (Freeway Pro), they cannot have any other item placed on top of them. If the imported image is larger than the box that holds it, 
it will not be displayed at all, nor will it output—it will overflow the box and display a cross through it. 

To fit the box to the actual size of the imported image, choose Fit Box to Content from the Item menu. If having done this, the image 
still does not appear, it may be that the page itself is too small to contain the image. Make the page larger using the Page General panel of 
the Inspector palette to increase its width and/or height.



Using multimedia 
Some of the most exciting pages on the web use multimedia items such as sound, movies or animation. If you have multimedia items 
that you wish to display on the web, it can often be the case that you can add them to your page in Freeway in the same way as adding 
text or graphics—by creating boxes on the page to hold them or by dragging and dropping the file onto your page. 

Some multimedia content requires additional “plug-in” software in the browser to properly display, or sometimes the format used for 
the multimedia files may be completely unsupported—so it is important to understand the current level of support in browsers for each 
type of multimedia file so you they can be made to work on the widest range of device for the vast majority of web visitors.

Multimedia content in Freeway is often referred to as “plug-in” content and it is important to note that plug-in content cannot be 
previewed in Freeway’s Page view. However, some can be seen working in Preview mode, which is based on the same “engine” that 
drives Apple’s Safari browser, but sometimes the functionality has been “sandboxed” and will not play until it has been uploaded live to 
the web unless you edit the code first (by inserting http: before the // in the embed code supplied by YouTube for example). 

When playing certain kinds of multimedia content you can specify additional or optional parameters using Actions to control how it 
displays, and any such Actions will be listed in the appropriate section of this chapter.

If you use very large video or audio files on your web page, it is generally a good idea to let the visitor know what they will encounter 
on the page before it occurs. This gives visitors the freedom to decide in advance if they wish to view it or not, as it can be frustrating to 
wait for a very long time to download over a slow connection. 

In the past it was often necessary to offer alternative options for certain multimedia files so the visitor would be able to choose their 
preferred file type to use. More recently, however, support in modern browsers is far more universal, and it is now possible to include 
automatic “fallback” options so that if one file type is not supported, another file type will be offered for the visitor’s browser to use.

Note 1: Many modern browsers ship with recent multimedia plug-ins. However, while many include Flash plug-ins as standard, 
many PC browsers do not include the QuickTime plug-in. It is important to take this into account when considering including 
QuickTime-based multimedia content in your designs.

Note 2: Plug-in content will always play on top of other items on the page, even if other layered items are above the box 
item containing the plug-in content. If you want to prevent this default behavior (which can only be done in Freeway Pro, you 
might want to try selecting the item you want to appear above the multimedia content (such as a CSS Menu’s drop-down sub-
menu), go to Item>Extended, click on the “Div style” tab, then enter the Name/Value pair of z-index and 99 to force the item 
to display above the plug-in content. If you still find that the plug-in content is appearing above other items on your page, Pro 
users can select the item on the page again and add another Name/Value pair—this time using wmode and transparent.

Types of multimedia content 

HTML5 video 
Cross-browser support for HTML5 video is now very good—and it should be used for offering video content wherever possible. The 
reason it is considered to be the best method for offering video is because it offers alternative file formats to be used if HTML5 is not 
supported (such as in Firefox for Mac and PC) and also because it can be made to fall back to Flash for older browsers and some mobile 
devices.

How to offer a movie file as HTML5 video

The first thing you need to do is to save your movie file so it is encoded as H.264 and saved as either an .mp4 or .m4v file. If the file 
was not offered in that format you can usually convert it very quickly by using a free video converter application such as Miro Video 
Converter http://www.mirovideoconverter.com/ or by using a free online service such as the one at OnlineConvert.com http://video.
online-convert.com/convert-to-mp4. Both of these will let you 
convert many different video file types to MP4.

Once you have your .mp4 or .m4v file you can drag and drop it 
on the Freeway page and then, with the item selected, look at the 
options in the Item Output Settings tab of the Inspector.

•	 Type: If you have your page set to HTML5 or XHTML5, this 
popup will be set to Video by default, which means that the video 
will be output by Freeway as HTML5 video. If you have the page 
set to any other HTML level (HTML 4.01 Transitional, XHTML 1.0 
Transitional, etc.) the popup will display as QuickTime because the 
page will not validate correctly unless it has an HTML5 declaration 
in the head tag.

Working with multimedia
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•	 Source 2 and Source 3: These popups allow you to offer an alternative video file type which a browser can use if HTML5 is not 
supported. The two main file types you will use in here are OGG Video (OGG Theora or OGV) or WebM. If you don’t have those 
video file types already, you can use Miro Video Converter or OnlineConvert.com (see previous page) to convert your .mp4 or .m4v 
file into one or both of those file types. Currently, you only need to use just one alternative file type (it doesn’t matter which one).

•	 Poster (Pro-only): Choose an image (perhaps a screenshot of the movie) to show inside the HTML5 video item on your page before 
the movie starts to play by selecting the image file in this popup. This option is not available in Freeway Express.

•	 Preload: This lets the web designer choose a preferred action for how a browser treats the movie file. This set by default to default, 
which means that the visitor’s browser preferences will be allowed to control what happens on page load. There are three other 
options:

–	 none: This means that the designer would not like the movie to load on page load.
–	 metadata: This means that the designer wants only the metadata of the movie item to load on page load.
–	 auto: This means that the designer would like the entire video to load on page load (note that this will be chosen if Autoplay is 

switched on—see below).

•	 Controls: Lets you choose whether to show the video controller below the video window. The default is for this to be switched on.

•	 Autoplay: With this option switched off, the visitor will need to click on the play button to make the movie play. With the option 
switched on, the movie will play as soon as it has downloaded. It is important to note that with this option switched on it can cause 
mobile devices to switch to a different app (such as the standalone QT application on iOS devices)—so if you want a movie to play 
on the web page itself you should leave autoplay switched off.

•	 Loop: With this option switched off, the movie will play once and then stop. With the option switched on, the movie will play over 
and over.

•	 Muted: As the name suggests, switching on this option will mute the audio of the movie. When it is switched off, the movie will 
play with sound if there is sound on the movie file.

The HTML5 video item is like any other HTML item used on your Freeway page. You can select it and add graphic effects (such as 
Shadow or Border) if you wish, etc.

You can see in the above screenshot that the handles of the HTML5 video item display in red—and this is because it has a Width and 
Height of Flexible, meaning that the item will be sized at 100% of the size of the movie file it contains. To resize the movie on your 
page you need to click on the General Settings tab of the Inspector, change the Width and Height to Fixed and then you can either 
enter the values you want to use or you can scale it by using the handles (note that holding down Shift, Alt and Command and then 
dragging a corner handle you can resize it while retaining the movie’s proportions).

The Video Extras Action

Freeway allows you to use additional options for your movie item. To apply the 
Action, select the movie item on the page, go to Item>Actions and choose Video 
Extras. With the item selected on the page you can see the available options in 
the Actions palette.

The first option is Click Video to Play/Pause (if no controls), which is switched 
on by default. With the option switched on the visitor will be able to simply 
click on the movie item on the page to make start playing or toggle between 
play or pause by clicking. As the name suggests this means that the visitor has 
some control over the playing of the movie when the Controls option has been 
switched off in the Item Output Settings tab of the Inspector when the movie item 
is selected.

The other options are all for setting up “fallback” behavior should HTML5 and 
alternative versions of the movie used in the Source 2 and Source 3 popup not be 
supported in particular browsers. Older browsers (especially very old browsers such 
as IE6 and IE7 for PC) will almost certainly support movie content if it is offered 
as Flash, so applying this Action to the movie item will add further universal 
browser support for the movie content. The Flash Fallback option is switched on 
by default.

In rare instances, the visitor might be using a browser which doesn’t support HTML5, either of the alternative formats chosen in the 
Source 2 and Source 3 popups or Flash—and so the last two further fallback options:

•	 Image Fallback: Click on this popup and choose a graphic so that the graphic will be displayed within the movie item container. 
The graphic can be used as a standalone graphic (by clicking on the Select... option) or as a background graphic (by choosing the 
Use Background Image option).

•	 Text Fallback: Just in case a visitor has graphic display switched off in their browser preferences, it is also possible to display a line of 
HTML text (which can be spoken to visitors with sight impairment who use screen readers) by entering the required text in the text 
field to use in place of video or graphic content on the page.
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Audio file
We recommend using MP3 files to offer audio on your web pages—but you should also use alternative file formats (such as OGG and/or 
WAV) so that visitors using Firefox (for Mac or PC) or older PC browsers will be able to use the alternative if the MP3 file format is not 
supported. Audio files can be quickly converted using a free online conversion service such as the one at http://audio.online-convert.
com/convert-to-mp3.

Drag and drop the MP3 file onto your Freeway page and then, with the item selected, look at the options in the Item Output Settings 
tab of the Inspector.

•	 Type: If you have your page set to HTML5 or XHTML5, this popup will be 
set to Audio by default. If you have the page set to any other HTML level 
(HTML 4.01 Transitional, XHTML 1.0 Transitional, etc.) the popup will 
display as QuickTime because the page will not validate correctly unless 
it has an HTML5 declaration in the head tag, and the audio file will be 
output as QuickTime (which may only play on some browsers, especially 
PC browsers, if the visitor has the QuickTime plug-in downloaded and 
installed).

•	 Source 2 and Source 3: These popups allow you to offer an alternative 
audio file type which a browser can use if the MP3 file format is not 
supported. The two main file types you will use in here are OGG or WAV. If 
you don’t have those video file types already, you can use OnlineConvert.
com (mentioned above) to convert your MP3 file into one or both of those 
file types.

•	 Preload: This lets the web designer choose a preferred action for how a browser treats the audio file. This set by default to default, 
which means that the visitor’s browser preferences will be allowed to control what happens on page load. There are three other 
options:

–	 none: This means that the designer would not like the audio file to load on page load.
–	 metadata: This means that the designer wants only the metadata of the audio file item to load on page load.
–	 auto: This means that the designer would like the entire audio file to load on page load (note that this will be chosen if Autoplay 

is switched on—see below).

•	 Controls: This option must be switched on, otherwise the default audio player controller bar will not display.

•	 Autoplay: With this option switched off, the visitor will need to click on the play button to make the audio file play. With the 
option switched on, it will play as soon as it has downloaded.

•	 Loop: With this option switched off, the audio file will play once and then stop. With the option switched on, the audio will play 
over and over.

•	 Muted: As the name suggests, switching on this option will mute the sound of the audio file, which will mean that the visitor will 
need to manually adjust the volume to listen to the file.

The HTML5 audio item is like any other HTML item used on your Freeway page. You can select it and add graphic effects (such as 
Shadow or Border) if you wish, etc.

You can see in the above screenshot that the handles of the HTML5 audio item display in red—and this is because it has a Width and 
Height of Flexible because that is the default size of a standalone audio controller bar. The height of an audio controller bar will always 
be 25px, but you can change the width of the item by clicking on the General Settings tab of the Inspector then changing the Width 
to Fixed before entering the value you want to use, or you can scale it by clicking and dragging the center left or center right handles.

QuickTime 
QuickTime was once the most common way for Mac users to offer movie content for multimedia and the web. It was also used for 
specialist Virtual Reality output or for exporting animations created in 3D modeling programs. 

However, although QuickTime works fine on all Mac computers and devices, it is often the case that PC visitors will need to download 
and install the QuickTime plug-in to see the multimedia content. Understandably, many PC users are reluctant to download plug-ins 
so they can watch a movie or animation due to security concerns (and many office users may not have the authority to do so)—so 
QuickTime is now out of favour compared to HTML5 video. 

QuickTime movies may consist of both sound and pictures, sound only, or pictures only, and are normally identified by having “.mov” 
at the end of the filename. 

Drag and drop the MP3 file onto your Freeway page and then, 
with the item selected, look at the options in the Item Output 
Settings tab of the Inspector.

The “Poster” frame of the movie will then appear inside the item. 
The poster frame is the first frame of the movie, or the frame 
that’s been set to show as a still image before the movie begins to 
play.
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•	 Type: If you have your page set to HTML5 or XHTML5, this popup will be set to Video by default, which means that the video will 
be output by Freeway as HTML5 video—so if you want to output the QuickTime file as QuickTime you will need to manually change 
the Type popup to QuickTime. If you have the page set to any other HTML level (HTML 4.01 Transitional, XHTML 1.0 Transitional, 
etc.) the popup will automatically display as QuickTime.

•	 Controller: Lets you choose to display the QuickTime controller bar below the movie window. The default is to be switched on.

•	 Autoplay: With this option switched off, the visitor will need to click on the play button to make the movie play. With the option 
switched on, the movie will play as soon as it has downloaded.

•	 Loop: With this option switched off, the movie will play once and then stop. Loop is set to No by default. If you choose Yes, the 
movie will play over and over. If the Palindrome option is selected, the full duration of the movie will be played forwards and then 
backwards repeatedly. 

•	 Eolas Workaround (Pro-only) When applied to a page containing multimedia content, will update the Freeway generated HTML so 
that files play seamlessly again. The ability to turn off this setting is not available in Freeway Express. 

The Eolas Workaround—what is it for? 

As a result of the Eolas vs Internet Explorer court case Microsoft was forced 
to rethink the way Internet Explorer works with rich media content. A 
standard QuickTime movie, for example, will cause the browser to display 
an alert. 

Consequently, when embedding Flash, QuickTime or Java into web pages, 
for example, Internet Explorer 6 or above will not allow user interaction 
until the user clicks on the element to ‘activate’ it. 

The Eolas Workaround, when applied to a page containing multimedia 
content, will update the Freeway generated HTML so that files play 
seamlessly again.

•	 Alt Text: Determines whether alt text for image items is shown in the browser when the viewer has chosen not to display images. 
This option is on by default. 

Note that it is not possible to scale or crop a QuickTime movie item. If you resize the box, the movie will be cropped when displayed in 
the browser. It is possible, however to scale the movie using the QuickTime Extras Action (see below).

The QuickTime Extras Action

This Freeway Action offers additional functionality 
for QuickTime items when used on your Freeway 
page. With the item selected, go to Item>Actions 
and choose QuickTime Extras.

•	 Movie Scale: This affects how the movie is 
scaled in the browser. There are three choices:

–	 Actual Size: The movie is displayed at its 
original size.

–	 Aspect: The movie is scaled to the container 
but maintains the aspect ratio.

–	 To Fit: The movie is scaled to the container 
without maintaining aspect ratio.

•	 All frames: This allows you to set up whether to 
display all frames in the movie or skip frames to 
keep in synch.

•	 Volume: You can set the initial audio volume to 
a value from 100% down to 0%.

The QuickTime Reference Movie Action

This Freeway Action is used to offer older (pre-3G) iPhone users an alternative movie file which has been reduced in file size—so it is 
playable on a standard cellphone connection. 

To use the Action in Freeway 5.5 and earlier, import a QuickTime movie as normal and then select the item on the Freeway page, go to 
Item>Actions and choose QT Reference Movie. In Freeway 6 you need to select the QuickTime movie item on your page then, go to 
the Output Settings tab of the Inspector, click on the Type popup and change Video to QuickTime—after that you can now go to 
Item>Actions and choose QuickTime Reference Movie.
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With the item selected on the page, look in the Actions palette to see the 
available options:

•	 iPhone (WiFi/3G): By default this popup is set to None. If you don’t already 
have an .m4v file to choose in the popup, click on the Generate button so 
that Freeway will automatically generate and choose a version of the original 
movie file used on the page, saved as an .m4v file for use on 3G and later 
versions of the iPhone. If you have already created a file to offer, click on the 
popup, choose Select then locate the file in the Open dialog and click Open.

•	 iPhone (EDGE): By default this popup is set to None. If you don’t already 
have a .3gp file to choose in the popup, click on the Generate button so 
that Freeway will automatically generate and choose a version of the original 
movie file used on the page, saved as a .3gp file for use on earlier iPhones (up 
to the original iPhone 3). If you have already created a file to offer, click on the popup, choose Select then locate the file in the Open 
dialog and click Open.

•	 Poster frame: By default this popup is set to Automatic, which means that Freeway will choose the first frame of your movie and 
display that as a clickable button for the visitor to click on to start the movie playing. If you wish to use a custom graphic you have 
saved on your computer, choose it in this popup by clicking on Select….

•	 Message: This lets you choose the text (if you want to use any) on the poster frame to prompt the visitor to click on the movie’s 
poster frame to make it start playing.

•	 Font: Choose the font in this popup to change the font used in the Message.

Note: If after applying the Action you see an error message telling you that you cannot use this Action, go to the Freeway menu (ie, the 
dropdown menu to the right of the Apple menu in the top left of your screen) and choose Preferences. In here, make sure you have the 
“Enable AppleScript in Actions” option checked and then click OK.

Flash 
Adobe Flash was at one time the most popular way to offer feature-rich animated content on the web. However, with the advent of the 
iPhone and iPad (neither of which support Flash) its popularity has waned and although it is still used on the web, it is more often used 
as a “fallback” format for HTML5 movie content.

Flash content in Freeway normally comes in two different types of file—.flv files (which are Flash video files) and .swf files (which are 
files created in Flash for animation or for functionality to run on a timeline, such as a slideshow with animated effects).

We will cover Flash video files later, but to import a Flash .swf file simply drag and drop it onto the page or draw an HTML box and choose 
Import… from the File menu then choose the .swf file to import. Unlike earlier versions of Freeway, Freeway 6 will not display the first 
frame of the Flash file inside the item. 

Unlike other plug-in content, it is possible to scale the Flash item. However, because dragging and dropping a Flash file onto the Freeway 
page will mean the Width and Height popups for the item are set to Flexible, you will need to select the item, change the Width and 
Height popups to Fixed and then you can rescale it to suit.

Note: If you try to import a Flash movie into a graphic item box, the 
movies and other plug-in files will appear grayed out in the Import dialog 
list. Choose All Files from the Show popup menu to make all items in the 
list selectable. Freeway will convert the graphic item box into an HTML 
item box on importing the Flash movie.

To set the parameters for the playback of the Flash file in the browser, 
use the options in the Item Output panel of the Inspector palette: 

•	 Loop: Causes the Flash file to be continuously replayed. 

•	 Play: Causes the Flash file to play automatically when the page is 
loaded. 

•	 Quality: Four options are available for setting the quality of the 
playback of the Flash file in the browser: Autohigh automatically 
sets the quality at the highest that the browser can handle (this is 
the default setting); Autolow automatically sets the quality at the 
lowest setting; High forces the movie to be exported at the highest 
quality; Low exports the movie at the lowest quality.

•	 Eolas Workaround: See QuickTime above.

•	 Alt Text: Determines whether alt text for image items is shown in the browser when the viewer has chosen not to display images. This 
option is on by default. 

Freeway Pro
Freeway Express
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The Flash Extras Action

This Freeway Action offers additional functionality for Flash items when 
used on your Freeway page. With the item selected, go to Item>Actions 
and choose Flash Extras.

•	 Edit Movie: This provides access to a further set of options that control 
settings within the movie (these affect the published movie but are not 
reflected in Freeway’s preview).

•	 Scale Movie: This scales the movie to the size of its box. If this is not 
selected, the movie will be clipped by its box.

•	 Protect Movie: Flash movies have an internal setting that prevents 
them being opened and edited in Flash authoring software. If your 
movie is not already protected, this option is enabled. Setting this 
parameter will force Freeway to publish a protected movie.

•	 Change BG Color: This allows you to change the background color within the movie. There are two options: Item sets the color to 
be that of containing item, while Other displays a color popup from which you can choose a specific color. 

•	 Links: Following the color options is a list of up to twenty links if URLs have been defined in the Flash movie. These are labeled with 
the link text followed by a number. If the movie has no links you will see no further parameters. If the movie has more than twenty 
links then only the first twenty are shown. The popup associated with the link allows you to link to any page within your Freeway 
Document or to an external URL (if you leave the popup at None, the original link is unchanged). Setting links for your Flash movie 
using the Flash Extras Action means that those links will be managed by Freeway. 

The FLV Player Action

This Freeway Action offers greater support for a Flash .flv movie file to be used on a Freeway page, so that iOS device users (iPhone, iPod 
Touch and iPad) will be automatically offered the movie as a QuickTime movie as an alternative. We do recommend, however, that you 
import the original movie as an H.264 encoded .mp4 or .m4v file so it can be output as HTML5 video instead (see earlier in this section) 
as that will mean the movie will viewable on the maximum number of browsers and devices.

To use the Action, click and hold on the Action tool on Freeway’s tool bar, choose FLV Player, draw an item on the page and then look 
in the Actions palette to see the options available:

•	 FLV File: Click and hold on this popup, choose Select…, locate the FLV file you 
wish to offer on your page then click Open.

•	 Poster frame: By default this popup is set to Automatic, which means that 
Freeway will choose the first frame of your movie and display that as a clickable 
button for the visitor to click on to start the movie playing. If you wish to use 
a custom graphic you have saved on your computer, choose it in this popup by 
clicking on Select…

•	 Choose Frame: If you know the time of a frame within the movie that you 
would like to use for the poster frame, enter the time in this field.

•	 Autoplay: If you want the movie to play automatically (without needing to click 
on a play button) check this option. Because a poster frame is not required for an 
autoplay movie, the Poster Frame and Choose Frame options will not appear if 
the Autoplay option is checked.

•	 Loop: If you want the movie to play over and over (rather than playing through 
to the end and stopping, which is the default behavior), check this option.

•	 Player: Click and hold on this popup to choose the “skin” you want to use for 
your movie. There are three preset ones to choose from: HTML5 (which outputs 
the file with an HTML5 fallback file), Over (which displays the controller bar 
above the movie) and Under (which displays the controller bar below the movie). 
Choose Custom Player so you can choose to use your own player file if you already have one to use.

•	 Player File: If you choose Custom Player in the Player popup, choose the file you want to use for your custom player in this popup.

•	 Actionscript: By default this popup is set to use the later version of Actionscript 3. If know that the player you want to use is built 
using Actionscript 2, choose 2 in this popup.

•	 Hide player: Checking this option will hide the movie item on your Freeway page.

•	 iPhone/iPad Compatibility: Checking this option will make the options below active.

•	 iPhone (WiFi/3G): By default this popup is set to None. If you don’t already have an .m4v file to choose in the popup, click on the 
Generate button so that Freeway will automatically generate and choose a version of the original movie file used on the page, saved 
as an .m4v file for use on 3G and later versions of the iPhone. If you have already created a file to offer, click on the popup, choose 
Select then locate the file in the Open dialog and click Open.

•	 iPhone (EDGE): By default this popup is set to None. If you don’t already have a .3gp file to choose in the popup, click on the 
Generate button so that Freeway will automatically generate and choose a version of the original movie file used on the page, saved 
as a .3gp file for use on earlier iPhones (up to the original iPhone 3). If you have already created a file to offer, click on the popup, 
choose Select then locate the file in the Open dialog and click Open.
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Java applets 
Java is a programming language developed by Sun Microsystems. Java is not to 
be confused with JavaScript, a separate language. Java is platform independent, 
which means the same program file (or “Java applet”) will run on any computer 
or browser that has Java capability. Java applets can function as graphic items, 
incorporate animation and interactivity or perform other useful tasks. Many 
applets available for download provide the same functionality that might 
otherwise be obtained using JavaScript Actions or Flash movies. 

It is worth noting that execution of Java applets can require a great deal of 
system resources on the visitor’s machine, and some browsers ship with the 
Java support disabled by default. If the applet fails to run for any reason, the 
visitor may just be left looking at a blank gray box on their screen with no 
explanation of what has gone wrong. 

Java applets can be imported into a box in Freeway just like any other content. You can add additional parameters to the applet in the 
Extended dialog on the Item menu. The applet parameters are inserted in the Parameters section of this dialog. If there is a large 
number of parameters, it might be best to insert a Markup box in Freeway and paste the code in there. You will need to upload the 
applet separately to the web server. For more information about adding markup, see Extending the code generated for specific items on page 
213.

There are three issues to be aware of when using Java applets: 

•	 Java applets often need to be stored in the same folder as the HTML file that refers to them. This means that you should probably 
make sure that you have selected the With HTML files option for the Resources in the Document Setup dialog. 

•	 Java applets may require additional files to be uploaded to your site. You will need to upload these files separately to the server, as 
Freeway will not know about them. See Dedicated FTP tools on page 142 for more information.

•	 Java applets can sometimes be locked so they only work from specific domains. Testing an applet which has this security feature may 
not work as expected unless the test site is published to a server that is online.

•	 Java applets normally can’t be renamed. If you rename them you will probably find that they will not run. 

You can find out more about Java technologies by visiting the Java.com web site).

Other types of non-standard web content
There are other types of non-standard web content (ie, items and file types which are not just simple text and graphic content which, 
although not specifically classed as “multimedia” that we should perhaps mention here. Below are some additional file types which are 
often used in web design.

PDF 
PDF (Portable Document Format) is an Adobe format for electronic documents. Electronic documents created as PDF files can be 
transferred via the web for viewing and printing locally. Older browsers required specific Adobe plug-ins to offer full functionality, but 
all modern browser can now handle PDF files so they can be displayed within the browser window and/or downloaded to the visitor’s 
computer.

Using Freeway you can offer visitors a link on a web page which can download the PDF or view it within a browser window (if their 
browser supports this). To do this, you should read through the KnowledgeBase articles on the Link to PDF Action (see: http://www.
softpress.com/kb/questions/340/ (to offer the link as an HTML text link) and the Graphic Link to PDF Action (to offer the link as a 
graphic item, such as a button).

Note: It is very important to note that drawing a graphic item on your page and then importing a PDF file (or dragging and dropping a 
PDF file onto a Freeway page) will not offer the PDF for download or viewing in a browser. Because Freeway supports the importing of 
PDFs as graphic file types, using those methods will simply import the first page of a PDF file and then, by default, Freeway will output 
the graphic as a JPEG by default. Because of this, if you want to specifically offer a PDF file for download or viewing in a browser, you 
must use one of the above Link to PDF Actions. 

Scalable Vector Graphics (SVG)
SVG is an XML-based vector graphics format developed by Adobe in association with the World Wide Web Consortium. In many ways 
similar to Flash, SVG supports layers, transparency, raster effects, and scripting. Currently, SVG has not been widely adopted, but is still 
used occasionally as an alternative to Flash animations.

Most mainstream browsers require a plug-in to support SVG. However, native support for the standard is in Firefox 1.5 and above and 
various other Mozilla-based browsers (see http://www.croczilla.com/svg). For more information about SVG, see  
http://www.adobe.com/svg/

An SVG file can be imported into an HTML box, but Freeway will treat it as pass-through plug-in content. As such, there is little control 
over the published output from within Freeway.
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Your content may be top notch but it’s of no benefit if visitors can’t navigate through your site. It is essential that you consider 
navigation as an important part of the planning of your site. 

To allow the visitor to navigate your site, you must define hypertext links (hyperlinks). A hyperlink can be applied to a selected run of 
text or to any box you have drawn in Freeway, with the exception of HTML text boxes. 

When creating navigation, you can set up links either between pages in the same document or to external pages and other objects 
anywhere on the web, using hyperlinks defined within Freeway. You can also define the browser window in which your linked file will 
open. 

There are many types of hyperlinks and this chapter will introduce you to all of them. The most important ones to begin with are the 
links that you create between pages in your document. 

Note: If you want to set up a full-featured navigation bar for your site you might want 
to look into using the CSS Menus Action. This Action makes it very quick and simple to 
build a drop-down-and-fly-out navigation bar you can use on all your pages to help visitors 
find their way around the pages of your site—even if you have some pages used as sub-pages 
of different sections of your site. You can read more about how to build a CSS Menu in the 
dedicated section at the end of this chapter

Linking between pages in your document 
Prior to laying out your pages, you should define the structure of your site; that is, what pages should be linked and how you want users 
to be able to navigate. Defining site navigation often starts when creating the basic layout of your web pages. To ensure that navigation 
is consistent and easy is one of the main tasks carried out when defining master Pages. 

Actually, creating the links to other pages can be done at any stage during the design process. If the destination page already exists in 
the document when you wish to link to it, you can simply choose it by name from the list of existing pages. If the destination page 
does not yet exist, you can create it as you define the hyperlink. This is called linking to a new page. 

When defining a link to a page in the same Freeway document (referred to as an internal link), it does not matter what the title of 
the destination page is, or what the filename of the destination page will be. In Freeway, pages in the same document are internally 
referenced as objects, and internal links are defined as being links to a page object whose title and filename may change before the 
site is exported. This provides you with a considerable amount of freedom and flexibility in the way you create your site, as you can 
continue to change the page titles and/or filenames right up until the site is published, without fear of breaking the links you have 
carefully defined. 

When the pages are published as HTML, the internal links are converted to explicit references to the actual page filenames as shown in the 
Inspector palette. 

Linking to external pages 
Sometimes you need to define a link to a page that is not part of the same Freeway document. When you do this, you must type or 
copy/paste a reference to that page into the Edit Hyperlink dialog yourself. To do this, you can either refer to the external page with an 
absolute reference, using its complete URL (Uniform Resource Locator), or with a relative reference, if the destination page is on the same 
web site as the source page. 

When entering external references, you must take care that the spelling and case used for external filenames is exactly the same. 

Absolute references 

If you use an absolute reference, this specifies which web server the destination page resides on, the exact path to it, and its filename. If 
you are linking to a page that is held on a different web server to the one your source page is on, you must use the absolute reference, 
specifying the complete URL. Here is an example of such a URL: 

http://www.robotsfrommars.com/my_folder/page1.html

This URL describes a page called page1.html, contained in the directory my_folder, on the web server www.robotsfrommars.com. No matter 
where the source page is located on the web, this link will always succeed if the destination page remains in the same location.

Relative references 

If you use a relative reference, then there is no mention of the specific server the destination page is on, and the link will assume that 
the source page and the destination page are on the same server. This method is of great advantage if you wish to have the flexibility to 
move the pages to a different location, without having to change the links. 

For example, if a customer has commissioned some pages and you wish to test them on your own server before giving them to the 
customer to put on their own web site, it may well be best to use relative references. Remember that this only applies if the source and 
destination pages are not part of the same Freeway document. 
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Here are three examples of relative references: 

1 	 page2.html 
2 	 marketing/index.html 
3 	 /marketing/index.html 

The first example would be used to link to a page with a filename of page2.html which resides in the same folder (“directory”) as the 
source page. If you move either the source page or the destination page to a different directory, the link will break. 

Example 2 would be used to link to a page with a filename of index.html which resides in a directory called marketing, which in turn 
resides in the same directory as the source page. If you move the source page to a different location from the directory marketing, then 
the link will break; but you can move both somewhere else together. 

The third example would be used to refer to a page with a filename of index.html which resides in a directory called marketing which is 
contained in the top level (or “root directory”) of the same web server. You can move the source page anywhere on the web server and 
the link will still work, but the link will not work if you move the source page to a different web server or if you move the directory 
marketing so that it is no longer in the root directory. 

It is also possible to have a relative link which includes references to parent directories. For example, this would be required to establish 
a relative link to a resource in another directory at the same level. From a page in a directory called marketing, to a page called sales.html, 
in a directory called sales, that resides next to the directory marketing: 

	 ../sales/sales.html 

Using the double dot (..), it is possible to refer to a higher level directory without specifying its name. In this case, “..” refers to the 
directory which contains both the sales and marketing directories—we don’t need to know its name. 

	 ../../charts 

This refers to a directory called charts, which is one level higher than the sales directory. 

For more information about managing links like this, see Managing your site on page 140.

Types of hyperlink 
As mentioned before, there is a wide variety of types of hyperlink, and you can specify any of these within Freeway’s Edit Hyperlink 
dialog when defining an external link. 

Here is a brief description of the different types of hyperlink: 

•	 file: A reference to a file on the local hard disk of the computer which is running the web browser. Use this to specify a local file 
when pages are to be viewed locally, not served by a web server. 

•	 ftp: A reference to a file held on an FTP server. 

•	 http: A reference to an HTML page or other object which is held on a web server. 

•	 https: A reference to an HTML page or other object which is held on a secure web server. When a web browser loads a page from a 
secure server, the information sent between the browser and the server is encrypted so that third parties cannot intercept or read it. 

•	 mailto: A reference to an email address. When the browser is configured correctly, clicking on a mailto link will automatically launch 
the selected email client application on the visitor’s computer and create a new blank email, addressed to the email address specified in 
the link. 

•	 news: A reference to a newsgroup stored on an Internet News server. When such a link is activated, the browser will attempt to launch a 
news reader and link to the default news server, if one is specified. 

Freeway also offers gopher, telnet, tel, and wais hyperlink protocols. 

When defining absolute references to external objects served by your web server, you must specify the protocol “http”; however, you 
must omit the protocol for relative references. 

If you have entered text into the text field, then subsequently specify or change the protocol, Freeway intelligently preserves your text 
and prefixes it correctly with the new protocol. 

Creating hyperlinks 
Within Freeway, hyperlinks may be applied to any run of text (which can be either HTML text or GIF text) or to any box drawn with 
Freeway’s drawing tools, except HTML text boxes and form controls. 

This section shows you how to: 

•	 Define an internal link to an existing page using the Edit Hyperlink dialog. 

•	 Define an internal link to an existing page using the internal links popup menu. 

•	 Define an external link using the Edit Hyperlink dialog. 

•	 Create a new page as you link to it. 

•	 Drag and Drop hyperlinks into Freeway. 

•	 Remove hyperlinks. 
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To define an internal link to an existing page  
using the Edit Hyperlink dialog 
1.	 Highlight the text, or select the box to which you wish to apply the hyperlink. 
2.	 Either: 

choose Hyperlink… from the Edit menu. 

 
Or:  
click on the globe icon at the bottom of the document window.  

3.	 Select a page from the list of Internal pages and click OK.  

The default HTML link style is underlined blue. 
Hyperlinked graphic items are marked with a 
small blue globe icon in the top left corner.

4.	 The link will be indicated by blue, underlined formatting for HTML text, OR by displaying a link icon in the top left corner of boxes, 
as appropriate. 

The link will be displayed, using the page title you have given to it in Freeway, in the hyperlink area at the foot of the document 
window when the linked text or box is selected.  

To define an internal link to an existing page using the Link popup menu 
1.	 Highlight the text or select the box to which you wish to apply the hyperlink. 
2.	 Click on the Link popup at the bottom of the document window, and select a page from the list of existing pages.  

3.	 The link will normally be indicated by blue, underlined formatting for text, or by displaying a link icon in the top left corner of 
boxes, as appropriate. The link will be displayed in the status line at the foot of the document window when the text is highlighted 
or the box is selected.

For more information about how to change the styling of HTML text hyperlinks, see Hyperlink styles on page 118.
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To define an external link using the Edit Hyperlink 
dialog 
1.	 Highlight the text or select the box to which you wish to apply the 

hyperlink. 
2.	 Either:  

choose Hyperlink… from the Edit menu. 
Or:  
click on the globe icon at the bottom of the document window. 

3.	 Select the External tab, and type or copy/paste the link reference 
into the text field provided. 

4.	 The link will be indicated by blue, underlined formatting for HTML 
text, or by displaying a link icon in the top left corner of boxes, as 
appropriate. The link will be displayed in the status line at the foot of 
the document window when the linked text or box is selected. 

Power Tip: If you have numerous email and URLs in your web site which 
you wish to apply frequently, Freeway stores the URLs in the Quick Links 
popup menu. 

To define an external link using the Link popup menu 
1.	 Highlight the text or select the box to which you wish to apply the 

hyperlink. 
2.	 Click on the Link popup at the bottom of the document window, 

and select a link from the External submenu. This lists external 
links that are already used in the document.

3.	 The link will be indicated by blue, underlined formatting for HTML 
text, or by displaying a link icon in the top left corner of boxes, as 
appropriate. The link will be displayed in the status line at the foot of 
the document window when the linked text or box is selected.

To create a new page as you link to it 
1.	 Highlight the text, or select the box to which you wish to apply the hyperlink. 
2.	 Either:  

choose Hyperlink… from the Edit menu. 
Or:  
click on the blue globe button at the bottom of the document window. 

3.	 Select the New Page… button and if you wish, choose a different master page on which to base the new page. 
4.	 Name the new page and click OK. 
5.	 The link will be indicated by blue, underlined formatting for HTML text, or by displaying a link icon in the top left corner of boxes, 

as appropriate. The link will be displayed in the status line at the foot of the document window when the linked text or box is 
selected. 

Drag and drop hyperlinks 
You can drag and drop hyperlinks from HTML text displayed in some browsers. You can drop the link onto graphic boxes in Freeway, or 
onto the link area at the bottom of the document window.

To copy the hyperlink to a box in your Freeway document, open a web page in your browser and find the text hyperlink you want to 
copy. Before you drag the link, you will need to create a graphic item in Freeway and arrange the windows of the browser and your 
Freeway document so that you can see both the link in the browser and the box in Freeway. 

Point to the linked text in the browser and drag it onto the item in your Freeway document. The URL representing this hypertext link 
is copied to your Freeway document, applied to the item and displayed in the hyperlink area at the bottom of the document window 
when you switch back into Freeway.

Links cannot be dragged directly onto a text selection within Freeway, but you can apply links to text by selecting the text and then 
dragging the link onto the link area at the bottom of the document window. 

Removing hyperlinks 
You can remove a hyperlink by highlighting the text or selecting the box in question, then going into the Edit Hyperlink dialog as above 
and click the Remove Link button. Alternatively, choose No Link from the hyperlinks popup menu at the bottom of the document 
window.
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Viewing and selecting hyperlinks defined for a 
page 
To view the hyperlinks in a document, choose Show Links from the  

 menu at the bottom of the Site panel. The links defined on each 
page will appear listed below the page. Links are shown as underlined. 
Clicking any link shown in the Site panel will select the text or item 
which bears the link and scroll that area of the page into view within 
the document window.

Defining the target window 
To define the window in which a linked file will open, set a “target” 
for the link in the Edit Hyperlink dialog. For a description of how to 
do this, please see Targeting links on page 196. 

Note: In Freeway Pro, if the page HTML level is set to HTML 4.01 Strict 
or XHTML 1.0 Strict link targeting is not possible as it is not valid code for 
these output levels.

The Target popup refers to how the linked page or anchor should be 
displayed (rather than which page is being targeted by a specific link). 
Two of the four target attributes are most commonly used (but not 
exclusively) with framesets, while two others are commonly used to 
control whether the linked page opens in the same browser window or 
browser tab as the link itself or whether it displays the linked page in a 
new browser window/tab. If you click on the Target popup you will see 
the following options:

•	 Parent Frame: This gives the link the target attribute of _parent, 
which means that the linked content will display in the parent of 
the current frame where the link is set. Note that if the frame where 
the link is set does not have a parent frame, the entire frameset will 
be displayed when the link is clicked on (which effectively 
means it works in the same way as Topmost Frame—see 
below). 
  This can also be used to make a link which is used in an 
iFrame to open the linked content in the main page on which 
the iFrame is used rather than being constrained with the 
iframe.

•	 Topmost Frame: This gives the link the target attribute of 
_top, which means that the linked content will display in the 
entire frameset rather than within a specific frame.

•	 New Window: This gives the link the target attribute of 
_blank, which means that the linked content will open in 
a new browser window or browser tab. Whether the visitor’s 
browser opens the link in a new window or tab will ultimately 
depend on how the visitor has their browser preferences set 
(the default for most browsers is to open in a new tab rather 
than a new window). 
  Most web designers use this attribute for external links (i.e., 
links which are outside of the home website) because it leaves 
the original website window open in the browser’s row of tabs.

•	 Current Window: This gives the link the target attribute of 
_self, which means that the linked content will open in the 
same browser window as the original link. 

Viewing hyperlinks on 
a page using the Site 
panel. Clicking the 
link will select the text 
or item that bears the 
link.
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Image maps 
Rather than creating a link on an entire graphic, it is possible to create links so that the visitor is taken to a different destination depending 
on which part of the graphic is clicked. This is called an image map. Freeway uses map area items to define such “hot-spots”; these are 
shown with purple outlines and cannot hold content or be given any fill or border. You draw map areas using the map area drawing tools 
in the Toolbar or Tools palette. 

Note: Freeway Express does not have a separate Tools palette.

Creating an image map 
Image maps are easy to define within Freeway by creating hot-spots over the areas of 
the graphic you wish to link to somewhere else. 

1.	 Import a graphic and position and size it as you wish. 
2.	 Draw a map area item over each part of the graphic you wish to be a hot-spot. 
3.	 Assign each map area item a unique hyperlink as described previously. 

You can create hotspots using one of the three map area tools: rectangle, oval, and 
path. Freeway creates client-side image maps, which are fully supported by most 
modern browsers. 

Note: If you apply a link to a graphic item that is exported as part of a 
combined image, the link will be recreated using an image map in the output.

Hyperlink styles 
When hyperlinks are displayed on HTML text in a web browser, they are normally shown in color and underlined to set them apart 
from normal text that is not linked. If you do not specify otherwise, the link colors set in the browser will be used. 

There are four colors and styles that may be displayed for any piece of linked HTML text. These are: (1) normal: the color and style of 
links that have yet to be visited, (2) visited: the color and style of links that have already been visited, (3) hover: the color and style of 
links when the mouse cursor is hovering over them, and (4) active: the color and style of links when they are clicked on. Web browsers 
remember which pages have been viewed in the past, and by changing the color of visited links they can show visitors what is yet to be 
explored. 

It is important that link colors contrast clearly against the page background or the visitor may find it hard to read the text or difficult to 
make out where the links on a page are located.

The default colors used by web browsers typically stand out against a white or gray page background but do not show up well against, 
for example, a dark or black background. You must use your judgement, and when you feel that it is necessary, specify your own colors 
to be used for linked text. However, users tend to expect hyperlinks to be blue and underlined. 

Setting hyperlink styles for a page 
You can set the styles for each of the four link states using the Links section in the Page Appearance panel of the Inspector palette. To 
ensure that the same styles are used across a range of pages, you can set this on the master page used by those pages. 

On the page or master page in question: 

1.	 Display the Page Appearance panel in the Inspector palette. Click on the disclosure triangle next to Links to show this 
section, if it is not already open.  

The Links section of the 
Inspector palette is not 
disclosed by default. Click on 
the disclosure triangle next to 
the Links label to show the 
options. Freeway Pro (left); 
Freeway Express (right).

Map areas can be 
drawn as rectangles, 
ovals, or paths.
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2.	 Choose an appropriate color and style for normal links (Link), visited links (Visited), links that are 
underneath the mouse cursor (Hover), and links that are being clicked on (Active). 

In Freeway Pro, the underline button has three states: on (dark gray), off (light gray), and undefined 
(white). When underlining is undefined, its actual state is determined by the inherited or default style. 
To access other link style options in Freeway Pro, click on the More button.

Any HTML text within the Freeway document which has a link applied will be displayed in the color 
and style set for Normal. GIF text will not show this feedback in Freeway or in the browser. 

Setting hyperlink colors for an item 
In Freeway Pro, you can set link styles for any CSS item. This is useful if you wish to have different link styles on different parts of a page. 
To set link styles for a CSS item:

1.	 Select the item and display the Item Appearance panel in the Inspector palette. Click on the disclosure triangle next to Links 
to show this section, if it is not already open. 

2.	 Choose an appropriate color and style for normal links (Link), visited links (Visited), links that are underneath the mouse cursor 
(Hover), and links that are being clicked on (Active). To access other link style options in Freeway Pro, click on the More button.

In Freeway Express, you can use the Text Link Style Action to set link styles for individual boxes. This Action also allows you to set link 
styles for non-CSS items.

Testing navigation within Freeway 
As you define the navigation between pages in your site, it is essential that you test it as you go along to ensure that the links go to 
the correct places and the navigation is smooth. You can do this while previewing the pages in your web browser but you can also test 
internal links from within Freeway.

To follow internal links within Freeway 
1.	 Highlight the text or select the box which has the internal link you wish to test. 
2.	 Choose Follow Link… from the Edit menu or Command-click on the link in the hyperlink area at the bottom of the document 

window. 
3.	 Freeway will switch to the destination page. 

To test external links, you must preview the site in a web browser. 

Managing links 
The Edit URLs dialog is used to manage the external links used in 
your document. It allows you to view and modify the links without 
the need to find each one and manually update it. 

Select URLs… from the Edit menu to display the Edit URLs dialog:

The URLs are listed in alphabetical order. 

To edit a URL, select it in the list and click the Edit… button. A 
dialog will appear allowing you to type a new URL. Modify the URL 
and press OK when you have finished. 

To delete a URL, click the Delete button or press the Delete or 
Backspace key. The right column will read: “[Deleted]”. 

To check that a URL is valid, click the Check button. (This assumes 
you are connected to the Internet. If you are using a dial-up 
internet connection, Freeway will attempt to dial up and connect.)

When you have finished editing the URLs in your document, 
press OK to apply the changes. If you press Cancel, none of your 
changes will be applied. 
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Anchors 
Using links between pages, you can allow visitors to your site to navigate from one page to another. When a new page is loading into 
the browser window and it is longer than can be shown in the window, a scroll bar will normally appear to allow the visitor to scroll 
down the page to any point they desire. 

This is usually exactly what is needed—however, on long pages it is often useful to allow visitors to navigate directly to a particular 
point on the page, rather than the top. Anchors provide a means of allowing this. 

What are anchors? 
An anchor is a way of marking a vertical location on a page, and this location can then be referenced as a specific destination when you 
are creating links to that page. 

When someone follows a link that includes an anchor reference, the destination page will load and automatically scroll to the position 
of the anchor if that location is not already visible in the window. 

Why use anchors? 
Anchors are useful on long pages. If there is some information to which you’d like a link, and it’s half way down the page, an anchor 
will take the user directly to it. 

You might also offer links at the top of a page, which will scroll to headings that appear further down. This can be used as a sort of 
dynamic table of contents to allow easier navigation within the current page. 

It’s also common practice on long pages to offer links back to an anchor at the top of the page. This way it is easier for the visitor to 
return to the top when they have finished reading—these links are often found at the end of each section in a long page, as well as at 
the foot of the page. 

How do anchors work? 
At each vertical location which you’d like to become a target destination, an anchor must be defined. When you define an anchor, you 
do so by giving it a name. Every anchor should be given a unique name, so that no two anchors within the same page share the same 
name. Each anchor can then be referenced as the destination of a link by using its name.

Once anchors have been defined within a Freeway document, they will be available for linking. You start by defining a link, which 
simply points to the page itself as normal, but you then have the option to additionally specify any anchor that has been defined 
within that page. You can also link to anchors on external pages. 

When defining anchors, it’s usually a good idea to give them descriptive names. Although it’s often quicker and easier to simply use 
different numbers or letters for the names of your anchors, meaningful names can assist visitors as they navigate your site. 

Meaningful anchor names help visitors to navigate because as the visitor moves the mouse over a link in their browser, the destination 
of the link will usually appear in the status bar of the browser window, or as a help tag under the mouse cursor. This will display the 
name of any anchor specified. Careful naming of anchors will help the visitor decide whether they wish to follow the link. 

For example, if you have some HTML text giving contact information at the bottom of one of your pages, you can create an anchor on 
the text and give it the name “contact”. You might link to this contact information from other points on the page or from other pages. 

Defining anchors within Freeway 
In Freeway, you can place an anchor on any run of text in an HTML item or on any graphic item. It is not possible to apply an anchor 
to an HTML item.

To define an anchor 
1.	 Highlight the text or select the item you wish to bear the anchor. 
2.	 Choose Anchor… from the Edit menu or press Shift-Command-a to bring up 

the Define Anchor dialog. 
3.	 Type a name for the anchor. 
4.	 Click OK. 

The anchor will now be available in the anchor popup menu when you are defining 
links to that page using the Edit Hyperlink dialog. 

Viewing and selecting anchors defined for a page 
To view the anchors in a document, choose Show Links from the  
menu at the bottom of the Site panel. The links and anchors defined on 
each page will appear listed below the page. Anchors and links are shown 
with an underline. Clicking any link or anchor shown in the Site panel 
will select the text or item which bears the link or anchor and scroll that 
area of the page into view in the document window.

To edit an anchor 
1.	 Highlight the text or select the item that bears the anchor. 
2.	 Choose Anchor… from the Edit menu to bring up the Define Anchor dialog. You should see the name of the anchor displayed in 

the dialog. 
3.	 Edit the name and click OK. 

The anchor “fourth page#top” 
appears in the links shown for 
“fourth page”.
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The anchor will be updated with its new name and all links in the same document that refer to that anchor will be automatically 
updated to reflect the change. If you have already linked to the anchor from outside the document, you will need to edit these 
external links manually to reflect the change. 

To remove an anchor 
1.	 Highlight the text or select the item that bears the anchor. 
2.	 Choose Anchor… from the Edit menu to bring up the Define Anchor dialog. You should see the name of the anchor displayed in 

the dialog. 
3.	 Click Remove Anchor button. 

The anchor will be removed and will no longer show in the anchor popup menu. 

Note: When working with anchors on text, if the text selection is not exactly the same as it was when 
the anchor was defined, you may get unexpected results when editing or trying to remove the anchor. If 
the selection includes additional text which was not part of the original selection, you will see a hyphen 
(–) indicating that there is a mixture of attributes specified for anchor. Alternatively, if you do not select 
all the originally highlighted text, the anchor will not be completely removed from the page.

Linking to anchors 
Within the same Freeway document 

You can create links within Freeway by using the Edit Hyperlink dialog, or by using the popup menu at the bottom of the document 
window. You can link to any existing anchors on a particular page only from the Edit Hyperlink dialog. 

Linking to anchors using the Edit Hyperlink dialog 

1.	 Highlight the text or select the item you wish to bear the link. 
2.	 Choose Hyperlink… from the Edit menu to bring up the Edit Hyperlink dialog.  

3.	 Using the scrolling list, choose the page containing the anchor to which you wish to link.
4.	 Using the Anchor popup menu, choose the anchor on the destination page to which you wish to link and click OK. 

The name of the anchor takes the form of the page title, followed by a “#” symbol and the anchor’s name.

To remove a link to an anchor 

1.	 Highlight the text or select the item that bears the link. 
2.	 Select <None> from the Anchor popup menu in the Edit Hyperlink dialog to remove the link to the anchor, leaving only a link to 

the page. 

Removing items that have anchors attached to them 

When an item (or text) that bears an anchor is deleted—either directly or by a page/folder/master being deleted—a dialog will appear 
warning you that all links to this item will be removed. Clicking OK will delete the item and remove all links to it in the same 
document. Clicking Cancel will leave your document unchanged.
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Email links 
Email links allow you to define a link that, when clicked on by the user, creates a new mail message in the user’s email application with the 
“To:” field filled in with the details you specify in the Email link. An Email hyperlink is defined by the mailto protocol. 

Encoded email addresses 
Freeway automatically encodes email addresses, in HTML text and in links, to make them less accessible to spam harvesters. Encoded 
addresses can still be read by humans and web browsers, of course, and are a limited defense against more sophisticated spam harvesters.

In Freeway Pro, this feature can be turned off using the Output pane of the Document Setup dialog. 

Useful Freeway Actions for Hyperlinks
There are many Freeway Actions which can be used to help you build a navigation bar (which can be used on every page as the main tool 
for choosing pages to visit) and also to help with styling the color and underline behavior, especially if you want to over-ride the page-level 
Link Styles covered earlier in this chapter.

The CSS Menus Action

Freeway offers a powerful yet quick and simple way to create reliable and elegant “drop-down-and-fly-out” navigation menus using CSS—
making them quick to load, fast in operation and Accessibility-friendly for visitors with disabilities. The menus will even display if the 
visitor has JavaScript turned off in their browser.

The CSS Menus Action is applied to an HTML item and this item must only contain “list” text. To create a CSS Menu, draw an HTML item 
on your page, go to the Inspector, open the List panel at the foot of the General Settings tab of the Inspector by clicking on the disclosure 
triangle on its header bar and click on the right arrow once. Any text you type will now be formatted in the HTML list style. Don’t worry 
about entries in the list displaying with bullets, they won’t display with bullets in the finished CSS Menu.

A “nested list” is text within a list which has varying list levels applied. The level of a list item 
determines whether the word(s) of a list entry will be used as a main menu, a submenu or a 
submenu of a submenu, etc., of the CSS Menu. If you want to make an entry in your list a 
submenu of another, simply click on the right arrow again in the List panel of the Inspector.

To go back a level in your list you need to click on the left arrow in the List panel of the Inspector. 
Each click will take you back a level. Note that clicking on the left arrow when you are currently in 
the base level of a list will turn your text back into normal text (ie, not a list).

Text with the base level list styling (which is the level that will be used for your main menu items 
in your CSS Menu) displays with a round black bullet. Clicking on the right arrow button in the 
List panel will display text in the next list level which is indented further from the left and has 
white circle bullets with a black outline. Clicking again on the right arrow in the List panel will 
display text indented further from the left and the text will have square black bullets in front of them.

In the screenshot right, you can see the hierarchy of the nested list for a photography web site. The 
list entries “Welcome”, “Services”, “Galleries” and “Contact” are base level list items, so they will 
display in the finished CSS Menu as main menu items.

In the screenshot, the entries for “Weddings” and “Portraits” are second level list entries and, 
because they appear immediately underneath “Galleries”, they will appear as a submenu of that 
main menu item.

The entries for “Adults”, “Children” and “Pets” are third level list entries which will appear as 
submenu items of “Portraits”, which in turn is a submenu of “Galleries”.

After entering the text for “Pets” (which is a third level list item) it is necessary to click the left arrow in the List panel of the Inspector 
twice to go back two list levels, so that “Contact” is a base level list item.

You can see how this will look in the finished CSS Menu in the first screenshot in this article (above).

Linking and styling a CSS Menu
Now that the hierarchy for the list is done, links need to be established for each menu entry to the appropriate page in the site. To do this, 
you need to create a page for each menu item you want to display as a link.

Once that’s done, you’ll notice that linked text now displays in blue with an underline—you can ignore this for now as the CSS Menu 
Action will take care of the color and underline behavior of text in the navigation bar.

To style a CSS Menu, it’s important that you only apply Font, Size, Style and Align attributes to the text in the Inspector - all other styling 
(link color, underlining, etc.) is controlled by options applied in the CSS Menus Action (Note: Pro-users can use Pro-specific styling or a CSS 
text style to apply additional styling to a CSS Menu item, but take care not to apply a color or underline attribute to the text as this will 
conflict with the CSS Menu Action).
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Applying and setting options for a CSS Menu
The CSS Menus Action is applied to the item by selecting it, going to Item>Actions and choosing CSS Menus.

As soon as the Action is applied to the item, you’ll see a message displayed on the item 
itself stating that you need to publish your file to see a preview of the CSS Menu—this is 
because the HTML for the menu needs to be generated so a preview can be displayed.

With the item selected, open the Actions palette to see that there are two panels of settings 
which control how the menu will behave—Main Menu Settings and Submenu Settings—
and these are chosen by clicking on the popup at the very top of the Actions palette. 
As you would expect, the Main Menu Settings refer to the settings of the menu items 
displayed when you first see the page in a browser, and the Submenu Settings refer to the 
submenus which appear when you move your mouse over menu items with associated submenus.

Main Menu Settings options
The default layout of the CSS Menus Actions palette is shown here. Click on the disclosure 
triangles for each section to view all the options. Sections with checkboxes need checking for 
options to become active.

•	 Highlight Current Page: Setting this option will give the site visitor a visual reference of 
which page they are currently viewing. After turning this on, you will be able to set a value 
for the Current Page in the Links and Background sections.

•	 Text Direction Right to Left: Set this if your menu is using right-to-left text.

Size and Shape section

•	 Layout: This offers the choice of a vertical or horizontal layout for the main menu items. If you choose Horizontal, an option 
appears called Use Content Width which will make main menu widths relative to the width of the text within it.

•	 Alignment: This controls the alignment of the CSS Menu within its container item.

•	 Width: The width of each “cell” of the main menu can be given in Ems (a measurement relative to the size of HTML text) or in 
Pixels (a fixed width) by choosing the unit of measurement in the Units popup. Width values can be set to one decimal place for 
Ems, but a Pixel value must be a whole number. Note: Using Use Content Width (above) will render Width inactive.

•	 Padding: This controls the amount of space around the text in each main menu “cell”. By adjusting these values you can position 
your text within the menu cell. Adding to the padding value for top and bottom will increase the height of a menu cell.

Links section

•	 Link: This controls the color of link text within a CSS Menu cell in its normal state. Note that 
you will only see this take effect once links have been established.

•	 Hover: This controls the color of the text within a CSS Menu cell when it is moused over.

•	 Click: This controls the color of the text within a CSS Menu cell in its clicked state (ie, when 
the click button on a mouse is depressed).The three link states above each have an Underline 
option to the right of their color popups.

•	 Current Page: This option will only appear in the Links section if the Highlight Current Page option is checked in the Main Menu 
Settings. This controls the color of the text for the main menu cell of the page currently displaying in the visitor’s browser.

Background section

The options in this section will be greyed out until the Background checkbox is checked. The 
colors here apply to the background color of the CSS Menu cell in the normal, mouseover and 
click states.

All the popups in here are exactly the same as those in the Links section—the main difference is 
that there is a different option to the right of the popups.

•	 Use Image: This offers the choice to import a graphic to use as a background to a menu cell 
in each state. With the option checked, two new options appear underneath:

•	 Image: Click on the popup and choose Select... to choose the graphic you want to use for your menu item background.

•	 Repeat: The left popup controls whether the imported graphic “tiles” horizontally and 
vertically (xy), horizontally only (x), vertically only (y) or doesn’t tile at all (None). The right 
popup controls the position of where the graphic initially appears in the menu cell.

•	 Current Page: If the option is checked in the Main Menu Settings this popup can be used to 
apply settings to the background of the Current Page menu cell.
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Border section

The options in this section will be greyed out until the Border checkbox is checked. Here you can choose a border for the overall area of 
CSS Menu. Note that if you want to apply a dividing rule between individual menu cells, you need to use the options in the Item Divider 
section.

•	 Custom Borders: By default, the border will be applied all around the CSS Menu—but 
you can check this option to display a popup for each border edge where you can apply a 
different border or choose to have a border only on specified edges.

•	 Border: This popup allows you to choose a color for the border.

•	 Style: In addition to a solid rule border, you can choose from a selection of different border styles, such as Dotted or Double.

•	 Size: Here you can choose from a selection of preset pixel widths for your border.

Item Dividers section

This section offers options to display dividing rules between the individual cells of the menu.

•	 Top/Bottom or Left/Right: Depending on whether you chose a Vertical or Horizontal 
layout for your CSS Menu in the Size and Shape Section, the popups here will show either 
Top and Bottom (for a Vertical menu) or Left and Right (for a Horizontal menu). Use these to 
choose a color for one edge or both (or choose None).

•	 Style and Size: As with the Border section, you can choose from a selection of different dividing rule styles.

Arrows section

When a main menu has a submenu, or if a submenu has a further submenu, it can be useful to give the visitor a visual reference so they 
know that there are more choices available if they hover the mouse over the menu item (see an example on the screenshot at the start of 
this article). In this section you can choose to automatically apply a preset arrow graphic to the menu cell for this purpose—or you can 
import a custom graphic.

•	 Style: Click on this popup to choose from a selection of preset colored triangles, or choose 
Custom Files... to activate the File popup below, where you can choose Select... to import a 
custom graphic.

•	 File: This popup is greyed out and inactive unless Custom Files... is chosen in the Style 
popup.

•	 Offset (px): This value controls the offset in pixels for the position of the arrow graphic from the right-hand edge of the menu cell 
(or left-hand edge of the cell if using right-to-left text).

Submenu Settings options

The options in the Submenu Settings panel are almost identical to the Main Menu Settings�. The main differences being that you have 
options for Submenu Direction and Use Main Menu Settings. The only other difference is that there are fewer options in the Size and 
Shape section—which is because many options are pre-determined by those used in the Main Menu Settings.

•	 Submenu Direction: There is an option (mainly for those using Right to Left languages) to display any submenus to the left of a 
parent menu cell.

•	 Use Main Menu Settings: Checking this will copy across the options chosen for your main menus. If you want to use different 
widths, colored menus, etc., for submenus, leave this unchecked (though this will mean entering all the options again in the 
Submenu Settings panel). Note that using Use Content Width in the Main Menu settings can cause issues with this option.

Previewing your CSS Menu
Once all the options are set for the CSS Menu, you can now publish the file to create a preview image which will give you some idea of 
how the menu will look when viewed in a browser.

If, as suggested earlier, you created the CSS Menu on a normal site page (rather than a Master page), you can simply go to File>Publish site 
to see a preview of how your menu will look.

If you created your CSS Menu on a Master page, you will see a message inside the menu item on the page stating “Live Preview not 
available on Master Page”. To see a preview of how the menu looks, click on a site page created from that Master. To make edits to your 
menu, remember to go back to the Master page again so the edits will take effect on all site pages created from that Master.

If you want to test your CSS Menu and all of its links, you will need to preview the file in a browser.

CSS Menu troubleshooting tips
Softpress Support occasionally gets queries from new users who can’t get their CSS Menu to work as they want or who have particular 
issues. Let’s look at some of common queries and their solutions:

Query: Why are some (or all) links in my CSS Menu appearing with underlining when the option isn’t checked in 
the CSS Menus Action?

Solution: This is almost always because there is some Color or Underline styling applied to the text in the CSS Menu. Double-click on the 
item to show the text, select all the text in the menu, go to Style>Remove Styling, reapply just Font and Size attributes (plus Align if you 
want anything other than the default Left align) in the Inspector’s General Settings tab.

If the above doesn’t fix the problem, check you don’t have any Links styling applied to the page. To check this, make sure nothing 
is selected on the page, go to the Links panel in the Paintbrush tab of the Inspector and make sure all states display as None and the 
Underline buttons display as white (if they don’t, click the buttons repeatedly to toggle them back to white).
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Freeway Pro users may find they have a custom CSS text style applied to the text in the menu. This style may contain attributes which 
conflict with the options chosen in the CSS Menus Action itself. Removing the styling using the method above should solve this.

Query: Why do the submenus of my CSS Menu appear behind other items on my page?

Solution: In Freeway Express the submenus of a CSS Menu will always appear above any other content on a page. However, if you are 
using “layer” items in Freeway Pro (perhaps by having your CSS Layout button switched on), it is possible that items on your page are 
above the CSS Menu item.

To fix this, select the CSS Menu item and make it a layer (if it isn’t already a layer item) by switching on the Layer option in the Inspector 
and then going to Item>Bring to Front.

Query: Why can’t I get the widths of my submenus to display correctly in the CSS Menu?

Solution: The most likely reason for this to happen is if you have the Use Content Width option checked in the Main Menu Settings and 
you also have the Use Main Menu Settings option checked in the Submenu Settings.

You need to be aware that the Use Content Width option cannot be made to work for submenus. If you have the options switched on in 
the Main Menu Settings, you’ll need to uncheck the Use Main Menu Settings option in the Submenu Settings and manually apply the 
submenu options.

The Text Link Style Action
To set up the links styles for your page (or site) we recommend you use the Links panel at the foot 
of the Inspector’s Paintbrush tab (see earlier in this chapter on page 118). If you set up the links 
styles for your Master page(s) this will be applied site wide. The Text Link Style Action lets you set 
different color and underline behaviour for the links contained within individual HTML items, as 
styles chosen here will overwrite the styles set in the Links panel for any HTML item this Action is 
a applied to (or is a child item of).

To use the Action, select an HTML item which contains text hyperlinks, go to Item>Actions 
and choose Text Link Style. With the item selected on the page, you can see the options in the 
Actions palette (note that the Actions palette varies between Express and Pro—the screenshot 
right is how it looks in Express):

•	 Normal: This controls the link color and underline behavior of the link text when it is in its 
normal state (ie, when it displays on the page without being moused over and without that 
link being visited previously). Click and hold on the Color button to see the list of color in 
your site or choose Other… to choose a new color.

•	 Visited: This controls the link color and underline behavior of the link text when it has been used previously (in that browsing 
session). Click and hold on the Color button to see the list of colors in your site or choose Other… to choose a new color.

•	 Hover: This controls the link color and underline behavior of the link text when it is in its “hover” or “MouseOver” state. Click and 
hold on the Color button to see the list of colors in your site or choose Other… to choose a new color.

•	 Active: This controls the link color and underline behavior of the link text when you have the mouse button held down on mouseover 
(so that the link is being clicked on). Click and hold on the Color button to see the list of colors in your site or choose Other… to 
choose a new color.



Note: We strongly recommend that you use the Sitemapper Action on your Freeway file if you want to get the best search 
engine results for your site. See the section at the end of this chapter called “The Sitemapper Action” for further details.

Meta tags
Applying meta tags 
Unseen by visitors to your site, meta tags play an important role in enhancing your site’s effectiveness. The most important use of meta 
tags is to make it easier for potential visitors to find out more about your site and what it can do for them. Without the correct meta 
tags to help search engines to bring visitors—no matter how well designed your site or how compelling the content—the chances of 
making a big impact are greatly reduced. 

Meta tags added to an HTML page are not visible when viewed in a browser, but they can be seen when viewing the HTML source code. If 
you are new to web publishing, it’s a good idea to visit some sites that are similar to the one you are going to design and view their source 
to see how the designers have used meta tags. You’ll find that successful sites and those created by professional designers will usually have 
well specified meta tags, whereas those created by novices or casual web publishers won’t. 

There are many potential uses for meta tags, but here are some of the more common ones: 

•	 Describing the content of a page. 

•	 Listing keywords which relate to the page. 

•	 Storing the name of the author of the site. 

•	 Storing the name of the software used in the site creation. 

•	 Loading a different page automatically. 

The most important uses are the first two—it is the content and keywords which have the most effect on the ability of Internet search 
engines to correctly store and retrieve your site in response to user queries. 

Be sure to define the description and keywords meta tags correctly for the home or index page for your site, so that you will get the 
most benefit from search engines. 

Should you tag all your pages? 
Opinions differ on whether it is a good thing to add description and keywords tags to every page in your site. It is probably best though 
to define these tags only for the home or index page. The reason for this is that once your site becomes live and has been indexed by 
several search engines, references to your site may abound in the outside world and will be largely outside your power to change. This 
becomes a problem if you subsequently move or rename the pages which are referenced by outside agencies, as the links to your site 
will be broken and people will find it far less easy to get to your pages. The one page which will always be there in the future and whose 
name is unlikely to change, is the home page. 

Another reason is that you generally want visitors to come through the front page so that they will see any new information you have 
added since the last time they visited. 

How to add meta tags in Freeway 
Meta tags are added to pages in Freeway using the Meta Tags… 
command on the Page menu. If you want particular tags to 
appear on more than one page, consider adding the meta tags to a 
common master page. 

Here is an example of a meta tag:  
<meta name="GENERATOR" content="Freeway Pro 6.1.2">

This tag is added to every page that Freeway Pro creates by default 
(but note that the version number will change according to the 
version of Freeway you use at the time of publishing your file). 

When you choose the Meta Tags… command in Freeway, it 
displays the Meta Tags dialog box, which is divided into two 
parts: User and System (HTTP-EQUIV). 

You can add new tags to either of these parts using the New…, 
Delete, and Edit buttons.

Meta Tags and Search Engines
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Defining a new meta tag 
To define a new meta tag for a page: 

1.	 Choose Meta Tags… from the Page menu. 
2.	 Click Add to define a new tag. This displays a new Name and Content field, which allows you to define a new Name/Content pair. 
3.	 Type the text you wish to appear for NAME or HTTP-EQUIV as appropriate in the Name text field. 
4.	 Type the text you wish to appear for CONTENT in the Content text field. 
5.	 Click OK to return to the Meta Tags dialog. 
6.	 Either click Add to define another tag or click OK to accept the changes. 
7.	 When you preview or publish the site, the tags you defined will be added to the HTML output for the page. 

Defining the description of a page 
When the search engines bring up a list of found sites that relate to the search criteria entered by a user, they often have the option to 
display a description of what the site contains. If you have defined a DESCRIPTION meta tag, the contents of this are used to describe 
your site in the found list. If you haven’t, then the listing may either display no information beyond the URL and page title or it may 
display the first sentence or two of text from the page. 

To define the description of your page: 

1.	 Change to the page on which you wish to include the description. 
2.	 Choose Meta Tags… from the Page menu. 
3.	 Click Add to define a new User Variable tag. 
4.	 For Name, type the word “description”. 
5.	 For Content, type a sentence or two describing your site. 
6.	 Click OK to return to the Meta Tags dialog. 
7.	 The next time you preview or publish the page, your tags will be added 

to the output. For example:  
<meta name=description content=Softpress Systems, home of 
Freeway Express and Pro> 

Defining keywords that describe your site 
In the past, keywords were recommended to be added to sites so search engines could identify terms that are relevant to the words or 
phrase entered by a web user—but these days Google and Yahoo virtually ignore the keywords meta tag (possibly because they have 
been abused over the years).

Some of the other search engines, however, may still take notice of 
keywords, so to define keywords for a given page: 

1.	 Change to the page on which you wish to include the keywords. 
2.	 Choose Meta Tags… from the Page menu. 
3.	 Click Add to define a new User Variable tag.
4.	 For Name, type the word “keywords”. 
5.	 For Content, type relevant keywords, separated by commas and spaces. 
6.	 Click OK to return to the Meta Tags dialog. 
7.	 The next time you preview or publish the page, your tags will be added 

to the output. For example:  
<meta name=keywords content=Freeway,Web,Design, 
Software>

Note: Search Engine Optimization (SEO) is a very specialist area and the search 
engine companies regularly change the rules they operate by—so unfortunately 
there is no way to guarantee SEO success by simply applying meta tags to your 
pages. There is no substitute for creating a site with most of the text content used 
as HTML text (so it can be indexed by search engines) and for it to be well written 
with relevant terms.

Loading another page automatically 
Using a particular meta tag, REFRESH, it is possible to cause web browsers to reload the page after a certain delay; and adding a different 
URL to the meta tag allows the loading of a different page automatically. 

This tag is commonly used when a popular page or site has moved to a new location. Frequently, a special page is left in the old location to 
inform people of the change and asks them to update their bookmarks. This page can be used to transfer the visitor automatically to the new 
page, after a preset delay. 

This redirect technique is also used as a special effect, where on entering a new site, a “splash page” is displayed for a few moments 
before automatically entering the main page of the site. 

The easiest way to implement page redirection in Freeway is with the Timed Redirect Action (see the KnowledgeBase article at http://
www.softpress.com/kb/questions/367/), but the following is an alternative using meta tags: 
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1.	 Change to the page in the site you wish to add the tag to. 
2.	 Choose Meta Tags… from the Page menu. 
3.	 Click to the System HTTP-EQUIV tab.
4.	 Click New… to define a new tag—these use the syntax HTTP-EQUIV rather than NAME. 
5.	 For Name, type the word “REFRESH”. 
6.	 For Value, type the following text, substituting the number “5” with a different delay in seconds if desired, and replacing the text 

“nextpage.html” with the URL to which you wish to transfer the visitor:  
5;URL=nextpage.html 

7.	 Click OK to return to the Meta Tags dialog and click OK again. 
8.	 The next time you preview or publish the page, your tags will be added to the output. For example:  

<meta http-equiv=”REFRESH” content=”5;URL=nextpage.html”>

Finding out more about meta tags 
There is a great deal more to learn about meta tags, their origins, and their use—one of the best resources is the following:  
http://vancouver-Webpages.com/META/ 

Search Engines

Getting noticed on the web 
In the seemingly endless expanse of the web, search engines play an important role in bringing people to your site. In fact, apart from 
other methods such as costly advertising, a search engine is the main way to get those coveted hits. 

This short guide will show you how to construct your site to use the search engines to your advantage and provide a few hints and tips 
for getting your site listed—but please be aware that we do not offer full support for Search Engine Optimization (SEO) because it is a 
specialist field and the rules change regularly.

The four main factors are: 

•	 Meta tags 

•	 HTML style attributes

•	 Page content

•	 Submitting to search engines 

Tagging the page 
First, we will talk about tagging the page. To make a site “search-engine friendly”, you need to have two tags attached to the page: 
description and keywords. Adding these is simple in Freeway; simply go to the Page menu and select Meta tags…. Here you need to add 
two tags: 

•	 Description 

•	 Keywords 

These two tags are used by most search engines as a base for evaluating your site. For example if you were a car dealer, then your 
description and keywords tags may be similar to this: 

<meta name=”DESCRIPTION” content=”Car Dealer selling audi, saab, and other cars”>  
<meta name=”KEYWORDS” content=”cars, car dealer, audi, saab etc...”> 

When a search engine comes across a web page it uses the page’s description tag to define what the site is about and the keywords tag 
for matching the terms used in a search. If someone does a search for “car dealer”, then the search engine would list your site based 
on the above entries. However, where your site appears on that list is another point that needs to be taken into consideration. 

Improving your rank 
Having an effective page title (see Page title and file name on page 25 and strongly constructed keyword and description tags can help with 
your search engine ranking. To make an effective tag, you need to use a few techniques that apply to a wide selection of search engines. 

Let’s say that we are the car dealer in the previous example and we are situated in the UK. We would construct our tags to look 
something like this: 

•	 Page Title: UK Car Dealer, selling a wide selection of Audi, Saab, Volvo, and more 

•	 Description tag: UK Car Dealer selling a wide selection of Audi, Saab, Volvo, Vauxhall, Ford, and many other types and models. 

•	 Keywords tag: UK Car Dealer, audi, saab, volvo, vauxhall, ford, renault, bmw, uk cars, cars in the uk, etc. 

HTML style attributes
Currently, search engines are giving greater weight to HTML text styles, since meta tags have been abused in the past to falsely enhance 
ranking. To help to improve your site’s search engine friendliness, the use of <h> and <p> tags is recommended. For more information on 
using HTML tags in Freeway, see Freeway’s Default Styles on page 155. 
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Page content
Notice that we use the same phrase within each of the three tags: “UK CAR DEALER”. The reason is that when a search engine reads 
through the tags, it will pick up that key phrase (or “keyword”) and note it as being more relevant to a match for that particular search. 
The other point to note here is that if the content of the page does not have the keyword “UK CAR DEALER”, then the search engine will 
give it less emphasis than a site that does. So you need to construct the page to include that phrase more than once but not so obviously 
that you are pushing it—search engines can tell if you are trying to “spam” them, that is, attempting to attain a higher ranking by being 
sneaky. 

Noframes content 
The Noframes content section of a frames page (see Noframes content on page 191) can serve you well when submitting your site to 
a search engine. If you use a frameset, make sure that you also have a Noframes section. Here you can add a description of your site 
in addition to your keywords. It’s also a good policy to tell the visitor why they are viewing that page instead of the complete site. 
Don’t just leave them staring at a blank page or a chunk of text that says, “Sorry, your browser does not support frames.” Here, a good 
description of your site will also be helpful, because the search engine will register this text. Furthermore, if the Noframes section 
contains links to the body of your site, a search engine may be able to follow the links and still access the content of your site. 

Important points 
Don’t excessively repeat the same word in your tags. Search engine evaluations are not case-sensitive, so if you’ve used the phrase “car 
dealer”, you shouldn’t enter “Car Dealer” as well. 

Try to keep your description tag under 150 characters long. Even though some search engines will allow more than that, most do not. 
Although some people say there is a limit to the amount of times a particular word can appear, you will probably find that if you are 
using your words carefully, you will not be penalized for repeats. If you have several choice phrases, you can use them in your keywords 
tag. 

For keywords, use a maximum of 950 characters. You can’t be too long-winded! 

Don’t use lots of hidden text within your page (i.e., text in the same color as the page background) and fill the page with keywords; a 
search engine will just ignore it, or downgrade your listing, and it will add size to your page. 

Try to submit a page under 100K. If the page is full of text and all of your main words are contained near the end of the page source, 
then the chances are it will be ignored. The search engine may only read the beginning of your page and not actually reach the content. 

How to submit your site to search engines
There are supposedly thousands of search engines out there, but because they tend to share data, submitting to all of them will be 
counterproductive and time consuming. There are services that submit your page to a search engine for you, but that process is 
automated, so if a search engine is down at the time of submission or the “add URL” feature was experiencing problems, then the 
chances of your site being submitted are slim.

Because of this, Freeway offers a method of letting the main search engines that your site has been updated and is available to be 
indexed. This is done by using the Sitemapper Action on your Freeway file—details of which are at the end of this chapter.

Once the Action has been applied to the site, each time you update your site the search engines will be “pinged” to alert them that new 
content is available to be indexed.

Shared databases 
The above list comprises just a few of the thousands of search engines that are available. But remember that if you are listed within the 
majority of these, then you are likely to be listed in many other search engines. 

Many search engines and directories also use other search engines’ databases. By submitting a site to the “master” search engine 
database, you will ensure your listing appears elsewhere. For example, searching with HotBot will offer a choice of using Ask or Google; 
Direct Hit and Lycos both use the Ask database, while Net Find uses Google.

Google currently appears to be the most popular search engine, as a search bar is included as standard in many recent browsers. Although 
there is a direct URL submission link system, this simply ensures your web site isn’t missed by Google’s automated “spiders”. By ensuring 
your site has good keywords, page content, and descriptive page titles, it will eventually be “spidered” and entered into the Google 
database. Much has been written about how you might be able to influence the Google rankings, and search engine optimization (SEO) 
has become a complete industry in its own right.

Also note that DMOZ—the Open Directory Project—is gaining popularity. This directory relies on human review of your site 
submissions within whatever category you have elected. To be listed by DMOZ is beneficial. Be descriptive with your site in a directory 
but don’t just fill it with keywords; you will be penalized or possibly excluded completely. 

Another point to note is that you need to allow time for your submissions to appear with a search engine. When submitting a site to a 
search engine or directory, check to see the estimated time, which can usually be found within the “Add URL” page in the site’s “Help” 
section. If it estimates two weeks to list your site, and it does not appear after this period, leave it for a few more days and submit the 
site again. If you still can’t get it listed, then go to the help section and email the search engine’s “Support” address with your problem. 
You will be amazed at how helpful they can be. 

For more information on search engines, see: 

http://www.searchenginewatch.com/

Also of interest is:

http://www.searchengineguide.com/

http://www.thehelpful.com/befound/
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The Site Mapper Action
Internet search engines need to index the content and pages of a site in order to assess the relevance of a site so it can best match the 
terms used in the search. You can help this process along by creating a “Sitemap” file (not to be confused with another term used to 
describe a list of pages often used to help visitors find their way around a large, complex site).

A Sitemap file is an xml file which can be submitted to search engines so they can be given information about the page structure and 
links of your site. Previously, this was something which needed to be done manually after the site had been uploaded and at regular 
intervals thereafter, but now Freeway 6 has made the process a lot simpler and quicker.

The new Site Mapper Actions can be set to create and upload the xml file with the rest of your site files and particular pages can have 
their details submitted at set frequencies or with a specific priority. You can also choose which search engines you wish to submit the 
Sitemap file to.

Applying the Site Mapper Folder Action
You need to apply the Site Mapper Action to the Site Folder in your Freeway file. First, however, you will need to enter the web address 
(where the site will eventually be available once it is uploaded) in the Upload panel of the Document Setup dialog. If you apply the 
Action without entering a web address you will see a prompt in the Actions palette telling you to set up the URL.

To enter the URL go to File>Document Setup, click on the Upload tab, enter the URL in the Web Address field and click OK.

After setting up the URL the Actions palette you can now select the Site Folder in 
your Site Panel (the folder at the top of list of site pages, immediately underneath the 
line below the Master page(s). To do this, select the Site Folder, go to Page>Folder 
Actions and choose Site Mapper from the list.

After the Folder Action has been applied, you will see an alert in the Actions palette 
telling you that you need to apply the Site Mapper File Location Action to a page in 
your site (this is so the sitemap file will point to a specific page).

Select the page you want to use as the main sitemap page in the Site Panel (this is 
normally your home page), go to Page>Page Actions and choose Site Mapper File 
Location (note that there are no options for this Action in the Actions palette). Now 
you can set up the Site Mapper Folder Action by selecting the folder which has the 
Action applied.

In the Actions palette you will see a few options. The XML sitemap checkbox lets 
you switch on or off the generation and uploading of the Sitemap file.

Below this is a popup and slider to set the frequency and priority for all the pages in 
your site (if you want to use frequency and priority settings  for individual pages, you 
can use the Site Mapper Page Action, which is mentioned later).

There is an option for compressing the Sitemap file into a gzip archive, which is best 
used for large sites as it can reduce the server bandwidth and required resources.

Below this is a panel (closed by default) which you can open by clicking on the 
disclosure triangle to the left of Submitting your sitemap to reveal a list of internet 
search engines and some options for submitting the file – which will be covered later. 
Leave this panel closed for now.

Finally, there is an option to submit a Yahoo URL list, which will create another file 
(called urllist.txt). This does a similar job to a Sitemap file, but is specific to Yahoo. 
This is best left switched on unless you have good reason for doing otherwise.
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Submitting your Sitemap
It’s best to apply the Site Mapper Action as you are working locally and then, once 
the site has been uploaded, you can submit the Sitemap to the search engines. To 
do this, select the folder which has the Site Mapper folder Action applied in the Site 
Panel in Freeway and open the Submitting your sitemap panel.

By default you will see that the list of search engines are checked by default (you can 
uncheck individual ones if you wish). Check the checkbox to the left of Yes, the site 
has been uploaded to the web server (which will make the button below active), 
then click the Submit site map button. This will “ping” the checked search engines to 
notify them of the location of your Sitemap file.

Clicking the Submit site map button will open a browser window where you will see 
the progress of notifying each of the search engines. Once the process is complete you 
can close the browser window.

Applying frequency and priority to individual pages
Applying the Site Mapper Action to your Site Folder will generate a Sitemap file for your entire site which has the same settings for every 
page. You can, however, use different settings for specific pages of your site by applying the Site Mapper Page Action to those pages.

To do this, go to your page then go to Page>Page Actions and choose Site Mapper. The Actions palette for the Site Mapper Page 
Action is a cut-down version of the Folder Action you applied to the Site Folder.

Any frequency and/or priority settings made in the Site Mapper Page Action will over-ride those settings made in Action applied which 
has the Site Mapper Action applied.

Excluding specified pages from the Sitemapper Action
There may be times when you wish to exclude specific pages of your site from the 
.xml file generated by the Sitemapper Action. A new option has been added to the 
Sitemapper Page Options Action in Freeway 6 which can now do this on each page 
you wish to exclude.

•	 Make sure nothing is selected on your page and go to Item>Actions and choose 
Sitemapper Page Options.

•	 Check the Remove this page from the Sitemap checkbox to exclude the page 
(see screenshot above).



Previewing, publishing, and uploading
Once you have designed your web pages, you will want to get them 
uploaded to your web server space in order for the world to see. 
This section looks at previewing, publishing, and uploading your 
pages. 

Preview options
Freeway offers a variety of page previewing options. The Preview in Browser command (Alt-Command-b), located under the File 
menu, publishes the whole site as HTML and displays the current page in a web browser, whereas the Preview in Freeway command 
(Alt-Command-p), located under the View menu or by clicking the Preview button near the top left of the window, previews just the 
page you are working on. 

While you’re working in Freeway, you are already working in a kind 
of preview or “WYSIWYG” mode—Freeway does its best to show you 
what you will see in the browser itself, assuming default browser 
settings. However, there are several other options that Freeway 
provides you to give more detailed information on what will happen 
in the output. 

Previewing text 
If you wish, you may change the default display fonts in Freeway using the Text 
option in Document Setup. This way you can approximate what a visitor will 
see if their browser is set to display fonts differently from the default font settings. 
Remember that many visitors will have increased the font size in their browser in 
order to make on-screen text easier to read. 

An important issue to remember is that text may look substantially larger when your pages are viewed using Windows browsers. This 
is because the nominal screen resolution of a Windows computer is 96 ppi (pixels per inch), whereas the typical screen resolution of a 
Macintosh computer is 72 ppi. 

To preview roughly how your text will look when viewed under Windows if you don’t have access to a Windows PC, increase the type 
size by using the browser’s controls until the text is as large as it will go. Alternatively, set the font size to 16 pixels in the browser’s 
preferences. This can give you an idea of where any problem areas may occur on your page, but it is not a substitute for previewing in a 
proper PC browser. 

Anti-aliasing 
When you publish your page using text or colored boxes as GIF graphics, there is a likelihood that any curved or diagonal edges will 
appear jagged on the screen, owing to the low resolution of the pixel grid used to display computer video. This jaggedness is called aliasing 
and leads to unprofessional-looking graphics. 

Professional image-editing software is used to create bitmapped graphics that do not display this jaggedness, using a procedure called anti-
aliasing. This method smooths jagged edges by blending the colors of the pixels along the edge. 

Anti-alias off

Anti-alias automaticAnti-alias off Anti-alias automatic

These images have been 
magnified to show the effect 
of anti-aliasing.

Graphics created by Freeway are automatically anti-aliased by default, although you may turn the function off if you wish (see Export 
formats on page 99). Freeway offers you the chance to preview what they will be like—without exporting the graphics—by turning on the 
Graphics Preview command. 

Note: In Page view, Freeway automatically renders graphic fonts with a form of anti-aliasing 
so they appear smooth at various magnification levels. Turning on Graphics Preview will 
cause text and images to appear blocky at zoom levels above 100%. 

Publishing and Uploading

Note: Freeway’s internal Preview does not support working 
hyperlinks. It will preview rollover effects, target images and give 
you a good impression of how the page will appear in a proper web 
browser, but it is recommended that for serious testing you should 
always preview in a browser.

Note: Under normal circumstances, the default 
settings in the Text section of Document Setup 
should not be changed unless there are specific reasons 
to modify them.

Important Note: There are known issues and incompatibilities with 
Microsoft Internet Explorer versions 5 and 6 which mean standards 
compliant web pages may not display correctly.
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Previewing graphics 
Any text or object to be exported with anti-aliased edges will be 
displayed with its edges softened artificially. It is worth turning on 
the Graphics Preview to see a more accurate view of your page 
while you’re creating it. It uses a bit more memory than normal to 
display the page, and slows performance slightly, though it’s not 
normally noticeable. 

When you import any graphic (with the exception of images 
imported as “pass-through”—see Pass-through graphics on page 105), 
Freeway uses the original as a basis for a completely new exported 
version. In the process, Freeway offers you precise options that can 
be used to adjust the compression, interlacing, color palette, and 
number of colors in the resulting exported graphic. However, these 
options may have a profound effect on either the final file size, the 
appearance of the resulting image or both; and it’s useful to have 
feedback on these two factors when adjusting the options provided. 

When adjusting images with the Inspector palette’s Item Output panel graphics controls, in order to preview the effect of your 
changes in real-time, the Graphics Preview command can be used. When you turn on Graphics Preview, all the graphics in the page 
go through the entire export process and are then displayed for you in position on the page, just as they would appear in the browser.

Graphics previewing can take a few seconds, depending on the processor speed of your Mac, during which time a “checkerboard” 
pattern may be displayed over graphics being processed. Graphics are displayed individually after they have been processed. Using the 
Item Output panel of the Inspector palette, you may adjust the image controls. When you change an option, the graphic will be 
updated and redrawn. Significant changes, such as changing from GIF to JPEG or panning the graphic within its box, may cause the 
display to temporarily revert to the checkerboard pattern again. Once the graphic is displayed, the Size option in the Item Output 
panel reports its exact size in bytes. 

You can use Graphics Preview to help optimize images in your page. Turn on Graphics Preview, then make adjustments to the quality 
level (JPEG), or number of colors used (GIF and PNG). You will see the effect of the adjustments in your page, so you can get the quality 
set for the best looking image at the smallest overall file size.

At any point while Graphics Preview is calculating, it can be 
interrupted—for example, to turn it off again, move elements, 
or carry out any other action. However, once it has been 
interrupted, it needs to restart the process from the beginning, if 
you allow it to continue. 

Graphics Preview requires quite intensive processing and can 
use a fair amount of memory. It can also slow down your work 
in Freeway to unacceptable levels (especially on older G3 iMac 
and iBook computers), so it’s recommended that you only turn it 
on when you need to work with the graphic output options and 
turn it off again when you’re finished.

HTML layout 
In Freeway, when working with table layouts (in Freeway Pro this means with the CSS button off), it is possible to place an HTML item 
in front of a graphic item. When you do this, the HTML item slices the graphic item behind it, revealing the page background color or 
background image—this is how the output will appear in a web browser. 

Note: Freeway Express does not support CSS layers and works in table 
layout mode only.

Upon publishing your site, Freeway slices the underlying image appropriately and exports it in sections, holding them together in 
the HTML. The HTML text will expand in two directions to fill the 
available space defined by the size of the HTML box. If the text 
becomes too large in the browser, the area occupied by the HTML 
box will expand. This can cause problems in some circumstances—as 
the HTML box expands, it will force apart the cut segments of the 
“underlying” image. 

Enabling the HTML Layout option from the View menu can help 
avoid this problem—Freeway displays the cuts made to images (if 
any) as light blue lines; and where an HTML box may potentially 
cause problems, the danger zone is indicated by red arrows. These 
arrows indicate the areas where your design may break if the text size 
used in the browser is too large. 

If Graphics Preview is turned on graphic text will  
appear blocky in page view when zoomed in for detailed work.

With HTML Layout on, 
problem areas of overlapping 
items that may break in a 
browser are highlighted by 
red arrows.
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You may find that designs will break on Windows PCs even 
though they seemed robust at the largest text point size on a 
Macintosh. This is because, on the Windows platform, the font 
can be set to an even larger size than it can on a Mac. When 
creating commercial work, it is essential to view your pages using 
browsers under Windows.

Note: When viewing under the HTML Layout 
option, it’s best to switch off Outlines in the View 
menu; otherwise, the HTML table outlines could be 
confusing.

HTML layout with the CSS button on (Freeway Pro only) is 
unlikely to encounter layout splitting, since each item is held on 
its own discreet layer with relation to other items on the page. 

Previewing in a browser 
Previewing your work in browsers is an essential part of creating your site. It’s important to test your pages in several browsers to make 
sure they appear as you expect. For example, your page may look different in Safari and Firefox. This is down to differences in the way 
that web pages are rendered in the different browsers. While Freeway attempts to give you the best preview possible while working 
inside Freeway, this is actually a compromise between how the pages will look in several of the more popular browsers. 

It is also important to check how your pages will look when 
viewed on Windows PCs. Equivalent font sizes are displayed 
approximately one-third larger in Windows compared with 
the Macintosh, and this can potentially cause problems. If 
you don’t have access to a PC, you can view your pages in 
Internet Explorer with the fonts set to their largest size, or set 
the font size to 16-point instead of 12-point in your browser’s 
preferences. This will give an approximation of what may happen under Windows. 

Freeway maintains a list of browsers on your computer to make it easy to preview your work in the browser of your choice. When you 
first launch Freeway, it compiles a list of currently installed browsers. You can subsequently add or remove browsers from the list, or 
have Freeway check for any changes to your installed browsers and update the list automatically. 

You can also choose which browser you wish to preview in most often and set that as your default browser. This is also the browser that 
will be used when you use the keyboard shortcut for previewing the current page in a browser. When you first launch Freeway, it sets as 
the default browser the one that is the system default browser. 

Maintaining the browser list 
1.	 Choose Preview Setup from the Preview submenu in the File menu. 
2.	 Freeway displays a list of browsers on your system and shows a check 

mark next to the default browser: 
Click New… to add a new browser to the list. 

To remove a browser from the list, select it and then click Delete. 

To update a reference to a browser, select it and then click Edit…. Locate 
the browser in its new location and click OK. 

To set one of the browsers as the default, select it and then click in the 
Default column. 

To have Freeway automatically update the list with any new browsers, 
click Update. 

3.	 When you’re done, click OK. 

To preview the current page in the default browser, press Alt-Command-b. 

Viewing your document’s HTML 
There are two ways to view the HTML that Freeway generates:

•	 Preview the page as normal in a browser. Then from the browser’s View menu, choose to view the source (all browsers use the word 
“source”, even though the command may be worded differently). 

•	 Within Freeway, choose a text editor (such as BBEdit) as a browser. Follow the procedure for adding a browser (discussed above in 
Maintaining the browser list) but choose your text editor of choice. 

In either case, when viewing the HTML, make sure to choose 
More Readable from the HTML code popup menu in the 
Output panel in the Document Setup dialog.

On the left is how we might expect 
the previous image to preview in a 
browser. On the right is what happens 
when the browser’s text is enlarged.

Note: Internet Explorer Mac is no longer installed as standard with new 
Macs, and Microsoft has not supported it now for well over ten years—so 
it is no longer considered to be a reliable testing tool. Older or obsolete 
browsers, however, can sometimes be found on the Evolt.org web site: 
http://browsers.evolt.org.

Note: If you choose a text editor as a browser, make sure to close the file 
in the text editor before attempting to republish the site. If the file remains 
open, Freeway may not be able to overwrite it when you republish changes.
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Refreshing the browser—when the browser misrepresents what’s on the page 
Browsers often “cache” images, potentially causing display anomalies when you preview sites more than once from Freeway. The effect 
can be most problematic when you are working with frames (see Working with Frames on page 187), rollover, or target images (see 
Rollovers on the Softpress Knowledgebase). The solution is to “refresh” or “reload” the page in the browser. 

To do this, choose Reload or Refresh from the browser’s View menu, click the Reload or Refresh button on the browser’s tool bar or press 
Command-r. You may also have to force the browser to refresh 
by holding the Alt key while refreshing. If this doesn’t work, go 
to the browser’s Preferences and in the Advanced section, clear 
the cache. Quitting and restarting the browser may also help. 
Some browsers let you set the cache to 0MB.

Publishing the site 
When you publish your document, Freeway outputs any pages or images that have been changed since the last time the site was published, 
ensuring that the site folder contains a complete and current version of your site. 

To prevent the site folder from becoming clogged up with out-of-date files, Freeway ensures that any files that are no longer needed for 
the site are removed each time you publish. If you need to change your site folder at any point, you can use the Document Setup… 
command on the File menu (see Document Setup: Site folder on pages 231–2 for more information). The next time you preview the site, 
Freeway will generate a completely new version of all the files. Freeway stores information about what files should be in the site folder 
using a small file called “_siteinfo” which also resides in the site folder. Site folder information is also stored in the Freeway document 
itself. 

When you’re ready to publish your document to the web, Freeway can upload all the required files to your server. 

The three commands related to publishing your site are: 

Publish: Updates the site folder with any changes. 
Preview: Updates the site folder and loads the current page in a web browser. 
Upload: Updates the site folder and then transfers all the required files to your server. 

Whenever you make changes to the original Freeway document, you will need 
to republish the site using one of the above commands so that these changes 
are reflected in the site folder. 

When you change the contents of a page or create a new one, the Site panel 
displays a bullet point beside its icon in the palette to show that it needs to 
be rebuilt. 

The HTML code that Freeway generates can be customized using the Output 
settings in Preferences. You can choose whether to make the HTML more 
compact or more readable, and whether HTML tags are output in upper- or 
lowercase; you can also set how any layout tables are reinforced and select 
the type of line feeds that will be used. You can also do this on a page-by-page basis using the Page Output panel in the Inspector 
palette.

Setting the site folder 
The site folder can be set in the New Document dialog when 
creating a new document or at any other time using the 
Document Setup… command on the File menu. However, if 
you haven’t set your site folder at all, you will be prompted to 
create one the first time your site is published using the Publish, 
Preview, or Upload commands. 

Freeway displays a Choose a Site Folder dialog, allowing you 
to navigate to a folder of your choice or create a new one. When 
the dialog displays the name of your chosen folder, click the 
Choose button to set it to be your new site folder. 

Publishing a fresh version of your site 
Occasionally, you may wish to create a completely new version of your site. You can do this in two ways. Either choose a new site 
folder using the Document Setup… command on the File menu or use the Publish Everything command. Publish Everything forces 
Freeway to completely regenerate your site HTML from the document and is a useful way of ensuring that everything is up-to-date. 

To use the Publish Everything command, hold down the Control key and choose Publish Everything from the File menu. 

Power Tip: When working with rollover or target images, you may refresh 
the mouseover image in the browser by holding the cursor over the rollover 
item and then pressing Command-r to refresh the image.

The Site panel shows 
pages that have been 
modified and need 
republishing marked with 
bullet points.
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Force republish 
To force a particular page to be published the next time you publish, choose Force Republish from the 
Page menu. A bullet point will appear beside the page’s icon in the Site panel.

Choosing between efficient and readable 
HTML 
You can choose whether the HTML generated for your site is 
as efficient as possible for quick downloading or slightly less 
efficient but easier to read. 

By default, Freeway outputs HTML with indents and line breaks 
so it is more readable. If you want to make Freeway create more 
efficient HTML, without any line breaking or other “white 
space” characters to achieve the most compact file size, choose 
Document Setup… from the File menu, click on the Output 
button and choose More Efficient from the HTML code popup 
menu. 

To preview your site in a text editor (such as BBEdit or 
TextWrangler) instead of a browser, see Viewing your document’s 
HTML on page 134. 

Line feeds 
Freeway offers three options for the line feed characters it 
produces: Macintosh, Unix, or DOS. Selecting the appropriate 
platform will allow the HTML text files to be read more easily. 
These settings will not affect page display in browsers but may 
be important for CGI scripts and the like. 

To set the appropriate line feed characters, choose the Output 
button in Document Setup. In the Line feeds popup menu, 
select the desired operating system. The default setting is Unix.

Specifying whether layout tables are reinforced 
When you position non-CSS layer items on the page, Freeway Pro reproduces the design using invisible 
HTML layout tables. Freeway Express, which does not have the CSS layer option, always publishes designs 
using HTML layout tables.

These tables are automatically reinforced by Freeway to prevent possible collapse or distortion, produced 
by some browsers. Freeway reinforces using invisible single-pixel GIF images.

To turn off the layout table reinforcement for your whole web site, deselect the Reinforce layout 
tables checkbox in the Output panel of Document Setup. To turn off layout table reinforcement for 
individual pages, ensure nothing is selected on the page and deselect the Reinforce Layout checkbox in 
the Page Output panel of the Inspector palette.

Reuse of images 
When publishing your site, Freeway checks every image generated to see if an identical image has already been published. If so, Freeway 
won’t publish another copy of the image but instead will make an HTML reference to the first instance of the image. This results in 
much faster performance when your pages are viewed over the web. 

One implication of this automatic reuse of images is that you can’t always be certain that an individual graphic item will result in a 
corresponding image in the published Resources folder. A previously generated image may simply be reused instead. For more information, 
see File names on page 99.

Uploading 
Once your site is contained in its local site folder, the next stage is to upload the files to your web space. This may be a web server that 
you can access on your own network, but more often you’ll use File Transfer Protocol (FTP) to upload your files to a remote web server. 
Either way, you can use Freeway’s Upload… command to publish your site and make the changes live. 

Use the Document Setup dialog to set how readable the published 
HTML code is, set the preferred line feeds and whether layout tables 
are reinforced globally for the whole site.
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To publish your site on the web, choose Upload… from the File menu. Freeway will update the local site folder and then begin to 
synchronize the remote web space with your site folder. Freeway will recognize what has changed in your site and automatically transfer 
any files that need to be updated on the remote web space and clear out any redundant files or folders. Using a method other than 
Freeway for uploading relies on you to identify all the parts of your site that have changed and may therefore be less reliable. 

In order to make the connection to your web space using FTP, you need to know the server name and directory, and your username and 
password. If in doubt about these, speak to your web server system administrator or consult your Internet Service Provider’s web site or 
support helpline.

You can enter these details into the Document Setup dialog once you have created your document. 

Upload method 
A site can be uploaded using either File Transfer Protocol (FTP) or File Copy. Use the Upload popup menu in the Document Setup or 
Upload dialog to specify which upload method you require. 

A site located on a remote server, which can only be accessed over the Internet, will usually be uploaded using FTP—this will normally 
be the method to use if you rent or receive free web space from a web hosting service or from your internet service provider (ISP). 

A site located on a local volume (or on a server that is accessed using a local network), or on an iDisk volume other than the Sites 
folder, must be uploaded using File Copy. This will normally be the method to use if you have your own web server or if you will be 
publishing your site using your own computer and Personal Web Sharing (or similar software). Like FTP, File Copy determines any 
changes to your site and automatically uploads or deletes the changed files only. 

Setting the upload options 
Before you can use the Upload facility to update your active web site, you need to tell Freeway where this is located and the upload 
method you wish to use; you may also need to enter a username and password. You can do this using the Document Setup dialog or the 
first time you choose the Upload command. 

The upload settings—including the password, if you wish—are saved with your Freeway document. If you set the upload options and 
then save your file, they will be retained for future sessions. You will need to enter the upload settings again for every new Freeway 
document you create. 

To set the upload options 
1.	 Choose Document Setup… from the File menu. The Document Setup dialog appears. 
2.	 Specify the upload settings you require using the options in the Upload section. 
3.	 Click OK to accept your choices and return to the document. 

To set the upload options the first time you choose the Upload… command 
1.	 Choose Upload… from the File menu. The Upload dialog box appears. 
2.	 Specify the upload settings you require.
3.	 Click OK to tell Freeway to proceed with updating your remote site. The options you specify here will be retained and used the next 

time you choose the Upload command and will be saved with your documents. 

The Upload options dialog appears each time you choose to upload your site. 

Upload options for FTP 
When you choose to upload your site via FTP using the Upload command, you need to specify the following options: 

•	 Server 

•	 Directory 

•	 User name 

•	 Password 

•	 Web Address

From the Upload dialog you may also choose to use Passive FTP Mode, save an FTP log or enter your own scripts.

To find out the required information, you must contact the administrator or technical support department responsible for your web 
space. If you are renting web space or receive it free from an ISP, visit their web site or contact their support department. 

The information for uploading a site must be entered exactly—if there are any spelling errors, or the “/” symbol is confused with “\”, 
Freeway will not be able to upload successfully. Obtaining the information from your ISP’s web site or their support department via 
email will allow you to copy/paste the path directly into the required field in Freeway. If you have to type the information yourself, take 
care to type it exactly as specified. 

Server: This is the name of the FTP server to which you are uploading your site. Here is an example: 

	 ftp.softpress.com 

	 The address for the ftp server may be in domain-name format (as above) or in IP format (such as 236.26.122.7). It can also 
optionally include a port number (for example, ftp.softpress.com:21). 

Note: Server may also be called FTP server, hostname or host.
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Directory: In some cases, you may need to specify a directory as the location on the FTP server to which your files should be copied. An 
example is: 

	 homepages/~spaceworld 

	 Unfortunately there is no specific info that we can give here, as all web hosts use different methods. Some have the server set up so 
you upload the files into the base level of the web server (in which case the Directory field is left blank) whereas other hosts need 
you to enter a Directory with a name like “public_html“, “ht_docs”, “www”, “html”, or some other specified directory. You should 
refer back to the information sent to you by your host to see if you are 
required to upload the files to a specific directory.

	 Note that the directory must already exist on the server. 

User name: In order to complete the upload successfully, you must enter your user name—once again, take care to enter it exactly as 
given. You can enter it into the upload settings at the same time as you enter the other upload information or you can leave this 
option blank. If you leave the User name field blank here, Freeway will ask for you to enter it in a second dialog the first time you use 
the Upload command during a session, and the user name will not be saved within your document. If you enter your user name here, 
then Freeway will remember and reuse it, as it will be saved 
with your document. Normally, it’s best to enter it into the 
upload settings for convenience. 

Password: You must also enter your password before Freeway can upload your site but, as with the user name, you have the option of 
whether to enter it into the upload settings or leave the password field blank. If you enter your password into the upload settings, 
then Freeway will remember and reuse it, since it will be saved within your document (in encrypted form for security). This is less 
secure, because anyone who gains access to your Freeway document will be able to modify your active web site using the upload 
command. If you leave the password field blank, then Freeway will request the password in a second dialog each time you use the 
Upload command in a session, and it will not be saved with the document. 

Web Address: This field is used in conjunction with some Actions, specifically the Freeway Shop Actions suite.

FTP Mode: By default this is set to Automatic. If you experience problems uploading, try choosing Passive in this popup and then try 
again. If that doesn’t work, try using Non-Passive. 

Save FTP log: This creates a text file which is saved in a Freeway folder in ~username/Library/Logs/Freeway/FTP Logs. This file may 
be quite large, so unless you want a detailed record of Freeway’s FTP transfers, you should leave this turned off. If you are having FTP 
problems, Freeway’s support department may ask you for a copy. 

Script: In rare situations, your ISP may require you to enter certain FTP commands to access your site. Login scripts contain FTP 
commands that are sent to the FTP server after Freeway has logged in with the user’s name and password. This allows server-specific 
login commands to be sent (such as “ACCT” to specify an FTP account). 

	 Within a login script, each FTP command must be on a separate line, and the following line should specify one or more response codes, 
which the FTP server sends to indicate that the command has been completed successfully. For example: 

	 site group test1 
	 200 201 

	 sends the command ‘site group test1’ and waits for the server to respond with ‘200’ or ‘201’ to indicate that the command was 
successfully executed. If the server responds with a different code, this is interpreted as an error and the login is aborted. 

	 FTP commands can also include <input> or <password> tokens, which prompt Freeway to display a dialog asking for user input. For 
example: 

	 site group <input> 
	 200, 201

	 would cause Freeway to display a dialog asking the user to type the text which should be sent after ‘site group’. If the script contains 
<password> instead of <input>, this has the same effect, except that the text is displayed as bullets on screen and is also hidden in 
FTP log files. Only one <input> or <password> token can be included in each command. There is also a limit of eight tokens for the 
whole script. 

Upload options for File Copy 
The required options for File Copy are more basic than for FTP, as 
this option simply copies the site files to a specified folder on a local 
volume or to a folder located on a server on your network. 

Select: Freeway needs to know the location of the destination folder 
into which it will upload your site. Click the Select button and 
navigate to the folder you wish to choose as your destination 
folder for upload. If this is located on a server volume, you need 
to ensure that the volume is mounted before you set this for the 
first time. Freeway will remember the chosen destination folder for 
subsequent File Copy “uploads”.

Web Address: Some Freeway Actions require information on where 
the site will ultimately be located when it is live on the web, so 
you should enter the location (such as http://www.mysite.com/) 
so that information can be added to URL paths used by Freeway 
Actions.

Note: Directory may also be called path.

Note: User name may also be called user id or login name.
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Publishing your site on your own 
computer using personal web sharing
You can use the personal web sharing built into Mac OS X to 
host your web site from your own computer. In this case you 
upload your site using File Copy.

To turn on personal web sharing
•	 Open the Sharing panel in the Mac OS X System 

Preferences on your computer.

•	 In the Services tab, click to turn on Personal Web 
Sharing.

To upload files using File Copy
•	 From the File menu, choose Upload…, then choose File 

Copy from the Upload popup menu.

•	 Click the Select… button and browse to the location where 
you want to upload the site. In the case of using personal 
web sharing, this will be to the Sites folder in your user 
Home folder.

You can then access your site using the URL in the form of:

http://xxx.xxx.xxx.xxx/~myname/

where xxx.xxx.xxx.xxx is the IP address of your computer, and myname is your user name. This information is displayed in the System 
Preferences Sharing panel when you turn on Personal Web Sharing.

Alternatively, instead of using the IP address of your computer, you can use the local hostname, which is displayed beneath “Computer 
Name” in the Sharing panel of System Preferences, using the form of something like:

http://mycomputer.local/~myname/

where mycomputer.local is the local hostname of your computer.

Uploading your site using FTP, SFTP or FTPS
Your host will have given you instructions on how to upload your files to their web servers. Most commonly this will be by choosing 
the default FTP option in the Upload dialog—however, if your host has specified that you need to use a specific type of secure FTP 
(FTPS or SFTP) choose the appropriate type in the Upload dialog.

To upload your site 
1.	 Choose Upload… from the File menu. If you have not already specified the local site folder, Freeway will ask you to locate it before 

you proceed. 
2.	 Choose from either FTP, FTPS or SFTP in the Upload dialog.
3.	 You may have already entered into the Upload settings in the 

Document Setup dialog—if not, enter the required information for 
the Server, Directory, User Name and Password. 

4.	 Click OK to proceed with the upload. If all the information is correct, 
Freeway will now publish the site into the site folder first, to ensure 
that this is up-to-date with any changes made to your document. 

5.	 Before uploading, Freeway will ask for your name and password if 
you have not entered these in the Document Setup or Upload 
dialogs. If you enter your name and password at this stage, Freeway 
will remember your name for the duration of the Freeway session but 
will ask you for your password each time you connect. 

6.	 Freeway will now compare the files in the upload destination folder 
with those in the site folder and upload any files that have changed. 
It will also perform any housekeeping that is required, removing old 
files or folders which are no longer needed. 

Need help with what info to use in which field? 
Upload: Select the upload type, this will usually be FTP but if your 

hosts supports secure transfers then, depending on the method they 
support, choose FTPS or SFTP (you host should have specified which 
to use in their correspondence, if not choose FTP).

Note: If you have problems uploading to a secure server when choosing 
FTPS in the Upload popup, try de-selecting the Authenticate Certificate 
option in the Upload dialog (which is switched on by default) and then click 
OK to try again.
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Server: The address of your web server. An example of this looks like ftp.domainname.com, or in IP format 123.456.789.0. This is not 
the same as your web address (although it can sometimes look similar). Your web address is linked to a particular directory (folder) on 
your web server.

Port: This field should be left blank unless your host has specified a particular port number to use.
Directory: Some hosts require you to upload your pages into a specific directory (folder) on your web server.  If your host has not 

instructed you to use a specific directory (which may be called something like “public_html“, “ht_docs”, “www” or “html”) try 
leaving it blank.

Username: The username provided by your host.
Password: The password provided by your host.

Ultimately, if you can’t upload it is almost certain because you have entered incorrect information in one or more fields—in which case, 
you will need to check with your host to ask them what specific information you need to enter in each field.

How files are uploaded 
During the upload, Freeway displays a progress window to show how many files remain to be processed. You can stop the upload at any 
time by clicking the Stop button on the progress window. While uploading is in progress you can continue to work on in Freeway or in 
other applications. It is possible to perform two or more uploads simultaneously if you wish. 

During the upload process, Freeway copies any files which have changed since the site was last 
uploaded and deletes any files which are no longer needed. Files are also uploaded if they have 
been removed from the server or if their size and date does not match the size and date of the 
uploaded files. Files are not uploaded if they have not been changed. 

The upload process is carried out as a background task and the progress window will stay open 
even if you bring other windows in front of it. You can continue editing the document being 
uploaded, work on a different document or switch to another application. You cannot publish 
a document while it is being uploaded (the Publish option is disabled), but you may preview 
pages if they have not been changed since the upload was started (the Preview option is 
disabled for pages that have been changed). 

The progress window displays the number of items which remain to be processed (that is, 
compared and possibly uploaded to or deleted from the upload site), along with a progress bar and text showing the current operation. 
Two or more sites can be uploaded at the same time. 

If the progress window is hidden behind another window (such as a document window), it can be brought to the front of the screen by 
selecting it from the Window menu, where progress windows are listed in a separate section. 

The progress window for the current document can also be brought to the front of the screen by selecting the Upload option in a 
document while the site is being uploaded. 

A document cannot be closed inadvertently while it is being uploaded. If you try to close it, Freeway will display an alert asking if you 
wish to stop the upload. Similar alerts are displayed if you try to quit Freeway while a site is being uploaded or if an alert message has 
not been dismissed. 

To cancel an upload 
Uploading can be stopped by clicking the Stop button in the progress window or by pressing the Escape key when the progress window is at 
the front of the screen. 

If an error occurs while uploading 
If an error occurs while uploading a site, Freeway displays an alert message in the progress 
window and brings it to the front of the screen if it is not already the front window. If Freeway is 
not the front application, it plays a system beep and its Dock icon will bounce. 

Re-check the information you have used in the Upload dialog to make sure it is correct and, if 
you believe it is all as it should be, contact your host to ask them to tell you the correct info to 
use in each field.

Managing your site 
There is more to managing your site than simply publishing and uploading it in Freeway. One of the most important advantages of web 
publishing over conventional paper printing is the ease with which information can be updated. Many large web sites are updated daily. 
Regular updates will encourage readers to revisit your site. 

Use your home page to highlight new information and areas. Regular visitors appreciate the convenience of seeing any new stories 
when they return to your site. 

When you edit your document to add new information and then use the Preview in Browser, Preview in Freeway, Publish Site, or 
Upload… commands, Freeway only needs to send any items that have changed since last time the site was published. 

Splitting your Freeway document 
There may be occasions when you wish to split your Freeway site across several documents. Perhaps you want to move one of the 
sections to a different web server (for example, you might set up a dedicated server for the “Sales” section of the site). Or you might 
want to split the site into several documents to allow different people to work on it at the same time. This is similar to subdividing a 
book in InDesign or splitting a QuarkXPress publication into separate documents for each chapter. 
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How to split your Freeway document 
Ideally, site splitting should be something that you plan in advance when you first begin working on the site—you should map out how 
the site will develop in terms of workflow and organization. 

If after creating a Freeway document you subsequently need to divide it, a couple of questions should be addressed. What sections does 
the site fall into naturally (for example, Sales, Support, Contacts), and what sections need to be divided for the purpose of updating 
them independently from the main site document (for example, a press releases or news area)? 

To begin splitting a site, start by saving a copy using Save As… in the File menu. After you’ve made the copy, delete the pages that are 
not needed in each document. As Freeway deletes pages, you will be given the option to automatically replace links to the deleted pages 
with “relative links” so you won’t have to type them in later by hand. 

It’s best to split the Freeway document in such a way that each new document contains the files for one folder in the site. For example, 
if you have a “Sales” section and a “Support” section, you might want to divide the site so that each of these was contained in a separate 
Freeway document. 

To do this, begin by creating two new folders in Freeway for Sales and Support using the New Folder option in the  menu at the bottom 
of the Site panel. Next, select the pages that belong in the Sales folder of the Site panel by highlighting their names and Shift-clicking to 
select them, and then drag them into the Sales folder. Similarly, drag the Support pages into the Support folder. This will make it easier for 
Freeway to set up the correct links between the two sections. 

Now, use Save As… to make a copy of the document for the Sales section, and do this again to make a document for the Support 
section. Open the Freeway document you’ve saved as Support and delete all the pages that do not belong in that section (that is, all 
the Sales pages and all the pages from the main section). You will be prompted to either remove the links or replace them with relative 
references. Click the button to select relative references. Freeway assumes that the folders and pages will keep the same relative positions 
in the site structure. Delete the unwanted pages from the Sales document and the main document in a similar way. 

When you have two or more files that constitute your web site, you will have to create links between them. You won’t be able to use 
internal links to pages that are contained in other Freeway documents, so you need to use “relative paths.” A relative path is a way to 
specify how to get to another page in the same site from the current page. It’s called a relative path because it specifies a location in 
relation to the current location. You can find more information about this in Hyperlinks: Linking to external pages on page 113. 

Creating relative links 
Select the text or item to which you’d like to link, then bring up the Edit Hyperlink dialog. Enter a relative link into the URL field of 
the dialog, replacing the “http://” text if it is a new link. In this dialog, you will have to enter the file name of the HTML file to which 
you want to link.

The file name is shown in the Page General panel of the Inspector palette of the relevant page. If the file you want to link to is in 
the same folder, just enter this file name. For instance, if you want to link to a page called Company X Home Page whose file is called 
index.html, you would enter index.html in the URL field. 

If the linked file is in a folder within the folder from which you are linking, you would preface the file name with the folder name(s). 
Our example illustrates a folder called Site Folder, within which is a home page (index.html) and two folders: Sales and Support. If 
you were linking from the home page to a page called offers.html within the Sales folder, you would type sales/offers.html. 

If the linked file is in a folder that contains the folder in which 
your current page resides, then you need to preface the file 
name with a “double dot” and a slash: ../ —this means “go 
up to the folder above”. For example, if you were making a link 
from a page in the Sales folder back up to the home page in the 
folder above, you would enter ../index.html. 

If the linked file is in a folder that is in the same parent folder as 
the folder that the source page is in, you need to use ../ and the 
folder name. So if you were linking from a page in the Sales folder 
to a page called faq.html within the Support folder, you would 
type ../support/faq.html. 

Generally, you should try to make these kinds of links as 
infrequently as possible, as they are more difficult to maintain 
than internal links within the same Freeway document. To avoid 
making too many links across documents, make sure your site 
is organized in such a way that there is one means of entering 
the Sales section and most of the links within that section are 
to other pages within the same Freeway document. This minimizes the number of links you need to check and enter by hand. It also 
makes your site easier to navigate—for example, if someone wants sales information, they know that they can find everything they need 
in that one section without having to jump around to different sections of the web site. 

The URLs… option on the Edit menu allows you to manage these links and make global changes, and you might also find the Link 
Map useful. 

Before making such a major change to your web site, it’s best to make a backup of your Freeway document(s) in case you delete anything 
by mistake. It’s also a good idea to create some small test documents and practice linking between them so that you can familiarize yourself 
with how the process works.

Note: The Link Map is not available in Freeway Express.
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Dedicated FTP tools 
Freeway’s FTP upload option has everything you need to upload your site to the web server, manage the files and delete files which are 
no longer needed. However, there are a few things that you might need to do which require a more comprehensive FTP tool. 

Freeway will not delete any files that were previously on the FTP server—it will only overwrite them where necessary. This is because you 
might have some pages on the server which have been uploaded using another Freeway document or by someone else. When you upload 
a particular Freeway document, the only redundant files which will be deleted are those which formerly belonged to that document. You 
would need to use another tool if you needed to completely delete all the files on the server to remove an old site. 

When you are uploading your site, if you want to upload to a directory that does not exist on the server, you need to use a tool like 
Transmit or Fetch to create that directory on the FTP site first. You might want to do this if you want to upload a separate site for 
someone else in a folder within your own site or a test site that doesn’t replace your own site. 

The first step is to log on to the server using your chosen tool. Launch the application and enter the Upload details. For example, using 
Transmit, you need to select Connect to Server from the Go menu, enter your details, and then click Connect. In Fetch you would 
select New Connection from the File menu, enter the details and click on OK. 

Most modern FTP applications offer a “synchronize” feature which lets you synch what’s on the web server with what’s in your Site 
Folder (or File Copy Folder if you use that method). This means that after the first upload, you can simply log on to the server using the 
FTP application and then synch the files so only the files necessary since the previous upload will be uploaded.

Deleting files 
Once connected, you will see a window showing the contents of the folder on the server. Click on the file or files that you want to 
delete, or use Select All. Depending on your software you can delete using menu commands, or by typing Command-backspace. 

Creating a directory or folder 
In Transmit, select New Folder from the File menu and enter the name for the new directory. In Fetch, select Create New Directory 
from the Directories menu. 

External files
You might also need to use an FTP application if you need to upload any files which are not automatically uploaded by Freeway—for 
example some extra items required for a Java applet, or a script that you need to use on your site. 

To do this, you would just log on to the site as described above and drag the item from the Finder into the window to upload it. 

Where to find FTP applications
Something like 100 FTP applications are currently available—you can find them on download sites such as CNet (see http://download.
cnet.com/mac/). Some are freeware, such as Cyberduck, some are shareware, such as Captain FTP and Interarchy, while others are 
commercial applications, such as Fetch and Transmit. We’ve added URLs to the more well-known and well-established FTP applications. 

Cyberduck (freeware): http://cyberduck.ch/

Captain FTP (shareware): http://captainftp.xdsnet.de/

Interarchy (shareware): http://nolobe.com/interarchy/

Fetch (commercial): http://fetchsoftworks.com/

Transmit (commercial): http://www.panic.com/transmit/

Freeway and IE Compatibility
According to current (July 2011) browser statistics (see http://www.w3schools.com/browsers/browsers_stats.asp), Internet 
Explorer is the third most widely used web browser. Unfortunately, IE6 and IE7 are also the least standards-compliant browsers, though 
Explorer 8 and 9 are much better. This means that web pages which display correctly in other browsers—and contain valid (X)HTML 
and CSS—may be displayed incorrectly in Internet Explorer 6 (which is now quite old and has less than 3% usage).

One way in which web designers sometimes adapt their pages to work in Explorer is by use of so-called “browser hacks”. These exploit 
bugs in Internet Explorer’s handling of HTML and CSS in order to fix display bugs without affecting the way that a page is displayed 
in other browsers. This approach has several disadvantages, including the fact that browser hacks depend upon non-standard or 
illegitimate use of HTML and CSS.

An alternative approach is to use conditional comments to include code which is specific to Internet Explorer.

Freeway takes this second approach. If you select an IE-compatible option, Freeway Pro writes an IE-specific stylesheet which contains 
style definitions that are used to work around some of the problems. Freeway also writes some other files which allow PNG images to be 
displayed transparently in IE6.

Note: IE6 is unable to display PNG graphics transparently as background 
images. There are no acceptable workarounds for this problem.
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Conditional comments do not work with versions of Internet Explorer older than 5.5. If you require pages to display correctly on very 
old versions of Explorer (or Netscape), you should use table layouts rather than CSS layouts.

Freeway provides four options for browser compatibility:

•	 Normal compatibility makes no concessions for limitations in Internet Explorer.

•	 IE6/IE7/IE8 compatibility allows pages to be displayed correctly in Internet Explorer 8, and also provides a degree of backward 
compatibility with IE6 and IE7.



An important difference between print publishing and web publishing is the method for defining color and the range of available 
colors. Although many computer monitors support thousands or millions of colors, the use of cell phones and other methods of 
accessing the web is on the rise. The result can be an unexpected dithering of colors on the viewer’s monitor, making your images look 
sloppy. 

Freeway allows you to define colors and apply them to your page backgrounds 
as well as text and other items created on the page. The Color popup menu is 
the standard way of applying color and appears in various places in Freeway. 
Colors can also be applied through the Styles & Colors palette.

Web-safe color 
The standard 256 colors differ slightly on a Mac and a Windows PC, so if you want to make sure that viewers see colors as you intend, 
then you should choose from the 216 “web-safe” colors, especially for flat areas such as fills and background colors for pages. These are 
defined and offered whenever you need to specify additional colors in Freeway. It is also possible to define colors outside the 216 web-
safe colors. 

On the web, colors are defined in RGB, using a hexadecimal (Base 16) system of numbers. Hex uses the numbers 0 to 9 and the letters A 
to F to represent the numbers 0 to 15. 

Web-safe colors are defined using six possible percentages for red, green, and blue. These are 100%, 80%, 60%, 40%, 20%, or 0%. The 
hexadecimal numbers that relate to these percentages are FF for 100%, CC for 80%, 99 for 60%, 66 for 40%, 33 for 20%, and 00 for 0%. 
These percentages can also be presented as red, green, and blue values in Photoshop. The corresponding values are 255, 204, 153, 102, 
51, and 0. 

Shown as a table, the hexadecimal numbers, their RGB Photoshop values and corresponding percentages look like this: 

Hex 	 Photoshop 	 Percentages 
FF 	 255 	 100% 
CC 	 204 	 80% 
99 	 153 	 60% 
66 	 102 	 40% 
33 	 51 	 20% 
00 	 0 	 0% 

Only 216 combinations of the color values contained in this table are possible when working with the three color channels Red, Green, 
and Blue, and these combinations provide the 216 web-safe colors. Any color composed in RGB using combinations of the above values 
will be web-safe and reproduce without dithering. 

You can use the web-safe palette when applying an indexed palette to graphic items set to export as GIF or PNG images. This may result 
in a dithered or posterized image but the result will be more consistent when viewed under different conditions than the millions of 
colors in a JPEG or PNG image. An adaptive palette gives better results in most cases but is less predictable because it may contain non-
web-safe colors. 

Temporary and permanent colors FW Pro only  

Colors listed in the Styles & Colors palette or Colors popup 
menu can be either temporary or permanent: 

•	 Temporary colors appear in italic type in the Styles 
& Colors palette. Temporary colors are deleted from a 
document when they are not used. Convert temporary colors to permanent colors to prevent this (see Making temporary colors 
permanent on page 150).

•	 Permanent colors appear in bold type in the Styles & Colors palette. The default permanent colors are None, Black, White, Cyan, 
Magenta, Yellow, Red, Green, and Blue. Knockout is available for graphic text only. Permanent colors remain in a document, even if they 
are not currently used. 

Working with Color

Note: Freeway Express does not have a Styles & Colors 
palette, or support the saving of custom colors. More 
information about using colors in Freeway Express can be 
found on page 151.

Note: Colors, aside from the permanent standard colors (None, Knockout, 
Black, Blue, Cyan, Green, Magenta, Red, White, Yellow), are always 
temporary in Freeway Express.
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Color panels 
In Freeway Pro, the Styles & Colors palette provides two color panels: a Colors panel and a Web Colors panel. Switch panels by 
clicking on their tabs. 

Anatomy of the Styles & Colors palette FW Pro only  

Custom  
colors button

Web-safe 
colors button

Options menu: 
gives options to 
create new colors 
and edit existing 
ones

Styles button  
(see Defining  
styles on page 159)

Color list 

Opacity slider: this only 
works with colors applied 
to graphic items

Apply to popup 
menu

Permanent  
custom color

Temporary  
custom color

Checkbox to  
force the custom 
color to the nearest 
web-safe color

Renamed permanent  
custom color

Colors panel FW Pro only  

Temporary custom color

Permanent custom color

You can create more colors and add them to the Colors panel in the Styles & Colors palette. Colors applied to elements of your 
document are also listed here automatically. 

Colors shown in bold are permanent, while those shown in plain type are temporary. Colors added to the list as you work or defined 
from scratch are editable—you can change them or delete them from the palette. The default colors are not editable. 
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Web-safe Colors panel FW Pro only  

To display the Web Colors panel, click on its button in the Styles & 
Colors palette.

To apply a web-safe color, select the object and click on the color swatch 
in the Web Colors panel. Colors applied to text and boxes are displayed 
with a black outline when the object is selected. Colors cannot be added 
to the Web Colors panel, but applied colors are added to the Styles & 
Colors palette. 

Hover the mouse cursor over a color swatch to show that color’s 
hexadecimal value (requires Help Tags to be on in Freeway’s 
Preferences—see page 232 for more information).

Note: In the early days of the internet, some older computer screens would 
only support 256 colors—so it was always advised to use the list of 216 
colors called “web-safe” colors. Now that most computer screens support 
millions of colors, this list is rarely adhered to now.

 menu FW Pro only  

The  menu on the Styles & Colors palette offers commands for 
managing your colors. 

New Color FW Pro only  

Choosing New Color… from the Styles & Colors palette  
menu brings up the Color dialog. In addition, the dialog allows 
you to view or edit the RGB color values, edit the Hex value 
and lets you choose a name for the new color. If you know the 
hexadecimal number for a color, you can enter it in the Hex 
field—color numbers entered here do not need to be web-safe. 
You can also click on the Color Picker button (the color swatch 
button to the right of the Hex value field which, by default, 
displays in White) to access the Mac OS Color Picker and use any 
one of the options available there to define a new color (for more 
information, see Color Picker button below).

Choosing Other… from the color popup menus elsewhere in 
Freeway also brings up the Color dialog. 

Color Picker button FW Pro only  

Click on the Color Picker button (highlighted in the screenshot, 
right) to display the Mac OS X Color Picker, from which you can 
choose any of the available options. Choosing a color here creates 
a new permanent color in the Freeway Styles & Colors palette. 

The Color dialog 
allows you to 
choose web-safe 
colors, add new 
colors (including 
non-web-safe 
colors) by typing 
in the Hex value 
and change a 
color’s name. 
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After clicking on the Color Picker Button the standard Mac OS X Color 
Picker is displayed where you can choose from the different tabs at top. 
As the Color Picker is the standard one seen in many Mac applications as 
part of the Mac OS X interface the various options are not covered in this 
Reference manual.

If you click on the magnifying glass icon in the Mac OS X Color Picker, you 
can sample a color from anywhere on the screen.

Edit Colors FW Pro only  
Choosing Edit Colors… brings up the Edit Colors dialog, which can also 
be accessed from the Edit menu and by Control-clicking on the Styles & 
Colors palette. 

From here you can manage the list of custom colors defined in your 
document. For example, you can duplicate or delete an existing custom 
color, create new colors or import custom colors from another Freeway 
document.

Web-safe Colors FW Pro only  
When this option is turned on, non-web-safe custom colors have a checkbox that allows them to be 
automatically matched to the nearest web-safe color values. It is important to remember that this action 
will alter the custom color to the nearest web-safe equivalent throughout your Freeway 
document.

Applying color 
You can color text and boxes by applying: 

•	 Existing colors in the document. 

•	 New colors you’ve created or edited. 

•	 Colors you’ve imported from another Freeway document. 

You can use the Colors and Web Colors panels in the Styles & Colors palette (Freeway Pro only), the 
Color popup in the Inspector palette or Freeway’s menus and dialog boxes to apply color. 

You can, for example, simply select an object and click on a color in either panel of the Styles & Colors 
palette. (If the Styles & Colors palette isn’t already on the screen, choose Styles and Colors from the 
Window menu.) At the top of its window, the Styles & Colors palette has a popup menu, which can 
be used to apply color for shadow, glow, background, foreground, text, text background and foreground 
options. These options are contextual, depending on what kind of item is selected. 

Power Tip: Control-click on a color in the 
Styles & Colors palette to quickly access 

various options from the 
contextual menu. You can 
use the contextual menu 
to delete the custom color 
you have clicked, create 
a new color, call up the 
Color Picker, open the Edit 

Colors dialog to edit the chosen color, and 
toggle the display of Web-safe Colors. 

When Web-safe Colors is 
turned on, a checkbox appears 
next to custom colors in the 
colors list— if this is selected, 
the color will be matched to the 
nearest web-safe color value.



Freeway Reference: Working with Color
148

148

Applying color to text 
The simplest way to apply a color to a text run is to select it and choose a color from the Color popup in the Inspector palette. You 
can use this method to make different words in a box appear in different colors. 

Applying color to a box FW Pro only  

Select the box (or with the text cursor in a box, choose Background from the Apply To popup menu at the top of the Styles & Colors 
palette) and choose a color from the Styles & Colors palette or Inspector palette. When the box is selected, the color is highlighted in 
the Styles & Colors palette. If you select several boxes filled with different colors, all the selected colors appear highlighted in the Styles 
& Colors palette. 

Note: If a box has a border applied, it is only possible to change the color by 
using the Item Appearance panel in the Inspector palette. 

Note: Freeway Express users can apply color to boxes using the color popup 
menus in the Inspector palette. See page 151 for details.

None and Knockout
Freeway’s colors list includes two special colors: None and Knockout. 

None
HTML and graphic items drawn on the page in Freeway have None as the background color by 
default. None means there is no color fill applied to the selected item, so it will be transparent 
and show items and colored items behind it. 

Graphic text can also be given a fill of None. This can be used in association with the Overlay 
attribute to give the selected text a border but a transparent background so that the colors of 
items behind the text show through.

Create transparent text with an outline attribute using 
Freeway Pro

1.	 Select some graphic text.
2.	 Choose the color None in the Styles and Colors palette.
3.	 Choose the Text Appearance panel of the Inspector palette.
4.	 Reveal the Effects if it is not already showing.
5.	 Click on the Overlay Effects icon.
6.	 In the Overlay panel, choose a color to create the outline effect. 

Set the overlay, opacity, width, position and filter as you wish.

Create transparent text with an outline in Freeway 
Express

1.	 Select some graphic text.
2.	 Choose the Text Appearance panel of the Inspector palette.
3.	 Select the Outline effect button. This gives a default 1px green 

outline. Set the outline color, opacity, and outline thickness as 
desired.

Note: The Overlay and Outline effects can only be applied 
to text while it is selected.
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Knockout
Knockout can be used to punch text through its container item’s background 
color. You can only apply Knockout to selected text; the color cannot be 
applied to graphic items. In this example, we’ve also used the Overlay 
attribute to outline the word, and applied the Shadow attribute to the item 
that contains the knocked out text.

To create this effect in Freeway Pro and Express:

1.	 Draw some graphic items that will become the background to the text. These can contain photographs, plain background colors, or 
fills created using graphic Actions. You can also just use the page background color or image.

2.	 Draw a graphic item, click in it and add some text. The Knockout effect works best with bold typefaces.
3.	 Give the text box a color, then select the text and choose Knockout from the color popup menu.

The text will appear to have been punched out of its container 
item, and any background items will show through. Add further 
effects as you wish.

Creating a new color 
You can use the Mac OS Color Picker to create a new color and add it to the Colors panel of the palette or to edit an existing color. The 
Color Picker also gives you a choice of color models, which allows you to specify colors in slightly different ways. 

In order to create a new color, you can type in Hex values or display the Color Picker. There are three ways to do this in Freeway Pro: 

•	 Choose Colors from the Edit menu, click New…, then click on the Picker button.

•	 Click on the Styles & Colors palette pop-out menu and choose New Color, or Control-click and choose New Color… from the 
contextual menu, then click on the Picker button. 

•	 Click on the Styles & Colors palette pop-out menu and choose Color Picker…, or Control-click and choose Color Picker… from 
the contextual menu

The Mac OS X Color Picker window is displayed, showing the available color pickers. To use the different color pickers, click on one of 
the color model icons in the top of the Color Picker window, then select your color using the available controls. 

Editing, duplicating, and deleting colors 
Once you’ve created a color in Freeway Pro, you can edit, 
duplicate, or delete it. 

Editing a color created in Freeway FW Pro only  

You can alter the color mix of an existing editable color as 
follows: 

1.	 The Color dialog must first be displayed, which can be 
done in a number of ways: Command-click on the color 
in the list of custom colors in the Styles & Colors palette; 
choose Edit Colors… from the Styles & Colors palette 
pop-out menu; or choose Colors… from the Edit menu, 
select the color to edit from the scrolling list and then click 
on Edit. 

2.	 With the Color dialog now displayed, choose a new color. 
3.	 Click OK. 

Freeway now changes the color in the Styles & Colors palette and the menus. Any object or text using the original color is changed to 
show the new color. 

Duplicating a color FW Pro only  

Duplicating a non-editable color allows you to edit the duplicate. You 
can duplicate an existing color as follows: 

1.	 Choose Colors… from the Edit menu, or in the Styles & Colors 
palette choose Edit Colors… from the  menu. 

2.	 Select the color to duplicate from the scrolling list. 
3.	 Click the Duplicate button.

Freeway makes a copy of the color and adds it to the bottom of the 
scrolling list using the original name plus the word “copy”. Now you 
can edit the duplicate color (and change its name, if you want).

Power Tip: You can edit a specific color quickly by Control-
clicking it in the Styles & Colors palette and choosing Edit 
Color… from the contextual menu.

Note: When using Knockout, the text color Opacity and Filters have no 
effect on the selected text.

The Color Picker 
button opens the 
Mac OS X colors 
palette, where 
you can specify 
and choose a 
custom color from 
the various color 
models. See also 
Color Picker 
button on page 
146.
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Deleting a color FW Pro only  

1.	 Choose Colors… from the Edit menu, or in the Styles & Colors palette choose Edit Colors… 
from the  menu. 

2.	 Select the color you want to remove from the scrolling list. If the color can be deleted, the 
Delete button will be active. You can’t change or delete the non-editable colors—these are 
None, Knockout, Black, Blue, Cyan, Green, Magenta, Red, White, and Yellow. 

3.	 Click Delete or press the Backspace or Delete key. If the color is used in your document, 
Freeway displays the Select Color dialog box asking you to select from the scrolling list a color 
that you want to use in place of the deleted color. 

4.	 Select a color and click OK. 
5.	 Click OK on the Edit Colors dialog box. 

Freeway deletes the color from the list. Where the original color has been applied to text or graphics 
in the document, Freeway substitutes your chosen replacement color. 

Power Tip: You can delete a specific color quickly from the Styles & Colors palette by 
Control-clicking and choosing Delete… from the contextual menu. 

Importing colors 
FW Pro only

 
You can import colors directly from other Freeway documents. 

Importing colors from a Freeway document 
To import colors from another Freeway document, first make sure that they are permanent colors, then follow these steps: 

1.	 Choose Colors… from the Edit menu, or in the Styles & Colors palette choose Edit Colors… from the  menu. 
2.	 Click on Import…. 
3.	 Find and select the document in the File selection dialog box. 
4.	 Click OK. 

Freeway imports the colors from the selected document and displays them in the Styles & Colors palette as permanent colors. 

Imported colors are displayed using their original names. If different colors using the same name already exist in the receiving 
document, Freeway displays a warning notice which gives you the options to let Freeway rename the imported colors automatically, 
cancel the import, or carry on. 

If you click OK, the imported colors may replace colors already in the document which you would like to keep, giving unpredictable 
results. If possible, rename the colors in the original document and they will then import correctly. 

Making temporary colors permanent 
FW Pro only

 
To make a temporary color permanent, use the Edit Colors dialog or the Colors dialog. To access the Edit Colors dialog: 

•	 Choose Edit Colors… from the Styles & Colors palette  menu (see screenshot below left). 

Select the color to edit from the list and then select the box in the Permanent column. 

•	 Choose Colors… from the Edit menu. 

To use the Color dialog, Command-click on the color in the list of custom colors in the Styles & Colors palette, select the Permanent 
box and click OK (see screenshot below right). Freeway then changes the color from temporary to permanent and displays its name in 
bold in the Styles & Colors palette. It will not be deleted if it is unused in the document, unlike a temporary color.
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Using colors in Freeway Express
Freeway Express does not have a Styles & Colors palette, or support 
the saving of custom colors. You can choose colors other than the 
standard set by choosing Other… from the Color popup menu in the 
Inspector palette, then choosing the color you want from the Mac 
OS X Color Picker. 

Freeway Express remembers custom colors you have used in your 
design, but you cannot rename them, or make them permanent. This 
means, if you delete the only item that uses a specific color, that color 
will disappear from the list. 

Color popup menus appear at various places in the Inspector 
palette. Colors can be chosen for page backgrounds, HTML text, box 
backgrounds and borders, graphic text and effects, and graphic item 
backgrounds, borders, and effects.

Power Tip: To avoid the accidental deletion of a custom color when you 
delete items that may use it, create an item on the pasteboard area, apply the 
color, then turn off the Publish checkbox in the Inspector palette. 

With a graphic box selected, one of 
the preset styles has been selected. 
You can see here that there are two 
color popup menus, one for the box 
background color (shown here with 
the color list showing) and one 
for the border color. To choose a 
custom color, select Other… from 
the top of the color popup menu. 
This opens the Mac OS color picker 
dialog. Once a custom color has 
been added to the popup menu list, 
it can be used for other elements in 
your design.



Specifying the appearance of text
You can specify the appearance of text by selecting it and then using the options in the Inspector palette. The options available 
are divided into Character settings and Paragraph settings, and 
depend on whether it is HTML text or graphic text, and which 
version of HTML you are generating.

The options in the Character section apply to the currently selected 
characters, and you can apply different character formatting to 
different characters within a line or paragraph.

The options in the Paragraph section apply to the entire 
paragraph.

HTML text, HTML 4.01, XHTML 1.0, HTML5 and 
XHTML5
With HTML 4.01, XHTML 1.0, HTML5 and XHTML5, Freeway takes 
advantage of CSS style sheets to provide additional options, including 
absolute sizes and indented paragraphs.

Graphic text
With graphic text you can use any of the fonts available on your 
computer, at any size. 

You can also apply a wide range of text effects, using the options on the 
Text Appearance panel of the Inspector palette.

To change the appearance of text
•	 Select the text you want to change.

•	 Select the options as required from the Character and Paragraph panels of the Inspector palette.

To select all the text in an HTML item or graphic item
•	 Double-click in the item to place the insertion point in the text, and then choose Select All from the Edit menu.

Styling Text

Note: Freeway Express produces HTML 5 code only. The ability to set 
alternative HTML levels is a Freeway Pro feature.

Note: For a discussion about the differences between and uses of 
HTML text and graphic text, and how to insert and import text into 
your Freeway document, see Working with text, beginning on page 
80.
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To create graphic text within an HTML item
If you need text in a distinctive font or style within a block of HTML text, 
you can convert a selection into graphic text. When you publish the site, 
Freeway will convert the section of text into an in-line GIF image.

•	 Select the text you want to create as a graphic.

•	 Click on the text icon at the top of the Inspector palette to display the 
character and paragraph settings.

•	 In the Character section, choose GIF from the Type popup menu to 
convert the selected characters into graphic text.

The formatting options will then change to the options for graphic text and 
you can specify the settings as required.

To convert a paragraph into graphic text
You can also convert a complete paragraph into graphic text.

•	 Position the insertion point in the paragraph and select triple-click to select 
it.

•	 Click on the text icon at the top of the Inspector palette.

•	 In the Paragraph section choose GIF from the Type popup menu to 
convert the entire paragraph into graphic text.

The formatting options will then change to the options for graphic text, and 
you can specify the settings as required.

For more information about editing text, checking your spelling and finding 
and replacing words in your Freeway document, see Working with text on page 
80.

What are styles? 
FW Pro only

 
In traditional DTP and word processor applications, styles are used to control how the lettering on the page looks.

Sea of probabilities
Throughout this chapter, we will be making references to probabilities. When designing a web site, all we can do is hope that the end 
user will see what we have designed. This is down to a good number of factors:

•	 The client machine is set to override your settings

•	 The fonts you specified are not on the client machine

•	 The client machine can only “display” text

•	 Different browser

•	 Different operating system

•	 … etc.

Because of this, we cannot be 100 per cent sure that the end display will represent your design as you intend it. However, as you will 
learn, using Freeway’s styles can help improve the chances of conveying your message, despite the above limitations.

It is also very likely that the client machine will display your text differently, even if it has the same fonts that you specify. This is due 
to the way in which different Operating Systems (OS) display text. You may find in some cases that different browsers will display text 
differently on the same OS. Because of this, you should test your layouts on more than one browser in at least Mac OS X and Windows 
to ensure that there are no nasty layout surprises in store.

Important Note: Most of the content of this chapter is concerned with Freeway Pro. Freeway Express does 
not support creation of styles, so whilst Express users can style and color text using the Inspector palette, the 
creation of permanent reusable styles is not possible. See Styling text on page 152.

This chapter contains examples of HTML created by Freeway. This is included to give you a better understanding 
of what is going on when Freeway generates the HTML. While you do not have to learn HTML to use Freeway, it is 
helpful to have an idea of what is going on so you can get the most out of the software.

This chapter will also discuss some of the deeper issues in web design. Again, this is unavoidable as using styles 
effectively in any web design application requires knowing more than just colors and typeface names.

Note: “Display” does not always mean “show on a screen”. It can also 
mean “read in a synthetic voice” or “translate into Braille”.
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HTML styles 
FW Pro only

 
HTML is basically a text file which contains various bits of information. HTML is not a document description language in the way that 
PostScript is. PostScript is a language that describes all aspects of a page from the position of blocks of text and images to any gradients, 
lines, and fills used. PostScript is output by applications such as Adobe’s InDesign and Illustrator, and QuarkXPress, and any other 
application that has a print button. This information is sent to a printer or image setter which uses the instructions to print the page.

In contrast, HTML is a description of how information is organized. This information includes text that can be read. It was not designed 
for the control that one can exert over printed documents. It has been bent into that task by web designers who want more control over 
the layout of the page and positioning of items.

CSS
CSS is an acronym for Cascading Style Sheets. These are used to apply styling to text and layout in an HTML document. CSS can control a 
good many things: positioning of items, borders around items as well as the appearance of HTML-based text.

Classes
In HTML, a class can be used to assign one or more style attributes to a part of the page, for instance a block of text or an item. This 
functionality is mirrored in Freeway using Styles. When a Freeway site containing HTML text is published, Freeway generates classes 
for the Styles used on the page and assigns them to the relevant text or objects in the HTML output. The classes are then used by the 
browser to display text and objects on the page in the way they have been styled in the Freeway document.

About HTML Text 
HTML text is fluid; it can be resized by the user, and it can be read electronically by search engine spiders that index a site, as well as 
assistive devices that help those who have difficulty using displays. HTML text can be styled — we can change the color, font, and size 
of this text. What we can’t do is make this styling absolute. The user can always override the choices made. This kind of text can also be 
selected in the browser and can be copied and pasted into another application.

HTML text also occupies a small amount of space. It is fast to download and will normally be displayed before any graphics are.

Serving Suggestions
The most we can hope to do is suggest to the user’s browser that the text is displayed in a particular way (for example Verdana at 11 
pixels). The user’s machine may not be able to display the text for a number of reasons:

•	 The user has set up defaults that override your settings.

•	 The font may not be present on the client machine

•	 The site may be being browsed using a Braille reader or a system that reads text using a synthetic voice.

•	 The browser displaying the site may be too primitive to handle layout instructions (e.g. Lynx)

It should be pointed out that these are likely to be minority users, but remember that minority users have just as much right to view 
your web site as those with the capabilities to view everything you care to throw at them.

What fonts are available?
Freeway offers a very limited set of fonts for use with HTML styles. This is not an oversight; Freeway gives you access to the fonts that 
are most likely to be on most machines.

Google Web Fonts and other new HTML font options

There was a time when HTML text could only be used with one of the web-safe fonts—which is a small list of fonts which include 
Times, Helvetica (Arial), Courier, Symbol, Verdana, Trebuchet MS and Georgia— but in the last few years a greater select of fonts have 
become available as either Google Web Fonts or “@font-face” fonts.

Both of these new methods work in a similar way. Google Web Fonts uses code which links to a font that is uploaded to Google’s servers 
(so it is effectively available on any computer) and @font-face fonts are generated and then uploaded to your web server with the rest of 
your HTML files so they will display correctly on any computer.

To read more about using Google Web Fonts, see the KnowledgeBase article at http://www.softpress.com/kb/questions/276/.

There are two free third-party Actions which make it easy to choose any font that has the necessary permissions to use as @font-face 
fonts. See the following pages on the Internet:

•	 Caxton: http://actionsworld.com/Actions/Caxton/index.php

•	 Web Fonts: http://www.freewayactions.com/product.php?id=034

Both of the above Actions will let you use third-party fonts as HTML text on your websites—but it is very important that you have the 
necessary permissions to use the fonts, as using them as @font-face fonts is effectively sharing the font.
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Setting up Font Sets
You can add to the small list of Font Sets in Freeway. There are fonts that are used on other machines 
that may not have been included in Freeway’s default set of font sets. To create a font set, you need to 
do the following in Freeway Pro and Freeway Express.

If you want to create a font set that can be used in any document, you need to do the following with no 
document open.

1.	 Select Font Sets from the Edit menu.
2.	 Click on the New… button (see screenshot below left).
3.	 In the dialogue that opens (see screenshot below right), give the font set a name. Select the screen 

font in the drop down. Its name will appear in the text field below. You need to add some extra font 
names yourself manually. These are fonts that will be used if your selected font is not available on 
the client machine. Be sure to include fonts that are more likely to be available. In this case, we have 
opted for Helvetica, Arial, Geneva, and sans-serif as the final fallback. Click OK.

4.	 Click OK. Your new font set will now be available to you in Freeway.

As the majority of visitors to your site will be running Windows in some form, it is worth checking on Microsoft’s site to see what fonts 
Windows ships with before building a new font set.

To find out more about the core web fonts:

http://www.microsoft.com/typography/fonts/default.aspx 
http://www.ampsoft.net/webdesign-l/WindowsMacFonts.html

Graphic styles
If you want to ensure text appears in a certain style, regardless of the fonts or browser settings specific to a particular user’s computer, 
you can use a Graphic Style. There are some very good reasons to avoid excessive use of graphic text, for example:

•	 Not readable by assistive devices
•	 Not displayed by more primitive browsers (such as Lynx)
•	 Cannot be indexed by search engines
•	 Some browsers may have images switched off

Note: If you use the Inspector palette to supply useful Alt text for images, 
some of these issues can be overcome (see page 99 for further details).

Freeway’s default styles 
FW Pro only

 
Freeway will insert styles into your HTML at certain points. This is to ensure correct browser display and to preserve the WYSIWYG 
model, and will not adversely affect your own styling of the page. These styles will start with an underscore (–) character, such as the 
“_lp” style which is applied to the last paragraph of text.

HTML styles have meaning
HTML’s structural tags have a bearing on Styles. Freeway supports the creation of tag styles—when a site is output, any HTML text to 
which they are applied will be enclosed in the HTML tag specified for the Style.

When you apply a tag style to a block of HTML text, you are doing two things. The most obvious thing you will see is a change in the 
appearance of the text: color, size, weight, and so on. These changes will help your site’s visitors see any distinctions you care to make 
when the page is being browsed, and hopefully will make reading the content easier.

The second change that is made is the way which the information being sent appears to the browser. By applying a heading style, you are 
giving that text more importance than the normal paragraph text, and search engine bots (for example Google’s indexing system) will pick up 
on that when your site is indexed.
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For example:

The above text is all set with the same style. Both the heading AND the text underneath carry the same weight both visually and 
electronically.

Now consider this:

You can see that the heading is now more visually important. The underlying HTML will reflect this too:

<h1>This text is a heading</h1>
<p>And here is some text underneath which is to do with the heading</p>

The <h1> tags around the heading text indicates to the device reading the HTML that this text has a higher weight of importance 
than the rest of the text.

So, as you can see, getting styles right not only means that the information you present is visually well structured, but it will also be 
structured well for non-visual systems that read your pages. A site with good markup is more likely to perform well in search engine 
results, especially if the content of the text following a header is relevant.

When a style is applied to HTML text in Freeway (or any other modern HTML editor/generator), two things happen. Firstly, an HTML 
tag is created, and secondly, a CSS style is created. The CSS style is used by supporting browsers to display the text in the way that has 
been specified. If the browser can not display the style, or does not support CSS, then it will revert to a default. However, by creating the 
tag, the page has been marked up and the importance of the styled text is evident to the browser and its viewer.

Paragraph <p> styles
By default Freeway wraps a <p> tag around the text like this:

The HTML for the above example text looks like this:

<p>Gustav's Hat</p>
<p class="_lp">Gustav's hat is brown with a pink feather in it.</p>

Both paragraphs of text are enclosed in a <p> tag. 

It is important to realize that a <p> tag is created by default. If the <p> tag is not present, the HTML page could fail validation.

<h> styles
The <h> tag is used to mark out portions of HTML text that are headers. By default, these will be displayed bigger and bolder than 
normal text by the browser. However, you can define their appearance in Freeway more precisely to fit in with your site’s design.

The <h> tags are block level tags. They will affect whole paragraphs, rather than the selected words. As such, they are not substitutes for 
emboldening text.

Consider this block of text:

So, a block of text with an <h> tag applied to it will look like this in the HTML source:

<h1>Gustav's Hat</h1>
<p class="_lp">Gustav's hat is brown with a pink feather in it.</p>

You will see that the header “Gustav’s Hat” is in an <h1> tag instead of a <p> tag.

There are six levels of <h> tags, allowing you to create a hierarchy of headings. <h1> is the most important, whilst <h6> is the least. So, you could 
have your page title contained within an <h1> tag, headings on the page as <h2> tags and so on.
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These tags help search engines and other non-visual readers to determine the importance of information on a page, so use intelligently and 
for maximum impact ensure that the heading is relevant to the text that follows it.

Emphasis <em>
The Emphasis tag usually causes the browser to display the text in italics. 

For example:

Note that Freeway automatically wraps a <em> tag around the word “brown”:

<h1>Gustav's Hat</h1>
<p class="_lp">Gustav's hat is <em>brown</em> with a pink feather in it.</
p>

Again, like the <h1> tag, you can define the appearance of the text more. In the case above, simply italicizing the text will be enough.

Strong
This tag by default causes the browser to embolden the text it’s applied to.

For example:

The HTML produced looks like this:

<h1>Gustav's Hat</h1>
<p class="_lp">Gustav's hat is <em>brown</em> with a <strong>pink</
strong> feather in it.</p>

The word “pink” has a <strong> tag wrapped around it. Again, you can change the appearance of the text beyond simply emboldening 
it using Freeway Pro’s Edit Styles dialogs.

Use in Freeway
All the above options are available to you from within Freeway’s interface. You can apply them as you 
would any other style using the Styles & Colors palette.

In the example on the right, an extra <h1> style has been defined (called “h1.newstyle”), in addition 
to those supplied in the default Blank template. You apply these to selected text just as you would any 
other style. Freeway will then create appropriate CSS and HTML.

Styles on items 
FW Pro only

 
HTML text boxes and tables can have a default <p> style attached to them. Simply select the item as normal and click on the style’s 
name in the inspector palette. The item will then get that style as the default style for any HTML text it contains.

Pages
A page can be given a default style. To apply the style to a page, select the page in the Site panel 
(it has to be highlighted) and then click on the style name.

This has the effect of applying a class to the body tag:

Any unstyled text on that page will have the selected style applied.

<body class="BodyText">
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HTML boxes
Styles can be applied to an HTML box.

<div id="item1" class="BodyText" style="position:absolute; left:9px;  
top:9px; width:266px; height:55px; z-index:1">
	 <p>Gustav's hat was blown away by the wind and landed in a puddle.</p>
	 <p class="_lp">&quot;Oh, bother,&quot; said Gustav.</p> 
</div>

The above code shows the HTML created when applying a style named BodyText to a CSS positioned HTML box. The style is named as a 
class in the DIV tag, with the <p> tags having only Freeway’s default styles (where needed).

Tables
A style can also be applied to whole tables. Select the table as normal, and click on the style’s name in the Styles & Colors palette. In 
HTML <tr> means a table row, and <td> means a cell within that row.

<table class="BodyText" border=0 cellspacing=0 cellpadding=0>
	 <tr>
		  <td width=282 height=50 valign=top><p class="_lp">Gustav's hat was 
blown away by the wind and landed in a puddle.</p>
		  </td>
	 </tr>
	 <tr>
		  <td width=282 height=50 valign=top><p class="_lp">&quot;Oh, 
bother,&quot; said Gustav.</p>
		  </td>
	 </tr>
</table>

In the above code, the table gets a class “BodyText”. All default text within the table will have this style as its default.

Table cells
You can apply a default style to a table cell or group of table cells. Simply select the cells as normal, and click on the style’s name in the 
Styles & Colors palette. 

<table border=0 cellspacing=0 cellpadding=0>
	 <tr>
		  <td class="BodyText" width=282 height=50 valign=top><p class="_
lp">Gustav's hat was blown away by the wind and landed in a puddle.</p>
		  </td>
	 </tr>
	 <tr>
		  <td width=282 height=50 valign=top><p class=_lp">&quot;Oh, 
bother,&quot; said Gustav.</p>
		  </td>
	 </tr>
</table>

In this case, the style “BodyText” has been applied to one of the table cells.

Table rows or columns
Styles can be applied to a row or column. Simply select the row or column as normal, and click on the style name in the Styles & 
Colors palette. The style will be applied to all the table cells in that row or column in a similar fashion to the example given above.

Advantages
Applying styles to items like the previous examples means less bulky code; no extra style definitions need to be defined in the <p> tag.

Mix and match
It is possible to apply more than one style to more than one table cell, with an overall style for the main table. For example, take the 
following table:
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The HTML for the above looks like this:

<table class="TableStyle" border=1 cellspacing=0 cellpadding=0>
	 <tr>
		  <td class="TableHeader" width=111 height=27 valign=middle 
bgcolor="#ffffcc"><p class="_lp">Header 1</p>
		  </td>
		  <td class="TableHeader width=111 valign=middle 
bgcolor="#ffffcc"><p class="_lp">Header 2</p>
		  </td>
		  <td class="TableHeader" width=111 valign=middle 
bgcolor="#ffffcc"><p class="_lp">Header 3</p>
		  </td>
	 </tr>
	 <tr>
		  <td width=111 height=27 valign=middle><p class="_lp">Item 1</p>
		  </td>
		  <td width=111 valign=middle><p class="_lp">Item 2</p>
		  </td>
		  <td width=111 valign=middle><p class="_lp">Item 3</p>
		  </td>
	 </tr>
	 <tr>
		  <td width=111 height=27 valign=middle><p class="_lp">Item 4</p>
		  </td>
		  <td class="TableSub" width=111 valign=middle><p class="_lp">Item 
5</p>
		  </td>
		  <td class="TableSub" width=111 valign=middle><p class="_lp">Item 
6</p>
		  </td>
	 </tr>
</table>

The above HTML shows that various style classes have been applied to the table cells (and even the table itself). The actual content of 
the table cells themselves only have Freeway’s default control styles applied.

Defining styles 
FW Pro only

 
The Styles & Colors palette can display permanent styles or both permanent and temporary styles.

The Edit Styles dialog covers both CSS styling and graphic styling at the same time. Attributes that are 
peculiar to one or the other type of text will be labelled as such in the edit styles dialogue.

Most of the effects listed here can also be applied in the Inspector palette. Freeway Express users will 
not be able to define styles, but they will have access to most of the effects listed here.

The information here covers CSS, which is supported in Freeway using all HTML or XHTML levels.

Note: The Styles & Colors palette and Edit Styles dialog are only 
available for Freeway Pro. Freeway Express does not support defined 
reusable styles.

Styling text
The simplest way to style text in Freeway is to select the text you wish to change, and change settings in the Inspector palette. Most 
styling options are available to you in either the Inspector palette, or in the Style menu. For Freeway Express users, this is the only 
way to change styles, and more semantic style/tag combinations such as <h1> are not available.

Freeway Pro users can define a style in the Edit Styles dialog and reuse these as often as needed. This makes creating a consistently styled 
site much easier. 

Temporary styles
Freeway will build temporary styles whenever you apply styling attributes to text using the Inspector palette if it does not already have a 
style with those attributes. Temporary styles exist only as long as text with those attributes exists. Their names are shown in the Styles & 
Colors palette in a regular font weight.
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Permanent styles
Permanent styles are those styles that have been marked by the user as styles that should always be available, even if that style is not used 
in the site. Permanent styles are set in the Edit Styles dialog window, and the names are shown in bold.

Style definition
You can define styles in a number of ways. The most obvious way is to select the text in Freeway and use the Inspector palette to 
change the attributes of the text. If you want to make 
the style permanent, select the text and use the Styles & 
Colors palette to make the style permanent (and even 
give it a more meaningful name).

However, this is not the most satisfactory way to define a 
style, nor is it the best if you want to include meaningful 
mark-up in your HTML. The best way to define a style is 
via the Edit Styles dialog.

Edit Styles dialog 
FW Pro only

 
Go to the Styles… option in the Edit menu. A new window will open for you. It will look something like the image below.

Down the left hand side is the list of defined styles in your document, and to the right is the area where you will be creating your style.

There is a View popup menu at the bottom of the window that lets you see either CSS Attributes, Graphic Attributes, or both. Showing 
both allows you to define styles that can be applied to both HTML and graphic text. If you are defining a style for just HTML text, you can 
just show the CSS attributes.

CSS and HTML styles are defined using the same dialog. In most situations, it is possible to define a style that can combine both graphic 
and HTML text. However, if you want to create a style for just HTML text, or one for use solely on graphic elements, then you can use 
the View popup menu to select which attributes you want to see.

Tags and names
You need to give your style a name. Make the name meaningful, so you know what it is when you come to use it on the site. A good 
idea to is to use a name that is descriptive of the style’s function, so you may want to name the text that is applied to the body text of 
your site BodyText. Note that style names can not have a space in them.

As discussed previously, you can also make Freeway output a tag around the text as well as styling information. So, in our example 
BodyText will be applied to most of the text on the page, so we can select the <p> tag in the Tag popup menu. If you wanted to make an 
<h1> tagged style, then select h1 in the Tag popup menu.

Adding attributes
You can add different attributes to the right hand panel by clicking 
the  button. This gives you a menu of attributes from which you 
can pick the ones you want. If you want to select more than one at 
this stage, click the Select button at the bottom of the dialog box, 
and select those you want. Click Select again to return to the main 
style editing view.

The following section describes the various options available in the Edit Styles dialog.

Note: There is a very in-depth article on how to set up custom CSS text styles in 
Freeway Pro on our KnowledgeBase. This shows how to set things up using best 
practice tips so you avoid creating dozens of temporary text styles. Before you start 
to set up your custom CSS text styles we strongly recommend that you read through 
the article at http://www.softpress.com/kb/questions/230/ which is also available as 
a PDF download by clicking on the link at the foot of the article.
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Character Attributes 
FW Pro only

 

Font
You use this option to select the fonts to use in the style. The fonts available are limited to the font sets that have been defined to 
allow for maximum compatibility with other machines on the Internet. The Graphic drop down allows you to select any font on your 
machine. This will only be used when the style is applied to graphic text.

Size
This allows you to define the size of the font using a number of different methods. Note that the item marked Graphic will only apply 
to styles applied to graphic text.

Style

This setting affects the appearance of the text. Note that Word Underline  is an option for graphic text only 

Color

This changes the color of the text.

Background Color

This changes the background color of the text.

Image

You can also have your HTML text use a background image. When applied, 
you can select various tiling options.

Note: Note that Freeway can not display this effect in 
the page layout. You will need to preview the page to see 
the effect.

Isolating Effects
It is not necessary to define a style with every attribute needed. You could, for example, define a style that just applies a background 
texture to a paragraph, or just changes the color of the text. This provides a great deal of flexibility when creating styles.

Graphic text effects in Freeway Pro
Graphic effects can be used to enhance the appearance of graphic text.

To apply an effect to graphic text:

1.	 Select the text and choose the Text Appearance panel from the Inspector palette. 
2.	 Choose an effect from the Effects section. 

There are five effects to choose from: Normal, Background, Shadow, Glow, and Overlay.

You can remove a text effect by clicking a second time on the effect icon to deselect it, or by clicking on the far right of the section 
header for that effect (Freeway displays a minus icon under the mouse when you move it to this point). It is also possible to disable an 
effect without removing it: to do this, hold down the Alt key when you move the mouse to the right of the section header. Disabled 
effects are indicated by an eye with a red line through it—click on this a second time to re-enable the effect.
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Normal
The Normal effect allows you to set a text color, along with other attributes such as outline and background filter.

Text with the Emboss 
filter applied.

Color: This popup menu lets you choose an existing color for the text, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the text. The default setting is 100%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Draw: Choose whether text is drawn solid, or with an outline, or solid and thickened.

Filter: This popup allows you to apply an emboss, blur, or scatter filter. See page 163 for filter settings.

Background
The Background effect allows you to set a background on which the text will be drawn.

The above text has a red 
background set to 50% 
opacity. The yellow box 
is positioned behind the 
word TEXT.

Color: This popup menu lets you choose an existing color for the background, or choose a new color if required.

Opacity: The Opacity slider sets the transparency level of the background. The default setting is 100%, and the range is from 0% 
(completely transparent) to 100% (completely opaque).

Shadow
The Shadow effect allows you to add a drop shadow to text.

Example of the 
Shadow effect.

Color: This popup menu lets you choose an existing color for the shadow effect, or choose a new color if required. The default shadow color 
is Black.

Opacity: The Opacity slider sets the transparency level of the shadow. The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Angle: Control the angle of the “light source” that generates the shadow effect. Changes can be made by clicking and dragging the control 
button, or entering numbers in the text field. 

Global: This checkbox, selected by default, ensures that the same angle information is used for other global effects on the current page.

Offset: The slider controls the amount the shadow is offset from the text. 

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very blurred). 

Glow
The Glow effect allows you to add a glow to text.

Example of the 
Glow effect.

Color: This popup menu lets you choose an existing color for the glow effect, or choose a new color if required. The default glow color is Red. 

Opacity: This slider sets the transparency level of the glow. The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Spread: The slider controls the amount the glow is spread from the text, from 0 (default) to 10. 

Blur: The slider controls the amount of blur, from 0 (no blur) to 20 (very blurred). 
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Overlay
The Overlay effect allows you to add an overlay layer to text. This is useful for creating outlines and other effects.

The Overlay 
effect in action.

Color: This popup menu lets you choose an existing color for the overlay effect, or choose a new color if required. 

Opacity: This slider sets the transparency level of the overlay. The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Draw: Choose whether the overlay is drawn solid, or with an outline, or solid and thickened.

Filter: This popup allows you to apply an emboss, blur, or scatter filter to the overlay. See page 163 for filter settings.

Effect filters  
There are three filters that can be applied to graphic text with normal and/or overlay effects.

Emboss

Angle / Altitude: Control the angle and height of the “light source” that generates the emboss effect. Changes can be made by clicking and 
dragging the control button, or entering numbers in the text fields. 

Global: This checkbox, selected by default, ensures that the same angle and height information is used for other global effects on the 
current page.

Specular: Controls the percentage of specular highlight. Higher values make the object look smooth and shiny. 

Diffuse: Specifies the percentage of diffuse lighting. Higher values make the object look rough or matte. 

Blur

The slider controls the amount of blur, from 0 (no blur) to 20 (very blurred). 

Scatter

The slider controls the amount of scatter, from 0 (no scatter) to 20 (very scattered).

Graphic text effects in Freeway Express
Graphic effects can be used to enhance the appearance of graphic text.

To apply an effect to graphic text:

1.	 Select the text and choose the Text Appearance panel from the Inspector palette. 
2.	 Choose a graphic effect from the Effects area. 

There are four effects that can be selected in various combinations: Outline, Shadow, Emboss, and Scatter.

Outline effect
The Outline effect allows you to set an outline on graphic text.

Color: This popup menu lets you choose a color for the text fill that is used to create the outline effect.

Opacity: The Opacity slider sets the transparency level of the text fill that is used to create the outline effect. The default setting is 
100%, and the range is from 0% (completely transparent) to 100% (completely opaque).

Shadow effect
The Shadow effect allows you to add a drop shadow to graphic text.

Color: This popup menu lets you choose an existing color for the shadow effect, or choose a new color if required. The default shadow color 
is Black.

Opacity: The Opacity slider sets the transparency level of the shadow. The default setting is 75%, and the range is from 0% (completely 
transparent) to 100% (completely opaque).

Offset: The slider controls the amount the shadow is offset from the text. 

Emboss effect
The Emboss effect allows you to create an embossed appearance for graphic text.

Specular: Controls the percentage of specular highlight. Higher values make the object look smooth and shiny. 

Diffuse: Specifies the percentage of diffuse lighting. Higher values make the object look rough or matte.

Scatter effect
The Scatter effect allows you to create a scattered appearance for graphic text.

Radius: The slider controls the amount of scatter, from 0 (no scatter) to 20 (very scattered).
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Lighting
Angle / Altitude: Control the angle and height of the “light source” that generates the shadow and emboss effects. Changes can be 

made by clicking and dragging the control button, or entering numbers in the text fields. Note that any changes that are made to 
lighting are global—they affect everything on the current page that has a shadow or emboss effect.

Graphic shape effects
Shape effects can be applied to graphic text. They modify the basic shape of the text characters by adding a crack or wobble.

Wobble
Period: The distance between each peak or trough, from 0px to 

100px.

Random: Increases the randomness of the wobble.

Deviation: Causes the wobbles to vary by the entered amount, 
from 0px to 100px.

Smooth: Varies the smoothness of the wobble, from 0% (sharp) to 
100% (smooth).

Crack
Period: The distance between each crack, from 0px to 100px.

Random: Makes the cracks appear at random depths.

Gap: Varies the gap between cracks, from 0px to 100px.

Depth: Varies the depth of the cracks, to a maximum of 
100px.

Paragraph attributes
Paragraph attributes force Freeway to create styles that will apply to a whole paragraph. Even if one word is selected when the style is 
applied, the whole paragraph will be styled. 

If you create styles that generate tags, some will force this behavior as the behavior of those tags will be the same as the paragraph tag. 
The most obvious example are the <p> and <h#> tags. 

Selecting the Wobble effect in Freeway Pro (left) and Freeway Express.

The effect of 
Wobble.

Selecting the Crack effect in Freeway Pro (left) and Freeway Express.
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Force Graphic Paragraph

There will be times when you want a graphic style to be applied to a whole paragraph of text, or that you want to force the creation of a 
paragraph. Setting this attribute lets you do this. Note that the graphic text will still be rendered as an image, and not as HTML text.

Align

This allows you to set the alignment (and justification) of the text. Most of these options are available for both graphic and CSS based 
styles, with only one—force justify—being available only for graphic styles.

List

This lets you create list styles that can be applied to list items. Note that list styles will not have any 
visible effect unless they are applied to list items. (See page 84 for list styling.)

Leading

This lets you change the space between lines of your text. Leading can be defined in percentages or 
pixels. 

Leading refers to the space between lines including the space occupied by the type. So, applying 
leading of 100% to 12px text will mean that there are no spaces between lines. Leading of 14px 
applied to 12px text means that the lines will be 2 pixels apart. 

First Indent

This will indent the first line of the paragraph to which the style is applied. The indent can be defined in pixels, or ems.

Left Indent

This will indent the left side of the paragraph to which the style is applied. The indent can be defined in pixels, or ems.

Right Indent

This will indent the right side of the paragraph to which the style is applied. The indent can be defined in pixels, or ems.

Space Before

This allows you to define the space that precedes a paragraph. The size can be fixed (in pixels) or relative (as a percentage).
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Space After

This allows you to define the space that follows a paragraph. The size can be fixed (in pixels) or relative (as a percentage).

Word Space

This allows you to control the spacing of words in your text. The first field is the minimum a word will shrink to during the justification 
process – and the last field is the longest a word will expand to during the process. This is a graphic attribute only.

Letter Space

This controls the spacing of individual letters in the text. Again, a graphic only attribute.

Thinking ahead with styles 
FW Pro only

 
When starting a new site, it is best to think about the styles fairly early on. Even if you change a style’s appearance later on, you can still 
use it during the early design stages.

Foundation Styles
These styles hold the bulk of the content. If this document were a web site, the text you are reading right now would be a foundation 
style. This style would be a paragraph style. Freeway allows you to specify not just the size, font, and color of the text, but also leading, 
indents, and more. Define these styles, and bear in mind that these will change as you develop the site.

Setting your main body text in such a style will allow for more streamlined HTML, which may help improve display speeds as well as 
non-visual browsers.

Text modification styles
These are styles that affect text at the character level, styles such as bold, italic, and so on.

Headers
These are defined as H# tags. This will allow your document’s mark-up to be better structured. Using these, and getting a good hierarchy 
worked out will only make your site (and its HTML) better.

Apply sensibly
First, apply the main “foundation style” to all your text. Then apply the other styles to places where they are needed. This structural 
construction will help keep your HTML clean, but it will also help with the ordering of the site and will make style changes easier in the 
future.

Making global changes 
FW Pro only

 
The power of styles is that you can change a lot of effects very simply. Let’s say that your client suddenly wants all the main body text 
on the site set in Helvetica instead of Verdana. Instead of visiting every text block and changing the style manually, you need only open 
the Edit Styles dialog and change the typeface in one style. Click the OK button and…

…all the text changes in one go. All that is needed is a quick check on each page to ensure that the text is flowing logically, and you are 
all set to publish and upload. So how does one achieve this?

Define BodyText
Start by defining your BodyText style. This would be a paragraph, and would define everything—text size, leading, font, color. This 
style would be applied to every block of HTML text that you enter. You could even set it as a default style on any HTML boxes on your 
master Pages.

Define ancillary styles
Next, you would define your italic, bold, and other similar styles. This time, you would only need to use the Italic and Bold Style 
attributes, and nothing else. To earn extra points, set the style to define emphasis and strong tags.

Apply your Styles
Now apply the styles as normal. If you need to make a change, such as the typeface you need only alter the BodyText style.

This working method can be applied for most attributes—color, size, leading, and so on. It can be used equally effectively with graphic 
styles as well as HTML styles. Making global changes such as this is one of the major strengths of Freeway.



Freeway Reference: Styling Text
167

167

Working with styles 
FW Pro only

 

Note: Freeway Express does not support custom styles.

When working with formatting options, it is useful to note that attributes fall into two categories: 

•	 Character attributes such as font and size—which can apply to a run of text of any length, even to a single character.

•	 Paragraph attributes such as alignment and interlinear spacing (and also font attributes)—which apply to entire paragraphs. 

In Freeway, you can apply attributes directly to selected text, but this can be slow and tedious work if there are several attributes applied 
to similar pieces of text that appear throughout a document. 

To save time and effort, a set of attributes may be saved as a style, and applied in one step to any piece of text that you want to look 
this way. Applying styles to text gives a consistent look to your document. 

For more information about using styles in Freeway, see What are styles? on page 153.

Freeway generates styles on the fly as you work, which saves you the effort of creating your own styles from scratch. Freeway also offers 
both character-level and paragraph-level styles, so that you have all the advantages of styles for words and individual characters as well 
as entire paragraphs. 

Basic concepts about styles 
This section introduces the basic concepts you’ll need to understand for working with styles.  

Methods of creating, applying, and changing styles 
There are several ways of working with styles in Freeway: 

•	 You can alter the character and paragraph attributes of an individual run of text, using either the Text panel of the Inspector 
palette or the Styles menu. Each time you alter a text attribute using one of these methods, a new temporary style is created in the 
Styles & Colors palette. New styles are only created for unique sets of attributes. 

•	 If you apply the same set of attributes to two runs of text, Freeway will use the existing style. 

•	 You can change the definition of an existing style, using the Edit Styles dialog box, and therefore alter the appearance of all text in 
the document that currently uses that style. 

•	 You can change the appearance of selected text by applying a different style from the Styles & Colors palette. 

•	 You can define a completely new style using the Edit Styles dialog box and then apply it to text using the Styles & Colors palette. 

The Styles & Colors palette FW Pro only  

The Styles & Colors palette shows you which styles currently exist within a document and which ones are applied to selected text. 
You can also use the Styles & Colors palette to apply different styles to text.

The Styles & Colors palette contains some predefined styles: em, h1, h2, h3, p, and strong. These are default CSS tags and styles. You 
can edit these styles if you wish. For a discussion about these default styles, see Freeway’s default styles on page 155.

Styles can be either temporary or permanent. Every time you change a character or paragraph attribute in a run of text, a temporary 
style is created. This style only exists while it is in use (applied to one or more text runs). If the text is deleted or the attributes changed, 
the style is removed. 

For example, if you type a word and then change its font, you’ll create a temporary style called “style1”. If you then change the font 
size of that word, “style1” will disappear and you’ll create a new “style2”. 

However, you can make a style permanent so that it remains in the document, regardless of whether it is currently in use. Temporary style 
names appear in plain text in the Styles & Colors palette, while permanent style names appear in bold. 

HTML and graphic text styles FW Pro only  

The formatting attributes available differ somewhat for HTML and graphic text. When defining a style, you may select HTML or GIF 
attributes. However, taking a style defined with one set of attributes for export in one format and setting it to export as the other format 
will lead to different results—only the attributes relevant for the export format already chosen for the text will be applied. 

[No Style] and other default styles FW Pro only  

In a new document, you’ll see [No Style], em, h1, h2, h3, p, and strong listed in the Styles & Colors 
palette. 

When you first type text into a new document, it has [No Style] applied to it, although the style is not 
highlighted in the palette. Because it has no character or paragraph attributes set explicitly by the user, it 
draws its attributes from the Default style. Generally speaking, it is best to leave this style set to the defaults 
in the Document Setup dialog. (See Freeway’s default styles on page 155.)
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Character and paragraph styles FW Pro only  

You can create both character and paragraph styles. Character styles contain attributes, which can be applied to an individual character, 
for example, font, size, style, and color. Paragraph styles include attributes such as alignment, leading (the vertical space between lines) 
and indents and are shown in the Styles & Colors palette with the “¶” symbol. 

Basic graphic text styling can be applied 
using the Inspector palette (see right). 
More comprehensive letter and paragraph 
attributes can be found under the Style 
menu when a run of text is selected.

Basic HTML text styling can be 
applied using the Inspector 
palette (see right). More 
comprehensive letter and paragraph 
attributes can be found under the 
Style menu when a run of text is 
selected.
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The Text panel on the Inspector palette and the Style menu show you some of the character and paragraph attributes for HTML and 
GIF text. The Edit Styles dialog box offers controls for the full range of character and paragraph attributes (see Creating a style on page 
171 for more information about the Edit Styles dialog). 

If you have applied a character style to part of a paragraph and a paragraph style to the paragraph as a whole, you will see both styles 
highlighted in the Styles & Colors palette when the text is selected. 

Applying a style FW Pro only  

The Styles & Colors palette displays all the styles currently in use within a document. Once you have created a style, you can apply it 
to other text: 

1.	 Select the text to which you want to apply the style. 
2.	 In the Styles & Colors palette, click on the name of the style you want to apply.

If you highlight a text run that has more than one style applied 
to it, all the styles will be highlighted in the Styles & Colors 
palette. To apply one style to a run of text, select the text and 
then click on a style name in the Styles & Colors palette. You 
can click either on one of the already highlighted styles or a 
completely different one. 

Renaming a style FW Pro only  

You may want to change style names to make them easier to identify. To rename a 
style: 

1.	 In the Styles & Colors palette, Control-click on the style you wish to edit and 
choose Edit Style… from the contextual menu, or choose Edit Styles… from the 

 menu to open the Edit Styles dialog box. 
2.	 Enter a new name for the style in the Name text field. 
3.	 Click OK to close the Edit Styles dialog box. 

You can also Alt-click on the name of the style in the Styles & Colors palette to 
highlight the existing name—type the new name and press the Return key to accept 
the change. Style names can only contain letters and numbers; other characters are 
not permitted. Any spaces you type will automatically be removed because they are 
“illegal” CSS code.

Removing styles from a run of text FW Pro only  

You can remove all current styles applied to run of text: 

1.	 Select the text run.
2.	 Click on [No Style] in the Styles & Colors palette. 

Freeway removes all style attributes and reapplies the default style attributes. 

As it is possible to apply styles to items and pages as well as runs of text in your document, you may find the Styles Inspector gives more 
control over which styles are removed. For more information on using the Styles Inspector, see page 174.

Importing styles FW Pro only  

You can import the permanent styles defined in a different Freeway document. The styles will be imported as a new style sheet:

1.	 Choose Styles… from the Edit menu. 
2.	 Click on the  menu at the bottom of the dialog box, and choose Import… 
3.	 Locate the source document (the one from which you want to import styles), select it and click Open.  

To import permanent styles 
from another Freeway 
document, use the Import… 
command in the Edit Styles 
dialog.

Freeway imports all the permanent styles from the selected document into a new style sheet.

4.	 You can now drag styles from the new style sheet into the existing style sheet. 

Dragging makes a copy of the styles, leaving the originals in the imported style sheet. Once you have moved the styles you want, you 
can choose to delete the imported style sheet by selecting its name in the list and clicking the  button at the bottom of the Edit 
Styles dialog. 

Note: If the Styles & Colors palette is not currently visible, open it by 
choosing Styles from the Window menu. The Styles & Colors palette 
will show the predefined Default styles with every new document.
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Imported styles 
can be dragged 
into the current 
main style sheet.

5.	 Click OK to close the Edit Styles dialog box. 

Making a temporary style permanent FW Pro only  

A permanent style is always displayed in the Styles & Colors palette, regardless of 
whether it is currently in use. To make a temporary style permanent: 

1.	 Control-click on the temporary style name in the Styles & Colors palette. This 
opens the Edit Style dialog for the selected style.

2.	 Select the Permanent box in the Edit Style dialog box. 
3.	 Give the style a new name, if you wish. Click OK to close 

the Edit Style dialog box. 

Hiding and showing temporary styles FW Pro only  

The list displayed in the Styles & Colors palette can show either permanent 
styles only, or both temporary and permanent styles. To change the list of styles 
displayed, click on the Styles & Colors palette  menu and choose either 
Temporary Styles or Permanent Styles Only. 
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Working with the predefined styles FW Pro only  

You can alter and work with these styles or ignore them and use only the styles you create and name yourself. 

To change the predefined styles:

1.	 Choose Edit Styles… from the Styles & Colors palette  menu. 
2.	 The Edit Styles dialog opens.
3.	 Select the style you wish to edit from the sheet1 list on the left. 
4.	 Make the changes to the attributes as you wish. 
5.	 Click OK to confirm your settings and close the Edit Styles dialog box. The chosen attributes will now be applied whenever you 

choose the style you have edited.

Creating a style 
FW Pro only

 

Tag field. Structural 
tags can be typed into 
the field, or chosen 
from the popup menu.

Name field. Used to 
edit style names. 

List of styles in 
the style sheet.

Attributes 
selector When 
clicked, this shows 
a list of available 
attributes.

Permanent checkbox. This is 
used to ensure styles remain in the 
Styles & Colors palette even if the 
only item with the style is deleted.

Click on the  
button to add a 
new style, or the 

 button to 
delete the selected 
style or stylesheet. The  menu 
gives options to create a new style 
sheet, duplicate existing styles, and 
import styles from other documents or 
style sheets.

Select button. This shows a full list of 
the available attributes, and allows you 
to pick which ones you want to appear 
in your style sheet.

View popup menu. From this menu you 
can choose to show just CSS attributes, 
just graphic attributes, or both sets of 
attributes together.

Extended button. 
Used to add 
extended code 
to the style. See 
Extending the 
code generated 
for specific items 
on page 213.

Click this to 
remove the 
attribute from the 
Edit Styles view.

A practical example is perhaps the best way to show how styles in Freeway Pro work. First, set up your document. The size doesn’t 
matter for the purposes of this example, so let’s choose one of the standard settings: XHTML 1.0, 800px by 600px.

Before you do anything else, choose Styles… from the Edit menu. This will show the Edit Styles dialog.

Since we want to work with HTML text for this example, choose CSS Attributes from the View popup menu in the bottom right 
corner. This will hide any references to graphic text from the Edit Styles dialog and make it easier to set up the attributes you want.

Click on the  button at the bottom left of the dialog. This adds a new style to the list, called “style1”. 
You will notice that, at the moment, the new style has no attributes.

Click the Select button at the bottom center of the dialog window. This changes the main view to show a 
list of all the attributes you can add to your new style. In this case, we will choose just the basic Character 
attributes for Font, Size, and Color, and Paragraph attributes of Align, Leading, Space before, and 
Space after. You may need to scroll down the window to see all the of attributes. Once you have clicked 
all the required checkboxes, click the Select button once more to return to the main dialog window.

You will see that the attributes you selected have been added to your style, but they are still default 
settings. Set the attributes as follows:

Font	 Verdana
Size	 11px
Color	 Black
Align	 Left
Leading	 100%
Space before	 6px
Space after	 0px
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Give the new style a name. 

Type “MainBody” into the Name field at the top right. Click OK to close the Edit Styles dialog.

Note: If you type a style name with spaces, Freeway will automatically remove 
them. This is because space characters are not legal for CSS titles. Other illegal 
characters include quote marks and apostrophes.

Open the Styles & Colors palette from the Window menu. You can also open it by clicking and 
holding the Inspector button at the top right of the Toolbar, or typing Alt-Command-y. Click on the 
Document Styles icon  at the left of the palette to show the styles in your document.

Your new style appears in the list. Because it includes paragraph attributes, it is marked with a pillcrow 
(¶). Styles that only contain character attributes do not have this symbol, for instance the predefined 
styles of “em” and “strong”. The new style’s name also has a full point at the start. This is a standard 
CSS naming convention, and is handled automatically by Freeway as you create styles.

Note: Please also refer to Styles Inspector on page 174. 

Using the style
The most obvious way we can use this style is to draw an HTML item, type some text into it, select all of the text, then click on the style 
in the Styles & Colors palette. There is nothing wrong with this method, and it has served Freeway users—and many DTP application 
users—well for many years. However, Freeway Pro can use the style in a couple of ways that can make your life easier. Let’s explore 
them.

Applying a custom style to a CSS item
1.	 Draw an HTML item box on the page.
2.	 While the box is still selected, click on the .MainBody style.
3.	 Enter some text in the box.

The text you have entered has adopted the .MainBody style, instead of 
appearing in the default Times that is set in Freeway’s Document Setup 
dialog.

Although the style is applied to all the text entered into the box, local 
formatting can be applied, such as bold and italic (using strong and em, for 
example). You can also apply other paragraph and character styles to selected 
text, for example to create headings and so on.

Applying a custom style to a page
While applying a style to an item, as in our previous example, is a useful trick, 
you have to apply it to each individual item on your page. You can also apply 
a style to the whole page.

1.	 Select the page in the Site panel, so that it is highlighted.
2.	 Click on the .MainBody style in the Styles & Colors palette.

You will note that the text on the Styles & Colors palette, just below the 
icons, changes to read “Apply to: Page”.

3.	 Now draw an HTML item box and type some text into it. The box appears 
to have already acquired the style. 

So, applying a style to the page means that every HTML item box you draw 
will automatically have the correct style. In CSS terms, you have created a 
class. You can also still apply local formatting as you work.

Power Tip: Applying a class style to your page allows for quick formatting 
of tabular material. A table will automatically acquire the main body style 
as it is drawn.
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Using tags for accessibility 
FW Pro only

 
See also Freeway’s Default Styles on page 155.

Using our example document, we shall now look at adding structural tags to our styles.

Creating a header style
1.	 From the Styles & Colors palette  menu select New 

Style…
2.	 Set the character and paragraph attributes as follows:

The blue in this example was chosen from the web-safe palette, 
and given a custom name.

3.	 Give the style the name “Header” and click OK.

The new style appears in the Styles & Colors palette. 

Now we have two custom styles in the Styles & Colors palette. 
Both styles can be used right away, but they don’t really provide 
any clear indication of the structure of your page to a screen 
reader, or a browser not capable of displaying the style as 
intended. To overcome this, we can assign structural tags to our 
styles.

Adding tags
1.	 From the Edit menu, choose Styles…
2.	 Select the Header style created earlier, and choose h1 from the Tag field popup menu. 

3.	 The Header style is renamed to reflect the tag that’s been added to it.

Nothing obviously happens to the style on your Freeway page, or in a browser. However, an extra tag has been added to the HTML 
output:

<h1 class=”Header”>Header</h1>

The <h> styles (see also <h> styles on page 156) are tags which define headers in CSS. This helps to format your page if a browser is not 
able to read the style sheet. <h1> is the largest header style.

It is also worth considering applying the <p> tag to the .MainBody style.
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Overriding the page style
An overall body text style applied to your page can be a real time-saver as you work. It means that 
you don’t have to apply the style to each box as you draw them. Sometimes, however, you might 
need to use a different style in a box, such as a pull quote or navigation box.

In this example, we duplicated the original .MainBody style, renamed it, and edited the attributes 
so the font color is white. The style has been applied to the blue HTML box. If the .MainBody style 
was edited at a later date, perhaps to change the font size or paragraph spacing, the blue box style 
would not be affected.

Power Tip: An alternative—and powerful—method of providing a “base” style which affects 
your whole web site design is to customize the predefined <p> style. Edit the style using the Edit 
Styles dialog box to add font, size, color, paragraph attributes, etc. When you draw an HTML item 
anywhere in your design it will automatically assume the settings of the default <p> tag.

Learning more
As you can see from this brief outline, Freeway Pro allows some complex styles to be built and used in your designs. The purpose of this 
section was to give a quick glimpse of some of the powerful ways CSS can be harnessed in Freeway. CSS is a much larger subject than we 
can comfortably cover in this Reference, so here are some web sites which will allow you to learn more.

To learn more about CSS and XHTML, visit http://www.w3schools.com and http://www.alistapart.com/

Styles Inspector 
FW Pro only

 
With Freeway Pro’s ability to apply text styles to pages and items, as well as to text, it can be a little overwhelming when trying to work 
out which style has been applied to what and where. The Styles Inspector gives an easy-to-follow hierarchical overview of where CSS 
styles have been applied in your design.

The Styles Inspector is a panel that appears in the Inspector palette. Depending on what is currently selected, it gives a hierarchical 
list of page elements, and styles that have been applied to those elements. To describe the Styles Inspector’s functionality, we have 
shown the Styles & Colors palette alongside the Inspector palette, together with items on a page. 

Note: See also What are Styles? on page 153, and Working with Styles on page 167. 

Note: Freeway Express does not support the saving of custom styles. The Styles 
Inspector is a Freeway Pro feature only.

Anatomy of the Styles Inspector

The Styles Inspector button.

Applied styles are shown in a 
standard order, showing Page, 
Item (or Table and Cell) and 
Text in a fixed hierarchy. Clicking 
a style name will open the Edit 
Styles dialog.

The  button removes the 
style. The  button shows a 
popup menu (see below).

When clicked, the  button shows 
a menu with options to create a new 
style, or choose an existing one. Only 
styles that can be applied to the 
particular item are shown. In this case, 
only paragraph styles can be applied to 
the item “clearbox”.

Disclosure triangles can 
be set to show or hide the 
styles for each element.
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Page level styles
With a page selected in the Site panel, the paragraph style 
“.MainBody” has been selected in the Styles & Colors palette. With 
no items selected on the page, the Styles Inspector shows Page, 
with the currently applied style shown in the list.

The  button allows the style to be removed from the page.

The  button, when clicked, shows a popup menu that allows a 
style to be applied from the currently available list. Choosing New… 
from the menu opens up the Edit Styles dialog so a new style can be 
created.

If no style has been applied to the page, then the section shows just 
Page and the  button. 

Item level styles
Selecting an item changes the Styles Inspector display to show 
any style applied to that item. This information appears below 
the Page section.

The  button allows the style to be removed from the item.

The  button, when clicked, shows a popup menu that allows 
a paragraph style to be applied from the currently available 
list. Choosing New… from the menu opens up the Edit Styles 
dialog so a new style can be created.

If no style has been applied to the item, then the section shows just 
Item and the  button. 

Table styles
Selecting a table or table cell changes the Styles Inspector 
display to show any styles applied to that table or cell. This 
information appears below the Page section.

The  button allows the style to be removed from the item.

The  button, when clicked, shows a popup menu that allows 
a paragraph style to be applied from the currently available 
list. Choosing New… from the menu opens up the Edit Styles 
dialog so a new style can be created.

If no style has been applied to the table or cell, then the section 
shows just Table or Table Cell and the  button. 
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Text level styles
Selecting some text in an item adds a further Text section to 
the Styles Inspector. This information appears sequentially 
below the Page and Item sections.

The  button allows the style to be removed from the selected text.

The  button, when clicked, shows a popup menu that allows paragraph 
or character styles to be applied from the currently available list. Choosing 
New… from the menu opens up the Edit Styles dialog so a new style can 
be created.

If both paragraph and character styles have been applied to the 
selection, both styles will be displayed in the Styles Inspector. 
Permanent paragraph styles show a ¶ (paragraph symbol) and the style 
name in bold type; temporary styles are shown in plain type. Styles are 
listed with the most recently applied at the bottom of the list.

If no style has been applied to the text, then the section shows just Text 
and the  button.

If the selected text has more than one style applied, the Text section 
lists all the styles affecting the selection, listed in the order that they will 
appear in the output HTML code.

If there are different runs of styled text within the selection, then it is 
not possible to produce a single list of styles that reflects the output. 
Instead, the Styles Inspector displays Mixed Styles in gray text at the 
bottom of the Text panel. Styles that apply to the whole selection will 
be listed as usual. For example, in the illustration above, the selected 
text has the “global” style of .AltBody, and “mixed styles” of em, strong 
and .style1.

If you wish to remove the mixed styles from the selection, hover the 
mouse cursor to the right of the gray text, and click on the  that 
appears. This action will remove the mixed styles, leaving the base style 
of the selection in place.

If a style is applied to a master page, the Styles Inspector displays the 
“inherited” style enclosed by square brackets on every page based on the 
master page. This also applies to items, tables, and table cells on master 
pages.

Editing styles
By clicking the name of a style listed in the Styles Inspector, Freeway 
will open the Edit Styles dialog.
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In Freeway, tables are a powerful means of organizing and presenting tabular (rows and columns) information correctly and easily. 
Tables are quite useful for presenting such content as price lists, schedules, product features and the like. They can also be advantageous 
for designing complex forms, where form control items (see Working with forms on page 198) and text must be carefully arranged. 

A table consists of a collection of rectangular “cells”, laid out side by side to form rows and columns. When you create a table in 
Freeway, you will be asked to specify the number of rows and columns you want the table to contain. Once you have created a table, 
you can adjust the width and height of the cells in the table, join cells, enter text and place inflow graphic items or form control items. 

Tables within Freeway are classified as HTML items, which means that they behave in a similar manner to HTML text boxes, pass-
through graphics, or form controls. Just like form controls in Freeway, tables can’t have other items in front of them, and they can cause 
graphic items behind them to be cut up, unless they are layered items (Freeway Pro only). 

When you first create a table, all the rows will be the same height and all the columns will be the same width. Once you have created a table, 
you can then resize the individual rows and columns as you wish within the overall dimensions of the table. You can add or remove rows or 
columns at any time. 

Like other HTML items, the vertical height of a table on your page may vary when the page is viewed in a web browser; this is because 
browsers may have different default text sizes. Using tables in complex layouts requires the same care as the use of HTML text boxes or 
form controls, as they can expand and potentially cause items on your page to break or shift when the page is viewed. 

In addition to the number and relative sizes of the rows and columns in the table, you can also control other aspects of how the table 
is displayed. These include the presence and thickness of a border between the table cells, fill color to be applied to the table or cell 
background, and the vertical alignment of the contents of the cell. You can also choose to merge two or more adjacent cells in a table into 
a single cell, which gives even more flexibility in presenting and arranging the information contained in your tables. 

Creating tables 
Tables may be created in Freeway using the Table drawing tool or by 
choosing the Insert Table… command from the Insert menu. Using 
either method, you will be asked to specify the number of rows and 
the number of columns that you wish your table to contain. 

Creating a table using the Table tool 
To draw a table using the Table tool: 

1.	 Select the Table tool in the Toolbar or Tools palette. 
2.	 Click and drag diagonally on the page to define a rectangular area. This area 

defines the size and position for the new table. 
3.	 In the Insert Table dialog which appears, enter numeric values for the number 

of rows and columns you wish the new table to contain, and set the border, 
cell spacing, and cell padding attributes as you wish, and click OK. You can 
change the number of rows or columns, and the border, spacing, and padding 
settings using the Inspector palette at a later stage if you wish.

A new table will appear in the area you defined by dragging with the Table tool. 
The rows and columns are evenly spaced to fit the size of the table. 

Note: Freeway Express does not have a Tools palette.

Working with tables

In Freeway Express, left, choose 
the Table tool from the HTML 
Item drop-down menu in the 
Toolbar. 

In Freeway Pro, the Table tool 
can be found on the Toolbar, 
and in the Tools palette, 
right.
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Creating a table using the Insert menu 
Using the Table… command on the Insert menu, you can create a table as an inflow item in an existing HTML box. To do this: 

1.	 Draw an HTML box, and click inside it to get the text insertion cursor. 
2.	 Choose Table… from the Insert menu. The Insert Table dialog will appear. 
3.	 In the Insert Table dialog which appears, enter numeric values for the number of rows and columns you wish the new table to 

contain, and set the border, cell spacing, and cell padding attributes as you wish, and click OK. You can change these settings at a later 
stage if you wish. 

A new table will appear at the insertion point, with the rows 
and columns evenly spaced to fit the size of the table. The 
starting size of the inserted table will vary depending on the 
number of cells, the width of borders, spacing, and padding.

Note: The Insert Table dialog defaults to a table of two rows and two 
columns, with Border and Cell spacing of 5px. If you change these 
settings, Freeway will remember them for all new tables you draw, even 
when you quit Freeway.

Modifying tables 
There is a variety of options that can be specified for tables and 
their cells. To access most of these, Freeway offers two panels in the 
Inspector palette—the Table General panel and the Table Cell 
panel. The Table General panel is available whenever you’re working 
with tables. 

The Table Cell panel is available whenever you’re working with table 
cells or their contents. There are also commands related to working 
with tables on the Item menu. 

You can control the following options for tables: 

•	 Position 

•	 Size

•	 Number of rows and columns 

•	 Cell, row, or column sizes 

•	 Border widths 

•	 Cell spacing 

•	 Cell padding 

•	 Cell and table background color 

•	 Join/split cells 

•	 Vertical alignment of cell contents

Positioning tables 
Tables can be moved and positioned like other independent objects on the Freeway 
page either by dragging with the mouse or numerically using the Inspector palette. 

To position a table using the mouse 
1.	 Using the Selection tool, point to the border of the table or a cell until the cursor 

changes to a hollow pointer. 
2.	 Click and drag to move the table to a new position. A solid outline indicates the 

position of the table while you are dragging it, and the Item General panel in the 
Inspector palette will display the coordinates of the table as you drag it around 
the page. 

	

Power Tip: Using this technique you can insert a table into the cell of 
an existing table, if you so wish. See Importing content into tables on 
page 185.

The Table Inspectors: on 
the left is the overall Table 
Inspector, with controls for 
numbers of columns and rows, 
etc; on the right is the Table Cell 
Inspector, giving control over cell 
size and content, etc. (Both are 
Freeway Pro; Express is similar.)
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To position a table numerically using page coordinates 
1.	 Select the table. 
2.	 In the Item General panel in the Inspector palette, use the X and Y values to enter the offset 

across and down from the top left corner of the page to the top left corner of the table. You can 
press the Tab key while you are editing to move between fields in the Inspector palette, and press 
Return when you are finished to accept the changes. 

Resizing tables 
Tables may be resized by dragging with the mouse or by entering a new width and height using the Item General panel in the 
Inspector palette. It isn’t possible to resize a table smaller than its contents. 

It’s important to note that many of the actions performed on individual rows, columns, or cells in the table may also affect the overall 
size. For example, the right column or bottom-most row may be resized by dragging the right or bottom edge of the table and this will 
affect the size of the table as a whole. 

To resize a table using the mouse 
1.	 Select the table by Alt-Command-clicking on a cell so that the table’s selection handles appear. 
2.	 Using the Selection tool, point to a handle so that the cursor becomes a tail-less black pointer. 
3.	 Click and drag to resize the table. All the rows and columns in the table will be resized in proportion. 

To resize a table using numeric values 
1.	 Select the table. 
2.	 In the Item General panel in the Inspector palette, use the W and H values to enter new width and height for the table. You can 

press the Tab key while you are editing to move between fields in the Inspector palette, and press Return when you are finished 
to accept the changes.

Selecting table cells, rows, and columns 
When working with cell background color or when joining and splitting cells in your table, you first need to select the cells with which 
you wish to work. In addition, when joining cells which have different content or background color, you need to be able to specify 
which cell’s settings are retained. 

Freeway allows you to select one or more cells in the table, even if the selected cells are not adjacent or touching. 

When selecting more than one cell, the first cell selected is marked as the “master” cell in the selection. If performing the Join Cells 
command, it is this cell whose settings and content will be used 
as a basis for the new span (see Joining and Splitting Cells on page 
184 for more explanation). 

When more than one cell is selected, the master cell is shown 
using a thick gray outline, and the rest of the cells in the 
selection are denoted by a lighter gray outline. 

Freeway also allows you to select entire rows or columns quickly 
by clicking at the top or left-hand edge—a small solid arrow is 
displayed to show that when you click, a row or column will be 
selected. 

To select a cell 
Using the Selection tool, click on the cell you wish to select. You can move the cell selection using the Tab and arrow keys. 

This table’s top row has 
been selected, and shows 
the master cell with the 
solid gray border. Note the 
small solid arrow used to 
select complete rows or 
columns.
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To select two or more cells 
1.	 Using the Selection tool, click on the first cell you wish to select. 
2.	 Now, hold down the S key and click on the second and subsequent cells 

to be added to the selection. The cells do not need to be adjacent. You can 
also use S with the arrow keys to extend the selection to adjacent cells. 

Note: If you wish to remove a selected cell from the selection, Shift-clicking 
again will deselect it while retaining the selection of any other cells. 

To select an entire row or column 
1.	 Move the mouse over the top of a column or the left-hand edge of a row 

until the cursor changes to a small solid arrow. 
2.	 Click to select the row or column. 

You can also select multiple rows or columns: With one row or column 
selected as above, hold down the Shift key and select another one. The 
selections may or may not be contiguous or connected (for instance, you 
can select the 2nd and 5th rows of a table, or any others, for quickly 
deleting or applying formatting to the cells or their contents). The selection 
need not be only rows or columns—you can also have multiple rows and 
columns selected simultaneously.

Note: Any cell spans (that is, two or more cells that have been joined) will 
be selected only if they start in that row or column. 

To select the table 
1.	 Click on any cell to select it. 
2.	 Alt-Command-click to select the table that contains it. 

Adding and removing rows and columns 
You can add or remove rows or columns at any time. To change the number of rows and columns, edit the settings in the Cells panel of 
the Item General panel in the Inspector palette or directly insert or delete rows and columns at a particular point in the table. Table cells, 
however, cannot be deleted. 

When using the Inspector palette to edit the number of rows and columns for the table, rows and columns are added or removed at 
the lower and right hand edges of the table. 

When using the Insert commands from the Table submenu in the Item menu, Freeway displays a dialog for the user to choose where 
to insert the desired row or column. 

To change the overall number of rows and columns in the table 
1.	 Select the table and view the Table Cell panel in the Inspector palette.
2.	 Using the Rows and Cols options, enter the number of rows and columns you wish to have. You can 

press the Tab key while you are editing to move between fields in the Inspector palette, and press 
Return when you are finished to accept the changes. The table will be updated to reflect your changes, 
and if any rows or columns need to be added or removed, this will be done from the bottom right of the 
table outwards. 

You can also select a table by 
positioning the mouse cursor 
arrow over the edge of the 
table border. When the cursor 
turns to a hollow pointer, you 
can click to select the table.
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Deleting one or more rows or columns 
You can easily delete specific rows or columns within a table in 
two ways, depending on whether you select the entire row or 
column, or a cell within a desired row (the latter method only 
applies to rows). 

Follow the above steps for selecting rows and columns. With 
your targets selected, press Backspace. 

If you have selected a single cell, you can also delete the row or 
column to which the cell belongs by choosing Delete Row or 
Delete Column from the Table submenu in the Item menu, 
or by Control-clicking and choosing Delete Row or Delete 
Column from the contextual menu. 

Adding rows and columns 
1.	 Select the table, a cell, or a range of cells in the table. 
2.	 From the Table submenu on the Item menu, choose Insert Rows or Insert Columns as appropriate. You may find that one or 

more of these options is unavailable, depending on the current cell selection—for example, if you have an entire row selected, you 
will not be able to insert a column, and vice versa. 

3.	 Freeway displays a dialog that allows you to choose the number, size and location of the columns or rows to be created. Click OK 
once you have made your choice. 

4.	 The new row or column is added. 

Insert Columns… is 
grayed out here because 
the initial selection was 
an entire row.

Power Tip: You can quickly create a new row or column by following these steps:
1	 Begin dragging the border between two rows or columns (as described in Resizing rows and columns on page 182) 
2	 Press the Alt key as you continue to drag
3	 Release the mouse, then release the Alt key
4	 A new row or column will be added

Deleting cell content 
To delete the content of cells, rows, or columns, select them and choose 
Delete Content from the Edit menu or type Command-b. All cells will retain 
formatting such as their fill color, etc. 

Use the 
contextual 
menu to 
quickly access 
table editing 
commands.
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Empty cells 
In HTML, table cells may be defined as “empty”, which means 
that no cell is displayed at all at that location in the table—this 
is different from an ordinary cell that simply has no content. For 
example, empty cells do not display the border if one is applied 
to the table. You can select any cell or cells and set them to be 
empty cells, causing any existing content to be discarded. 

To set a cell to be empty 
1.	 Select one or more cells in the table. 
2.	 In the Table Cell panel of the Inspector palette, select the 

Empty checkbox. Any existing content will be deleted, and 
the cell will show as a blank area in the table. 

3.	 To recreate a cell, click with the Selection tool where the cell 
should be and deselect the Empty checkbox in the Inspector 
palette. Clicking twice with the Selection tool where the 
cell should be, and then entering content will also recreate a 
cell. Local formatting will be retained, such as font size and 
styling, content positioning, and cell background color. 
 

Resizing rows and columns 
When you resize a row or a column using the mouse, you can choose whether the adjacent row or column has its size changed to 
preserve the current table size or is simply repositioned. 

You can also specify the size for rows and columns using numeric values. 

To change the widths of rows or columns using the mouse 
1.	 Using the Selection tool, point to the border between two rows or columns so that the 

cursor changes to the resizing shape .
2.	 Click and drag to reposition the border and resize the row above or the column to the 

left, as appropriate.

The adjacent row or column will be repositioned. 

Note 1: Dragging a divider up or to the left will cause the table to shrink. Dragging 
down or to the right will cause the table to grow. You can cause the adjacent row or 
column to be resized, instead of repositioned, by holding down the Command key 
after you have begun to drag, and releasing the key after releasing the mouse button. 

Note 2: Rows and columns have a minimum size when empty and cannot be made 
smaller. If cells contain text, they cannot be made smaller than the size required to 
hold the text. When a cell contains an inflow item, the cell contents will overflow if 
the cell is too small to display the entire item. 

Changing table borders 
When a table is displayed in a web browser, it can be shown with three-
dimensional beveled borders around the edges of the cells and the table. You 
can turn this border on or off and specify its thickness. By default, all new tables 
created in Freeway are given a border with a 5-pixel thickness, unless you set the 
border to 0px when you created the table. 

To change the table border 
1.	 Select the table. 
2.	 In the Inspector palette, enter a new numeric value in the Border field in the Cells panel and press Return. 

To remove the table border 
1.	 Select the table. 
2.	 In the Inspector palette, enter 0px in the Border option in the Cells panel and press Return.  
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Changing cell spacing 
The cells in each row and column may be separated by a certain amount of space—this is called the cell spacing. By default, this spacing 
is set to 5 pixels when new tables are created in Freeway, unless you set the spacing to 0px when you created the table. Changing this 
option for the table will cause the overall dimensions of the table to change. 

To change the cell spacing 
1.	 Select the table. 
2.	 In the Inspector palette, enter a new numeric value in the Cell spacing field in the Cells panel 

and press Return. 

To remove the cell spacing 
1.	 Select the table. 
2.	 In the Inspector palette, enter 0px in the Cell spacing field and press Return.

Changing cell padding 
Within each table cell, you can specify an offset between the inside edge of the cell and the content of the cell. This offset is called cell 
padding. When new tables are created in Freeway, cell padding is set to 0px by default. 

To change the cell padding 
1.	 Select the table. 
2.	 In the Inspector palette, enter a new numeric value in the Cell padding field in the Cells panel 

and press Return. 

To remove the cell padding 
1.	 Select the table. 
2.	 In the Inspector palette, enter 0px in the Cell padding field and press Return. 

Changing cell alignment 
The contents of table cells can be top-, middle-, or bottom-aligned using the Align buttons in the Table 
Cell panel of the Inspector palette. 

Applying color 
You can apply a colored fill to the background of the table or to 
individual cells. 

To apply color 
1.	 Select the table or a run of one or more cells. 
2.	 Choose the color you wish to apply from the Table or Table 

Cell panel in the Inspector palette, or as appropriate or 
from the Styles & Colors palette. 

Note: Freeway Express does not support the saving of custom 
colors. You can choose the background color for a table or cell by 
choosing Other… from the Color popup menu, then choosing 
the color you want from the Mac OS X Color Picker.
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Joining and splitting cells 
It is possible to combine two or more cells in order to define a single new cell that spans two or more rows or columns. Cells created in 
this way are called spans and can be used to create headings across the table or to group categories of cells together. Spans can be split 
back into an appropriate number of cells if desired.

To join two or more cells 
1.	 Select two or more cells as described in Selecting table cells, rows, and 

columns on page 179. The first cell selected will be the target cell for the 
selection, and it is the content and settings of this cell which determine 
those of the new span cell which will be created. 
 

2.	 Choose Join Cells from the Table submenu on the Item menu,  
Control-click and choose Join Cells from the contextual menu, or press 
Alt-Backspace. The cells will be combined into one new cell, with the 
content and settings of the target cell in the original selection. 

To split a cell 

Note: If the cells in the original selection were not adjacent cells in the 
same row or column, then Freeway will create a new span cell which fits the 
rectangle defined by the outermost cells in the selection.

To split a cell, select it and choose Split Cells from the Table submenu 
of the Item menu. In the Split Cells dialog box, choose the number 
of new cells you wish the selected cell to contain and whether you 
want to split it horizontally or vertically, then click OK. 

If splitting the cell will create an entirely new row or column, the 
cell will be split into equal parts. However, if the cell being split was 
created by joining cells initially, the original divisions will be recreated 
if the number of cells you specify matches the original number of cells. 

Formatting text across table cells 
Freeway can format text in a table as a whole, and in several table cells at the same time, although it isn’t possible to highlight text in 
more than one cell at a time. Select the actual cells containing the text you want to format by Shift-clicking on each one, then apply 
the formatting you want. 

See also Styles on items: Tables on page 158.

To apply a style to a table FW Pro only  

Applying a style to a whole table means that all cells in the table will use the chosen style. You can still apply local styling to individual 
cells or their text content.

1.	 Select the table, as already described.
2.	 Choose the style you wish to apply from the Styles & Colors palette.

See also Using the style: Applying a custom style to a CSS item on page 172.

Power Tip: Applying a “global” style to a page in Freeway Pro is a useful 
way to avoid a lot of repetitive clicking to apply styles to items. Applying a 
“local” style to a table can override the global style. See Using the style: 
Applying a custom style to a page on page 172.

Note: Freeway Express does not support custom styles, and 
does not have a Styles & Colors palette.
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Copy/pasting table data 
You can copy/paste cell selections between tables in your 
documents. 

1.	 Shift-click to select the cells you wish to work with. 
2.	 Choose Copy from the Edit menu. 
3.	 Select a cell in a destination table and choose Paste. 

Importing content into tables 
Table cells behave much like HTML text boxes and are primarily intended to contain numeric or text content. If you wish a table cell to 
contain a graphic or other content such as multimedia, you need to create an inflow item in the cell to contain this. 

It is possible to insert an HTML item, graphic item, another table, as well as Action and Markup items into a table cell. These options 
will be described later in this section, but we’ll start with adding text content to a table.

Adding text 
You can add text to a table cell by typing, pasting, or importing. 

When you add text, you are adding it to a single cell at a time. However, there is a way of importing delimited text into multiple cells. 
When you import tab-, comma-, or space-delimited text into a table cell, Freeway will automatically put each delimited entry into a 
separate table cell. Each line of text in the original text file becomes a separate row. When creating the text file for import in this way, 
individual entries can be separated by putting tab characters, spaces, or commas between them in the original text file. 

Adding text into a table cell 
Click inside a table cell using the Selection tool to create a text insertion point. To add text: 

•	 Type the text you want to add; or 

•	 Paste text from the clipboard; or 

•	 Use the Import Text… command on the File menu. 

As you add text into a table cell, it will wrap at the edge of the cell onto a new line. If no more lines of text will fit in the table cell, the 
cell will grow downwards to accommodate the text. This will normally cause the entire row to grow. 

To import delimited text into a table 
1.	 Create a text file in a word-processing document, using commas, spaces, or tabs to delimit each entry on a line. 
2.	 Create a table. 
3.	 Click using the Selection tool to create a text insertion point in the first table cell which you wish to hold the content from the 

text file. 
4.	 Choose Import Text… from the File menu, choose the type of delimited text from the Import popup menu, then locate the text 

file you wish to import. Click Open. 

Freeway will import the contents of the file into your table. Freeway 
will automatically put each delimited entry into a separate table cell 
and each line of text into a separate table row. If additional rows or 
columns are required, Freeway offers the option of creating them or 
truncating the imported content. 

To import graphic content into a table cell 
1.	 Click inside a table cell using the Selection tool to create a 

text insertion point. 
2.	 Choose either Graphic Item from the Insert menu to insert 

an inflow item. 
3.	 Command-click twice on the new item to select it and then 

choose Import… from the File menu. 

To import pass-through content into a table cell 
1.	 Click inside a table cell using the Selection tool to create a 

text insertion point. 
2.	 Choose HTML Item from the Insert menu to insert an 

inflow item. 
3.	 Command-click twice on the new item to select it and then 

choose Import… from the File menu. 

Note: If, when pasting copied cells, the table you’re pasting into needs 
to be resized to accommodate the pasted information, Freeway will show 
a warning dialog box. Be careful when choosing from the options in the 
warning dialog, because if a page is enlarged to accommodate the growing 
table, other design elements may be adversely affected.

Note: The file needs to be saved as a text file, with a .txt extension. 
If an RTF file is imported, Freeway reads the rich text formatting data 
that is normally hidden. 

Power Tip: If the graphic item is too wide, it will overflow the table. 
In that case it is best to first draw a graphic box on the page, import the 
graphic and then resize the box to fit it by pressing Shift-Command-d. 
Select and Copy the graphic item, then click on the table cell in which you’d 
like to place it, and Paste. You can then resize the width of the column to 
accommodate the item. Setting the height of the cell to 0 will cause the row 
to fit snugly against the item.

Note: If imported image is too large to fit the inflow box, a diagonal cross 
will show in the box. Making the box fit the content may force the table 
to grow with unpredictable results. In most cases it may be best to import 
a pass-through image into an HTML box drawn elsewhere on the page, 
copying it and pasting it as an inflow item, as described earlier. See To 
import graphic content into a table cell.
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To import other content into a table cell 
1.	 Click inside a table cell using the Selection tool to create a 

text insertion point. 
2.	 Choose the preferred content type from the Insert menu 

(table, Action, or Markup) to insert an inflow item.

Nesting inflow items
It is possible to insert inflow items within inflow items, both in tables and within other items, 
with no real limit to how many can be nested in this way. While nesting items like this opens 
lots of possibilities in terms of layout and control of items on the page, remember there are often 
several, perhaps better, ways to create such layouts in Freeway.

Note: Inflow Actions and Mark-up items work the same in table cells as 
when they are imported into normal HTML boxes. To find out more about 
Actions, see the Freeway Knowledgebase online. To find out more about 
Markup items, see Adding markup code in Freeway on page 212.



Frames 
Frames can enhance the performance, navigation, and branding of your site when used well, but they can be unsightly and confusing 
for the visitor when used inappropriately. It is important to be aware that frames also have some unique disadvantages compared with 
presenting your site without frames. 

What are frames and frameset pages? 
Frames are essentially a different way of viewing individual HTML pages in a web browser. When viewing HTML pages normally (that is, 
without frames) a single HTML page is viewed in a single browser window. If you wish to view two HTML pages together, each must be 
viewed in its own browser window. 

However, with frames, a single browser window may be used 
to view two or more HTML pages at the same time, by using 
commands to split the window into two or more parts. The 
parts created by splitting the window are called frames and each 
frame then holds a single HTML page. 

A simple use of frames is to make a navigation bar along the 
side or top of your site and a main frame for the content. So 
if your content is long and requires scrolling, for instance, the 
navigation bar will always be available. 

The way it commonly works is that the user clicks on a link 
in the navigation bar and the linked page appears in the main 
frame. Basically, frames are just containers for your web pages. 

To define how the browser window must be split and what 
HTML pages should be displayed in each part, a special kind 
of HTML page is used, called a frameset page. When viewed in 
a frames-capable web browser, this page displays no content 
of its own, but is simply used to define the way in which 
the window is split into frames, and which further HTML 
page should be displayed in each frame to begin with. This 
information is called the frameset definition. 

Once you have defined your frameset, you have a single container for your web pages. It’s then just a matter of using Freeway to define 
your links so that when the user clicks on a link, the page opens in the intended frame. 

The frameset page defines the number and orientation of the frames to be created in the browser window, as well as information about 
how each frame should behave. You can define: 

•	 Whether a border is to be displayed between frames, and if so, what its width will be. 

•	 Whether frames are to be a fixed-width, or a width proportional to the actual width of the browser window. 

•	 Whether to show scroll bars if there is more content than can be displayed at a particular size. 

•	 Whether a frame can be resized interactively by the web site visitor. 

Here is a summary of Frames terminology: 

Frame: Part of a browser window which has been split to display two or more HTML pages at the same time. 

Frameset: The container for two or more frames. Framesets may be nested within each other to create complex structures.

Frameset page: An HTML page which contains one or more framesets. 

Source : The page that is displayed within a frame when the frameset page is viewed in a web browser. 

The frameset page may also contain content to be displayed by web browsers that cannot display frames. This is called Noframes content, 
and it will never be seen by the majority of visitors who will be using frames-capable browsers. It is important to display some basic 
content to allow people who aren’t using frames-capable browsers to contact you. You might want to link them to a separate, non-
frames version of your site. 

Linking within frames 
When the user follows a link contained in a frame, the default behavior of the browser software is to load the new page into the same 
frame as the link. This is usually the correct thing for it to do, but there are important cases when something different should happen. 
Examples of when this may not be appropriate are when links point to external web sites or when separate frames are being used for 
navigation and displaying content. 

To allow the necessary control over this, there are two other important ideas which are related to the use of frames; the naming of 
individual frames, and the ability to target a link to load the new page somewhere other than the frame in which the link appears. 

Working with frames
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Using link targeting, you can tell the browser that, instead of replacing the content of the frame containing the link, the new 
page should appear somewhere else—such as in a different frame in the same window or a new window altogether—or replace the 
entire content of the current browser window. 

In order to load the new page into a different frame in the same browser window, you need to be able to tell the browser which frame is 
to be the “target” of the link. To permit this, you can give any frame a unique name so that it can be identified. 

Once you have named a frame, you can specify that name as the target when you specify links. You can specify a unique target for every 
link you create. However, to save time and effort when several links on a page all need to be targeted the same way, it is possible to set 
a “base target” option for the page containing the links. If this is set, all links on that page without individual link targets should load 
into the given target frame. 

Benefits of using frames 
As mentioned initially, good use of framesets can enhance site performance, navigation, and branding. They can also make site 
maintenance easier, and be used to solve certain layout problems. 

Faster Performance 

When separate frames are used for displaying navigation or site-branding elements distinguished from the content of the site, it can 
sometimes make a site considerably faster to browse. This is because the elements that are the same from page to page no longer have 
to be unloaded and reloaded as new content pages are visited. Content pages become smaller and less complex as a result and therefore 
download and render more quickly. 

Easier Navigation 

When navigation links and content are contained on the same page, this can make it harder for visitors to navigate, especially if pages 
scroll vertically so that the navigation links disappear out of sight. Using a separate frame for navigation links ensures that even when 
scrolling in the content frame occurs, the visitor never loses their navigation controls. 

Branding 

As with navigation, when branding elements such as company name and logo are contained within a separate frame from the content, 
frames ensure that these elements are always kept in sight—reinforcing the corporate identity and the user’s sense of where they are. 
When placing advertising banners on a web site, the same benefits apply if they are set in their own frame—the advertiser’s message is 
kept in constant view, which makes the advertising space more effective.

Easier Maintenance 

Using separate frames for navigation, branding, and content makes it easier to maintain a web site. The pages that lie behind such 
frames act in the same way that master pages do in desktop publishing and in Freeway documents, so that elements which repeat 
throughout the site can be created once and subsequently reused. For maintenance thereafter, changes need only be made in one place, 
instead of on every page. 

Layout Advantages 

When constructing a site using frames, they can be used to solve certain layout problems that may cause difficulty otherwise. Examples 
are: 

•	 True vertical and horizontal centering of page elements within the browser window. 

•	 Cropping of page background images to a specific size. 

•	 Using different page background colors within different areas of the browser window. 

•	 Using different link colors within different areas of the browser window. 

Disadvantages of using frames 
Although the benefits of using frames can be great, they can 
be time-consuming to create and work with, especially at first. 
They may also be confusing to beginners. There are other 
disadvantages too that must be understood and weighed against 
the benefits. 

Frames—in depth

Using frames to construct a site goes against some of the theoretical 
principles underlying the development of the web as an information 
space. One leading commentator on the web is a strong critic of the use 
of frames—read Jakob Nielsen’s views about how “Frames suck most of 
the time” at: http://www.useit.com/alertbox/9612.html. Also: 
http://www.apptools.com/rants/framesevil.php. 

You may also want to consider iFrames. More information about 
using iFrames (supported by third-party Actions in Freeway 
Pro and Express) can be found on the Softpress Knowledgebase 
(http://www.softpress.com/kb/questions/210/). Other sources of 
information about frames and iFrames can be found on these links: 
http://www.webmonkey.com/2010/02/iframe/ 
http://www.webmonkey.com/2010/02/Floating_Content_ 
in_I-Frames/

Please be aware that these links are not aimed at the visual designer, and contain 
a lot of HTML mark-up code.
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Browser support 

Frames were originally a proprietary extension to the HTML language, which became popular with users and web site designers long 
before there was any formal recognition of them in the HTML specification. 

Statistically speaking, at the time of this writing, almost everyone who visits your site will be using a frames-capable browser of some sort. Studies 
indicate that between 95–100% of visitors to most sites are using a frames-capable browser. 

However, it’s worth remembering that in some browsers, it is possible to turn off the display of frames using the browser preference 
options. This means that even someone using a frames-capable browser may not be able to see your frames site if the display of these 
has been turned off (whether by accident or intentionally). 

Visitors who aren’t using a frames-capable browser at all may include people using text-based or PDA-based web browsers, and visually 
impaired people using speaking browsers. 

Web designers need to decide for themselves whether to use frames at all, provide alternate content or sites for the non-frame users, or 
just ignore the issue altogether, based on the kind of site they’re designing and the anticipated audience. 

It often helps to see what other designers have done when creating frames-based sites similar to yours. One option is to visit a few sites 
which are aimed at the same sort of audience as yours, and simply view the source of the main frameset page in your web browser to 
see if there is Noframes content specified. Another method would be to obtain a browser that 
does not support frames, and visit a selection of sites using it. Microsoft Internet Explorer 
Mac is probably the only browser which allows the user to set a preference to turn off frames 
while browsing, but is no longer available as a download from Microsoft. A large number of 
major sites which use frames, offer no alternative content whatsoever, without seeming to 
antagonize people. 

Bookmarking URLs 

One of the great strengths of the web as an information resource is the ability to find any page you want at any time, using its unique 
address, the URL. However, when browsing pages through a frameset instead of directly in their own window, the browser location bar 
no longer displays the URL for the actual pages being browsed—rather, it displays the URL for the frameset page through which the 
content pages are being viewed. Bookmarking this URL after following a few links and returning to it later will restore the pages that 
were in view initially, not the pages that were in view when the bookmark was created, and many people find this irritating. 

There are other problems related to this. In the original concept of the web, a page was a self-contained unit—it contained all the 
information provided by the author regarding context, links, and so on, so that when you revisited a page you had been to before, you 
had the same options and information available to you. 

However, in a frames site where branding, navigation, and content can be split over different pages, this self-contained aspect is lost. 
Suppose you did manage to record the URL for the actual content page you were viewing and returned to this page at a later date; all that 
you would see is the content page itself, without the context of the originally accompanying frames which surrounded it. In order to see 
exactly what you saw the first time, you would need to start at the original frameset and proceed through the same series of links. 

Print Problems 

Web browsers are notoriously bad at printing web pages at the best of times, but the additional problems which result from trying to 
print framesets as you see them make it nearly impossible for the browser to get it right. For example, should all the frames be printed 
or just one? What should happen if you have more content than will fit in a frame without scrolling? What should happen if there are 
two or more frames with scrolling content in view at the same time? 

Where visitors are likely to wish to print the page contents, experienced web publishers often provide alternate versions of the page 
which have been specifically designed for printing to try to get around these problems. 

Search Engines 

Search engines use a variety of methods for indexing a site and often have problems deciding what exactly to index in frames sites. This 
can result in referencing inappropriate entries. To read some real-life experiences of how one web master got on with search engines and 
his frames-based site, visit http://www.eric-a-hall.com/articles/19980209.html. 

Another problem can occur if visitors enter a site through a search engine reference to one of the content pages. If branding and 
navigation are created using separate frames, visitors who access one of the content pages on its own may be left with no idea of which 
site they are on or how to navigate to other pages. For this reason, many web designers repeat a selection of important links as HTML 
text at the foot of every page, so that such visitors can always reach important places like the home page. 

User Preference 

Although many people like visiting frames sites, especially sites that use frames elegantly, there is a small but substantial group of people 
who dislike their use. For some of them, the dislike is a rational one, based on some or all of the reasons above; for others, it seems to be 
simply personal preference. It’s worth remembering that not everyone may be pleased to see a new frames version of your site, despite 
whatever benefits it brings. 

Note: Older or obsolete browsers can 
sometimes be found on the Evolt.org web 
site: http://browsers.evolt.org
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How to create frameset pages 
The easiest way to create a frameset in Freeway is to use the New 
Frameset… command on the Frames submenu on the Page menu. This 
displays a dialog allowing you to select from a range of predefined frame 
layouts. A new frameset page will be created in your document. You can 
choose whether or not Freeway automatically creates source pages for the 
frames in the new frameset page. 

Additionally, any page in a Freeway document can be made into a frameset 
page with two or more frames using the Split Horizontal or Split Vertical 
commands. Each frame may point to either a page in the same Freeway 
document or an external HTML page. The page referenced in a frame is 
known as the source page of that frame. 

If the source page for any of the frames is not available when a frameset 
page is rendered in the web browser, the browser may display a dialog 
box containing an error message. Freeway will warn you if you publish a 
frameset that has unspecified source pages. 

The same source page may be referenced in two or more frames in the same 
frameset page—this is often done, for example, when using empty HTML 
pages (which usually contain nothing but a page background color) as fillers 
in a layout designed using frames. A source page will usually be a standard 
HTML page, although it is possible for the source of the frame to be another 
frameset page (thereby creating a nested frameset) or any valid HTML 
object, such as a graphic or multimedia element. 

Creating a predefined frameset page 
1.	 Choose New Frameset from the Frames submenu on the Page menu, click on the  menu and choose New Frameset… in 

Frames palette.
2.	 Give the frameset a descriptive name. 
3.	 Choose the frame layout of your choice from the selection and specify to Show borders if desired. 
4.	 Enable the Create pages for frames option if you wish Freeway to create source pages for the frames in the new frameset pages 

and select a master page on which to base these. 
5.	 Click OK. 

A new frameset page will be created in your document with the frames named and given the most likely attributes. 
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Viewing Pages, Framesets, and Noframes content 
Once you have defined a frameset, you no longer view a single Freeway page but rather the actual frameset on which you are working. 
The Page button near the top left of the document window is replaced by a Noframes and a Frameset button. 

You can work directly in each frame as it appears in the window or you can use the Link Map or Site panel to select a page by clicking 
on the page’s icon. If a page is selected, the Noframes and Frameset buttons 
revert to the Page button. You can return to the frameset at any time by clicking 
its icon in the Link Map or Site panel. 

Changing normal pages into frameset pages within a Freeway document 
The procedure described in this section is useful if you have an existing page that you want to define as the Noframes content for a 
frameset. The result will be an empty frameset—each frame of which is ready to be linked with a source page. Making your existing page 
into a frameset is easy: 

1.	 View the page you wish to become the frameset page. 
2.	 Choose either Split Horizontal or Split Vertical from the Page menu. 

The normal page outline and pasteboard will disappear and be replaced by two colored sections, dividing the area of the document 
window in half. These areas are the frames you have created. 

If the page already contains content when it is changed into a frameset page, it 
is not lost in the process; and if you remove the frames from the page, the initial 
content will be restored. The original page contents are output in the HTML 
as Noframes content, which will not be displayed in frames-capable browsers, 
although it will be downloaded in the background when the page is viewed, 
increasing download time. 

In the Site panel, frameset pages are differentiated from normal pages by a 
different icon. 

Noframes content 
Noframes content is displayed when a frameset page is viewed using any browser which is not frames-capable, or when a frameset page 
is viewed with the option to display frames turned off

There are two ways of creating Noframes content within Freeway. First, as described above, any content on the page before it is made 
into a frameset page will be specified as Noframes content. Second, you may choose to edit the Noframes content by selecting the 
Noframes view button at the bottom right of the window. 

Some web publishers do not designate any Noframes content at all, but this can be unfair to users of other browsers who visit your site. 
Without Noframes content being specified, visitors who come to your site with browsers which are not frames-capable see absolutely 
nothing—not even an error message. 

On each frameset page, you can define some Noframes content, which at the very least informs visitors without frames capability 
why they aren’t seeing your site. It’s a good idea to provide Noframes visitors with an email address and basic contact details. You 
may also wish to supply a list of links into the content pages of your site. This not only assists Noframes visitors, but can also help 
some search engines to index your site more effectively. 

Options for working with frames 
The necessary options for working with frames are located at the foot of the Page menu, in the Inspector palette and in the Frames 
palette  menu. Note that there is a panel in the Inspector palette called the Frameset panel, which should not be confused with the 
Frames palette itself. 

Frameset General panel on the 
left, with the Frames palette on 
the right.

Note: Link Map is not available in Freeway Express.

Frameset pages have a 
different icon to normal 
pages in the Site panel.
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When on a frames page, the Inspector palette always displays the Frameset General panel, which 
has a different icon from the normal Page General panel. This panel allows you to give the frameset 
page a title, change the filename which will be generated for the page or change the width of the border 
between the frames in the browser window. 

When working with selected frames, you may also see the Current Frameset and Current Frame 
panels, which contain the options for the selected frame and its enclosing frameset. 

Finally, because you can edit the pages that are being displayed inside the frames on a frameset page, you 
will see the Page General panel for the page being edited in the Inspector palette alongside the frameset 
panels. 

Once you have created a frameset page, you may:

•	 Select any frame and specify a source page for it. The source page may be another page in the same 
Freeway document or an external HTML page. 

•	 Split a frame so as to contain further frames nested within it. Nested framesets contained within a 
frame do not need to have the same orientation as their parent frameset. 

•	 Add more frames at the same level, creating a frameset with three or more frames. (Subsequent 
frames added to the same frameset must share the same horizontal or vertical orientation.) 

•	 Change the orientation of the frames in the frameset. 

•	 Change the border width between the frames. 

Specifying an existing page to be the frame source 
1.	 Select the frame by clicking inside it. A selection marquee will then appear inside the selected frame. 
2.	 In the Frameset General panel of the Inspector palette, locate the Current Frame section. From the Source popup menu, choose 

the existing page you wish to set as the source for the selected frame. 

The frame now displays the source page as its content. You may edit objects on the source page as if you were viewing it as the current 
page. 

Creating a new page to be the source of the frame 
1.	 Select the frame by clicking inside it. A selection marquee appears 

inside the selected frame. 
2.	 In the Current Frame panel of the Inspector palette, choose Other… 

from the Source popup menu. The Frame Source dialog will appear. 
3.	 Click the New Page… button and then select the master page on 

which you wish the new page to be based. 
4.	 Click OK. After the New Page dialog appears, type the title for the new 

page and click OK. 

The frame now displays the source page as its content. You may edit 
objects on the source page as if you were viewing it as the current page. 

Note: With any frame selected, you can use the Frame Source… command on the 
Frames submenu of the Page menu (or the Frame Source… command on the 
options menu in the Frames palette) to set or change the source page for that frame. 
You can also use the Go to Selected Page command to change from the frameset page 
to the actual content page itself, if the content page is in the same Freeway document.

Specifying an external HTML page as the frame source 
In order to do this, you first need to know the file name of the HTML page you wish to set as the frame source, as well as where it will 
reside in relation to the frameset page you’re creating. To find out more about specifying relative URLs to external pages, see Relative 
references on page 113. 

1.	 Select the frame by clicking inside it. A selection marquee appears inside the selected frame. 
2.	 In the Current Frame panel, choose Other… from the Source popup menu. The Frame Source dialog will appear. 
3.	 Select the External tab. Choose the option URL and type or paste in the URL for the external page you wish to specify as the frame 

source. The URL for the external page will appear in the frame against the colored background. 

When the page is viewed using a browser, the browser will attempt to load the specified URL into the frame. 

Freeway allows you to view and edit the contents of the pages viewed in a frameset, as long as they are contained within the same 
Freeway document and do not themselves contain framesets. This offers a great advantage for designing your site, since you can see 
what the finished result will look like without having to constantly switch in and out of a web browser to preview changes. 

The edge of the source page viewed within a frame is indicated 
by means of a dotted line. You can create, move, or delete 
objects on the source page, type text or change page attributes 
using the Inspector palette, just as if it was the current page 
in view instead of the frameset page. 

Note: When working in Frameset view, the zoom level is fixed at 100%, 
and it is not possible to zoom in or out of the page. If you wish to work at a 
closer zoom level, switch to the source page using the Site panel.
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Creating a new frameset within a frame
This technique is necessary when adding frames of a different orientation from the other frames in the window. 

1.	 Select the frame by clicking inside it. A selection marquee will appear inside the selected frame. 
2.	 Choose Split Vertical or Split Horizontal from the Frames submenu on the Page menu. A nested frameset will be created in the 

frame, dividing the frame into two parts. Each of the two new frames can either be given a source page or subdivided further using 
the Split Horizontal or Split Vertical command. 

Adding more frames at the same level 
1.	 Select one of the existing frames. 
2.	 Choose Insert Frame… from the Frames submenu in the Page menu or click on the  icon at the top right of the Frames 

palette and choose Insert Frame…. A dialog appears allowing you to choose where the new frame is to be inserted. 
3.	 Click OK. A new frame is added to the same frameset as the selected frame. 

Using the mouse to add frames 
It’s also possible to add frames using the mouse. You can do this by holding down the Alt key on the keyboard as you drag from the 
edge of a frame. 

Alt-dragging the dividing border between two frames in the same frameset will add a new frame at the same level. 

Alt-dragging the border between a frame and the edge of the window will add a new frame in the same frameset or create a new 
frame in an enclosing frameset.

Changing the orientation of the frames in a frameset 
1.	 Select the frameset or a frame within it. 
2.	 In the Current Frameset panel of the Inspector palette, use the Vertical checkbox to specify 

whether the frames should be vertical (checked) or horizontal (unchecked). 

Removing a frame 
1.	 Select a frame. 
2.	 Choose Delete Frame… from the Frames submenu on the Page menu or click on the  icon at the top right of the Frames 

palette and choose Delete Frame…. The selected frame will be deleted. 

If you have only two frames, deleting one will delete the frameset altogether and revert the page from being a frameset page to a normal 
one. If you attempt to delete one of the only two frames defined for a frameset page, Freeway will display a dialog box asking you to 
confirm your choice. 

Selecting frames 
To select a frame, click within it using the Selection tool. You may also select 
frames using the Frames palette. In both the document window and the Frames 
palette, clicking on a frame will select it. Clicking on the border between two 
frames will select the frameset that contains those frames. Clicking on the outer 
border of the frames around the edge of the document window or the Frames 
palette will select the outermost or top level frameset defined for the page. 

Only one frame or frameset may be selected at any one time. 

Power Tip: Using the Frames palette, you can select the enclosing 
framesets of a frame by Alt-clicking on the selected frame until the frameset 
you want is selected.

Deselecting frames 
To remove an active frame selection, you can hold down the Shift key while clicking inside the selected frame. In addition, clicking and 
dragging with the mouse on an empty part of the page viewed within a frame will deactivate the frame selection, as will selecting an object 
on the page viewed inside the frame. 

Using the Frames palette 
The Frames palette can be of great assistance in seeing the 
structure of your framesets. It shows how the various framesets 
on your page are nested, and the orientation and number of 
frames within them. Put another way, it is a schematic view 
of your frame set that will allow you to see how your frames 
and framesets are organized. The dimensions of the frames 
and framesets shown in the Frames palette do not reflect the 
actual dimensions that are specified. 

Selecting a frame 
using the Frames 
palette. In this 
example, the left 
frame has been 
selected.

Add new frame to 
frameset button

Frames in the 
frameset

Extra frames 
options menu 
button

Delete frame or 
frameset button

Add new 
frameset button
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This palette will show the currently selected or active frame and the name of the frame, if any. When you have the frame itself selected, 
the Frames palette shows the selected frame in dark gray 
instead of light gray. However, if your current selection 
is an object or text contained on the page being viewed 
through the frame, then the active frame in the Frames 
palette is indicated using a gray, diagonally striped pattern. 

You can also use the palette to select individual frames or framesets. Clicking in a frame shown in the palette will select the frame. 
Shift-clicking will toggle the selection on or off. Alt-clicking in turn will select the successively enclosing framesets. You can also select 
a frameset using the palette by clicking on the border between the frames themselves or between the frames and the edge of the palette. 

You can use the Frames palette to select “invisible” frames too. These are frames that can’t be displayed because the other frames are 
taking up all the available room in the window. 

Sizing frames 
Whether the frame border is visible or not, you can resize any frame while working in Freeway. You can either use the mouse or type 
in numeric values to size a frame. Because frames are the result of splitting the page area and are not objects in their own right, resizing 
one frame will always affect at least one other in the frameset. Regardless of whether you use the mouse or type in values to size frames, 
each frame may have its dimension specified either as a proportion of the overall dimension of the frameset that contains it or as a 
fixed size in pixels. 

Except in the case of predefined frameset pages, frames are initially created using proportional values to specify their dimension. This 
means that their actual size, when viewed, will depend on the current size of the browser window. When a visitor resizes the browser 
window, the size of the frames will also change. If a frame becomes too small to display all of the content within it, it will display scroll 
bars to allow the rest of the content to be viewed. It is also possible to set a frame so as not to display scroll bars if there is more content 
than can be viewed in one go. 

You can also set the frame to use a fixed value for its dimension instead of a proportional one. If you set all the frames to be fixed sizes, 
in practice, this will be overridden by the browser’s current window size. The result can be an unpredictable appearance if the user 
resizes the browser’s current window by using the mouse. 

Resizing the current window is generally beyond the designer’s control unless complex JavaScript is to be employed. The designer is able 
to control when a new window is “spawned” from a current page using JavaScript commands—the dimensions of the new window can 
be set as it is spawned.

It is also impossible to prevent the existing browser window 
from being resized by the visitor. For these reasons, you should 
take into account the different sizes possible for the browser 
window and allow for at least one of your frames to be a 
flexible size. Taking flexibility into account (and even making it 
work for you) is one of the key steps to becoming a skilled web 
page designer. 

Interactive resizing of frames 
When the frame borders are visible in the browser window, by default, visitors are able to use their mouse to resize the frames and affect 
their viewing experience. When using frames for layout or design purposes, this is often undesirable and it is possible to set frames so that 
the visitor can not resize them. In most browsers (though not all), hiding the frame borders by turning off the Show Borders checkbox in 
the Inspector palette’s Frameset General panel will prevent the visitor from resizing the frames in any case. 

Although generally you will want to make your frames so they cannot be resized by the visitor, resizable frames can be seen as a 
generous concession. For example, some sites that use a frame to display advertising banners allow the frame to be made smaller—in 
effect hiding the adverts. This may be perceived negatively by advertisers, but is the kind of touch that visitors appreciate and which 
leads to higher revisit rates, which benefits both you and the advertisers. 

Sizing frames using the mouse 
Move the mouse to the edge of a frame. The cursor will become a double-headed arrow, 
even if the frame borders are turned off or have no pixel dimensions. If it is hard to see 
where the edge is, click in one of the frames to bring up the selection marquee—this will 
indicate where the edge is and assist you in resizing the frame. Drag to resize the frame as 
desired. 

To size a frame using a numeric value 
1.	 Select the frame you wish to size. 
2.	 In the Current Frame panel of the Inspector palette, type the value you require into the Size text field. Depending on how the 

frame was created, the value you enter may be specified as a percentage of the size of the enclosing frameset or as a fixed value in 
points. 

3.	 Use the buttons beside the Size option to change the units from percentages (%) to pixels (px). 

Note: It is also possible for the source page to be the focus for keyboard 
commands without any objects or text being selected on it—this happens when 
you drag using the selection tool on the page, but no objects are left selected. 

Note: If a web design relies on the precise arrangement of frames, it could 
pose problems when viewed in different browsers. Netscape, for example, 
may alter the width in unpredictable ways. Furthermore, Netscape has 
a tendency to scroll a frame by about 8 pixels when the user refreshes or 
returns to it. Careful testing across browsers is needed if you intend to use 
frames heavily in your design. 

You can resize a frame 
on a frameset page by 
dragging its border.
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Setting frame size to be completely flexible 
If you wish to set a frame so that it will be completely flexible in size, set the other frames in the same frameset to be fixed value, and 
leave this frame set as a percentage or proportional value. The same result is also attainable by explicitly setting the frame to have a 
flexible size: 

1.	 Select the frame.  

2.	 Deselect the Size checkbox in the Current Frame panel of the Inspector palette. 

In the HTML output, the size for this frame will now appear as an asterisk (*) rather than as a percentage value (such as 76%). 

Making frames that can’t be resized when viewed 
To effectively prevent the visitor from resizing the frames in the browser window, you can set the frame border to be 0px using the 
Border option in the Frameset Page panel. You can also explicitly instruct the browser to prevent the frame from being resized, and 
you must do this in any event to prevent resizing if the frame border is to be left visible. 

To set a frame so that it can’t be resized: 

1.	 Select a frame.  

2.	 In the Current Frame panel of the Inspector palette, select the No Resize checkbox.

The selected frame will no longer be resizable even when frame borders are shown. Note that depending on the number of frames in the 
same frameset, this may also prevent the neighboring frame from being resized. 

Controlling whether frames scroll 
There are three settings to control the behavior of a frame if there is more content displayed inside it than can be viewed at one time. 
By default, frames are created so that they will automatically display scroll bars if necessary, but if all the content of the page fits into 
the available size of the frame, the scroll bars won’t appear; this is called Auto scrolling. You also have the options to set the frame so 
that it will permanently display scroll bars—these will be drawn grayed out if the content fits comfortably within the frame—or never to 
display scroll bars. 

To set the scrolling behavior of a frame 
1.	 Select the frame. 
2.	 In the Current Frame panel, use the Scroll popup to choose from: 

Auto: (default) display scroll bars only if necessary. 

Yes: always display scroll bars, even if content fits. 

No: never show scroll bars, even if content does not fit. 

Freeway gives you feedback on the current scrolling behavior in 
each frame as follows: 

•	 Frames set to “scroll=Auto” display outline scrollbars and real scroll bars if the source page contents viewed inside the frame don’t fit. 

•	 Frames set to “scroll=Yes” show grayed out versions of scroll bars and real scroll bars if the source page contents don’t fit. 

•	 Frames set to “scroll=No” show nothing, even if the source page contents don’t fit. 

When setting the width of an Auto-scrolling frame, you need to allow 10 to 15 pixels extra room inside the frame in addition to the width of 
the page contents to be displayed, otherwise it will always display a horizontal scroll bar. 

Freeway is designed to try to display correct feedback in these cases, but you should always test your pages in as comprehensive a 
range of browsers as possible to ensure that individual differences between browsers don’t cause problems. 

Important: When a frame is set to Auto, browsers display scroll bars 
even when the content displayed in the frame should theoretically fit 
without scrolling. Extra room is required within the frame to prevent scroll 
bars appearing. 

Note 1: Vertical and horizontal scroll bars don’t always behave identically when there is more content than will 
fit inside an Auto scrolling frame. If content fits comfortably within the width of the frame but the height of the 
content exceeds the height of the frame, only a vertical scroll bar will be displayed. However, if the content fits 
comfortably within the height of the frame but is excessively wide, both horizontal and vertical scroll bars will 
usually be shown. 

Note 2: Be very careful when setting the scrolling of a frame to No. If there is overflow content within the frame, 
there may be no way for the visitor to display it and no clue that there is content which isn’t being displayed. 

Note 3: Different browsers may calculate the size of the content area differently. As ever, try to check your design in 
as many browsers on different computer platforms as possible.
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Setting the border for the frameset 
To set the border width for the frames within a frameset page: 

1.	 In the Inspector palette, view the Frameset General 
panel. 

2.	 Using the Border width option, specify the desired width 
of the frame border in pixels. If you set the border width 
to be zero, web browsers will display the frames without any border (which is the same effect as turning off the Show Borders 
checkbox).

Specifying a name for a frame 
To set the name for a frame, so that it can be explicitly 
referenced by a link target command or within a script: 

1.	 Select a frame. 
2.	 In the Current Frames panel of the Inspector palette, 

type or paste the desired name into the Name text field and 
press Return. 

Targeting links 
Using link targets allows you to decide where the result of clicking on a link will appear. Link results can replace the contents viewed in 
a different frame or frameset within the same frameset page, replace the content of the entire browser window or appear in a completely 
new browser window. Individual links can be targeted in the Hyperlinks dialog while all links on a given page can be targeted in the 
Page panel of the Inspector palette. There are preset targets available but you can also define your own by naming frames. 

Setting a particular frame as the target of a link 
1.	 Give the target frame a name as described above. The name is added 

to the list of known targets for the document. 
2.	 Select the text or item that is being linked on. 
3.	 Choose Hyperlink… from the Edit menu to bring up the Edit 

Hyperlink dialog box. 
4.	 Using the Target popup menu, choose the name of the desired 

frame from the list. The target name appears in the Target text 
field. Now, when the link is activated in the browser window, the 
result of the link will appear in the named target frame. 

Note 2: When targeting links, you can type a name into the Target text field for a 
link before you have named the intended frame. However, if there has been a typing 
error or if for any reason the browser can’t find the frame target, it will open a new 
window. This will also happen if you have removed or renamed your frame. Always 
name the frame, and then choose this name from the Target popup menu when 
applying the link. If you change the name of a frame, make sure you update the links 
which have that frame as their target.

Note 1: It is also possible to 
type the name of a target directly 
into the Target text field. This is 
useful when the frameset definition 
is contained within a different 
Freeway document or in an 
external HTML page. 

Setting a default target for all the links on a page 
Although you can target links individually, this can be wearisome and inefficient if many links on the same page all need to share the same 
target. It is possible to set a base target for a page, so that all the links contained within that page will use it by default without any further 
action required. 

To set a base target for a page 
1.	 Change to the page containing the links. 
2.	 In the Page Output panel of the Inspector palette, choose the name of the desired target 

frame from the Target popup menu. All links on the page will now target this frame, unless a 
specific target is defined for individual links. 

Using the predefined link targets 
In the Target popup menu, you will see four predefined link targets. You can use these to cause 
the link result to do one of the following: 

•	 Replace the contents of the entire browser window. 

•	 Replace the content of the frameset containing the frame that contains the link. 

•	 Open in a new browser window. 

•	 Open in the same frame containing the link (this last is the browser default, and does not 
need to be specified). 

Note: Although in HTML it is possible to mix the border attributes used 
in different nested framesets within the same frameset page, this is not 
supported within Netscape browsers. Freeway therefore only allows you to 
set the frame border width for the page as a whole.

Note: Setting a frame name does not affect either the page title or the 
file name that will be used. Using words that are reserved commands in 
HTML or JavaScript as frame names may lead to unexpected results. If link 
targeting or references to the frame name in a script fail to work as expected, 
try changing the word you have chosen for the name to something else. 
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To apply a predefined link target 
1.	 Select the text or item to which the link is applied and choose Hyperlink… from the Edit menu (or locate the Target popup on the 

Page Output panel of the Inspector palette if setting a base target for the page). 
2.	 From the Target popup menu, choose from the following predefined targets: 

	 _parent: opens the result of the link in the frameset or window containing the frame in which the link occurs. (For instance, if you 
want the linked file to replace the frameset of the current link, then choose this option.) 

	 _top: opens the result of the link in the current browser window, replacing the top-level frameset. 

	 _blank: opens the result of the link in a new browser window. 

	 _self: opens the result of the link in the frame that contains the link. (This is the default behavior.) 

Extending the FRAME and FRAMESET tags 
Should there be any requirement to add additional code within the <FRAME> or <FRAMESET> tags generated for your frameset page, 
you can do so by selecting a frame or frameset and choosing the Extended… option from the Item menu. You can define Name/Value 
pairs here that will be inserted into the HTML code generated by Freeway for the selected item. You can find out more about extending 
the HTML generated by Freeway in the section entitled Customizing the HTML output on page 212.
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Working with forms

There are many different types of form used on the web, though some 
of them are not so easy to identify as being a form, such as a PayPal 
button or a guest book.

This chapter covers the standard type of forms which use three main 
parts—form items and input fields, a Submit button and some method 
of processing the form so it can be submitted to the server.

Freeway features a core Action—called the Send Form Action—which 
makes it very simple to create a “feedback form”, which is a form 
that can be posted onto a web page which the visitor can fill in with 
relevant data and then submit so the information is emailed to the 
specified recipient.

By using the Send Form Action you won’t need to set up a form 
handling script, as the Action does it all for you. However, it is also 
possible to make any form in Freeway work with your own script, and 
that is covered later in the chapter.

Form Items
HTML offers a set of standard form items which you can use to build 
your forms. These are items which are used by the visitor to enter 
information or make choices which can then be processed by the form 
script and sent as an email so the recipient can see the information 
given in the form.

How to use form items on your Freeway page
To use a form item you can use one of two methods. First you can click 
and hold on the HTML tool button on Freeway’s Tool Bar and choose 
the form item you want to draw on your page.

The other way is to click on the Insert menu and choose the form item 
you want to insert.

Using the Insert menu, you can either insert the form item into the flow of text inside an item or, if nothing is selected on the page the 
form item will be placed on the page as a standalone item.

Creating a new form item on your page. Above by choosing an item 
from the HTML tool dropdown menu before drawing the item on the 
page. Right by inserting an item from the Insert menu.

Input/Field
An Item/Field item provides an area one line deep where someone viewing your web page can add text. You can set the number of 
characters the field will accept and the physical size of the field. If the number of characters exceed 
the size of the field, the field will scroll as the cursor types or moves through the text. All text in an 
Input/Field item appears on a single line. For multi-line input, use a Text Area item. 

When you draw the item on the page (or insert it) you will see that the top and bottom handles display in red, which means that you 
cannot alter the item’s height as the Height popup is set to Flexible in the Inspector. An item with a Height set to Flexible will only 
ever be as high as the content inside it (and because form text is a standard size, this means that the item will be 20px by default). If 

The above screenshot shows how a table can be made to 
contain all the different elements of a reply form, which helps 
to keep all the different items aligned. The form contains each 
of the different type of standard form item, which are (from the 
top): an Input/Field item (for Name and Email), a Menu, a List, 
a “cluster” of Checkboxes, a “group” of Radio Buttons, a Text 
Area and a Submit Button.



Freeway Reference: Working with Forms
199

199

you want, you can change the Height popup to Fixed (to give the item a fixed pixel value height) 
by dragging one of the top or bottom handles or entering a specific value in the Height field of the 
Inspector), but you need to be aware that an Input/Field item will only ever contain a single line of text 
which will be centered vertically within the Input/Field item.

As the Width of the Input/Field item is set to Fixed by default, this means that you can drag one of the 
black left or right handles on the item to make it the width you want (or you can enter a specific value 
in the Width field of the Inspector).

Input/Field item options 
You can set the text field options using the Item Output Settings tab of the Inspector palette.

Name: This identifies the Input/Field item. It is not displayed on the page, but it is sent back as part 
of the response when the form is submitted. The name can also be used to identify the Input/Field 
item in JavaScript. 

Value: You can enter a default value if you wish, which will be displayed in the text field when the form 
is viewed. The visitor can leave this in place, add to it or replace it with their own text. 

Type: This is where you can choose the “input type” value for what you expect to be used inside the 
Input/Field item. There are some features which will work only on desktop computers, whereas 
other features are for smartphones and tablets (such as specifying the keyboard used for numeric, 
URLs, etc., on those devices). The list of options is shown in the screenshot on the right.

	 The result for choosing each different option are as follows:

	 Text: This is the default and it will work just like any normal field. The options when choosing 
Text in the Type popup are shown in the screenshot shown in the screenshot above right.

	 Password: When the visitor enters information in the field it will appear as “hidden” text (ie, it 
displays as a row of bullets). The options when choosing Password in the Type popup are shown in 
the screenshot shown in the screenshot above right.

	 File Upload: When this is chosen a Browse button displays instead of an input field when the page 
is previewed in Freeway or previewed in a browser. To the right of the button the wording “No file 
selected” appears, which will automatically change to display the file name of any file chosen by 
clicking on the Browse button. It is important to note, however, that the Send Form Action will not 
allow for a file to be selected and sent with the form information—so if you need to offer a file so 
it can be sent with the form info, you will need to use your own script rather than use the Action. 
The options when choosing File Upload are very different to the Text and Password (above).

	 Search: For most forms this will make no difference to using the default of Text. However, 
advanced users can take advantage of this to create a search field. The options when choosing 
Password in the Type popup are shown in the screenshot shown in the screenshot above right.

	 Telephone: This will mean that smartphone and tablet visitors will see a numeric keyboard 
when they click on the field. The options when choosing Password in the Type popup are shown in the screenshot shown in the 
screenshot above right.

	 URL: This will mean that smartphone and tablet visitors will see the keyboard their device uses for inputting URLs when they click 
on the field. The options when choosing Password in the Type popup are shown in the screenshot above right.

	 Email: This will mean that smartphone and tablet visitors will see the keyboard their device uses for inputting email addresses 
when they click on the field. The other options in the Inspector as the same as shown in the screenshot above right, but with an 
additional option called Multiple (checking Multiple allows you to use multiple email addresses separated by a comma, so the form 
will validate—as without Multiple being checked a comma will make an email field invalid).

	 Date and Time: This will mean that smartphone and tablet visitors will see the keyboard their device uses for inputting dates and 
times when they click on the field. Depending on the device or browser, this could, for example, bring up a calendar or diary page. 
The other options in the Inspector change for this option (and all others down to and including Local Date and Time) to display 
options for Min Value, Max Value and Step. Min Value and Max Value let you set a number range (such 1 to 12 for month) and 
Step is the increment used between the Min and Max values so the form field can be validated.

	 Date, Month, Week, Time and Local Date And Time: This will mean that smartphone and tablet visitors will see the keyboard 
their device uses for inputting dates and times when they click on the field. Just as with Date and Time (above) this could be used 
by specific smartphones and tablets to choose dates and times from applications such as Apple’s Calendar (but it will depend on the 
device). The other options in the Inspector are the same as for Date and Time.

	 Number: This will mean that smartphone and tablet device visitors will see the numeric keyboard when they click on the field. The 
other options in the Inspector are the same for Date and Time but with the addition of an option for Placeholder.

	 Range: This is similar to number, but it displays as a slider on a scale to represent an upper 
and lower values. An example is shown in the screenshot on the right.

	 Color: This allows the user to select a color and returns the hex value for that color. If a browser supports this option, users will 
either be able to type the value or select from a color picker, which will either be native to the operating system or the browser.

Placeholder: You can enter characters in this field so they show up in the Input/Field item itself when the file is previewed in a browser. 
However, it is important to note that some older browsers do not support placeholder text, so you need to make sure you also use 
text labels for your form fields, otherwise some visitors may not be able to see what information the field is meant to contain.

Pattern: This lets you add complex validation to a form field so that the form will not validate unless the pattern code is matched.
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Required: Checking this option will mean that the form will not send unless the field has content inside it. Depending on the Input 
Type (the option chosen in the Type popup in the Inspector) this may require specific content (such as numeric, alphabetical, email-
type format with “@” and .com, etc.). Currently, Safari ignores this HTML5 function, but we have added specific functionality to the 
Send Form Action the make Safari replicate this behavior.

Readonly: As the name suggests, with this option checked the input field cannot be modified by the visitor, but they can tab or click 
into it, highlight it, etc.

Autocomplete: This popup gives options for Default (which uses the visitor’s browser’s default settings), On or Off. If you want a form 
to autocomplete, choose Yes (or Default if you want to leave it up to the browser’s default settings).

Maximum length: Lets you enter a value to limit the number of characters the field can contain.

Size: This sets the width of the Input/Field item on the page. If you make the input field wider, the Size value automatically increases to 
suit. The width of the field is calculated using CSS for pixel values or sized to accommodate a specified amount of characters.

Access key: This is an accessibility aid which is used by typing a specified keyboard combination to bring focus to a field in the form. 
For example, if you enter “y” in the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will highlight the form 
item on the page in a browser and typing will enter characters into the field.

Text Area
You can create larger fields for visitors to enter text into, if you wish them 
to provide more information than would be convenient in a one-line text 
field—this is called a text area. In the browser, text areas have scroll bars 
which become active when the user adds more text than the field can 
display at one time. 

Text area options 
Name: This identifies the text area. It is not displayed on the page but is sent back as part of the response when the form is submitted. The 

name can also be used to identify the text area in JavaScript. 

Text: This field allows you to enter some default text which the visitor can either leave as it is, add to or 
overtype with their own text. This is optional. 

Placeholder: You can enter characters in this field so they show up in the Input/Field item itself when 
the file is previewed in a browser. However, it is important to note that some older browsers do not 
support placeholder text, so you need to make sure you also use text labels for your form fields, 
otherwise some visitors may not be able to see what information the field is meant to contain.

Rows: This field allows you to enter the number of rows of text that can be displayed vertically at one 
time. Note that if you make the Text Area item larger in height on the page, this value will increase 
automatically.

Columns: This field allows you to enter the number of characters that can be displayed horizontally 
at one time. Note that if you make the Text Area item larger in width on the page, this value will 
increase automatically.

Required: Checking this option will mean that the form will not send unless the field has content inside it. 

Access key: This is an accessibility aid which is used by typing a specified keyboard combination to bring focus to a field in the form. 
For example, if you enter “y” in the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will highlight the form 
item on the page in a browser and typing will enter characters into the field

This is how it may appear in the browser: 

Checkbox
Checkboxes allow visitors to select multiple options, limited only by the number of checkboxes you create. 
Visitors can check none, one, two, or more of the boxes offered them. Freeway imposes no limits on the 
number of options you can create, or the number the visitor is able to turn on at one time. 

It is important to note that there are two very different ways to place Checkbox items onto your Freeway page. 

If you have nothing selected on the page and then go to Insert>Checkbox, Freeway will place a standalone 
checkbox item on the page. This will display as a checkbox with the word “Checkbox” to the right of it.

To change the word “Checkbox” to the text you want to use, you will need to click and drag through the text inside the item and type 
the wording you want to use.

If you place the checkbox item inside an item as an “inflow” item (such as inside a table cell) when you go to Insert>Checkbox (or 
choose Checkbox in the HTML tool button and then draw an item inside the item) all you will see is the checkbox itself. You can then 
enter the text you want to use for the label for the checkbox immediately after the checkbox.
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Doing the above, all you are doing is simply changing the name of the label 
that is placed to the side of the checkbox. To set up the options for how 
the checkbox works you need to select the checkbox itself (so you can see it 
selected), then you can choose the options in the Output Settings tab of the 
Inspector.

Note that in the screenshot on the right you can see that the handles of the 
checkbox displays in red. This is because the Width and Height values of the 
checkbox are set to Flexible (which means that you cannot edit the size of the 
item). Although it is possible to change the size to Fixed so you can edit the site 
of the checkbox we do not recommend doing so as an HTML checkbox is a very 
familiar tool on the form and it will look odd to use it at a different size.

Checkbox options 
Name: This is the name which identifies each individual checkbox. By default this is set to the same as the current value for Title (which 

appears in the Item panel of the Inspector palette, marked here by a checkbox icon), but you can specify your own text if you wish. 
This is not displayed on the page but is sent back as part of the response when the form is submitted. 

Value: This is the value that is sent to the server if this item is active when the form is sent. It defaults to nothing, and this is usually 
suitable since it will send a default value of “ON” back to the server, though you may wish to change it to something like “Yes” if 
this makes more sense in the context of the information that is being requested. You don’t need to change this option unless you 
want to. 

Checked: This determines whether the checkbox is checked or not when the page is first viewed. Checkboxes are unchecked by default 
when you create them. 

Grouped: Freeway 6 supports grouped checkboxes. Grouped checkboxes are like radio boxes in that they share a common (group) 
name. In the case of grouped checkboxes, the name should end in square brackets (name[]) or in square brackets enclosing a 
variable (name[i]). In Freeway 6, the export panel for checkboxes contains a Grouped checkbox. If this is turned on, Freeway 
changes the Name field to a Group field (in the same way as radio buttons) and ensures that this field contains a correctly formatted 
name.

	 Adding square brackets ([ ]) to the end of existing checkbox names also turns on the Grouped checkbox, and removing square 
brackets turns off the Grouped checkbox. The popup for the Group field of grouped checkboxes contains a set of default group 
names (cgroup1[] through cgroup5[]). The combo popup for the Group field of radio buttons similarly contains a set of default 
group names (group1 to group5). The default group names are intentionally different for radio buttons and checkboxes.

Required: Checking this option will mean that the form will not send unless at least one checkbox (whether the checkboxes are 
individual or in a group) has been checked.

Access key: This is an accessibility aid which is used by typing a specified keyboard combination to bring focus to a field in the form. 
For example, if you enter “y” in the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will highlight the form 
item on the page in a browser and typing will enter characters into the field

Radio Button
Radio buttons are used to allow viewers to choose between a number of mutually exclusive options. Radio 
buttons are grouped in clusters. Only one of the buttons in a cluster can be active at a time. When a new one is 
clicked, it turns the previously active button off. You can have several clusters of radio buttons on a page, as long 
as the buttons in each cluster share a common value for their Name that is different for each cluster. 

It is important to note that, like checkboxes, there are two very different ways to place radio button items onto your Freeway page. 

If you have nothing selected on the page and then go to Insert>Radio, Freeway will place a standalone radio 
button item on the page. This will display as a radio button with the words “Radio button” to the right of it.

To change the word “Radio button” to the text you want to use, you will need to click and drag through the text inside the item and 
type the wording you want to use.

If you place the radio button item inside an item as an “inflow” item (such as inside a table cell) when you go to 
Insert>Radio (or choose Radio in the HTML tool button and then draw an item inside the item) all you will see is 
the radio button itself. You can then enter the text you want to use for the label immediately after the radio button.

Doing the above, all you are doing is simply changing the name of the label that is 
placed to the side of the radio button. To set up the options for how the radio button 
works you need to select the radio button itself (so you can see it selected), then you 
can choose the options in the Output Settings tab of the Inspector.

Note that in the next screenshot you can see that the handles of the radio button 
displays in red. This is because the Width and Height values of the radio button are 
set to Flexible (which means that you cannot edit the size of the item). Although it 
is possible to change the size to Fixed so you can edit the site of the checkbox we do 
not recommend doing so as an HTML radio button is a very familiar tool on the form 
and it will look odd to use it at a different size.
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Radio button options 
Name: This option is the name of the group to which the button belongs. By default it is “group1”. Enter a new Name here if you want 

your radio button to belong to a new group of buttons. This will be returned with the form. The two choices in the above example 
have the same Name. If there were other options for the age, they too would share the same Name, and only one could be chosen 
by the visitor. 

Value: This is the information which is sent back to the server if this button is active when the form is sent. By default this is set to the 
same as the current value for Name, but you can specify your own text if you wish. 

Checked: You can set the state of the radio button (on or off) when the page is first viewed. For each cluster of radio buttons (each group 
of radio buttons which share the same Group) you must ensure that one (and only one) is checked. 

Required: Checking this option will mean that the form will not send unless at least one radio button in any particular group has been 
checked.

Access key: This is an accessibility aid which is used by typing a specified keyboard combination to bring focus to a field in the form. 
For example, if you enter “y” in the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will highlight the form 
item on the page in a browser and typing will enter characters into the field

Popup Menus and Selection Lists
If the visitor is to choose from a selection of preset options, it is often most convenient 
to present these in the form of either a popup menu or a scrolling selection list. These are 
very useful if there are too many options to conveniently show as checkboxes or radio 
buttons. Use a popup menu if the visitor is allowed to select only one option from the list (such as country of residence). 

This may appear in the browser as: 

Use a scrolling selection list as an alternative if you wish more 
of the available options to be visible at one time, or if the 
visitor is allowed to select more than one option at a time.

If you allow multiple selection of options in the list, turn on the Multiple checkbox in the Menu/List Item Output panel. To select 
more than one option, the visitor can hold down the Command key (the Control key on a Windows PC) while selecting their second and 
subsequent choices in the list. It’s best to tell visitors on your page how to select multiple items if you offer the choice. 

Whether items drawn with this tool display as a popup menu or a selection list depends on the height of the box containing the form 
control. If the box is only large enough for the form control to show one line of text, the form control will display as a popup menu. 

By going to Insert>Menu/List, the default item placed on the 
page is as the item above. As long as the item is sized so it is 
tall and thin, this item will always be a Selection List item.

If you grab the center top handle of the Menu/List item 
and drag it so it is only one line high, the item will 

always be a Popup Menu item.

You can enter the number of lines you’d like the box to display in the Size field of the Menu/List Item Output panel. 

If the box is large enough to show two or more lines of text, the form control displays as a scrolling list. 

Popup menu/selection list options 
Name: This identifies the popup menu or selection list. It is not displayed on the page, but is 

sent back as part of the response when the form is submitted. The name can also be used 
to identify the popup menu or selection list in JavaScript. 

Size: This field allows you to enter the number of lines of text that can be displayed given 
the current size of the box containing the form control. If you set the Size to 1, this 
will make the item display as a popup menu.

Multiple: Turn this on to allow multiple selections from the available options in the 
list. With it off, only one option may be active at a time. 

Required: Checking this option will mean that the form will not send unless at least 
one has been chosen in the popup menu or selection list..

Choice/Value list: This list is where you specify the options that will be available for the 
visitor to select from. For each option, you need to give the option a name which will 
appear in the menu/list (Choice) and a value which will be sent back to the server if the 
option is selected when the form is sent (Value). 

Access key: This is an accessibility aid which is used by typing a specified keyboard 
combination to bring focus to a field in the form. For example, if you enter “y” in 
the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will 
highlight the form item on the page in a browser and typing will enter characters 
into the field

The Menu/List item on the page 
when sized so it is output as a 
popup menu item

The Menu/List item on the 
page when sized so it is 
output as a selection list item



Freeway Reference: Working with Forms
203

203

The set of icons at the bottom of this panel allow you to create a new Choice/Value pair, edit an existing pair, remove a pair, or 
rearrange the order in which the pairs appear. 

New Choice/Value pair

Edit Choice/Value pair

Delete Choice/Value pair

Move selection  
up or down list

When you wish to control which option is initially active in the menu or list in the 
browser, you can do so by editing a Choice/Value pair and turning on the Initially 
Selected checkbox in the Edit Choice dialog. Only one option in a list may have this 
attribute turned on at one time (unless the Multiple selection box is checked). If you 
have already set one option in a list to be the initially selected choice, and repeat this 
for another, this attribute is automatically turned off for the previous option. 

Power Tip: You can quickly change the Choice/Value pair by clicking the √ 
column next to the pair’s name in the Inspector palette. 

Button
There are three types of button: Submit, Reset, and Button. 

You must add a Submit button to your form, so that the visitor can send the completed form 
to the server. 

A Reset button is optional. It clears the form completely, which is useful if the user has 
made a series of errors while completing the form or wishes to reset the form to its initial 
state for any reason. 

A Button button is not used for conventional forms but can be used to execute a JavaScript 
command. 

Note: The button in Freeway’s design view represents the Mac OS X browser button. The 
button style is drawn from the host computer’s graphics routines, and will appear differently 
in different Mac browsers, and appear differently again in Windows browsers. It is also worth 
noting that Firefox will always display the button with the words “Submit Query” on the button. 
If you don’t want those words to be used in Firefox (or you want to use custom wording for all 
browsers) you must set a specific Value, such as Submit, Send Form or whatever you want.

It is possible to set any graphic item to be a submit button, by checking 
the Submit option in the Button item output settings panel of the 
Inspector palette (see screenshot on the right).

Button options 
You can set the button options using the Button Item Output panel in the Inspector palette. 

Name: This is used in JavaScript to identify the button and is also returned with the form. You do  
not need to set this option for normal forms. 

Value : This is the text which is shown on the button in Freeway and on the web page. 

Type: Set the button to Submit, Reset, or Button from the popup menu. 

Don’t validate: It can sometimes be the case that when using validation on a form the Submit is 
preventing the form from being sent because the button itself is being validated. If you find this is the case, check this option in the 
Inspector to prevent the button from being validated.
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Access key: This is an accessibility aid which is used by typing a specified keyboard combination to bring focus to a field in the form. 
For example, if you enter “y” in the Access key field, typing Control-Alt-y (for Mac) or Alt-y (for PC/Linux) will highlight the form 
item on the page in a browser and typing will enter characters into the field

Form Labels  
FW Pro only

 
Freeway 6 supports form labels. A label is text that automatically selects an associated control when 
clicked. To create a label, select some HTML text and click on Label in the Character section of the 
Text panel of the Inspector palette. When the Label checkbox is selected, Freeway displays a Label 
for: popup that can be used to select a control to link to the label. The default Child option refers 
to any form item that is included within the label. When a non-inline checkbox or radio button is 
drawn on a page, Freeway 6 automatically generates label text for the control.

Applying Styling to Form Items  
FW Pro only

 
HTML5 introduced the ability to easily add limited CSS styling to form items. However, you should use styling sparingly to avoid 
making the form items look very unlike the standard form items used on most websites. You also need to be aware that adding 
something like a background color to a form’s Submit button you will see that the default behavior of a standard form button might be 
lost (such as the way that a default button changes color from white to black on click).

Most form items allow you to add a Background Color, Background Image, Border and 
Shadow by selecting the item and choosing the styling you want to use in the Inspector. 

It is also possible to create a pre-determined custom CSS style so you control the 
typeface, size, text color, etc., used in form items when the visitor clicks inside a form item to enter text. To do this, you first need to set 
up the style and then you can select a form item on your page (such as an Input/Field item), go to the Styles tab of the Inspector, click 
on the “+” button to the right of Item and choose the style you want to use.

There are two third-party Freeway Actions which offer further customization options for form items (see later in this chapter), but if you 
only want to use basic styling, most options are covered by what can be achieved using the Inspector or by creating a new style before 
applying it to a form item.

Using the Send Form Action in Freeway
Once you have built the form on your Freeway page, using the various form items mentioned on the previous pages of this chapter, you 
can apply the Send Form Action to either the page on which the form is used or on the parent item which contains all the form items.

Note: To see the form working correctly you will need to upload the 
page so it is live on the web (it will not work when previewed locally 
as it requires PHP for the functionality to work). The page must be 
uploaded to a server running PHP 5.2 or above to work.

For the reply form to work you need to create a page on which 
you will build the form itself, but you also need to create two 
additional pages—“Success” and an “Error” pages which will tell 
the visitor if the form information was sent successfully or if 
there has been a problem.

Unless you have a particular reason to do so (for example if you 
wish to use multiple forms on the same page—see below), we 
recommend you use the Page Action version of the Send Form 
Action. To do this, select the page on which the form will be 
used, go to Page>Page Actions and choose Send Form.

If you wish to use multiple forms, you will need to create a 
“parent” HTML or table item, inside which you need to use all 
the form items and labels as “child” items. Using a table can 
help with alignment of your form items and any labels used, 
by double-clicking inside each table cell then going to Insert 
menu and choosing a form item or an HTML/Graphic item for 
label items. To apply the Action, select the parent item, go to 
Item>Actions and choose Send Form.

For the Page Action, make sure nothing is selected on the page; 
for the Item Action, select the parent item—then look in the 
Actions palette to see the options:

Options in the Send Form Action palette
This site is hosted by GoDaddy: You might need to select this 

option to use the GoDaddy hosted scripts. We recommend 
that you try it first without switching this option on—then 
if you find that the form doesn’t work correctly you should try switching it on. You can find the GoDaddy scripts at http://support.
godaddy.com/help/article/3434/reinstalling-the-default-scripts-directory-on-linux-shared-hosting
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Recipient Details: This area lets you specify one or more email addresses to send the completed form to. If you only want to use a 
single recipient email address, enter the email address in the Recipient Address field. To add multiple addresses, separate each 
address with a comma (such as: support@softpress.com,sales@softpress.com) in the Recipient Address field (but note that this will 
send the email to all email addresses, rather than offering a choice—see later). To see how to specify an email address for GoDaddy, 
see http://support.godaddy.com/help/article/508/specifying-an-email-address-for-the-php-form-mailer

Use Item for Recipient Address List: In addition to specifying single or multiple email addresses you can create a Menu/List form 
item on the page (see http://www.softpress.com/kb/questions/449/) so the visitor can click on a popup to choose the recipient they 
wish to contact. If you set up a Menu/List containing (for example) support@softpress.com and sales@softpress.com the visitor 
can choose the value they wish and the form will only be sent to that specific address. To do this, click and hold on the Use Item 
for Recipient Address List popup and choose the Menu/List form item name. Note that the email addresses will be hidden from 
spammers using this method.

Sender Details: This area lets you specify whether you are sending the form to a specified person (full name) entered in the Sender 
Name field or two Text Field items for the sender’s name (so one field is the First Name and another is the Family Name), which is 
done by selecting the Text Field item names for each name in the Use Item for Sender Name popups 1 and 2 respectively. Note 
that the Sender Name (or Names) used here will be the name which appears in the From: field in the email message.

Sender Address: The address that’s used as the reply-to address in the email that’s received. Use this option only if you always want 
the reply-to address of the emails received from your form to be the same. This can be handy if you’re using rules to filter the emails 
received.

Use Item for Sender Address: Allow the visitor to specify the address to use as the reply to address by using a Menu/List item on the 
form page. Using this option will mean you can easily reply to emails received without having to copy and paste the email address 
into a new email. To do this, click and hold on the Use Item for Sender Address popup and choose the Menu/List form item 
name.

Subject: Specify the subject of the email in this field.

Use Item for Subject: Allow the visitor to specify the subject of the email when they fill out the form on your site and send it, by 
offering a choice of subjects in a Menu/List item. To do this, click and hold on the Use Item for Subject popup and choose the 
Menu/List form item name.This could be a Description field, for instance.

Supplemental Message: Add a supplemental message to the end of the email. You can use this to put a message that simply reminds 
the recipient of the email where the email was sent from. For instance “This message has been sent from http://softpress.com/
support/”

Error Page: A page to redirect to if there are any problems sending the message. Click and hold on this popup and choose the error 
page you created for your site file.

Success Page: A page to redirect to if the message was sent successfully. Click and hold on this popup and choose the success page you 
created for your site file.

Notes and troubleshooting:
•	 The page must be uploaded to a server running PHP 5.2 or above to work.  You will need to get in touch with your web host 

regarding the version of PHP if you see this error: “Fatal error: Call to undefined function: filter_has_var()”

•	 The script will fail if PHP is set to run in safe mode. Safe mode has been deprecated and removed from the most recent version of 
PHP so it’s (ironically) safe to turn it off. If you can’t do this, contact your host.

•	 Most options are not available to GoDaddy users—so use only Recipient Address, Sender Name, Sender Address, Email Subject 
and the Error/Success Pages.

•	 If using HTML5 pages, the Required option can be applied to text fields to tell the script that a certain field is required. If the field is 
required but not filled out, some browsers will prevent the form from being sent, or the form will redirect to the error page.

Setting up a form manually
As mentioned earlier, we recommend using the Send Form Action to build and handle the scripts for a reply form. However, there may 
be times when you want custom functionality that you can only achieve by setting up the form yourself with a custom script.

Servers and browsers 
In order to better understand forms, you may need some background on how web servers work and how a visitor’s browser 
communicates with it. 

If you want to view a web page over the Internet, you type its URL (Universal Resource Locator, which is basically an address) into your 
browser, then the browser searches the Internet for the web server that has the web page you’re looking for. If you’ve just typed an address like 
http://www.macintouch.com, your browser reads the first segment (“http:”) as the protocol (method of communication) and searches for the 
server www.macintouch.com. 

Having made a connection with the server, the browser then asks the server to fetch the requested page and send it down the line. If 
you haven’t specified a page on that server (such as www.macintouch.com/imac.html), the server will send the default page. This is why 
you must ensure your site has a home page with a name like “index.html” or “index.htm”. 

The system of fetching web pages is more or less static: the visitor uses the browser to ask for a page, and the web server sends it. The 
browser then processes the HTML to make what the visitor views as a web page. 

The next level beyond simple page fetching is dynamic: instead of just asking for a page, the browser can send information and request 
the server to do something with it, which is what happens with forms. You can use Freeway to set up forms so that when the visitor clicks 
a Submit button, the information they’ve provided in the form fields is sent to a place on the server where a certain script (usually a CGI-
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script) resides. For instance, “/cgi-bin/formmail.pl” is a typical location of a script on the server’s disk; if the form sends the information to 
that location, the script will automatically handle it, processing the form according to how the script has been written to carry out the job. 

Parts of a form 
There are three parts of a form. The first consists of form items that are viewed on the screen and allow the user to enter information in 
response to questions or select from available options. You draw or insert these items using tools in Freeway. 

The second part is the instructions that have to be given to the browser when your visitor clicks the Submit button—where the 
information is to be sent and what is to be done with it, for example. These instructions need to be entered into the Form Setup dialog 
on Freeway’s Page menu. 

The third part is a script, program, or other service hosted on the web server that deals with the information sent back from the completed 
form. Typically, “Perl” scripts, located in the cgi-bin directory of the server, handle form processing, but other technologies such as ASP and 
PHP are also used. The system administrator of the web server normally handles this part. If you are publishing your site through an Internet 
Service Provider (ISP), you must contact them to see what options are available to you. Often there are existing Perl scripts that you may use 
or occasionally you may be able to upload your own. 

Freeway provides an easy-to-use interface that allows you to deal with the first and second aspects of the process. Using the form tools, 
you can create form items or controls on your Freeway page. 

Forms may have the following elements: 

Name: Enables the form to be identified. This may cover just one element or a group. If you have a group of radio buttons, they will all 
have the same Name (with radio buttons, the user chooses one of multiple options). Other form items will generally have distinctive 
names. 

Value: What the form reports to the form handler. This is the information you want to receive from your visitor.

Action: The location of the script that will be handling the form. (This is not to be confused with Freeway Actions.) 

In most forms, the visitor provides information and then clicks a Submit button. The script handler processes the form and sends the 
results/information back to you at the email address you’ve specified in the Form Setup dialog. The form may also be configured to 
provide feedback to the sender, often by redirecting them to a “thank you” page. 

Form setup 

In order to tell the browser what to do with the form when it is submitted, you 
need to enter information in the Form Setup dialog. Choose Form Setup… 
from the Page menu, on the page containing the form. 

Form Setup dialog options 

Note: This section refers to the example in the blue tint panel on the next page.

Method 	 instruction 1
	 You can choose from two methods for sending the data in the completed 

form to the server, POST and GET. Unless you are told otherwise, you should 
always leave Method on the option POST. This sends the information to the 
server as an actual data stream, whereas GET sends the form information as 
part of the URL. 

Action 	 instruction 2
	 This is where you specify the location on the Internet of the script or program that will handle the form results. Note that this 

can be located on any server anywhere in the world, and does not necessarily have to point to the server that is hosting your site. 
Normally the action is expressed as a URL. Make sure not to enter it in quotation marks. 

	 You can test your form if you wish by pointing it at one of the URLs below—this is a service run free of charge by the NCSA 
(National Center for Supercomputing Applications), and will return a page to the browser showing the information that was sent to 
it. You cannot use this action on a form you publish on the web, as it is the visitor who will receive the results of the form, not you! 
Use it only for testing forms as you construct them, and use it in moderation, as it is a free service. 

Encoding
	 If you wish your form to submit information in a different language encoding, you can specify the encoding type here. You do not 

normally need to enter any information into this field. 

Hidden Fields
	 Many form-handling programs or scripts require additional information (parameters) to be returned along with the contents of the 

form. For example, a program which forwards the completed form details to an email address would require to be told which email 
address the completed information was to be mailed to and the Subject line to use for the email. For information on hidden fields 
that may be added to your form, see Hidden fields on page 207.

Setting up your form scripts 
When you ask your ISP about setting up a form, they might give you instructions in HTML code format. It can be a little difficult to 
work out where this information needs to be entered in the Freeway Form Setup dialog; the ISP may provide a script like the example 
below. 
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Example form setup code: 

 

<form method=POST action=/cgi-bin/FormMail.pl> 

<input type=hidden name=recipient value=email@domain.com> 

<input type=hidden name=subject value=The email subject> 

<input type=hidden name=redirect value=http://www.domain.com/thethankspage.html> 

<input type=text name=email> 

</form> 

4a 4b

3a 3b

1 2

5a 5b

6

It all looks very daunting, but getting these instructions into Freeway is straightforward. Copy the script (it will likely have been sent 
by email or will appear on the support section of your ISP’s web site) to your clipboard by selecting it and choosing Copy from the Edit 
menu in whatever program your viewing it. Go to the Freeway page on which the form appears and choose Paste Special… from the 
Edit menu. Now check the Form Setup dialog and the data will have appeared. 

Alternatively, you can add the information yourself. 

The first line of information which starts <form and ends with a > needs to go in the Form Setup dialog. method=POST means that 
you need to select POST from the Method popup. This is the most common setting for the Method. The text in quotes after action= 
needs to go into the Action field. This is the link which actually calls up the form on the server. You must not put quotes around this as 
Freeway will add quotes for you. 

Any tags which start with <input and contain type=hidden need to be added as Hidden fields in the Form Setup dialog. These are 
invisible to the site visitor but are sent back along with the form for the script to pick up. You can often add additional hidden fields of 
your own in order to return extra information from your form (for example so that you can recognize which page on your site the form 
came from). 

In this case, we have three hidden fields. Each has a name and a value. The name is in quotes after the text name= and the value is in 
quotes after value=. In each case you click the New… button in the Form Setup dialog. The text after name= goes in the Name field 
and the text after value= goes into the Value field. You should not enter quotes in here as Freeway adds them for you. 

Sometimes the script requires that certain fields are present—they are often called required fields. Often the visitor’s email address is 
required in order to send the form. You can add these as normal form items on the page, and you must make sure that the Name field is 
set correctly. The item in the example above (input type=text name=”email”) would create a text field item on the page and set the 
name of the item in the Text field item output settings panel in the Inspector palette to “email.” 

Hidden fields

Note: This section refers to instructions in the example set out in the blue 
tint panel above.

Here are some Hidden Fields, which may possibly be used in your form. The 
“name” part of the name/value pair appears below in bold font: 

recipient 	 instruction 3  
Indicates where you want the email sent. The value is an email address. This 
may be called send to in some forms. 

subject	 instruction 4  
This is the subject you want the email to have when you receive it. The 
value is something like “Web site form results” (without the quotes) or 
anything you like. 

redirect	 instruction 5  
The page to which you want to send the visitor after filling in the form. (This page might say “Thanks for filling in our form.”) The 
value should be the full URL for the page—for example: http://www.yourdomain.com/thanks.html. You must create this page as part 
of the web site and make sure it’s available on the server. If you don’t add the redirect field, a default message will appear instead 
when the visitor submits the form. This may be called resulturl in some forms. 

Less common hidden fields 

required: This is a comma-separated list of the fields which the user must fill in. The value would be something like: email, realname, 
address1, address2 and so on. (It’s a good idea to limit this to what is really required, and indicate those fields with an “*” on the 
original form, as some people find long forms annoying.) 

sort: Determines how the fields will be sorted in the email. The value would either be alphabetic or order: name1, name2, name3. 

You will need to find out the specific details for the form from your ISP. 

If you need help setting up your form after receiving the necessary information from your ISP, contact Softpress Support. 



Freeway Reference: Working with Forms
208

208

Form security 
If your form sends credit card details or other sensitive information, you should make sure that this will be transmitted securely so that 
it cannot be intercepted by hackers. The best way to do this is to have the form submitted via a Secure Server. When you use a secure 
server, the information is encrypted by the browser before it is transmitted across the web. Your web provider may be able to provide 
a secure server to process your forms—although they may charge extra for this service. If you are selling on the web, you will probably 
find that customers are reluctant to buy your products if their credit card information is not secure. 

Another option is to call the customer to take the credit card information separately. You can also set up an account with an Internet 
clearing service so that you don’t need to deal with the financial transaction at all—a third party processes the credit card transaction 
and credits the money to your account. However, this may involve a substantial charge. 

Where to find out about forms 
You’ll often find the information on the web site of your web space provider (look in the support section for any information about 
forms, CGI, or scripts). Or call up and ask about standard scripts for forms—if they don’t have a form provided as standard, ask if you 
can install your own. 

Troubleshooting forms 
Here are some answers to common problems when setting up forms: 

1.	 There is a server or browser error when I try to submit the form.  
Make sure you are online when you test the form. Also, make sure that the site is uploaded and running on the correct web server. 
Some scripts can only be called up from a page on the same web server, so you may find that a script that worked well on one of 
your web sites doesn’t work when you try it on another server. Check the Action field to make sure it’s exactly right. 

2.	 The page has some bad characters at the top (for example, extra “<” characters) and the form doesn’t work at all.  
This normally happens when you have put the wrong information in the Form Setup dialog—for example, if you have put extra 
quotes around some items, or you’ve included the whole “<form action=…” in the Action field, rather than just the quoted URL. 

3.	 The email comes back to me, but some of the information is missing. 
First of all, check that you have filled in the Name fields on all of your items. If something doesn’t have a name, it won’t be returned 
to the form.  
Also, some of the forms will only return some particular information so check the instructions. For example, some form scripts 
might only allow one field to be returned so you have to allow the user to put all the data in one box. 

4.	 The email comes back, but the items are sorted in a random order. 
Some form scripts sort the information alphabetically or just in the order they happen to receive them. Sometimes you can add a 
hidden field to specify the sort order of the fields but often you just have to put up with it. 

5.	 The form works fine, but the visitor is not redirected to my “thanks” page afterwards.  
Some form scripts don’t allow the visitor to be redirected. Other problems could be: the form requires a fully specified URL and 
you’ve entered a relative link; you have placed quotes around the URL; the page doesn’t exist; or you’ve entered the wrong name 
for the Redirection hidden field. 

6.	 I am using Radio buttons, but they don’t work properly—when I select an option, the others don’t turn off.  
Make sure the Radio buttons which are grouped together have the same Name. Make sure that each group has its own Name. 

7.	 The information comes back to me, but it’s hard to tell which field is which. 
Make sure you’ve given each item a sensible name in the relevant form Item panel in the Inspector palette—the default names 
probably won’t be very informative if you don’t change them to match your form data. 

If you think you’ve filled everything in correctly but you still can’t get the form to work, it might be a good idea to contact your web 
provider. However, if you want them to look at the code of your form page, make sure you turn on the More readable option for 
the HTML Output in Document Setup. You can also try contacting Softpress Technical Support, but make sure you pass on all the 
information you have from the web provider about the form so that we can check this against your form page.

Additional Freeway Actions to help with building forms (Pro only)
Although Freeway offers all the basic tools for building a form, there are some additional Actions you may want to use to enhance or 
extend the functionality of your form. Below is a list of free Freeway Actions available and what they do.

Multiple Form Suite
http://actionsforge.com/projects/view/24-multiple-form-suite

Freeway will “wrap” the entire page with a “form tag” when you use 
a form on the page—so you will need this Action if you are using 
more than one form on a page.

Note that it is not always obvious what is and isn’t a form (such 
as PayPal buttons which are a type of form). Normally, if it has a 
“submit” button, it is a form.

If you are using the Send Form Action on your page, select the other 
form item (or the parent item that contains the form items for the 
other form) and apply the Multiple Form Action to that item by 
going to Item>Actions and choosing Multiple Form.
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State/Prov List
http://actionsforge.com/projects/view/54-stateprov-list

If you want a popup on your form so a visitor can choose the US state or Canadian 
province where they live, this Action makes it very quick and simple. After it has 
been installed, you simply need to go to Insert>Action item and choose State/
Prov List.

It also allows you to select a default location that is shown in browser before the 
visitor clicks on it.

Validate Form Suite
http://actionsforge.com/projects/view/73-validate-form-suite

The PHP Feedback Form Action will “validate” the Name and Email fields of your reply 
form—ie, it will make sure that something has been entered into the Name field and also 
that the content in the Email field has an “@” character and ends with .com, etc.). If the 
visitor doesn’t fill in these fields correctly, the form will not be sent. However, you can add 
other “required” fields on your form by using the Validate Form Suite.

A PDF is included in the download with the Action which gives full instructions on how to 
set it up.

Country List
http://actionsforge.com/actions/view/85-country-list

Just like the State/Prov List, this Action lets you add a Country List to your form. 
This list contains every country in the world.

The Action also lets you add up to 10 “favorite” countries at the top of the list (so 
the visitor only needs to choose from the top list rather than scroll through the 
entire list of countries). The country list itself can also be edited.

Form Element Styler
http://actionsforge.com/actions/view/60-form-element-styler

This Action is similar to the Form Element CSS Action, and it gives you lots of different ways to style the items on the form. Click on 
the “Demo” link to see examples and instructions.

Form Element CSS
http://actionsforge.com/actions/view/146-form-element-css

This Action offers very similar styling options as the Form Element Styler options (with some differences). Click on the “Demo” link to 
see examples and instructions.

There are two 
third-party Freeway 
Actions which help 

you to apply custom 
styling to various 

form items—Form 
Element CSS (left) 
and Form Element 

Styler (right)
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For all of us, the web is increasingly becoming a part of everyday life. We use it for finding news, shopping, paying bills, searching for 
jobs, entertainment, and much more. Because it now plays such a vital role, it is important that the content we put on the web be 
available to everybody, including those who are using assistive technologies such as screen readers or braille converters.

Accessibility Report 
FW Pro only

 
The Accessibility Report dialog in Freeway Pro displays a list of the accessibility issues associated with the current document or page. 
The information about each issue tells you what the problem is and which item or page the problem is associated with. If you move the 
mouse over each item in the list, a help tag is displayed explaining why the issue is a problem for accessibility.

To view the Accessibility Report for an individual page, select the desired page in the Site Panel and choose Accessibility Report… from 
the Page menu. To view the Accessibility Report for the current document choose Accessibility Report… from the File menu.

The following types of issues are reported: problems with pages (e.g. absence of a title), problems with items (e.g. issues with alt text, 
form items without placeholder text, too much consecutive graphic text, lack of contrast between text and background), problems with 
links, problems with access keys, and problems with styles (e.g. use of the blink style). Freeway also lists text phrases that have links 
attached so that you can check that they would make sense when read out of context by a screen reader.

In cases where there is a problem with alt text, the Accessibility Report dialog provides a text field where you can edit the alt text.

Usability Report 
FW Express only

 
The Usability Report dialog in Freeway Express displays a list of usability issues associated with the current document or page. The 
information about each issue tells you what the problem is and which item or page the problem is associated with. If you move the 
mouse over each item in the list, a help tag is displayed explaining why the issue is a problem for usability.

To view the Usability Report for an individual page, select the desired page in the Site Panel and choose Usability Report… from the 
Page menu. To view the Usability Report for the current document choose Usability Report… from the File menu. 

The following types of issues are reported: problems with pages (e.g. absence of a title), problems with items (e.g. combined graphics 
covering an entire page, HTML items with text overlapping graphic items, text output as a JPEG, excessive use of graphic text, multiple 
spaces in HTML text, paragraphs split across flow-linked items), and problems with styles (e.g. use of the blink style, use of font sets that 
do not contain generic alternatives).

Preview options 
Freeway provides some options on the Preview Toolbar that can help you to assess how accessible a page is.

Text Size 
Clicking on the Text Size buttons will increase or decrease the size of HTML text. This can be useful for testing how usable a web layout 
is at different text sizes. Visually impaired readers may prefer to use larger than normal text sizes. You can also use the standard browser 
shortcuts: Command-+ and Command-minus (or dash).

Style sheet FW Pro only  

The Accessibility style sheet (available from the Style Sheet popup) displays how your web page might look to users who are using an 
accessibility style sheet in their browser.

Refresh 
This option will reload the page, as in a browser.

Images 
Clicking on the Images button will hide or show images on the page. Most browsers will display alt text when images are hidden—but 
there are some versions of Safari which fail to do this. Freeway uses Safari’s Webkit engine to preview web pages, which means that it 
will mirror Safari’s behavior in this respect.

B/W FW Pro only  

Clicking on B/W will toggle between displaying the page in black and white (grayscale) and in color. If parts of your page become 
unreadable when it is displayed in grayscale, you should consider using different colors for the benefit of users who have some form of 
color blindness.

A side-effect of using this option is that JavaScript is disabled when the page is displayed in grayscale.

Accessibility
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JavaScript 
Click on the JavaScript button to disable or enable JavaScript in Freeway’s Preview. Some users may have JavaScript disabled for 
security reasons, and some PDAs and mobile phone browsers do not have JavaScript support. In addition, JavaScript effects may be 
inaccessible to people using a screen reader.

This option can help you to check that your page functions correctly when JavaScript is disabled. You should also check with JavaScript 
turned off in a real browser.

Other accessibility features 

Alt text 
Alt text is helpful for people who use assisitive technology, such as screen readers, and for people who are using handheld devices or 
have low bandwidth connections and choose not to display images.

Freeway allows alt text to be set on images and map areas.

Select Alt Text in the View menu to view alt text and hide images. 

Select Alt Text… in the Page menu to display the Edit Alt Text dialog. This allows you to edit alt text on the current page and reports 
on any problems.

The Accessibility Report dialog (available from the File and Page menus) reports on problems with alt text, and allows you to edit the 
alt text for these items.

Select Show Alt Text from the Site panel  menu to display alt text in the Site panel. Problems will are indicated by a warning 
badge on the item’s icon. O-click on the alt text to edit it. 

Access keys 
Access keys are a way of providing keyboard shortcuts that offer an alternative way of navigating a page. Unfortunately, they may also 
conflict with keys that are already being used by assistive software.

See the following web pages for a list of recommended UK Government access keys, and a discussion of problems:

http://www.hobo-web.co.uk/uk-gov-access-keys/

Access keys can be set in the Edit Hyperlink dialog and in the Form Output panel of the Inspector palette.

Forms 
Forms can be made more accessible by the use of form labels and fieldsets—see the Fieldset Action and the Form Item Label Action, 
which can be found by searching the Softpress Knowledgebase online.

Select Tab Order in the View menu to show the tabbing order of form items. The tabbing order of form items is normally the same as 
the reading order of items on a page: items that are near the top left of the page come ahead of items that are further down or to the 
right (assuming left-to-right reading order). In the case of layer items, the tabbing order is the same as the stacking order: items that are 
further back in the stacking order precede items that are nearer the front of the stacking order.

Language 
The Page Output panel of the Inspector palette contains an option to set the language of a page. This is helpful for screen readers. In 
addition, any spelling language that is assigned to text is now output.

Tables 
The Inspector palette provides the following options to improve accessibility with tables:

•	 The Table Cell panel can be used to define table headers (helpful for screen readers).

•	 The Table Output panel contains a Summary field. This can be used to summarize the table’s contents for the benefit of screen 
readers.



Customizing the HTML output 
Freeway’s liberation from code is enhanced by Freeway 
Actions, which offer the ability to extend Freeway’s 
functionality without needing to edit HTML. However, there 
are some occasions when you may wish to insert extra HTML 
or other code into the Freeway output directly rather than 
using a Freeway Action. 

Of course, to be able to do this you must know the HTML or 
JavaScript code that needs to be added to achieve your aim. You also need to have a rough idea of the structure of an HTML document 
in order to help you know where the extra code needs to go. A final consideration is that you may also need to spend a fair amount of 
extra time on the project, as setting up special effects (and troubleshooting them if there are any hitches) can take significantly longer 
than most other work you do on a web site. 

The different types of markup code
Markup code comes in different types, depending on what the functionality is set up to do and there are three main ways to add custom 
code to your page:

•	 Adding code before/after a specific HTML tag

•	 Adding code in the body of the page

•	 Extending item tags

Sometimes it might be that you need to add a combination of two or three of the above, as it will always depend on the code you are 
supplied with and where you have been instructed to use it.

Adding code before/after a specific HTML tag 
The HTML Markup dialog provides a simple but powerful means of 
adding any other custom HTML code or script which needs to be added 
for a page. Select HTML Markup… in the Page menu and choose the 
section of the HTML document into which you wish the code to be 
inserted from the Insert popup menu and paste or type the code into the 
text field below. 

Freeway allows you to store separate pieces of code for each of the 
different sections of the HTML file created for the page so, for example, 
you can add code into the <HEAD> section as well as at the end of the 
<BODY> section for the same page.

This dialog is often used to add some JavaScript code to the page. The 
best place to add JavaScript code is in the section Before </HEAD>. This 
places it in the part of the page, which is processed before the <BODY> or 
page content is loaded. 

Inserting code at a specific point on the page 
Occasionally, it may be necessary to add custom code to your pages at a specific location on the page. For instance, you may want to 
add a piece of code for a social media button or an affiliate advert. You can use a “markup item” to do this. Markup items are created by 
going to the Insert>Markup item menu in Freeway and then pasting in the code before click OK.

After clicking OK, Freeway will place a small item on the page with <H> inside it (which signifies that it’s a markup item). You can then 
click and drag a corner handle to resize the item or the item can be selected and then a specific Width and Height value can be entered 
in the Inspector to make the item the correct size. Some markup code contains 
pixel dimensions in the code, so it is recommended to use those dimensions for 
the item so you can position it accurately on your layout.

The screenshot on the right shows some embed code taken from YouTube to 
display a movie item (sized at 560px wide by 315px high), which can be sized 
precisely so it can be used at the correct size within the layout of the page.

Not all markup code contains pixel dimensions, but we recommend that you 
size the markup item approximately so it is close to the size of its content when 
published. This will help to prevent problems with the item growing on the 
page to push other content down, making some items on the page overlap (or 
underlap) other content.

Adding markup code in Freeway

Important: Because of the way Freeway works (that is, it generates new 
HTML pages from scratch whenever a change is made in the Freeway 
document) it is not advisable to edit the HTML files that are created by 
Freeway after they have been published. The danger here is that if you 
alter the page within Freeway after you have edited its HTML file and then 
rebuild the site, your external changes will be lost. 
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You must ensure that the code you add is valid HTML; Freeway will insert it into the output without altering it. 

If you wish to edit a markup item later, simply double-click on the item on the page. Use the HTML Markup dialog to edit it and click 
OK again to close the dialog. 

Using a Markup item as an inflow item
Markup items can also be added as inflow items within a run of HTML text. To 
do this, click in the flow of text and then go to Insert>Markup item, paste in 
the code and click OK.

Note 1: Freeway doesn’t read or modify the code that you add in a Markup item. If the code 
references any images or other files which need to be uploaded to the web site, you will have 
to upload these manually (see Dedicated FTP tools on page 142). 

Extending the code generated for specific items 
When you need to add code to the HTML used to represent a specific item, you can use the Extended… command. You’ll see this 
command appear in several places in Freeway: on the Item menu, in the Edit Styles and Edit Hyperlink dialog and on the Page 
menu. It is also possible to extend the code generated for frames and for rows and cells of tables created in Freeway. 

This method is used to “extend” the HTML code by inserting extra code attributes inside the HTML tag that Freeway generates for that 
object. When you choose the Extended… command, a dialog box appears in which you define one or more “name/value” pairs for the 
object. You create a new name/value pair by clicking New… in the Extended dialog. The tag that is going to be extended by the name/
value pair you define depends on the type of object selected at the time and which Extended… command you’re using, and is shown at 
the top of the dialog box. 

•	 When you use the Extended… command on the Page menu, the name/value pair you define is added inside the <BODY> tag for that 
page. 

•	 When you use the Extended… command in the Edit Hyperlink dialog, the name/value pair you define is added inside the <A> tag. 
You must define a hyperlink on the selected item in order for your name/value pair to be added to the output. 

•	 When you use the Extended… command in the Item menu, the tag that will be extended depends on the selected object on the 
page—this might be <IMG> if a graphic element is selected, or <EMBED> if a multimedia element is selected. 

Other items that can be extended in this way are frames and framesets 
(using Extended… from the Item menu), Form items, CSS Layer items, 
and Styles (these last two apply only to Freeway Pro.).

Name/value pairs are defined so that the text you type into the two fields 
is added to either side of an “=” sign. In addition, the content of the 
Value field will be enclosed in double quotes on output. For example if 
you selected Extended… from the Page menu to extend the <BODY> tag, 
you could add a Name/Value pair as follows: 

Name: onUnload 
Value: alert(bye); 

This would appear in the output like this: 
<BODY … onUnload=alert(bye);>. 

The effect of this would be that when the visitor left your page, a dialog 
would appear saying “bye”. 

Important: Because Freeway will use double quotes to encapsulate 
the text you add for the value, you must use only single quotes within 
the Value field. 

Minimized Extended Attributes

With HTML5 there are some “minimized” attributes which do 
not require a Name/Value pair to be set up—for example you 
can use just the Name “checked” without a Value to make a 
checkbox on a form to be checked on page load.

Note that minimized attributes are not allowed in XHTML and 
are automatically expanded by Freeway for XHTML output.



Freeway Reference: Customizing Freeway’s Output
214

214

Referencing external URL content when the page is viewed 
There are occasions when you want the web page you create to include content dynamically, perhaps referencing graphics or HTML 
code which changes or is updated more frequently than your page. Examples of this might be advertising banners, counters which 
record how many visitors have viewed your page or stock market figures which are updated from a database live on the web. 

In cases like these, you wouldn’t want to import the new content, publish the site and upload the new files whenever the content changes. 
Instead, you want to leave room in your page for some external content, which is only inserted when the page is viewed by a visitor. There 
are two ways of doing this, depending on whether the content you want to reference externally is a graphic—generally generated by a script 
on the web server—or a text file containing a snippet of HTML code—also known as a Server Side Include. 

Using a URL box to reference external content 
In order to reference any external content on the web within a Freeway page: 

1.	 Create or select an appropriately sized box on the page. 
2.	 Position it where you want the external content to appear. 
3.	 Select the Output panel in the Inspector palette. 
4.	 Set the box to have the output type of URL using the Type popup menu. 
5.	 You will see new options in the Output panel. Using the Content popup menu, choose either Image or HTML, depending on whether 

the external content will be a graphic or a text file containing a snippet of HTML. 
6.	 Type or paste the URL of the external content into the URL text field. 

When the page is exported, Freeway simply leaves a space in the page the size of the box you drew and 
either references or includes the contents of the specified URL. When the page is viewed on the web, 
as long as the external content is available at the specified URL, the page will appear correctly with the 
external content in place. 

•	 When you specify a URL box by choosing Image, the URL you specify is inserted into the Freeway 
output inside an “IMG” tag as follows:  
<IMG SRC=/cgi-bin/counter.cgi BORDER=0> 

•	 When you specify a URL box by choosing HTML, the URL you specify is inserted into the Freeway 
output inside an “include” statement as follows:  
<!-- #include virtual=included.inc --> 

Nothing happens when the page is viewed locally, but when the page is requested from a web server, 
the server automatically extracts the above comment and substitutes the code contained in the file 
referenced by the URL. This file can be a complete HTML document, but it is better if it just contains the 
necessary piece of HTML required to achieve its purpose. 

Important: If you specify external content in a URL box using the HTML option, this can only be 
previewed when the pages are served by web server software—you will not see the included HTML 
when previewing locally in your browser. This is because the comment used to reference external 
HTML is not an instruction to a web browser but rather an instruction to web server software. 

This also requires the web server to be set up to support “Server Side Includes”. Many web servers disable this for security reasons. 

Import external HTML into a document 
If you have HTML content that you wish to reference within an existing page in Freeway, you can import an HTML text file from disk 
into a box in Freeway. The imported HTML can’t be displayed or edited within Freeway, but it will be visible when the page is previewed 
in a web browser. The external file must be available when the document is published. 

To import HTML content 
1.	 Draw a rectangular box and make sure that it is selected so that the handles are visible. (IMPORTANT: Ensure that you haven’t 

clicked inside the box to create a text cursor). 
2.	 Choose Import… from the File menu and select the text file containing the HTML code you wish to import. 

Note: The file to be imported must be named with the file extension 
“.htm”, “.html”, “.asp”, “.inc” or “.php”.

3.	 When the text file has been successfully “imported”, you will see a text file icon and a reference to the location of the imported file 
displayed in the box on the page. 
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You can use complete HTML pages if you need to, although some web browsers may react unpredictably. We recommend that if you are 
using this feature, the imported HTML file should be edited so as to contain only the parts you actually need. 

Bear in mind that some commands in the imported HTML file may conflict with commands used by Freeway, which may cause unpredictable 
results in the browser. An example of this is imported HTML that contains HTML form commands: form elements created in Freeway may fail to 
reproduce correctly when the page is viewed in the browser when the “combination page” is viewed.

Advanced techniques for inserting or editing code in a Freeway document
There are some third-party Freeway Actions which help you to add complex code to a page, but please bear in mind that Freeway software 
support cannot offer help for using these Actions as they require excellent coding knowledge.

The Crowbar Action
This third-party Action can be applied to the page in three different ways (as a Page Action, as an Inline Action or as an Item Action).

See http://actionsforge.com/actions/view/13-crowbar-inline

The Protaculous Action
This Action allows you to use functionality offered by the Prototype and/or script.aculo.us JavaScript libraries to your Freeway page. It 
includes separate observers for the dom:loaded and window:load events, so you can attach code to your page unobtrusively.

See http://actionsforge.com/actions/view/18-protaculous

The Source Code Snooper Action
Source Code Snooper allows Freeway users to alter the code that the application generates directly within the application itself, enabling 
users to tweak the code – from minor amendments to full blown server-side scripting applications.

See http://www.freewayactions.com/product.php?id=015
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What are Freeway Actions? 
Freeway Pro and Express come with a set of Actions which you can use to add functionality and dynamic effects to web pages. 

This chapter gives information on the use of the “standard” Actions that ship pre-installed with Freeway. Information on the use of 
custom Actions should be sought from the developer, or may be available on the Softpress KnowledgeBase.

They are comparable to plug-in modules, allowing you to do some remarkable things, which would require sophisticated programming 
on your part in other programs. Actions can be as simple as making an image change color when a visitor runs their mouse over it, or as 
complex as controlling forms, browser windows and multiple images, or for such tasks as creating navigation systems, processing graphics, 
or creating an on-line shop. 

Freeway Pro allows you to add further Actions which enhance the functionality of your web pages. Freeway Express allows you to add 
new Actions that are encoded. You can download custom Actions from the the websites of Action authors (such as ActionsWorld.com 
or FreewayActions.com), or you can download many others from ActionsForge.com which is the main place to look for after-market 
Freeway Actions.

You can also create your own Actions following the guide to developing Actions, which is also available from the KnowledgeBase. At the 
end of this section we have listed some Actions developers’ web sites where you can find other useful Actions.

It’s also helpful to subscribe to the FreewayTalk web forum (http://www.freewaytalk.net/) for active discussions about the many 
aspects of using Freeway and a wealth of tips on using Actions from the Freeway community. 

How to use Freeway Actions
All core Actions which ship with the application have their own KnowledgeBase article which tells you how to apply them and what 
options are available. Go to http://www.softpress.com/kb/ and search for the Action by name.

Installing extra Actions 
FW Pro only

 
Actions can be installed by dropping them directly onto the Freeway application icon, either in the Dock or in the Finder. You can also 
install Actions through the Edit Actions dialog (see The Edit Actions dialog below). You can use newly installed Actions immediately—
you don’t even need to restart Freeway when you add them.

In Freeway Pro, custom Actions are stored in  
~username/Library/Application Support/Freeway Pro/Actions

You should ensure that the Action has a .fwaction extension prior to installation. Other extensions, such as .act3 used for Freeway 3 
Actions, will also work.

Managing Actions 

Action Files 
Freeway Actions which ship with Freeway Pro and Express are stored in text files within the Freeway application bundle. Third party 
Actions are installed in the Application Support folder, in the user’s Library folder (see Installing extra Actions on page 216 for more 
information).

The Edit Actions dialog 
The Edit Actions dialog can be accessed from the Edit menu 
by choosing Actions…. The Edit Actions dialog allows you to 
switch individual Actions or sets of Actions on and off. 

There are 5 columns in the Edit Actions dialog: 

On/Off: Allows you to disable an Action so that it will no longer 
appear in the Freeway interface. 

Name: Shows the names of the Freeway Actions and the files 
and folders which contain them. 

Type: Denotes the type of Action: Object (Free-standing), Page, 
Folder, or Item. 

Used: Tells you how many times an Action has been used in the 
current Freeway document. 

Date Modified: Tells you the date of the last modification to a 
particular Freeway Action file. This can help you to ensure 
that you have the latest version of a particular Action. 

Freeway Actions
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Duplicate Actions 
If you have two Actions of the same type with the same name, Freeway will disable the older version by default and will warn 
you when you run or switch into Freeway. If you look in the Edit Actions dialog you will be able to find out which one has been 
disabled. If you wish to use a different Action, you can disable the Action currently in use and enable the one that has been disabled. 

Modifying Actions 
Because Freeway Actions are contained in standard text files, this means that you could modify them according to your own needs. 
Some of the Actions are very simple, but some are more complex and can interact with other Actions, so it’s probably a good idea not 
to edit them unless you know what you are doing. 

Freeway Express Actions are encoded, so it is not possible to edit them.

Writing Actions 
FW Pro only

 
If you wish to write your own Actions, see the Softpress Knowledgebase at (http://www.softpress.com/kb/questions/153/). You might 
also wish to share the Actions you write with other Freeway users. If you have some Actions that you would like to submit for inclusion 
on the Actions web site, please contact Softpress Technical support at support@softpress.com—it is helpful if you can also provide full 
documentation and examples for other Freeway users to follow.

Third Party Actions
If you find that the standard shipping Actions don’t quite fit your requirements, there are lots of third party Actions available. Here are 
some URLs to find numerous free and paid-for Actions:

http://www.actionsforge.com/
http://www.freewayactions.com
http://www.actionsworld.com
http://www.freewaystyle.com
http://t2studios.com/freeway/
http://www.freewaypro.com/

Actions in the Freeway interface
When Actions are applied to parts of a design in Freeway, there are various visual 
cues which appear as you work.

Anatomy of the Actions palette 

Title tab and close 
button: clicking this 
button removes the 
Action. (Not all Actions 
have this button.)

Add Action button. 
Pressing this calls up 
the Add Action dialog.

Action version number. Clicking 
this shows an information panel 
about the Action.

Note: This is a general overview of a typical graphics Action. There are slight variations 
in the Actions palette, depending on which Actions have been applied.

Types of Actions 
There are four types of Freeway Action: 

Item Actions: These are applied to existing items on your page. An example is a rollover: an image is swapped for another when the mouse 
moves over it. 

Page Actions: These are applied to the page itself. Examples are a background sound when the page is loaded or a timed redirect that 
automatically sends the viewer to a new page after a defined period. 

Folder Actions: These are applied to a folder in the Site Panel, or even the main “root” folder to which your site is published. A good example 
of this is the Freeway Shop Action suite.

“Free-standing” Action Items: Like other Freeway items, these are drawn on the page or inserted from the Insert menu. An example is a 
popup list of countries, which can be added to a form. 
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The applications for Actions technology extend to database connectivity, DHTML animation, ad banners, counters, and much 
more. A selection of Actions ships with Freeway, and a growing library of Actions is available for free download from the Softpress 
KnowledgeBase. 

The Actions button, available from 
the Toolbar in Freeway Pro and Express 
(above), and in the Tools palette 
(Freeway Pro only, below), presents a 
popup menu of “free-standing” Actions.

The Actions submenu 
on the Item menu. This 
menu contains different 
content depending on 
whether the item in 
question is HTML or 
graphic. Some of these 
Actions can also be 
applied to folders in the 
web site hierarchy. The 
Page Actions submenu 
on the Page menu, right, 
lets you apply Actions to 
an entire page rather than 
just items on that page.

To apply an Action to a Folder you first 
need to select a folder in the Site Panel 
and then the Folder Actions sub-menu 
will be active in the Page menu. 

Another method of applying a folder 
Action is to select a folder in the Site 
Panel and then click on the “+” button 
in the bottom left of the Actions panel to 
choose from the available Actions.
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You can create inflow Actions by 
placing the text cursor in a run of 
HTML text and choosing from the 
Action Item menu on the Insert 
menu. This menu offers the same 
Actions as those available from 
the Toolbar Actions button or the 
Tools palette.

To apply styling to a standalone Action, all you 
need to do is to draw an HTML item on the page, 
click inside it, type a space, go to Insert>Action 
item to add the standalone Action and then type 
another space. Now go to Edit>Select All to 
select the Action item as well as both spaces and 
then you can apply whatever styling you want to 
use in the Inspector.

Freeway Pro users can also select a standalone 
Action item on the page and apply a pre-
determined custom CSS text style.
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This section of the Freeway Reference covers the different 

types of layout methods used to build web sites with Freeway. 

setting Freeway’s Preferences, working with Document Setup, 

the Freeway toolbar and how to customize it, and lists the 

keyboard shortcuts.

APPENDIX 1—Layout Methods in Freeway

APPENDIX 2—Preferences and Dialogs

APPENDIX 3—Keyboard Shortcuts

	

Appendices
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Appendix 1: Deciding on your layout method in Freeway Pro
When you start a new project it is very important that you first consider what type of behavior you want your site to have when it is 
viewed in a browser, because once you have started in one particular type of layout, it can often mean that you will need to start again 
from scratch if you later decide you want the page to behave differently. There are four main methods used to build your pages in 
Freeway Pro:

•	 Table-based layout

•	 CSS-positioned layout

•	 CSS-positioned layout with Relative Page Layout

•	 Inflow layout

Table-based layout (Express or Pro)
This is the most basic type of layout, and it is normally the first method used by those starting out with Freeway. If you build the Using 
Freeway tutorial site you will very quickly learn how to work in table-based layout. Note that table-based layout is the only layout 
method supported in Freeway Express, and while Pro offers additional layout methods many Pro users also can start out with table-
based layout by working with the Pro-only CSS Layout button switched off.

Using table-based layout is simply a case of drawing, inserting or dragging and dropping items onto your page—and because Freeway is 
WYSIWYG (what-you-see-is-what-you-get) the position of the items used on your page will appear in virtually the same place when you 
preview the page in a web browser. This layout method is called table-based because when you “publish” your file (by clicking on the 
Preview button or clicking on the Browser button to preview in a browser) Freeway will build an invisible table to contain all the items 
on the page and to keep those items in position. 

The main advantage of using table-based layout is its sheer simplicity. It is very quick and simple to build pages by adding new items 
to the page and then moving them into position. Another benefit is that because the page content is held inside the invisible table 
that Freeway builds when you publish the file, if the height of any item increases slightly when it is rendered in a browser (which often 
happens with HTML text to varying degrees), the content below will be pushed down the page automatically. 

The above screenshot shows how the Home page 
of the Using Freeway tutorial renders in a browser 

when viewed at the default Zoom level.

This screenshot shows how the Home page of the Using Freeway tutorial 
renders in a browser when Command-+ has been used twice with “Zoom 

Text Only” switched on. Even though the text size has been increased, 
you can see that table-based layout pushes the content down on the page 

automatically so the layout doesn’t break.

Appendix 1
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There are, however, a few limitations in table-based layout, such as not being able to place an item on top of an HTML item which 
has content or graphic effects applied (as that will make the HTML item “overflow”) and placing HTML items on top of graphic items 
usually results in the graphic item slicing apart as the content of the HTML item grows when rendered in a browser.

If an item is placed on top of an HTML item which has content inside it, the 
HTML item in the background will “overflow” and its content will not be 

published. This is a limitation of using table-based layout.

When an HTML text item is placed on top of a graphic item, if the 
HTML text grows when rendered in a browser (which it often does), 

that will force the graphic background item to “slice” apart to show the 
page background in between.

Another disadvantage of using table-based layout is that you will not be able to use many of the more complex Freeway Actions 
(because for those Actions to work it requires an item to be a layer item so it can be targeted specifically).

Occasionally, the spacing between table-based items can behave a little erratically—and that is usually caused when a long HTML item is 
used alongside a column of separate items, such as navigation buttons. This can happen if the HTML text grows slightly in height when 
viewed in a browser, which can force the column of separate items to display with uneven spacing. The simple fix for this is to draw a 
marquee around the column of graphic buttons and then go to Item>Group to group them (which will force Freeway to publish all the 
items in the column into a single “cell” of the invisible table).

When HTML text is placed alongside separate items when using table-based 
layout, it can sometimes force items apart when the HTML text grows when 

rendered in a browser. In the right-hand example above, the red boxes have been 
grouped into a single group item which usually fixes the problem.

Using HTML text in table-based layout you need to be aware that the background of an HTML text item is never invisible when placing 
that item on top of another item on your page. Even if you set the background to “None”, the background of the item containing the 
text will be white. This isn’t too big a problem if you want to place the text on top of an item or page/background item which is a single 
color (as you can sample the background color and use that color as the background color of the HTML text item), but it is a very big 
problem if you want to place HTML text on top of a photograph or a graphic with a gradient color background.

This screenshot shows that HTML text items will always display with a white 
background (even if the background is set to “None”). This is another limitation 

with table-based layout.

Table-based layout does not let you draw items on your page which can be made to extend to the full width of a browser window. The 
only way to make that work is to embed a graphic item in the page’s background so it can be made to “tile” horizontally to always fill 
100% width in the browser window as a header bar. Although that workaround can be used to create a header bar, there is no reliable 
method of setting up 100% width mid-page or footer bars in table-based layout.
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CSS-positioned layout FW Pro only  

This is very similar to the table-based layout workflow, but you work with the CSS Layout button on Freeway Pro’s tool 
bar switched on. With the button switched on, every item you draw on the page will be used as a “layer” item and, if you 
select an item,  you will see the Layer option (or the CSS option for inflow items) checked in the General Settings tab of the 
Inspector. Note that there is no CSS Layout button in Express.

With the CSS Layout button switched on, all items drawn on the page will 
automatically be used as layer items. The items’ outlines will display in green 
and the Layer option is switched on in the Inspector when the item is selected.

There are many advantages of using CSS-positioned layout over table-based layout—and the main ones are that you can place HTML 
text items on top of other items so the HTML item has a transparent background; placing an item on top of an HTML item doesn’t 
make the item behind “overflow” like table-based layout; and because each layer item is a separate object on the page (and not a cell of 
a table or larger structure), this means that you can use many of the more complex Freeway Actions to set up fading transitions, sliding, 
etc.

The one crucial difference between table-based layout and CSS-positioned layout is—as the name suggests—layer items are positioned 
using CSS (using co-ordinates which are based from the top left corner of the page). In some ways this sounds like it is an advantage, 
because the items will be located in exactly the positioned they have been placed on the page—but in reality it is a disadvantage because 
if any HTML text content on the page grows in height when rendered in a browser, that can often mean that the text grows to a line 
or two longer to point where it overlaps the item(s) below. Unlike table-based layout, which moves the rest of the content down the 
page automatically when the content above it grows, CSS-positioned layout will mean that nothing moves down the page automatically 
because the items are fixed in position. 

This screenshot shows how two columns of three separate 
HTML text items have been created in a Freeway file. The left 
column (with green outlines) are CSS-positioned (layer) items, 

and the right column (with blue outlines) are table-based 
(non-layer) items.

This screenshot shows how the items shown in the previous 
screenshot are rendered in a browser. Note that because the 
left column of HTML text items are fixed in position using 
CSS (because they are CSS-positioned items) they will not 

automatically move down the page if the browser renders the 
text slightly larger, and this results in each item overlapping 

the item below. Every browser renders HTML text slightly 
different in size, although it varies from browser to browser 

and font to font.

Because of this inherent behavior in CSS-positioned layout in Freeway, we have introduced Relative Page Layout (see below) which 
makes CSS-positioned items behave like table-based items in terms of the items moving down the page when content above grows—so 
this gives you the best of both worlds.

Again, like table-based layout, CSS-positioned layout does not let you draw items on your page which can be made to extend to the full 
width of a browser window. The only way to make that work is to use a very limited workaround by embedding a graphic item in the 
page’s background so it can be made to “tile” horizontally to always fill 100% width in the browser window as a header bar. There is no 
reliable method of setting up 100% width mid-page or footer bars in CSS-positioned layout.
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Using Relative Page Layout (RPL)

As mentioned above, using Relative Page Layout (which we call RPL) together with working with the CSS Layout button switched on 
offers you the benefits of both types of layout.

Using Relative Page Layout will make CSS-positioned items behave like 
table-based items (see previous screenshot). For this screenshot, RPL has 

been applied to the Site Folder and the three HTML items in the left column 
have the Remove from Relative Page Layout Action applied to them.

To use RPL on your Freeway project you should read through the detailed KnowledgeBase article at http://www.softpress.com/kb/
questions/319/ which tells you everything you need to know.

There are, however, a few limitations you need to be aware of. Although RPL is very clever, it can’t calculate every layout—so there are 
some things you should try to avoid, and there are some things which can be fixed by using a Freeway Action specifically offered for 
such problems. It can sometimes appear that a layout is completely breaking when in reality just one item on the page needs to be fixed 
for it all to work exactly as it should.

RPL has been designed to expect items to be completely on top, completely behind or a completely standalone item. However, if there 
are items which partly overlap (or partly underlap) one or more items, RPL may have problems knowing what exactly you want it to do. 
This is when RPL needs a helping hand.

Usually there are three options to fix RPL problems—moving an item slightly so it doesn’t partially overlap (or underlap) one or more 
other items on the page; selecting the item which RPL is having difficulty with, then applying the Remove from Relative Page Layout 
Action to it; and sometimes selecting two or more items (especially if they are overlapping/underlapping) and grouping them so they 
are treated as a single item. This is covered in detail in the KnowledgeBase article on troubleshooting RPL problems at http://www.
softpress.com/kb/questions/287/.

In the troubleshooting article mentioned above, you will also get help with any error messages you might see when working with RPL. 
The most common error message is shown when an item is not a layer item. For RPL to do its work on the page, every single item on 
the page must be a layer item.

Inflow layout FW Pro only  

Inflow layout (often called “inline CSS layout”) offers the web designer all the functionality you need. Building sites which are “fluid” 
(ie, sites which are based on percentage widths, so the width of items will change according to the size of the browser window) and 
sites which use full-width header and footer bars can only be built when using inflow layout even when the page width itself is a fixed 
width.

In the next section the ways to build percentage-based and fixed-width inflow layouts will be explained. Inflow layout is more complex 
than the layout methods which have been covered earlier—and you will need to understand the different height and width attributes 
involved to make the layout work reliably.

It is very important to plan ahead so you consider which layout method you need to use to achieve the site layout that you require—
because changing your mind later in the project will usually require you to start the site again from scratch.
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Inflow layout tutorial
Percentage-based inflow layout
This type of layout method is sometimes called “fluid layout” because the layout of the page 
will reflow as the containers holding the content of each item grow wider or narrower as the 
browser window is resized.

Some web designers prefer the width of the container items on the page to stay at a fixed 
width (although full-width items such as header and footer bars still fill the width of the 
browser window regardless of its size) because the page layout can look very different when 
viewed on small screens and huge desktop screens. Fixed width and other inflow layout is 
discussed later.

Many people like to use percentage-based inflow layouts because they can be made to adapt 
well to different screen sizes, and with careful consideration with the design of the site it is 
possible to achieve a design which looks fine on a full-sized desktop computer screen as well 
as on a smartphone when the screen is used in portrait mode. However, it will always be a 
limitation of this type of layout that viewing the page on a very large screen can mean that 
paragraphs of text may run to just one or two lines, which can compromise the original design 
of the page layout.

Creating a percentage-based inflow layout page
All inflow layout uses the same basic principles of embedding items inside other items (sometimes to many levels of embedding), which 
is why the layout method is called “inflow”. 

To start with you need to create a new document. The size of the page isn’t particularly relevant because the page size will ultimately 
depend on how large the visitor will use their browser window when they view the file online. However, you need to have enough 
room to work on your layout in Freeway so create a new document using the Blank template in the General template folder, give the 
new file a name, choose where you want to save it and click Save. 

First thing to do is to click on the Master1 page then set the Width popup in the Measurements panel of the General Settings tab of 
the Inspector to Flexible. It is important to note that you need to leave the Align popup of the page set to None, as the alignment of 
items in inflow layouts are controlled by “Margins” and “Floats” (which will be covered later).

Next you need to create a “wrapper” to contain all the items used on the page. To do that, double-click in the empty page area (so you 
can see a flashing text cursor in the top right of the page) and then go to Insert>HTML item to place an HTML item in the top left 
corner. This item will be sized at 100 pixels square, which is the default size of items inserted using this method.

In the screenshots right and below you can see 
how a percentage-based inflow layout can be made 

to work on very wide desktop screens as well as 
narrow smartphone screens.
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Select the HTML item you inserted, then enter 100% in the Width field in the Dimensions panel of the 
Inspector and type a Return.

This now means that the page “wrapper” has a width of 100% of whatever size the browser window is used 
at, so it will always fill the width of the browser window and this item is effectively the background of the 
browser.

Now you need to set up the items which will make up the content of the page itself.

Double-click inside the HTML item page wrapper item and go to Insert>HTML item three times. Because 
the wrapper item uses the default Height setting of Minimum, this will make the wrapper item grow in 
height to fit all three inserted items.

Select the top HTML item then click on the Width popup in the Measurements panel of the Inspector and choose Available. 
Choosing Available will make that item fill the available width of its parent item (which is the page wrapper), so that will also give 
the top HTML item you inserted an effective width of 100%. Select the third (bottom) HTML item you inserted and set that width to 
Available. Finally, select the middle HTML item you inserted, click in the Width field in the Dimensions panel, enter 75% and type a 
Return.

You will now see that the top and bottom HTML items fill the width of the page wrapper item and the middle HTML item fills three-
quarters (75%) of the page wrapper—and that item is aligned left inside the page wrapper. To center an inflow item within its container, 
select the middle HTML item, click on the Margin popup in the Dimensions panel of the Inspector and choose Auto.

This is a good time to point out the benefits of giving your items 
logical names so you will be able to identify them when you start to 
build your pages, so click on the header bar of the Site Panel (to toggle 
the view from Site to Page) so you can see the items on the Master 
page in a list in the Site Panel. You can see in here that you have one 
item at the top of the list (which is the page wrapper item you first 
inserted) and three other items which are embedded “inflow” within 
the page wrapper.

Select the page wrapper item (it should be called “m1”) then Alt-
click on it and rename it “pagewrapper” (without the quotes). 
Now rename the inflow items m2, m3 and m4 as headercontainer, 
pagebodycontainer and footercontainer respectively.

While the items are displayed in the Site Panel, you can apply colors to 
each of the items so it can be previewed in a browser to see the current 
structure. Select the pagewrapper item and give it a color with a Hex value of FFFFDD. Select the headercontainer and footercontainer 
items and give them a color of blue, then select the pagebodycontainer item and give it a color of white. Now preview the file in a 
browser.

In the browser window you will see that the header and 
footer bars in blue always fill the browser window’s width 
and the white page area is always centered within the browser 
window with the area each side of it filling the rest of the 
browser window’s width. Although it isn’t too easy to see at 
the moment, this is the bare bones of a web page which has a 
header and footer area and a flexible main page area which is 
always sized to 75% of the browser window’s width.

It is important to point out here that each of the items has 
a Height attribute set to Minimum—and the reason for 
this is that because none of the items have content inside 
them (other than the pagewrapper item) giving the items an 
undefined height will make the item collapse so it is just 1px 
high, so this needs to be done after the items have content 
placed inside them. For now, however, we can give the pagewrapper an undefined height—and this is done by selecting the item in the 
Site Panel list then choosing Flexible in the Height popup in the Measurements panel of the Inspector.
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Let’s add some text to the header and footer bars. Select both items one at a time and click on the Padding popup in the Dimensions 
panel of the Inspector and choose 20px. Doing this will place 20 pixels of space around the inside of the item. After that, click inside 
the items and enter some text and style it, align it, etc., and then give both items an undefined height by selecting them one at a time 
and choosing Flexible in the Height popup in the Measurements panel of the Inspector. Preview the file in a browser again to see how it 
looks now.

Now we can add two panels of text inside the main body area of the page. Because the pagebodycontainer item has a percentage width, 
it is important to give percentage widths to items embedded inside it.

Select the pagebodycontainer item and give the item 20 pixels of Padding in the Dimensions popup of the Inspector.

Double-click on the pagebodycontainer item and go to Insert>HTML item twice. Select the top item and click on the Float popup in 
the Dimensions panel of the Inspector and choose Left. As soon as you float the item left the second HTML item will automatically 
jump up so it is alongside the first item.

Select the second HTML item and choose Right in the Float popup in the Inspector’s Dimensions panel. This will align the item right 
within the pagebodycontainer item.

Select the first HTML item again and you will see that although the parent item (the pagebodycontainer item) has a percentage width, 
the new items have been inserted with the normal default of a fixed width of 100px. With the item selected, enter 72% in the Width 
field of the Dimensions panel in the Inspector and then select the second HTML item and give that item a Width of 25% using the 
same method.

Now select each of the inserted HTML items in turn and apply a 1px black border in the Border panel of the Inspector’s Paintbrush 
tab then give them logical names in the Site Panel (name the first HTML item leftpanel and the second HTML item rightpanel).

Because there is some content inside the pagebodycontainer item, you can now select that item and change the Height popup in the 
Inspector’s Measurements panel to Flexible. After that, click in the Height field in the Inspector’s Measurements panel and enter 
1000px for both of the inserted HTML items before previewing in a browser to see it all looking a lot more like a proper web page. Test 
the percentage widths set on the pagebodycontainer, leftpanel and rightpanel items to see that as you change the width of the browser 
window the items change in relation to each other.

Going back to your Freeway file, select the leftpanel item and give it a Padding of 3% in the Dimensions panel of the Inspector then 
enter a lot of dummy text to almost fill the leftpanel item and give the item an undefined height by clicking on the Height popup in 
the Inspector’s Measurements panel and choose Flexible. If the dummy text is less than the 1000px you originally had set, the item 
will reduce in size to fit the text that is now inside it.

Let’s make the rightpanel item a column of two small box panels. To do that, first select the rightpanel item and remove the black 
bornder from it, double-click inside it and go to Insert>HTML item twice. Select each of the inserted HTML items in turn and choose 
Available in the Width popup of the Measurements panel of the Inspector to make them fill the width of the rightpanel item. 

Now select the top HTML item, apply a 1px black border to it and then, with 
the item selected, click on the Margin popup in the Measurements panel of 
the Inspector, choose Custom..., enter 20px in the Bottom field and click OK. 
What this does is to add 20 pixels of spacing between the two boxes in the right 
column. Margin is the opposite of Padding in that it adds space to the outside of 
an item rather than the inside.

Double-click inside the top box item, and insert two new HTML items then give 
both the new items a Width of Available. Select the first HTML item, give it 
a Padding of 10px in the Inspector’s Dimensions panel, enter the text “Box 
One”, style the text so it is in centered White type of 14px 
Helvetica, select the HTML item, apply a Black background 
and then click on the Height popup in the Measurements 
panel of the Inspector and choose Flexible to give it an 
undefined height.

Select the second HTML item, apply a Padding of 2%, 
add some dummy text inside the item and then give it an 
undefined height.

Repeat this to add content to the second box item in the 
rightpanel column (using the heading name of “Box Two”) 
and then you need to remember to select the item called 
rightpanel and give it an undefined height.

Finish off by giving the names of the items in the Site Panel 
list logical names so they are easy to identify and then 
preview the file in a browser to see how it looks and to test 
the page again by changing the width of the browser window.
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When you preview the page in a browser you may well find that the layout is not working correctly. This is because there is an 
issue when using a floated item inside a parent item which has a background color or embedded image applied to it. To fix this, the 
thing you need to do is to apply the Auto Clearfix Action to the page. You can get the Action for free from http://actionsforge.com/
actions?q=clearfix (after signing up if you have not done so already). After downloading and installing the Action, go to Page>Page 
Actions and choose Auto Clearfix. Now try previewing in a browser again and the problem with the layout should be fixed.

Fixed width inflow layout
Some website designs, especially complex multi-column layouts, don’t lend themselves well to being built with flexible widths, and 
many designers simply prefer using a fixed width layout because the content will not reflow and change the look of the page when 
viewed in different sized browser windows. 

A fixed width inflow layout is one which will show the browser background in equal amounts either side of the pixel width set for the 
page and when the browser window is made too narrow to display the full width of the page, the browser will simply chop off page 
content from the right side.

The workflow is very similar, and the main difference is that all width values are set as pixel widths (such as 200px rather than 20% for 
example when using a 1000px width page) in the Inspector.

The default Width setting for the page in Freeway Pro will be set to Maximum, which means that the width of the page can shrink, but 
it cannot grow so it’s larger than the maximum value entered in the Dimensions panel, even if the browser window is made larger.

The main disadvantage of fixed width layout is that mobile devices will display the full width of the page so it fills the screen of the 
device—so viewing a web page on a smartphone in upright aspect will always mean that text is very small. However, most mobile 
devices work in such a way that double-tapping on a touchscreen will make a specific column fill the width of the device’s screen, 
which make it quick and simple to read columns of text and other content. 

Another method used by some designers is to build sites using duplicate content which are made to display more appropriately on 
smartphones and/or tablets, and this is done by applying the Mobile Redirect Action on the normal site’s Home page so that when the 
visitor enters the URL of the site (or links to it from a link or search engine result) the web server will check to see what device they are 
using—and they will automatically be forwarded to the optimum version of the site for that type of device. You can read more about 
the Mobile Redirect Action on the KnowledgeBase at http://www.softpress.com/kb/questions/369/.

Different options for the page width 
FW Pro only

 
If you want to build a percentage-based layout but you don’t want the layout to change dramatically when the browser window is made 
wider or narrower, you can always compromise by using one of three other types of inflow layout offered by Freeway. 

If you click on the Width popup in the Measurements panel of the Inspector, you will see three more options other than than Fixed 
and Flexible:

•	 Minimum: Choosing Minimum or Minimum (%) for a page width or item width, you can choose a specific value which will mean 
that the browser will never shrink the width of the page or item below that point. For example, choosing 600px will mean that the 
browser will reduce a flexible width layout when the browser is made narrower, but the page or item will never shrink to a value of 
less than 600px. Using Minimum (%) you can specify a percentage value which will be used as the minimum width of the page or 
item.
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•	 Maximum:  This works in a similar way as Minimum (above) except that it specifies the maximum width an item can grow to when 
the browser window (or device screen) is wide enough for the width of the page or item to grow. For example, choosing 600px will 
mean that the browser will expand a flexible width layout when the browser is made wider, but the page or item will never grow to a 
value of more than 600px. Using Minimum (%) you can specify a percentage value which will be used as the maximum width of the 
page or item.

•	 Min/Max: As the name suggests, this lets you apply both a minimum and a maximum width for a page or item.

Height Options for Inflow CSS HTML Items 
FW Pro only

 
With an HTML item selected on the page, the Page Inspector offers the following options in the Width popup:

Fixed Height
An item with fixed height will always be displayed at the same height regardless of its contents. If an item has a fixed height of 100px, 
but the contents are 200px high, the item will be half the height of the content. 

Fixed % Height
If the height is a percentage, it will always be displayed at the same percentage height, but that will vary depending on the height of its 
parent.

Flexible Height
An item with flexible height will grow and shrink to fit its contents. This is similar to the “Height can shrink” option in earlier versions of 
Freeway. Flexible-height items are displayed with undefined height in the Dimensions section of the Inspector palette.

Minimum Height
An item with minimum height has a flexible height that will not shrink below the value that is set as its minimum height. If the content 
is added to an item, or the content is increased in size, the item will grow to accommodate the content. If content is removed, or the 
content is decreased, the item will stop shrinking when it reaches the value entered in the Minimum Height field. Minimum heights can 
be fixed pixels (in which case you should use this option) or percentage based (see below).

Minimum % Height
This setting works in exactly the same way as the Minimum Height option (above), but it is specifically for percentage-based values.

Stretchy Height

An item with stretchy height is defined by its top and bottom offsets, and will grow or shrink as its parent grows or shrinks.

Width Options for Inflow CSS HTML Items 
FW Pro only

 
With an HTML item selected on the page, the Page Inspector offers the following options in the Width popup:

Fixed Width
An item with fixed width will always be displayed at the same width regardless of its contents. Use this option if the item has a fixed 
pixel width

Fixed % Width
If the width is a percentage, it will always be displayed at the same percentage width, but that will vary depending on the width of its 
parent. Use this option if the item has a percentage-based width.

Flexible Width
An item with flexible width will grow and shrink to fit its contents. This is similar to flexible height, but you should be careful about 
using this option with paragraph text – unless it is constrained in some other way, an item may expand so that all the text in a paragraph 
is fitted on a single line.

Minimum Width
An item with minimum width has a flexible width that will not shrink beyond the value that is set as its minimum width. If the content 
is added to an item, or the content is increased in size, the item will grow to accommodate the content. If content is removed, or the 
content is decreased, the item will stop shrinking when it reaches the value entered in the Minimum Width field. Minimum widths can 
be can be fixed pixels (in which case you should use this option) or percentage based (see below).

Minimum % Width
This setting works in exactly the same way as the Minimum Width option (above), but it is specifically for percentage-based values.

Stretchy Width

An item with stretchy width is defined by its left and right offsets, and will grow or shrink as its parent grows or shrinks.
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Working with preferences 
The preferences for both Freeway Pro and Express are split logically between those that 
affect the application itself, and those that refer to the individual document. 

Preferences, found under the Freeway menu, allow you to set the working environment 
within Freeway. The Document Setup dialog, from the File menu, contains options that 
you can use to customize the output Freeway generates. 

The changes that you make in Document Setup will affect the current document you’re 
working in. To make the current settings your new application defaults so that they will affect 
any new documents you create, close any open documents, then reopen Document Setup 
from the File menu. 

General panel

General preference panel: Freeway Pro (left); and 
Freeway Express (above).

Arrows nudge FW Pro only  

In Freeway, you can move or resize selected items using the arrow keys on the keyboard. The value set for Arrows Nudge is the nudge 
distance. Normally, this is set to 1px.

Make backups 

When saving an existing document for the first time, Freeway automatically makes a backup version saved in the same location, with a 
“.fwbackup” extension to the file name. This ensures that if your document is lost or damaged, you will have a backup version to which 
you can revert. If you do not wish this to happen, you can 
deselect the Make Backups checkbox. You should be careful to 
keep manual backups in this case. 

Old Selection Behavior FW Pro only  

This preference allows you to revert to the way that older 
versions of Freeway behave when an item is clicked on. In current versions of Freeway, clicking on an item selects it as an item, and you 
normally click a second time in order to edit text or pan graphics. 

In older versions of Freeway, you had to click on the edge of a text or graphic box (or Command-click on the box) in order to select it, 
since a single click or drag would edit the text or pan the graphic. The new behavior makes it easier to select items, but existing users 
who are used to the old behavior can choose it via this preference.

Palettes snap FW Pro only  

In Freeway Pro, all palettes can be made to snap together at any edge. Once snapped, the group of palettes can be Command-dragged as 
a set. If you prefer palettes not to snap together, uncheck this preference.

Adjust box dimensions when adding padding FW Pro only  

Changes the size of graphic and HTML items to keep the content the same size when adding padding. With this option turned off, 
adding padding of say 6px to a box adds 12px to the height and width in the design view.

For more information about padding, see Padding and Margins on page 65.

Important: A backup is only made the first time you save after opening an 
existing document and make changes. Freeway does not make incremental 
backup copies as you work. If you want to do this, you can either save a 
copy manually from the File menu, or make copies manually in the Finder.
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Enable AppleScript in Actions 

The ability to run AppleScripts in Freeway Actions is switched off by default. If you see an error message in the Actions palette stating 
that AppleScript is required, you will need to switch this option on.  

Show Help Tags 

With Help Tags enabled, as you pass your cursor over the elements within palettes and dialog boxes, a small explanatory label will pop 
up.

Text panel

Freeway Pro (left); Freeway Express (above).

Minimum anti-alias size FW Pro only  

This option lets you define a minimum size for applying anti-aliasing (smoothing) to graphic text. As anti-aliasing softens the edges of 
lines, small fonts can appear blurred when anti-aliasing is applied. The default is 0px.

Invisibles color 

When you choose to display invisible characters (such as spaces and carriage returns) while working in Freeway, you can choose which 
color they are displayed in. Clicking the color button opens the Mac OS X system color picker dialog where you can choose a new color. 
Show or hide invisible characters by choosing Invisibles from the View menu. 

Readability when editing 

If you edit text that does not contrast with its background (e.g. yellow text on a white background), Freeway uses the Invisibles color to 
display the text while you are editing it. The More Readable option causes this to happen for a wider range of contrasts.

Appearance panel

Freeway Pro (left); Freeway Express (right).

Graphic Boxes

Specifies the color used for the border of graphic items. Clicking the color button opens the Mac OS X system color picker dialog where 
you can choose a new color.

Table-Positioned Boxes

Specifies the color used for the border of HTML non-layer items. Clicking the color button opens the Mac OS X system color picker 
dialog where you can choose a new color.

CSS-Positioned Boxes FW Pro only  

Specifies the color used for the border of HTML layer items. Clicking the color button opens the Mac OS X system color picker dialog 
where you can choose a new color.
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Map Area Boxes

Specifies the color used for the border of map area items. Clicking the color button opens the Mac OS X system color picker dialog 
where you can choose a new color.

Revert to Default Colors

Restores the original default color values if you have changed them.

Grids & Guides panel

Freeway Pro (left); Freeway Express (above).

Grid color FW Pro only  

Specifies the color used to display the grid lines. Clicking the color button opens the Mac OS X system color picker dialog where you can 
choose a new color.

Grid magnetic range FW Pro only  

Specifies the snap-to distance for grids. The default is 5 pixels.

Horizontal/Vertical guide color

Specifies the colors used to display the horizontal and vertical ruler guides. Link is checked by default, which makes the horizontal 
and vertical lines the same color. If you want horizontal and vertical guides to show as different colors, uncheck Link and click on the 
relevant color swatch button to define a new color. Clicking the color button opens the Mac OS X system color picker dialog where you 
can choose a new color.

Margin guide color FW Pro only  

Specifies the color used to display margins. Clicking the color button opens the Mac OS X system color picker dialog where you can 
choose a new color.

Guide magnetic range FW Pro only  

Specifies the snap-to distance for guides. The default is 5 pixels.

Document Setup

Document: Freeway Pro

Default page size

Specifies the default size of pages in your site. Choose from one 
of the predefined page sizes from the popup menu, or choose 
Custom and specify the size explicitly in the Width and Height 
fields.

Site folder

Click the Select… button to specify the location of the Site 
folder, which will be used to contain the HTML and resource 
files when the site is published.

Pasteboard width

Specifies how far the pasteboard extends in each direction outside 
the page area.
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Document graphics FW Pro only  

When you import a bitmap image into Freeway, Freeway notes the location of the original file on your computer. It also captures a 
72ppi (pixels per inch) version and stores this internally within the Freeway document. 

256 colors will give the smallest Freeway document size; Millions of colors will save the highest possible quality image with your 
Freeway document, allowing high quality images to be generated when you publish your site if the original images are not available.

Choosing 256 colors is not recommended for normal use, as 
it means that Freeway will not have sufficient information to 
export images at reasonable quality if the original image is 
unavailable.

Document: Freeway Express

Default page size

Specifies the default size of pages in your site. Choose from one of 
the predefined page sizes from the popup menu, or choose Custom 
and specify the size explicitly in the Width and Height fields.

Site folder

Click the Select… button to specify the location of the Site folder, 
which will be used to contain the HTML and resource files when the 
site is published.

Pasteboard width

Specifies how far the pasteboard extends in each direction outside the 
page area.

Output 

Freeway Pro

Default HTML FW Pro only  

Specifies the default standard of HTML generated by Freeway Pro. 
For more information about the different HTML levels available, see 
Default HTML on page 15 and Setting the HTML level on page 19.

HTML code

This determines the formatting applied to the HTML generated by 
Freeway. Note that this option has no effect on the appearance of the 
page in a browser.

More Efficient leaves out optional white space to make the files as 
small as possible.

More Readable makes the HTML easier to read by indenting the 
output.

Line Feeds FW Pro only  

Macintosh, DOS, and UNIX use different linefeed characters. 
Selecting DOS or UNIX will allow the HTML text files to be read more 
easily on DOS/UNIX systems. This doesn’t matter for browsers, but 
may be important for CGI scripts, etc.

Resources

For more information, see Resources on page 16.

File names

This specifies the conventions used to generate the file names of HTML files and resources when the site is published.

Alphanumeric: restricts the file names to letters and digits, as required by older servers.

DOS: restricts the file names to 8.3 format for maximum compatibility with MS-DOS web servers.

UNIX/Windows: (recommended) generates file names suitable for UNIX or Windows servers.

Reinforce layout tables FW Pro only  

For technical reasons, the layout tables generated by Freeway’s output may need to be reinforced to prevent browsers distorting the 
layout. Freeway Pro gives the option to insert invisible GIF images that are scaled to precise widths to reinforce the table. This option is 
on by default.

External Stylesheets FW Pro only  

Stores CSS style sheets in a separate file from the HTML. This option is off by default, because some Actions may exhibit problems with 
an externally referenced style sheet.

Note: Changing this option affects newly imported graphics. If you wish to 
re-import existing graphics, select Resample All in the Edit Resources 
dialog.

Above: The Document Setup dialog in Freeway Express (above) 
showing the options in the Document tab. Below: Freeway Pro showing 

the options in the Output tab.
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Uppercase tags

Specifies that the HTML tags should be generated in upper case rather than the default lower case. This is not applicable to the XHTML 
output options in Freeway Pro.

IE Compatibility

This setting specifies that Freeway will write an IE-specific stylesheet which contains style definitions that used to work around some of 
the known display problems in IE 6. For more information, see Freeway and IE compatibility on page 142. IE Compatibility defaults to 
IE7.

Max. filename length FW Pro only  

This specifies the maximum length of automatically generated filenames.

Image type creator FW Pro only  

When Freeway Pro creates image files, they are given a creator type to control which application will be used to open them. By default 
this is set to the default browser, as specified in Preview Setup… on the File menu.

For consistency you may wish to change the creator type to that of another application. Either type in a new creator type (these are 
a Mac OS attribute and are case sensitive) or choose the application you wish image files to be associated with using the Choose 
Application… command.

None: specifies no creator type.

Other: allows you to specify the four-letter creator type explicitly.

Default Browser: sets the image creator type to the default browser.

Choose Application…: allows you to set the creator by selecting an application on your hard disk.

Freeway Express

HTML code

This determines the formatting applied to the HTML generated by 
Freeway. Note that this option has no effect on the appearance of the 
page in a browser.

More Efficient leaves out optional white space to make the files as 
small as possible.

More Readable makes the HTML easier to read by indenting the 
output.

Resources

For more information, see Resources on page 16.

File names

This specifies the conventions used to generate the file names of HTML files and resources when the site is published.

Alphanumeric: restricts the file names to letters and digits, as required by older servers.

DOS: restricts the file names to 8.3 format for maximum compatibility with MS-DOS web servers.

UNIX/Windows: (recommended) generates file names suitable for UNIX or Windows servers.

Uppercase tags

Specifies that the HTML tags should be generated in upper case rather than the default lower case. This is not applicable to the XHTML 
output options in Freeway Pro.

Upload
The Upload panel specifies the default upload method for when your 
document is uploaded to a web server using the Upload… command 
on the File menu. 

There are four upload options, selected from the Method popup 
menu:

FTP: File Transfer Protocol. The default method of uploading web 
sites to a server. You will need to provide the Server, Directory 
(folder on the server), User Name, and Password information. 
Consult your service provider for this information if you don’t 
have it to hand.

File Copy: This setting allows you to copy to a site located on a local 
volume (or on a server accessed using a local network). This will 

The Document Setup dialog in Freeway Express, showing the options 
in the Output tab

The Document Setup dialog in Freeway Pro 
(above), showing the options in the Upload tab
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normally be the method to use if you have your own web server, 
or if you will publishing your site using your own computer and 
Personal Web Sharing (or similar software). Choose a local hard 
drive, folder or networked server by clicking the Select… button.

FTPS (Secure FTP): The encrypted version of FTP which some web 
hosts want you to choose as your preferred upload method.

SFTP (SSH File Transfer): Another encrpyted version of FTP, this 
method uses the secure SSH protocol.

Your web host should have sent you information telling you whether 
you should use FTP, FTPS or SFTP to upload your files to your web 
server.

File Copy is generally only used if you prefer to upload your files 
manually to your web server.

For information about uploading your web site, see Uploading on 
page 136 and Setting the upload options on page 137. For information 
about publishing using your own computer, see Publishing your site 
using personal web sharing on page 139.

Text

The Document Setup dialog in Freeway Pro (left) and Freeway Express (right) showing the options in the Text tab

This option specifies the default encoding and language used for HTML generated when the site is published, and the default fonts used 
to display text in the Freeway document when editing the site.

Default encoding FW Pro only   
When left at Automatic, the encoding is chosen based on the text in the site. Alternatively, you can choose an encoding from the 
popup menu.

Spelling/Hyphenation language 
Specifies the language used for spelling in the Freeway document.

Default fonts for encoding 
Allows you to specify the font and size to use for displaying both standard and fixed width text in your Freeway document for each 
of the encodings you want to use. Select the encoding from the popup menu, then specify the fonts and size using the Standard 
and Fixed-width popup menus.

Graphics FW Pro only  

Freeway Pro uses certain default values for GIF, PNG, and JPEG images that it creates. These can be controlled on an image by image 
basis using the Item Output panel of the Inspector palette or you can change the default values Freeway uses.

GIF/PNG
Allows you to specify the default color palette, and whether the resulting images will be interlaced. The settings for GIF and PNG are 
similar, but there is an option for PNGs to be saved with a color depth of “millions”.

JPEG 
Allows you to specify whether images are made progressive, and the default compression/quality level. The higher the quality setting, 
the larger will be the images exported by Freeway.

The Document Setup dialog in Freeway Express (above),  
showing the options in the Upload tab
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What is meant by Interlaced and Progressive?

Interlaced GIF and PNG graphics are displayed gradually as the file 
is downloaded by the browser. Your viewers see the image forming as 
they wait for the full file to download. Interlaced graphics may have 
slightly larger file sizes, but let viewers on slow Internet connections, 
such as a modem, to begin to see an image before it is fully loaded. 

Browsers can display JPEG images gradually as the file is 
downloaded so that viewers see the image forming on the page in 
their browser. Note that-progressive JPEGs are generally larger and 
take slightly longer to download than non-progressive JPEGs. 

Apply bilinear scaling to images 
This option allows you to determine whether images will be 
scaled using bilinear filtering. Bilinear scaled images generally look 
smoother than images that are scaled without bilinear filtering. This 
setting will not affect images imported as pass-through into HTML 
item boxes.

Dither images with 256 or fewer colors
This setting automatically dithers images with fewer than 256 colors to 
improve their appearance.

Mobile FW Pro only  

Freeway Pro offers a dedicated tab in the Document Setup dialog for 
Mobile options.

ViewPort Width
This popup offers four options:

Automatic 
This is the default option, and with this option chosen it will 
mean that a smartphone or tablet device will simply fill the 
device’s screen with the full width of the website. This will mean 
that if you have a website with a page width of 960px, the screen 
will display that 960px across the full width of the screen (ie, the 
browser background will not be visible in the width). One of the 
major benefits of this is that the site will always fill the device’s 
screen width, regardless of whether you change the screen from 
upright to landscape aspect.

Device Width 
This option will display the web page at its full size according to 
the pixel dimensions of the screen. This will mean that if you view a web page on an iPhone in upright mode you will only see the 
top left of the website, containing just 320px or 640px of content across the width (depending on whether it is being viewed on an 
iPhone 3 or iPhone4 and later) and just 480px, 960px or 1136px of height (again depending on the model). To view the whole page 
the visitor will need to pinch on the touchscreen to zoom out to display the full page. This is the option you should use if you are 
building a smartphone specific web page (by using the Mobile Redirect Action).

None 
Selecting None will mean that no ViewPort attribute will be used—which will mean that the default of 980px will be used.

Other 
Just as you can decide to use full width or the individual smartphone’s/tablet’s device screen width you can also choose to use your 
own custom width value.

ViewPort Height
This popup offers four options: Automatic, Device Width, None and Other. However, this option is rarely used because most web 
designers and visitors will normally expect the width to be most important aspect. Setting the ViewPort scaling to the page’s height will 
mean that longer pages will scale to a smaller size than shorter pages—and long pages will show the browser background used on the 
page rather than the page content.

Page can be Scaled on mobiles
This option is checked by default—which means that the visitor can zoom in and out by pinching out or in or by double-tapping on 
any column to fill the screen with the column’s width. It is very rare for this to be unchecked.

The Document Setup dialog in Freeway Pro, showing the  
options in the Graphics tab

The Document Setup dialog in Freeway Pro, showing the  
options in the Mobile tab
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Initial Scale
This option is unchecked by default. If you check the checkbox on the left you can then enter a percentage value which will be used to 
display the web page when it is first loaded on the device.

Minimum Scale and Maximum Scale
You can choose to enter a minimum and maximum level of zooming that the visitor can use. By default this is set to 25% for Minimum 
Scale and 160% for Maximum Scale. Unless you have a very specific reason to choose a different zoom level, we recommend you leave 
this to the defaults.

Telephone Number Detection
This option is checked by default—which will mean that a telephone number used on the page as HTML text will automatically be 
changed to a hyperlink using the “tel:” protocol when it is viewed on a mobile device. This makes it very simple for a visitor to simply 
click on a telephone number on their smartphone screen to make a phone call to that number. If you don’t want this feature to be used 
on smartphones, you can choose to switch it off.

Working with Freeway’s Toolbar
The Toolbar provides access to the tools you use for 
creating and editing items on your Freeway page.

The tools are described on page 240.

Changing the Toolbar view
The Toolbar view can be changed to suit the way you may work: 

•	 To change the Toolbar view, Command-click on the  button in the top right 
corner of the document window. This cycles through the following views: small icon 
with text, icon only, small icon only, text, text only and back to the default view.

•	 By Control-clicking on the Toolbar, you can choose an alternative view from the 
contextual menu.

•	 Hide the Toolbar by clicking the  button in the top right corner of the 
document window. This rolls the Toolbar up into the document window’s title bar. 
To show the Toolbar, click on the  button again. 

Customizing the Toolbar

The default tool set can also be customized. To do this, choose Customize Toolbar… from the View menu, or Control-click on the 
Toolbar area and choose Customize Toolbar… from the contextual menu. This presents the customization panel which allows you to 
drag your preferred tools into the Toolbar, and change their order if you wish.

Freeway Pro default Toolbar

Freeway Express default Toolbar
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•	 To add a tool to the Toolbar, drag the icon of the tool you wish to add into the Toolbar area and drop it where you want it to 
appear. The other tools will move to make room for the new tool you place.

•	 To remove a tool, drag it out of the Toolbar. 

•	 To return the Toolbar to the default tool set, drag the default set shown at the bottom of the customization panel.

Dragging a tool into the Toolbar.

Deleting a tool from the Toolbar.

You can also remove a tool directly from the Toolbar without opening the customization panel by L-clicking the tool you wish to 
remove and choosing Remove Item from the contextual menu. Note that this action only removes the item from the Toolbar, it does 
not completely delete the tool from Freeway itself.

The Inspector button
The Inspector button, found at the extreme right of the Toolbar, allows you to quickly show or 
hide the Inspector palette. Clicking and holding the button shows all the palettes that are not 
available in the Toolbar.

Modifier keys
Holding down certain keys on the keyboard while using any tool will alter the behavior of the 
tool until you release the key.

Holding the Alt key temporarily changes any tool (except the Zoom tool) to a grabber hand, 
allowing you to drag the page around within the window. Holding the Alt key while using the 
Zoom tool changes it from zoom in to zoom out.

Holding the Command key temporarily changes to the Select tool, allowing you to select, 
deselect, or move items.

Shift-Command temporarily changes to the Zoom tool.

For more information about using the Zoom tool, see Viewing the page at different magnifications 
on page 38.

Tools palette FW Pro only  

To show the Tools palette, choose Tools from the View menu. A floating palette of tools appears.

The Tools palette cannot be customized, but it does have the advantage that it can be moved freely about the screen, or “docked” to 
other floating palettes. It also allows the main Toolbar to be hidden, freeing up extra space to work on your document. 

Certain tools in the palette feature a small triangle, which denotes that clicking and holding the tool will show a submenu of 
further tools in that group. 

The Tools palette, 
shown with the CSS 
Layout button active.

The Tools palette, 
showing the HTML tool 

submenu which gives access 
to the various form tools.

The Inspector button contains 
a menu of palettes that can be 
shown or hidden by choosing from 
the list.
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Tools
The tools allow you to create or manipulate the different types of item you work with in Freeway. The tools available in Freeway Express 
can be found on page 241.

Standard tools (Freeway Pro)

Back/Forward  Steps between recently visited pages.

Select tool  Selects of manipulates items or edits text.

Zoom tool  Zooms in and out of the Freeway window to change the viewed scale of what you are working on.

CSS Layout  Specifies whether new items added to the page use CSS layers or invisible tables (compatible with older 
browsers).

HTML  Draws an HTML item on your page, to enter HTML text in your site or contain a web-ready graphic format 
such as GIF, JPEG, or PNG. Clicking and holding this tool displays a submenu with further tools.

Table  Draws a table on your page, with a specified number of rows and columns derived from a dialog box.

Action  Adds a Freeway Action to page. Clicking and holding this tool displays a submenu with further tools.

Graphic  Draws a rectangular graphic items on your page which can hold an image or text. Clicking and holding this 
tool displays a submenu with further tools.

Oval  Draws a graphic item with an oval outline.

Map Area  Draws rectangular clickable areas on images. Clicking and holding this tool displays a submenu with 
further tools.

Rotate  Rotates graphic items. Clicking and holding this tool displays a submenu with further tools. 

Flow tool  Links two or more HTML or graphic items that contain text so the text can flow between them. Clicking 
and holding this tool displays a submenu with further tools.

Inspector  Displays or hides the Inspector palette. Clicking and holding this tool displays a submenu with further 
tools.

Optional tools (Freeway Pro)
These are available from submenus on the standard tools, or you can add them to the Toolbar using the Customize Toolbar… 
command on the View menu (see Customizing the Toolbar on page 238).

Separator  Adds a dividing line to the Toolbar.

Space  Adds a space to the Toolbar.

Flexible space  Adds a space that right aligns subsequent tools.

Customize  Displays the Customize Toolbar dialog box.

Break Flow  Unlinks HTML or graphic items that have been linked with the Flow tool.

Path  Draws a graphic item with an arbitrary outline constructed from straight lines or smooth curves.
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Button  Adds a button to a form.

Checkbox  Adds a checkbox to a form.

Radio  Adds a radio button to a form.

Text Field  Adds a text field to a form.

Menu/List  Adds a popup menu or list item to a form.

Text Area  Adds a text area to a form.

Oval Map Area  Creates a clickable area with an arbitrary outline on an image.

Path Map Area  Creates a clickable area with an arbitrary outline on an image.

Skew  Skews graphic items.

Mirror  Mirrors graphic items.

Styles & Colors  Displays or hides the Styles & Colors palette.

Actions  Displays or hides the Actions palette.

Frames  Displays or hides the Frames palette.

Standard tools (Freeway Express)

Back/Forward  Steps between recently visited pages.

Select tool  Selects of manipulates items or edits  
text.

Zoom tool  Zooms in and out of the Freeway window to change the viewed scale of what you are working on.

HTML  Draws an HTML item on your page, to enter HTML text in your site or contain a web-ready graphic format such 
as GIF, JPEG, or PNG. Clicking and holding this tool displays a submenu with further tools.

Action  Adds a Freeway Action to page. Clicking and holding this tool displays a submenu with further tools.

Graphic  Draws a rectangular graphic items on your page which can hold an image or text. Clicking and holding this 
tool displays a submenu with further tools.

Oval  Draws a graphic item with an oval outline.

Map Area  Draws rectangular clickable areas on images. Clicking and holding this tool displays a submenu with further 
tools.

Rotate  Rotates graphic items. Clicking and holding this tool displays a submenu with further tools. 
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Flow tool  Links two or more HTML or graphic items that contain text so the text can flow between them. Clicking and 
holding this tool displays a submenu with further tools.

Colors  Displays or hides the Mac OS X system colors palette. 

Inspector  Displays or hides the Inspector palette. 

Optional tools (Freeway Express)
These are available from submenus on the standard tools, or you can add them to the Toolbar using the Customize Toolbar… 
command on the View menu (see Customizing the Toolbar on page 238).

Separator  Adds a dividing line to the Toolbar.

Space  Adds a space to the Toolbar.

Flexible space  Adds a space that right aligns subsequent tools.

Customize  Displays the Customize Toolbar dialog box.

Break Flow  Unlinks HTML or graphic items that have been linked with the Flow tool.

Path  Draws a graphic item with an arbitrary outline constructed from straight lines or smooth curves.

Table  Draws a table on your page, with a specified number of rows and columns derived from a dialog box.

Button  Adds a button to a form.

Checkbox  Adds a checkbox to a form.

Radio  Adds a radio button to a form.

Text Field  Adds a text field to a form.

Menu/List  Adds a popup menu or list item to a form.

Text Area  Adds a text area to a form.

Oval Map Area  Creates a clickable area with an arbitrary outline on an image.

Path Map Area  Creates a clickable area with an arbitrary outline on an image.
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Appendix 3

Keyboard Shortcuts

Freeway menu

C 	 Preferences…

Ch	 Hide Freeway

COhH	 Hide Others

Cq	 Quit Freeway

 
File menu

Cn	 New…

Co	 Open…

COo	 Open Backup…

Cw	 Close

COw	 Close All

Cs	 Save

CSs	 Save As…

Ce	 Import Text…/Import…

COe	 Export…

Cp	 Publish Site

CLp	 Publish Everything

COb	 Preview (in default browser)

Cu	 Upload…

 
Edit menu

Cz	 Undo/Redo

Cx	 Cut

Cc	 Copy

COc	 Copy Content

CSOc	 Copy as Picture (externalize the clipboard)

Cv	 Paste

Cb	 Delete Content

Ca	 Select All

Ck	 Hyperlink…
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= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:

CSOk	 Follow Link…/Check Link…

CSa	 Anchor…

Cf	 Find…

Cg	 Find Next

CSg	 Find Previous

CLh	 Find Previous Selection

Cr	 Replace…

Ct	 Replace Next

CSt	 Replace Previous

Cl	 Spelling…

 
Page menu

COn	 New Pages…

COf	 Form Setup…

 
Item menu

COt	 Transform… FW Pro only  

COSm	 Modify…/Modify Text… FW Pro only  

CSd	 Fit Box to Content

COx	 Extended…

COl	 Lock

CSOl	 Unlock

C=	 Bring to Front

C-	 Send to Back

C/	 Align to Grid FW Pro only  

COg	 Group/Ungroup

Cy	 Align…

Ct	 Distribute…

Cd	 Duplicate…

CSk	 Graphic: Original Size

OCSk	 Graphic: Pixel Size

CSm	 Graphic: Center

CSf	 Graphic: Scale to Box

CSO.	 Graphic: Scale Up

CSO 	 Graphic: Scale Down

CD	 Table: Join Cells
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Style menu

CS\	 Size: Other…

CS.	 Size: Next Size

CS 	 Size: Previous Size

CSO.	 Size: Grow Size

CSO 	 Size: Shrink Size

CSp	 Type Style: Plain

CSb	 Type Style: Bold

CSi	 Type Style: Italic

CSu	 Type Style: Underline

CSw	 Type Style: Word Underline

CSo	 Type Style: Outline

CSO\	 Width: Other…

CS9	 Width: Increase Width by 5%

CS0	 Width: Decrease Width by 5%

CSO9	 Width: Increase Width by 1%

CSO0	 Width: Decrease Width by 1%

CS]	 Spacing: Increase Spacing by 5%

CS[	 Spacing: Decrease Spacing by 5%

CSO]	 Spacing: Increase Spacing by 1%

CSO[	 Spacing: Decrease Spacing by 1%

CS=	 Baseline: Raise Baseline by 5%

CS-	 Baseline: Lower Baseline by 5%

CSO=	 Baseline: Raise Baseline by 1%

CSO-	 Baseline: Lower Baseline by 1%

CSl	 Alignment: Left

CSr	 Alignment: Right

CSj	 Alignment: Justified

CSOj	 Alignment: Forced

OCÂ	 List: Increase indent

OCÒ	 List: Decrease indent

CSe	 Leading: Other…

CS	 Leading: Increase Leading by 1px or 10%

CS;	 Leading: Decrease Leading by 1px or 10%

CSO	 Leading: Increase Leading by 1/10th px or 1%

CSO;	 Leading: Decrease Leading by 1/10th px or 1%

 
= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:
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Insert menu

CE	 Break (to next box in text flow)

SR	 New Line

CSR	 Rule

 
View menu

COz	 Zoom…

C1	 Actual Size

C0	 Fit in Window

CSOi	 Invisibles

CSOo	 Outlines

CSOt	 Titles

CSOg	 Guides

CSOp	 Graphics Preview

CSOh	 HTML layout

C[	 Back

C]	 Forward

COm	 Master Page

COp	 Preview in Freeway

COr	 Hide/Show Rulers

COs	 Hide/Show Site panel

 
Window menu

CSn	 New Window FW Pro only  

COi	 Inspector

COy	 Styles and Colors FW Pro only  

COa	 Actions

CSh	 Show/Hide Palettes

 
Selecting combined graphic items

OS click an item	 Selects all combined items* or its enclosing bounds

 *�If the items are grouped so that they become children of a graphic, OS-clicking will select the enclosing item.

 
Selecting and editing text

R	 Place text cursor in selected box

SÂ	 Highlight next character

= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:



Freeway Reference: Appendices
247

247

SÒ	 Highlight previous character

SÎ	 Highlight to next line

SË	 Highlight to previous line

SOÂ	 Highlight text to beginning of next word

SOÒ	 Highlight text to beginning of previous word

SOÎ	 Highlight text to beginning of next paragraph

SOË	 Highlight text to beginning of current paragraph

OÂ	 Moves to beginning of next word

OÒ	 Moves to beginning of previous word

OÎ	 Moves to end of current paragraph

OË	 Moves to beginning of current paragraph

CÒ	 Moves to beginning of line

CÂ	 Moves to end of line

CË	 Moves to beginning of text box

CÎ	 Moves to end of text box

SD	 Delete next character

 
Manipulating items
Shortcut	 Command

Hold S then draw	 Constrain box shape to square/circle

Start drawing then hold O	 Draw from center

Arrow keys ËÒÎÂ	 Move box by nudge distance

O +Arrow keys ËÒÎÂ	 Move box by 1/10th nudge distance (minimum 1px)

S + Arrow keys ËÒÎÂ	 Resize box in direction of arrow by nudge distance

SO + ËÒÎÂ	 Resize box in direction of arrow by 1/10th nudge 
	 distance (minimum 1px)

Drag handle and S	 Constrain shape of box to square circle

Drag handle and SO	 Constrain proportions of box (and scale graphic content)

CSd	 Fit box to content

S drag	 Move with horizontal and vertical constraints

Start drag with Select tool and then	 Move and clone box  
hold O

Start drag with Rotate tool then hold O	 Rotate and clone box and FW Pro only  	

Start drag with Skew tool then hold O	 Skew and clone box and FW Pro only  	

Start drag with Mirror tool then hold O	 Mirror and clone box and FW Pro only  	

S click box	 Add box to selection/Remove box from selection

 

= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:



Freeway Reference: Appendices
248

248

Manipulating graphic items
Shortcut	 Command

COt	 Display Transform dialog FW Pro only  

CSk	 Restore graphic to original size

CSd	 Fit box to content

CSm	 Center graphic in box

CSf	 Scale graphic exactly to box

CSOf	 Scale graphic to box maintaining proportions

CSO.	 Increase scaling of contents of box by 5%

CSO 	 Decrease scaling of contents of box by 5%

Start resizing box and then hold L	 Temporarily set graphic behavior to Preserve Size	

Start resizing box and then hold C	 Temporarily set graphic behavior to Scale	

Start resizing box and then hold CO	 Temporarily set graphic behavior to Scale and Pad	

Start resizing box and then O 	 Temporarily set graphic behavior to Scale and Trim

 
Manipulating tables
Shortcut	 Command

C click on cell	 Select a cell

CO click on an already selected cell	 Select a table

C click anywhere on a table and begin	 Move a table 
dragging

Select a cell; CS click another cell; 	 Join cells 
then type CD

Point to border between border two rows	 Resize a row or column (affects overall table size) 
or columns so cursor changes to resizing  
cursor; drag to desired size

With resizing cursor, C drag	 Resize a row or column (overall table size will not change) 
border between two rows or columns

With resizing shape, O drag border	 Insert a row or column 
between two rows or columns

Cb	 Delete contents of selected cells

 
Dialog boxes and palettes
Shortcut	 Command

R or E	 OK in a dialog box

‰	 Cancel in a dialog box

T	 Highlight next field in dialog box palette

ST	 Highlight previous field in dialog box/palette

C click on color in palette	 Displays Color dialog box FW Pro only  	

= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:
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C click on highlighted style	 Removes the style from the currently selected text or item  
in Styles & Colors palette	 item FW Pro only  

O click on style name in	 Edit style name FW Pro only   
Styles & Colors palette

O click on name in Site panel	 Edit name	

O click on color name in Styles & Colors	 Edit color name FW Pro only   
palette	

CLT	 Show Tools palette and select next tool FW Pro only  

CLST	 Show Tools palette and select previous tool FW Pro only  

 
Zoom control
Shortcut	 Command

LS click or LS drag	 Zoom in	

LSO click	 Zoom out

 
Special text characters

Shortcut	 Command

O-	 En dash

SO-	 Em dash

O then type a space	 Non-breaking space

OSR	 Start a new list block at the current list indent level.

O[	 “ (open double quote)

SO[	 ” (close double quote)

O]	 ‘ (open single quote)

SO]	 ’ (apostrophe or close single quote)

 
General

Shortcut	 Command

L click an object	 Displays a popup contextual menu of commands relating  
	 to the object.

= Alt = Command = Control = Tab = Arrow keys (Up, Left, Down and Right

Note: �Although capital letters are used here, you should use lower-case for all shortcuts

O C L T ËÒÎÂKEY:
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